Oracle Fusion
Cloud Sales
Automation

Implementing Customer Data Management for CX Sales and B2B Service

22C
## Contents

### Get Help

<table>
<thead>
<tr>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>i</td>
</tr>
</tbody>
</table>

### 1 About This Guide

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Audience and Scope</td>
<td>1</td>
</tr>
<tr>
<td>Related Guides</td>
<td>1</td>
</tr>
</tbody>
</table>

### 2 Implementation Overview

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overview of Implementing Customer Data Management</td>
<td>3</td>
</tr>
<tr>
<td>Where You Perform Customer Data Management Setup Tasks</td>
<td>4</td>
</tr>
<tr>
<td>Computer and Other System Requirements</td>
<td>5</td>
</tr>
<tr>
<td>Verify the Need for Additional Licenses</td>
<td>5</td>
</tr>
<tr>
<td>Considerations for Migrating Data Between Environments</td>
<td>6</td>
</tr>
</tbody>
</table>

### 3 Profile Options, Lookups, and Scheduled Processes

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>What are Profile Options, Lookups, and Scheduled Processes?</td>
<td>7</td>
</tr>
<tr>
<td>Profile Options</td>
<td>7</td>
</tr>
<tr>
<td>Lookup Types</td>
<td>10</td>
</tr>
<tr>
<td>Scheduled Processes</td>
<td>17</td>
</tr>
</tbody>
</table>

### 4 Users and Security

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overview of Defining Setup Users</td>
<td>19</td>
</tr>
<tr>
<td>Configure Password Policies</td>
<td>19</td>
</tr>
<tr>
<td>Discard Domain Emails</td>
<td>19</td>
</tr>
</tbody>
</table>

### 5 Geographies

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overview of Geographies</td>
<td>23</td>
</tr>
<tr>
<td>Best Practices for Managing Geography Mismatches</td>
<td>46</td>
</tr>
<tr>
<td>Overview of Zone Types and Zones</td>
<td>48</td>
</tr>
<tr>
<td>Import Geographies and Zones</td>
<td>50</td>
</tr>
<tr>
<td>Set Up Geocoding</td>
<td>74</td>
</tr>
</tbody>
</table>
# Oracle Fusion Cloud Sales Automation
## Implementing Customer Data Management for CX Sales and B2B Service

<table>
<thead>
<tr>
<th>Chapter</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Manage Relationship Groups</td>
<td>116</td>
<td></td>
</tr>
</tbody>
</table>

### Chapter 11: Classifications

- Classification Components  
  - Page 119
- How You Manage Organization Type Field  
  - Page 120
- FAQs for Define Classifications  
  - Page 121

### Chapter 12: Data Formats

- Data Styles and Data Formats  
  - Page 125
- Types of Data Formats  
  - Page 125
- Create an Address Style Format  
  - Page 126
- Update Address Formats  
  - Page 129
- Seeded Address Formats for Countries  
  - Page 130
- Create a Name Style Format  
  - Page 139
- FAQs for Define Data Formats  
  - Page 142

### Chapter 13: Contact Points

- Telephone Numbering Plan  
  - Page 145
- Update Telephone Numbering Plans  
  - Page 145
- How Telephone Number Plans Setup Fits in with other Setup Tasks  
  - Page 146
- FAQs for Define Contact Points  
  - Page 146

### Chapter 14: Import Your Data

- Data Import Options  
  - Page 149
- Import Attachments  
  - Page 154
- Import Data  
  - Page 158
- How You Enable Survivorship During Import  
  - Page 164
- Import Data  
  - Page 165

### Chapter 15: Export Your Data

- About Export Management  
  - Page 203
- Export Data  
  - Page 204
- Export Queues  
  - Page 209
- How You Manage Export Objects  
  - Page 210
- How You Monitor Export Activity  
  - Page 214
<table>
<thead>
<tr>
<th>Chapter</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>16</td>
<td>Configure Data Enrichment</td>
<td>219</td>
</tr>
<tr>
<td></td>
<td>Overview of Configuring Data Enrichment</td>
<td>219</td>
</tr>
<tr>
<td></td>
<td>Best Practices for Data Enrichment</td>
<td>222</td>
</tr>
<tr>
<td></td>
<td>Specify the Industry Classification for Accounts</td>
<td>222</td>
</tr>
<tr>
<td></td>
<td>Manual Data Enrichment</td>
<td>223</td>
</tr>
<tr>
<td>17</td>
<td>Manage Profile Options</td>
<td>225</td>
</tr>
<tr>
<td></td>
<td>Customer Hub Profile Options</td>
<td>225</td>
</tr>
<tr>
<td></td>
<td>Data Quality Profile Options</td>
<td>229</td>
</tr>
<tr>
<td></td>
<td>Foundation Profile Options</td>
<td>231</td>
</tr>
<tr>
<td>18</td>
<td>Duplicate Identification Setup</td>
<td>237</td>
</tr>
<tr>
<td></td>
<td>Overview of Duplicate Identification</td>
<td>237</td>
</tr>
<tr>
<td></td>
<td>Enterprise Data Quality Server Configurations</td>
<td>237</td>
</tr>
<tr>
<td></td>
<td>Enterprise Data Quality Matching Configurations</td>
<td>237</td>
</tr>
<tr>
<td></td>
<td>Manage Enterprise Data Quality Matching Configurations</td>
<td>241</td>
</tr>
<tr>
<td></td>
<td>Duplicate Identification Simplified Profile Options</td>
<td>242</td>
</tr>
<tr>
<td></td>
<td>Unique Identifiers and Elimination Identifiers</td>
<td>245</td>
</tr>
<tr>
<td></td>
<td>Manage Custom Match Rules and Scoring</td>
<td>246</td>
</tr>
<tr>
<td></td>
<td>Create Custom Match Rules</td>
<td>247</td>
</tr>
<tr>
<td></td>
<td>Considerations for Selecting Sources of Match Rules and Scoring</td>
<td>247</td>
</tr>
<tr>
<td></td>
<td>How You Configure Synonyms and Skip-words Dictionary</td>
<td>248</td>
</tr>
<tr>
<td></td>
<td>Key Generation</td>
<td>249</td>
</tr>
<tr>
<td></td>
<td>Select Customer Identifying URLs During Duplicate Identification</td>
<td>251</td>
</tr>
<tr>
<td></td>
<td>Identify Duplicates in Real-Time Using REST APIs and SOAP Web Services</td>
<td>252</td>
</tr>
<tr>
<td></td>
<td>FAQs for Duplicate Identification</td>
<td>254</td>
</tr>
<tr>
<td>19</td>
<td>Data Verification Setup</td>
<td>255</td>
</tr>
<tr>
<td></td>
<td>Overview of Data Verification</td>
<td>255</td>
</tr>
<tr>
<td></td>
<td>Configure Customer Data Management Cloud to Verification Services Integration</td>
<td>256</td>
</tr>
<tr>
<td></td>
<td>Enable the Verification of Addresses, Emails, and Phone Numbers</td>
<td>256</td>
</tr>
<tr>
<td></td>
<td>Phone and Email Verification</td>
<td>257</td>
</tr>
<tr>
<td></td>
<td>Address Cleansing Configuration</td>
<td>257</td>
</tr>
</tbody>
</table>
20 Duplicate Resolution Setup

Duplicate Resolution Simplified Profile Options
How You Validate the Customer Data Management Setup
Run Request Dispatch Job
Set Up Duplicate Resolution Using Groovy Scripts
Set Up Duplicate Resolution Using Oracle Business Rules
Source System Confidence
Automerge
High Volume Batch Deduplication
FAQs for Duplicate Resolution

21 Customer Data Management Integration with Other Cloud Services

Customer Data Management Integration Approaches
Merge Operation Process During Integration Cloud Service Based Integration
Get Help

There are a number of ways to learn more about your product and interact with Oracle and other users.

Get Help in the Applications
Use help icons to access help in the application. If you don't see any help icons on your page, click your user image or name in the global header and select Show Help Icons.

Get Support
You can get support at My Oracle Support. For accessible support, visit Oracle Accessibility Learning and Support.

Get Training
Increase your knowledge of Oracle Cloud by taking courses at Oracle University.

Join Our Community
Use Cloud Customer Connect to get information from industry experts at Oracle and in the partner community. You can join forums to connect with other customers, post questions, suggest ideas for product enhancements, and watch events.

Learn About Accessibility
For information about Oracle's commitment to accessibility, visit the Oracle Accessibility Program. Videos included in this guide are provided as a media alternative for text-based topics also available in this guide.

Share Your Feedback
We welcome your feedback about Oracle Applications user assistance. If you need clarification, find an error, or just want to tell us what you found helpful, we'd like to hear from you.

You can email your feedback to oracle_fusion_applications_help_ww_grp@oracle.com.

Thanks for helping us improve our user assistance!
1 About This Guide

Audience and Scope

This guide provides conceptual information and procedures needed to implement customer data management-specific components and features of your application.

You can use this guide to implement customer data management capabilities such as duplicate identification, duplicate resolution, address verification, and data enrichment. This guide assumes that the application is up and running at a basic level, as described in the use case contained in the Getting Started with Your Sales Implementation.

This guide also assumes that you have done additional setup for Core Sales following the Implementing Sales guide.

Related Guides

You can refer to the related guides listed in the following table to understand more about the tasks covered in this guide.

<table>
<thead>
<tr>
<th>Title</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Understanding Import and Export Management for CX Sales and B2B Service</td>
<td>Describes how to import legacy and other data into Oracle CX Sales and B2B Service using Import and Export Management, and export data out of these applications.</td>
</tr>
<tr>
<td>Using Account and Contact Enrichment by Dun &amp; Bradstreet</td>
<td>Describes how to use Oracle Account and Contact Enrichment by Dun &amp; Bradstreet (D&amp;B) to update company and contact data in your Oracle Cloud application.</td>
</tr>
<tr>
<td>Using Oracle Address, Email, and Phone Verification</td>
<td>Describes how to use Oracle Address, Email, and Phone Verification to verify and standardize addresses, emails, and phone numbers in your Oracle Cloud application.</td>
</tr>
</tbody>
</table>
2 Implementation Overview

Overview of Implementing Customer Data Management

To start an implementation of Customer Data Management Cloud, a user with the Application Implementation Consultant role (ORA_ASM_APPLICATION_IMPLEMENTATION_CONSULTANT_JOB) must opt into the offerings applicable to your business requirements.

Refer to the Oracle Applications Cloud Using Functional Setup Manager guide to manage the opt-in and setup of your offerings.

Customer Data Management Offering

Use the Customer Data Management offering to configure the customer data management processes to clean, consolidate, and enrich customer information, and to create a trusted master customer profile.

The following table specifies the primary functional areas of the Customer Data Management offering. For the full list of functional areas and features in the Customer Data Management offering, use the Associated Features report that you review when you plan the implementation of your offering.

<table>
<thead>
<tr>
<th>Functional Area</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data Quality</td>
<td>Manage data quality configurations to define how the data quality services, such as data quality matching and cleansing, are run during real time and during batch execution. Data quality services use these configurations to call appropriate services of the embedded data quality engine to consolidate, cleanse, and enrich customer data.</td>
</tr>
<tr>
<td>Customer Hub</td>
<td>Manage setup for the following features:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Customer Information Management</strong>: Import, create, and manage customer information, such as profile, usage assignments, relationships, classifications, source system references, hierarchy memberships, linked records, accounts, and contacts, in the Organizations, Persons, and Groups work areas.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Hierarchy Management</strong>: Manage the hierarchy of your customers across business processes. For example, you can use the hierarchy management capability to capture your customer’s corporate hierarchy and to show how headquarters, branches, subsidiaries, and so on are related. You can use the corporate hierarchy information to process payments from one customer and apply them to another customer in the same hierarchy.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Data Enrichment</strong>: Enrich account and contact data to ensure it’s comprehensive. Data enrichment improves the quality of your existing account or contact data and address information as well as enriches that data with additional information.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Duplicate Identification</strong>: Identify potential duplicates during data entry, data integration, or among records already in the application.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Duplicate Resolution</strong>: Resolve duplicates either by directly merging them or by creating duplicate resolution request, such as merge or link. The resolution request can be verified, approved or rejected, and processed later.</td>
</tr>
</tbody>
</table>

ORACLE
## Chapter 2
### Implementation Overview

<table>
<thead>
<tr>
<th>Functional Area</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Address Cleansing</td>
<td>Cleanse address data existing in the registry and ensures data accuracy over time. Real-time address cleansing ensures that the incoming data from source systems follows the same convention as the target system for consistent information.</td>
</tr>
</tbody>
</table>

**Related Topics**
- Plan Your Implementation

### Where You Perform Customer Data Management Setup Tasks

For most Customer Data Management setup tasks, you use the Setup and Maintenance work area to access the setup pages associated with the component or feature. The Setup and Maintenance work area is also known as the Functional Setup Manager.

**Note:** To start an implementation of Customer Data Management, a user with the Configure Oracle Fusion Applications Offering privilege (ASM_CONFIGURE_OFFERING_PRIV) such as Application Implementation Consultant, must opt into the offerings applicable to your business requirements. Refer to the Oracle Applications Cloud Using Functional Setup Manager guide to manage the opt-in and setup of your offerings.

For Customer Data Management setup tasks, a user with the Master Data Management Application Administrator role performs many, if not most, of the setup and configuration tasks.

You navigate to the Customer Data Management offering to access setup tasks:

1. Sign in as the Master Data Management Application Administrator or as a setup user and navigate to the Setup and Maintenance work area. The Setup page appears with an offering selected.

   **Tip:** To navigate to Setup and Maintenance, you can use the Navigator menu or the menu underneath your user image or name in the global header.

2. In the Setup page, select the Customer Data Management offering.

   The Setup: Customer Data Management page appears with a list of functional areas.

3. In the list of functional areas, click the functional area that has the tasks you need to access. A list of required tasks for the area is displayed.

4. In the list of tasks that appears, find the task you want and select it. (If the task you want isn't in the list, select All Tasks in the tasks filter.)

   The setup page for the task appears.

For more information about Functional Setup Manager, see the Oracle Applications Cloud Using Functional Setup Manager guide and the related topics.
Computer and Other System Requirements

Before using Oracle cloud applications in browsers and on your mobile devices, check the operating systems, supported browsers, and other computer requirements.

For information about system requirements, see the Related Topics. For previous releases, scroll to the end of the System Requirements for Oracle Applications Cloud page and find the system requirements link for the applicable previous release.

Verify the Need for Additional Licenses

You can only enable the functional areas for which your company has purchased licenses.

Customer Data Management is shipped free of cost with some Oracle Cloud Services such as Oracle CX. An Oracle CX license provides you access to the following customer data management functionality:

- Data Steward Productivity Tools
- Reporting and Analytics
- Audit Reporting
- Customer Hub
- Customer Hierarchy Management

To make use of Data Quality, Data Enrichment, and Address, Email, and Phone Verification capabilities, you require the following additional licenses:

- Oracle Fusion Data Quality Cloud Service: This service enables you to identify and resolve potential duplicates records in the database or potential duplicates of the records in the database within an import batch. You can use this service for both real-time and batch duplicate identification.
- Oracle Account and Contact Enrichment by Dun & Bradstreet (D&B): This service enables you to cleanse and verify addresses.
- Oracle Account Enrichment Cloud Service and Oracle Contact Enrichment Cloud Service: These licenses enable you to enrich company and contact data.
- Oracle DataFox: This service enables you to elevate business performance across the enterprise with account intelligence data.
Considerations for Migrating Data Between Environments

When you implement and maintain your Oracle Cloud applications, you almost always need to migrate data from one environment to another during the application life cycle.

For example, one typical use case in any enterprise application implementation is to first implement the applications in a development or test application environment and then deploy it to a production application instance after thorough testing. You use various methods or tools to accomplish the migration of data.

**Note:** When you migrate data to a new environment, the application doesn't retain all user-set values for various parameters. You need to add these values manually. For example, you need to set some profile option values again, even if they were previously set.

For more information on migrating data between environments, see the "Setup Data Export and Import" chapter in the Oracle Applications Cloud Using Functional Setup Manager guide.

**Related Topics**
- Overview of Setup Data Export and Import
- Implementation Process
3 Profile Options, Lookups, and Scheduled Processes

What are Profile Options, Lookups, and Scheduled Processes?

Profile options, lookup types, and scheduled processes let you configure application behavior and process data.

Briefly, here’s what profile options, lookup types, and scheduled processes do:

- Profile options: Let you configure the application behavior.
- Lookup types: Provide the lists of values in applications. Many lookup types can be modified to fit your business needs.
- Scheduled processes: Act on data in the applications.

Get additional information on profile options, lookup types, and scheduled processes in this chapter and in the related topics.

Related Topics
- How can I access predefined lookups?
- Overview of Scheduled Processes
- How can I access predefined profile options?

Profile Options

Overview of Profile Options

Profile options let you configure and control application data centrally. Administrators and setup users manage profile options in the Setup and Maintenance work area.

Profile options store various kinds of information. This table lists some examples:

<table>
<thead>
<tr>
<th>Type of Information</th>
<th>Profile Option Setting Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>User preferences</td>
<td>Set preferences at the user level</td>
</tr>
<tr>
<td>Installation information</td>
<td>Identify the location of a portal</td>
</tr>
<tr>
<td>Configuration choices</td>
<td>Change UI skins and actions</td>
</tr>
</tbody>
</table>

ORACLE
Profile Options, Lookups, and Scheduled Processes

Profile Option Hierarchy Levels

Profile options can be set at different levels, such as site level or user level. The application gives precedence to certain levels over others, when multiple levels are set. The levels that are allowed to be set are preconfigured with the application.

In the predefined profile option levels, the hierarchy levels and their precedence are:

1. User: This level affects only the current user. It has the highest precedence, over Site and Product.
2. Product: This level affects a product or product family. The application gives it priority over Site level. However, if the user level is set, the user level takes precedence.
3. Site: This level affects all applications for a given implementation. The application gives it the lowest precedence when other levels are set. If no other levels are set, however, it’s the highest level.

As a best practice, set site-level profile option values before specifying values at any other level (where available). The profile option values specified at the site-level work as the default until profile option values are specified at the other levels.

This table shows an example of the predefined profile option hierarchy levels and their priorities.

<table>
<thead>
<tr>
<th>Level</th>
<th>Priority</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Site</td>
<td>Lowest</td>
<td>Currency for a site is set to Euros.</td>
</tr>
<tr>
<td>Product</td>
<td>Supersedes Site</td>
<td>Currency for the product or set of products is set to UK pound sterling.</td>
</tr>
<tr>
<td>User</td>
<td>Highest, supersedes Product</td>
<td>Currency for a user is set to US dollars.</td>
</tr>
</tbody>
</table>

You can find additional information about profile options in the related topics.

Related Topics
- Set Profile Option Values
- SR Profile Options
- How can I access predefined profile options?

Import Profile Values

Use the Import option on the Manage Administrator Profile Values page to import profile values in bulk and associate them with a profile option.
Before you begin, make sure that the file containing the profile values is available in the document repository of Oracle WebCenter Content.

1. In the Setup and Maintenance work area, go to the Manage Administrator Profile Values task.
2. In the Search: Profile Options section, search for the profile option for which you want to import the values.
3. In the Search Results: Profile Options section, select the profile option.
4. In the <Profile Option>: Profile Values section, click Actions > Import.
5. On the Import User Profile Values window, select the WebCenter Content account to which the file was uploaded.
6. Enter the name of the file containing the profile values. The name here must match with the name of the file uploaded to the selected account.
7. Click Upload. The profile values are imported.

**Note:** If the import fails, click the link to the log file on the confirmation dialog box and examine the cause of failure.

__Related Topics__
- File Format for Importing Profile Values
- Import Flexfields, Lookups, or Profile Values Using Web Services
- How can I bulk update user preferences?
- Overview of Files for Import and Export

### File Format for Importing Profile Values

To import profile option values into the application, you create a text file with the values and upload the file to the Oracle WebCenter Content document repository.

The file must follow a specific format, as described here. After the file is in the document repository, you can then import the profile values into the application following the instructions in the Import Profile Values topic.

To create a file containing the profile values, include the following headers:

- **ProfileOptionCode**: The profile option code.
- **LevelName**: Must contain the value (Site, Product, or User).
- **UserName**: Must correspond to the registered user name in the application. Don't provide any other shortened or coded name of the user.
- **ProfileOptionValue**: The profile value to be imported.

While creating the file, adhere to the following guidelines:

- Use a vertical bar or pipe (|) as a delimiter between fields for both header and value rows.
- Set the file encoding to UTF-8 without the Byte Order Mark (BOM), as per the Oracle WebCenter Content specification.

Here's a sample file that contains the header values at the beginning of the file, followed by line entries of the two profile values that are to be imported. For importing several profile values, add more line entries in a similar format.

```
ProfileOptionCode|LevelName|UserName|ProfileOptionValue
AFLOG_BUFFER_MODE|USER|APP_IMPL_CONSULTANT|TEST
AFLOG_LEVEL|USER|APPLICATION_DEVELOPER|FINEST
```
Lookup Types

Overview of Lookup Types

Lookup types in the applications provide the lists of values in application fields that are drop-down lists.

For example, when closing an opportunity, salespeople can pick a reason that an opportunity was won or lost from the Win/Loss Reason field, which is a drop-down list. The values in that list are derived from the lookup type, MOO_WIN_LOSS_REASON, which has several potential values known as lookups, each with its own unique lookup code and a meaning that displays in the UI.

Configuring Lookup Types

You can configure many lookup types to fit your business needs. The level at which a lookup type is extensible determines whether the lookups in that lookup type can be edited. The levels are: User, Extensible, and System.

This table shows which lookup management tasks are allowed at each level:

<table>
<thead>
<tr>
<th>Allowed Task</th>
<th>User</th>
<th>Extensible</th>
<th>System</th>
</tr>
</thead>
<tbody>
<tr>
<td>Deleting a lookup type</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>Inserting new codes</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Changing the wording that displays on the page (Meaning field)</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Updating start date, end date, and enabled fields</td>
<td>Yes</td>
<td>Yes, only if the code isn't predefined data</td>
<td>No</td>
</tr>
<tr>
<td>Deleting codes</td>
<td>Yes</td>
<td>Yes, only if the code isn't predefined data</td>
<td>No</td>
</tr>
<tr>
<td>Updating tags</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>Updating module</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
</tr>
</tbody>
</table>
If a product depends on a lookup type, the configuration level must be System or Extensible to prevent deletion. After the configuration level is set for a lookup type, it can't be modified. The configuration level for lookup types created using the Define Lookups page is by default set at User level.

Sales Lookup Types

You find lookup types by accessing the associated task in the Sales offering in the Setup and Maintenance work area. Here are some of the common sales lookup tasks or task lists:

To access sales lookup types:

1. Sign in as a setup user and navigate to the Setup and Maintenance work area.
2. In Setup and Maintenance, go to the Sales offering.
3. In the list of functional areas, click the area where the lookup appears. See the list at the end of this procedure for more information.
   A list of tasks for the area is displayed.
4. In the list of tasks, click the lookups task.
5. In the lookup types page, modify the lookup type as needed.

Here are the Sales lookup type tasks and the functional areas where they appear:

- **Sales Foundation functional area:**
  - Manage Geography Lookups
  - Manage Applications Core Standard Lookups
  - Manage Activity Standard Lookups

- **Users and Security functional area:**
  - Manage Resource Role Lookups
  - Manage Resource Lookups

- **Accounts and Contracts functional area**
  - Manage Group Lookups
  - Manage Source System Lookups
  - Manage Hierarchy Lookups
  - Manage Trading Community Common Lookups
  - Manage Party Usage Lookups
  - Manage Relationship Lookups
  - Manage Contact Point Lookups
  - Manage Trading Community Organization Lookups
  - Manage Trading Community Location Lookups
  - Manage Trading Community Person Lookups
  - Manage Contact Lookups
  - Manage Customer Account Lookups
  - Manage Customer Center Lookups
• Sales Catalog and Products functional area:
  o Manage Product Group Lookups

• Sales Campaigns functional area:
  o Manage Marketing Standard Lookups

• Leads functional area:
  o Manage Sales Lead Standard Lookups
  o Manage Set Enabled Lookups

• Opportunities functional area:
  o Manage Set Enabled Lookups

• Territories functional area:
  o Manage Territory Management Non-extensible Lookups

• Business Plans functional area:
  o Manage Business Plan Non-extensible Lookups
  o Manage Objectives Non-extensible Lookups

• Partners functional area:
  o Manage Partner Lookups

Set-Enabled Lookup Types
Several applications support lookup types at the reference set level, allowing you to present different lists of values for different business units. You can find these in the Manage Set Enabled Lookups task within the functional area that supports these lookup types.

Related Topics
• How can I access predefined lookups?
• Why can't I see my lookup types?
• Reference Data Sets

How can I access predefined lookups?
Search for predefined lookups using any of the manage lookups tasks.

1. In the Setup and Maintenance work area, go to any of the following tasks that contains the lookups you're looking for:
  o Manage Standard Lookups
  o Manage Common Lookups
  o Manage Set-enabled Lookups
2. Enter any of the search parameters and click **Search**. If you don’t know the lookup type or the meaning, use the **Module** field to filter search results.

3. Click a lookup type to view its lookup codes.

   **Tip:** Click the Query By Example icon to filter the lookup codes.

---

**Related Topics**
- Use Query By Example

---

### How can I edit lookups?

On any of the Manage Lookups pages, you can edit the existing lookup codes of a lookup type or add new lookup codes. You can edit lookups using the following tasks in the Setup and Maintenance work area:

- Manage Standard Lookups
- Manage Common Lookups
- Manage Set-enabled Lookups

Each task contains a predefined set of lookup types that are classified and stored. Open a task to search and edit the required lookup. However, you may not be able to edit a lookup if its configuration level doesn’t support editing.

---

### Why can't I see my lookup types?

Lookup types are classified using tasks that involve a group of related lookups, such as Manage Geography Lookups. Each task gives you access only to certain lookup types.

However, the generic tasks provide access to all lookup types of a kind, such as common lookups associated with the Manage Common Lookups task. If the lookup types in an application are available in the standard, common, or set-enabled lookups view, they're are central to an application. However, lookup types defined for a specific application are managed using the task for that application.

---

### Import Lookups

On each page pertaining to the tasks of managing the Standard, Common, and Set Enabled lookups, use the Import option to import the lookup type and lookup code information.

**Prerequisite**
The separate files containing the lookup types and lookup codes are already available in the document repository of Oracle WebCenter Content.
Importing Lookups

To import lookups:

1. In the Setup and Maintenance work area, go to the Manage Standard Lookups task. Depending on the lookup you want to import, you may select the other lookup tasks.
2. In Search Results, from the Actions menu, select Import. The Import Lookups dialog box appears.
3. Select the WebCenter Content account to which the files were uploaded.
4. Enter the names of the separate files containing the lookup type and lookup code information. The names here must match with the names of the files uploaded to the selected account.
5. Click Upload. The lookup details are imported.

Note: If the import fails, click the link to the log file on the confirmation dialog box and examine the cause of failure.

Related Topics
- File Format for Importing Lookups
- Import Flexfields, Lookups, or Profile Values Using Web Services

File Format for Importing Lookups

To import lookups into an application, you create separate text files containing the lookup types and lookup codes and upload them to the Oracle WebCenter Content document repository.

The files must follow a specific format, as described here. After the files are in the document repository, you can then import the lookup types and lookup codes into the application following the instructions in the Import Lookups topic.

While creating the file, adhere to the following guidelines:

- Use a vertical bar or pipe ( | ) as a delimiter between fields for both header and value rows.
- Set the file encoding to UTF-8 without the Byte Order Mark (BOM), as per the Oracle WebCenter Content specification.

The following sections contain details about the specific lookup types and codes.

Prerequisite

You must have worked with lookups in Oracle Cloud applications.

Standard and Common Lookups

The lookup types and codes are similar for standard and common lookups. To create a file containing the lookup types, include the following headers:

- **LookupType**: The lookup type.
- **Meaning**: The display name of the lookup type.
- **Description**: The description of the lookup type. This header is optional.
- **ModuleType**: The module with which the lookup type is associated.
Profile Options, Lookups, and Scheduled Processes

Chapter 3

Profile Options, Lookups, and Scheduled Processes

Profile Options, Lookups, and Scheduled Processes

ModuleKey: The module code.

Here’s a sample file that contains the header values at the beginning of the file, followed by line entries of the two lookup types that are to be imported. For importing several lookup types, add more line entries in a similar format.

<table>
<thead>
<tr>
<th>LookupType</th>
<th>Meaning</th>
<th>Description</th>
<th>ModuleType</th>
<th>ModuleKey</th>
</tr>
</thead>
<tbody>
<tr>
<td>AFLOG_22APR_1</td>
<td>Log1</td>
<td>AFLOG_desc_1</td>
<td>APPLICATION</td>
<td>FND</td>
</tr>
<tr>
<td>PROD_22APR_2</td>
<td>Product1</td>
<td>PROD_desc_2</td>
<td>APPLICATION</td>
<td>FND</td>
</tr>
</tbody>
</table>

To create a file containing the lookup codes, include the following headers.

- **Required headers:**
  - **LookupType**: The lookup type.
  - **LookupCode**: The lookup code associated with the lookup type.
  - **DisplaySequence**: The sequence position at which the lookup code appears in the list of values.
  - **EnabledFlag**: Indicates the status of the lookup code, whether it’s enabled for display or not.
  - **Meaning**: The display name of the lookup code.

- **Optional headers:**
  - **StartDateActive**: Beginning of the date range during which the lookup code is active and visible on the page. The format is dd/M/yyyy.
  - **EndDateActive**: End of the date range during which the lookup code is active and visible on the page. The format is dd/M/yyyy.
  - **Description**: Description of the lookup code.
  - **Tag**: Any tag associated with the lookup code that may be used for a quick reference or retrieval of information.
  - **Seg**: The name of the API used for a global segment defined for the descriptive flexfield associated with the lookup.
  - **CONTEXT_ATTRIBUTE**: The context value specified in the CSV file for a particular descriptive flexfield.
  - **ctxSeg**: The name of the API for a context sensitive segment defined for a context attribute.

Here’s a sample file that contains two lookup codes:

<table>
<thead>
<tr>
<th>LookupType</th>
<th>LookupCode</th>
<th>DisplaySequence</th>
<th>EnabledFlag</th>
<th>StartDateActive</th>
<th>EndDateActive</th>
<th>Meaning</th>
<th>Description</th>
<th>Tag</th>
<th>Seg</th>
<th>CONTEXT_ATTRIBUTE</th>
<th>ctxSeg</th>
</tr>
</thead>
<tbody>
<tr>
<td>TASK_22APR_1</td>
<td>Code1_1</td>
<td>1</td>
<td>Y</td>
<td>25/12/2014</td>
<td>25/5/2015</td>
<td>TASK_22apr_1</td>
<td>TASK_desc_1</td>
<td>Tag1_1</td>
<td>testSeg1</td>
<td>TEST_CTX1</td>
<td>ctx1Seg1</td>
</tr>
<tr>
<td>TASK_22APR_1</td>
<td>Code1_2</td>
<td>2</td>
<td>N</td>
<td>25/1/2014</td>
<td>25/11/2015</td>
<td>TASK_22apr_2</td>
<td>TASK_desc_2</td>
<td>Tag1_2</td>
<td>testSeg2</td>
<td>TEST_CTX2</td>
<td>ctx2Seg2</td>
</tr>
<tr>
<td>TASK_22APR_2</td>
<td>Code2_1</td>
<td>3</td>
<td>N</td>
<td>25/12/2012</td>
<td>25/7/2015</td>
<td>TASK_22apr_2</td>
<td>TASK_desc_2</td>
<td>tag2_1</td>
<td>testSeg2</td>
<td>TEST_CTX2</td>
<td>ctx2Seg2</td>
</tr>
<tr>
<td>TASK_22APR_2</td>
<td>Code2_2</td>
<td>3</td>
<td>Y</td>
<td>25/12/2012</td>
<td>25/7/2015</td>
<td>TASK_22apr_2</td>
<td>TASK_desc_2</td>
<td>tag2_2</td>
<td>testSeg2</td>
<td>TEST_CTX2</td>
<td>ctx2Seg2</td>
</tr>
</tbody>
</table>

Set Enabled Lookups

To create a file containing the set enabled lookup types, include the following headers:

- **LookupType**: The lookup type.
- **Meaning**: The display name of the lookup type.
- **Description**: The description of the lookup type. This header is optional.
- **ModuleType**: The module with which the lookup type is associated.
- **ModuleKey**: The module code.
ReferenceGroupName: Name of the reference group that contains the reference data set.

Here's a sample that contains two set enabled lookup types:

<table>
<thead>
<tr>
<th>LookupType</th>
<th>Meaning</th>
<th>Description</th>
<th>ModuleType</th>
<th>ModuleKey</th>
<th>ReferenceGroupName</th>
</tr>
</thead>
<tbody>
<tr>
<td>CODE_22APR_1</td>
<td>CODE_22apr_1</td>
<td>Code_desc_1</td>
<td>APPLICATION</td>
<td>FND</td>
<td>BU_APAC</td>
</tr>
<tr>
<td>CODE_22APR_2</td>
<td>CODE_22qpr_2</td>
<td>Code_desc_2</td>
<td>APPLICATION</td>
<td>FND</td>
<td>BU_APAC</td>
</tr>
</tbody>
</table>

To create a file containing the set enabled lookup codes, include the following headers.

- **Required headers:**
  - `LookupType`: The lookup type.
  - `LookupCode`: The lookup code associated with the lookup type.
  - `DisplaySequence`: The sequence position at which the lookup code appears in the list of values.
  - `EnabledFlag`: Indicates the status of the lookup code, whether it's enabled for display or not.
  - `Meaning`: The display name of the lookup code.
  - `SetName`: Name of the reference data set.

- **Optional headers:**
  - `StartDateActive`: Beginning of the date range during which the lookup code is active and visible on the page. The format is dd/M/yyyy.
  - `EndDateActive`: End of the date range during which the lookup code is active and visible on the page. The format is dd/M/yyyy.
  - `Description`: Description of the lookup code.
  - `Tag`: Any tag associated with the lookup code that may be used for a quick reference or retrieval of information.

Here's a sample file that contains the header values at the beginning and lists four set enabled lookup codes to be imported. For importing several lookup codes, add more entries in the same format.

<table>
<thead>
<tr>
<th>LookupType</th>
<th>LookupCode</th>
<th>DisplaySequence</th>
<th>EnabledFlag</th>
<th>StartDateActive</th>
<th>EndDateActive</th>
<th>Meaning</th>
<th>Description</th>
<th>Tag</th>
<th>SetName</th>
</tr>
</thead>
<tbody>
<tr>
<td>CODE_22APR_1</td>
<td>Code1_1</td>
<td>1</td>
<td>Y</td>
<td>25/12/2014</td>
<td>25/5/2015</td>
<td>DATA_22apr_1</td>
<td>Data_desc_1</td>
<td>Tag1_1</td>
<td>TEST SET CODE 2</td>
</tr>
<tr>
<td>CODE_22APR_2</td>
<td>Code2_1</td>
<td>3</td>
<td>N</td>
<td>25/12/2012</td>
<td>25/7/2015</td>
<td>DATA_22qpr_2_1</td>
<td>Data_desc_2_1</td>
<td>tag2_1</td>
<td>TEST SET_ERR_CODE_Z</td>
</tr>
<tr>
<td>CODE_22APR_1</td>
<td>Code1_2</td>
<td>2</td>
<td>N</td>
<td>25/12/2014</td>
<td>25/11/2015</td>
<td>DATA_22apr_2</td>
<td>Data_desc_2</td>
<td>Tag1_2</td>
<td>TEST SET CODE 3</td>
</tr>
<tr>
<td>CODE_22APR_2</td>
<td>Code2_2</td>
<td>3</td>
<td>Y</td>
<td>25/12/2012</td>
<td>25/7/2015</td>
<td>DATA_22qpr_2</td>
<td>Data_desc_2_2</td>
<td>tag2_2</td>
<td></td>
</tr>
</tbody>
</table>

Related Topics

- Overview of Files for Import and Export
- Guidelines for File Import and Export
- Overview of Lookups
Scheduled Processes

Overview of Scheduled Processes

Scheduled processes do tasks that are too complex or time-consuming to do manually, for example importing data or updating many records. You can run scheduled processes on a recurring schedule and send notifications based on how the process ends.

Some scheduled processes give you printable output. Those processes might have Report in their name.

Use the Scheduled Processes work area to run all the processes you have access to and to manage submissions. If you need access to this work area, ask your security administrator to assign you a role that gives you access, for example a custom role with the Manage Scheduled Processes (FND_MANAGE_SCHEDULED_PROCESSES_PRIV) privilege. Other than the Scheduled Processes work area, you might be also able to run certain processes from other work areas.

Jobs and Job Definitions

Each scheduled process that you run is based on a job. The job is the executable that controls what the process does. Each job needs a job definition, which, for example, determines the parameters and other options you have for the process. You or your administrator can create job definitions for Oracle Analytics Publisher reports so that users can run the reports as scheduled processes.

Process Sets

A process set is a scheduled process that contains multiple processes or even other process sets. So, when you submit a process set, you’re running more than process.

Note: When you submit certain scheduled processes, the job logic causes other processes to automatically run. But in this case, you’re not submitting a process set that includes those other processes.

Submission

When you submit a scheduled process, you can use its parameters to control how, and which records are processed. For example, a process includes only the transactions that were edited by the person you select for a Last Updated By parameter. Some scheduled processes don’t have parameters.

As part of the submission, you can also set up a schedule for the process, for example to run once a week for two months. Every time a process runs, there’s a unique process ID.

Output

Some scheduled processes provide output in PDF, HTML, and other formats. For example, a process can import records and also produce output with details about those records. There are many types of output, for example a tax document or a list of transactions.
View Details About Predefined Scheduled Processes

To use web services to run predefined scheduled processes, you require details about the processes. View job definitions that the processes are based on, for example to get information about parameters.

You might also need to find security requirements for running the scheduled process.

Job Definitions

A job definition contains the metadata that determines how a scheduled process works and what options are available during submission.

To view job definitions:

1. Go to the Setup and Maintenance work area.
2. From the Application Extensions functional area, open any of these tasks as appropriate:
   - Manage Enterprise Scheduler Job Definitions and Job Sets for Financial, Supply Chain Management, and Related Applications
   - Manage Enterprise Scheduler Job Definitions and Job Sets for Human Capital Management and Related Applications
   - Manage Enterprise Scheduler Job Definitions and Job Sets for Customer Relationship Management and Related Applications
3. In the Manage Job Definitions tab, select your job definition and click Edit.

   ![Note: Predefined job definitions are marked with an asterisk.]

4. Cancel after you get the information you need.

Security

Privileges provide the access required to run specific scheduled processes. Privileges are granted to duty roles, which are granted to job roles. To see which job roles inherit the required privileges, use the Security Console or the security reference manuals for the appropriate product family.
Users and Security

Overview of Defining Setup Users

One of your first tasks when setting up the application is the creation of users who can perform setup tasks.

Oracle creates an initial user for you when your environment is provisioned. This initial user is configured to perform security tasks, such as creating other users and granting additional privileges. As an initial user you can create users, known as setup users, to help with application setup. The setup user performs the tasks in implementation projects, sets up enterprise structures, creates application users, and administers security.

Use the Manage Users task in the Setup and Maintenance work area to create setup users. You can access this task in the Setup and Maintenance work area by selecting these options:

- Offering: Customer Data Management
- Functional Area: Users and Security
- Task: Manage Users

For information about creating setup users, see the Oracle Fusion Cloud Sales Automation Getting Started with Your Sales Implementation guide.

Related Topics

Configure Password Policies

The applications have default settings around the user sign-in policies. For example, by default, users have 90 days before their sign-in passwords expire. You can change this default value, and you can configure other sign-in parameters. See the related topics for more information.

Related Topics

- Password Policy
- How can I reset a user’s password?
- User-Name and Password Notifications
- How can I notify users of their user names and passwords?

Discard Domain Emails

During an implementation, you set up users and test business flows that trigger automatic emails. During this stage of setup, you probably don’t want emails being sent to real users, so you can simply use discard email domains that Oracle has made available.
Discard Email Domains

Oracle recommends that you don't use fictitious email addresses, because this causes email bounces. Fictitious emails generally take three forms:

- An incorrect user identifier at a valid domain
- A random domain
- A domain that doesn't exist

Using fictitious email addresses can have numerous negative consequences, including unintentionally sending email to a real person or damaging the reputation of the IP address that sends out the email, potentially flagging it as a sender of spam. For example, you might send an email to tina.best@ssf.com, thinking that ssf is just a random alphabetic sequence and not an actual domain. However, your email is actually sent to the Spruce Street Foods (ssf.com). The Spruce Street Foods email server must then determine if there is a valid recipient and, if not, make a reputation decision about the sender’s IP address.

To avoid these undesirable conditions, Oracle has established email domains in each of its data centers that you can use temporarily during setup. Any email sent from Oracle cloud applications to one of the discard domains doesn't leave the data center. Instead, it’s discarded by the mail servers during the send process. You can turn any recipient address into a discard address by replacing the domain information with one of the discard domains. So, in the example presented here, we might use tina.best@discard.mail.us1.cloud.oracle.com.

Here are the discard domains and the data centers that they’re associated with:

<table>
<thead>
<tr>
<th>Discard Domain</th>
<th>Data Center</th>
</tr>
</thead>
<tbody>
<tr>
<td>@discard.mail.us1.cloud.oracle.com</td>
<td>Austin</td>
</tr>
<tr>
<td>@discard.mail.us2.cloud.oracle.com</td>
<td>Chicago</td>
</tr>
<tr>
<td>@discard.mail.us6.cloud.oracle.com</td>
<td>Ashburn</td>
</tr>
<tr>
<td>@discard.mail.ca2.cloud.oracle.com</td>
<td>Markham</td>
</tr>
<tr>
<td>@discard.mail.ca3.cloud.oracle.com</td>
<td>Calgary</td>
</tr>
<tr>
<td>@discard.mail.ap1.cloud.oracle.com</td>
<td>Sydney</td>
</tr>
<tr>
<td>@discard.mail.ap2.cloud.oracle.com</td>
<td>Singapore</td>
</tr>
<tr>
<td>@discard.mail.em1.cloud.oracle.com</td>
<td>Linlithgow</td>
</tr>
<tr>
<td>@discard.mail.em2.cloud.oracle.com</td>
<td>Amsterdam</td>
</tr>
<tr>
<td>@discard.mail.em3.cloud.oracle.com</td>
<td>Slough</td>
</tr>
</tbody>
</table>
Discard domains cross data center boundaries. You can use any of them, no matter which data center supplies your service. Oracle provides data center-specific domains in case you're concerned about geopolitical boundaries and want to ensure that discard data remains in your data center region.

Discard domains are also available for government and defense data centers. For details on these restricted data centers, log a service request for cloud operations through My Oracle Support.

If you're importing your users, you can use the discard domains in your import file and then go back later and re-import the users with the real domain information. For more information on importing users, see the importing users topics in the Getting Started with Your Sales Implementation guide.

<table>
<thead>
<tr>
<th>Discard Domain</th>
<th>Data Center</th>
</tr>
</thead>
<tbody>
<tr>
<td>@discard.mail.em4.cloud.oracle.com</td>
<td>Frankfurt</td>
</tr>
<tr>
<td>@discard.mail.em5.cloud.oracle.com</td>
<td>Munich</td>
</tr>
</tbody>
</table>
5 Geographies

Overview of Geographies

Overview of Geographies, Geographic Entities, and Locations

Geography is a physical space on Earth, such as a location or region, that's defined by a boundary. For example, it may be existing geopolitical locations such as San Jose or Peru.

These geographical locations are used in applications to manage business requirements such as sales territories, transportation deliveries, taxation, logistics, and so on.

Geography Type

A divisional grouping of geographies is named as Geography Types. It could be a geopolitical division such as Country, First Order Administrative Divisions (example: State, Province, District, and so on), City, Town, Village, or Non-Administrative Divisions (example: Southwest China, Northern California, and so on) or physical geographic divisions such as Island, Continent, Mountain, and so on.

Geography Use

Specifying the purpose and use of these geographies is known as Geography Use. Data could be classified for use by processes such as Taxation, Sales, Transportation, Marketing and so on.

Master Reference Geography Use

Master Reference Geography Use is data that's classified as being the source of truth. This data is used as a reference for creating User-defined Geography Uses and as the source when working with geographical data such as validating addresses or importing data. This data can be obtained from a third party or manually entered. It is defined by widely recognized administrative or political boundaries such as States, Provinces, Counties, Cities, and so on.

Master Reference Geographies

Master Reference Geographies are geographical boundary names and physical boundaries that are classified as being part of the Master Reference Geography Use. Examples include the State of California, the Province of Alberta, The Country of India, and so on.

Master Reference Geography Type

Master Reference Geography Type is a layer of Master Reference Geographies. Examples of Master Reference Geography Types would include States, Cities, Provinces, Countries, and so on.

How Geography Structure, Hierarchy, and Validation Fit Together

This topic presents the components of geographies.
The following three components are dependent on each other when defining a country:

1. Geography structure
2. Geography hierarchy
3. Geography validation

Every country must have the geography structure defined first before the hierarchy can be defined, and the geography hierarchy has to be defined before the validation can be defined.

### Geography Structures

The first step for defining a country is to create a geography structure in which geography types are part of the country structure, and then define how the geography types are hierarchically related within the country structure. For example, you can create geography types called State, City, and Postal Code. Then you can rank the State geography type as the highest level within the country, the City as the second level, and the Postal Code as the lowest level within the country structure. Geography structure can be defined using the Manage Geographies task, or can be imported using tasks in the Define Geographies activity.

**Note:** During import of geography data from any provider if one or more geography levels aren't available, n/a is substituted for those geography levels. For example, the list of values in the address UIs of accounts, contacts, suppliers, persons, and so on are displayed as n/a for such geography levels.

A geography structure is a hierarchical grouping of geography types for a country. The following table describes the geography structure for the United States.

<table>
<thead>
<tr>
<th>Level</th>
<th>Geography Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>State</td>
</tr>
<tr>
<td>2</td>
<td>County</td>
</tr>
<tr>
<td>3</td>
<td>City</td>
</tr>
<tr>
<td>4</td>
<td>Postal Code</td>
</tr>
</tbody>
</table>

You can use the geography structure to relate geography types for a country and define geography types for a country.

### Relate Geography Types for a Country

You can determine how a country's geographies are hierarchically related by creating the hierarchy of the geography types in the geography structure. When you define a country's structure, the geography type Country is implicitly at the highest level of the geography structure with level as 1. The subsequent geography types that you add after country are numbered in sequence.

You must add a geography type as a level in the country structure before you can define a geography for that geography type in a country. For example, before defining the state of California, the State geography type must be added to the...
United States country structure. To quickly create country structure, you can copy a structure from another country and modify the geography types for the country.

Define Geography Types for a Country
You can use any of the master reference geography types to create your geography structure. If required, you can create a geography type, before adding it to the country structure. Each geography type is added at a lower level to the current lowest level.

**Note:** You can’t delete geography types that have associated geography data. You can only delete the lowest level geography type of the country structure.

You can use a geography type that you create within the country structure for other country structures as well.

Geography Hierarchy
Once the geography structure is defined, the geographies for each geography type can be added to the hierarchy. For example, in the hierarchy of United States you can create a geography called California using a State geography type.

As part of managing the geography hierarchy you can view, create, edit, and delete the geographies for each geography type in the country structure. You can also add a primary and alternate name and code for each geography. A geography hierarchy can be created using the Manage Geographies task, or can be imported using tasks in the Define Geographies activity.

Geography hierarchy is a data model that creates conceptual parent-child relationships between geographies.

The application uses geography hierarchy information to facilitate business processes that rely on geography information, such as, tax calculation, order sourcing rules, and sales territory definition. The geography hierarchy information is centrally located and shared among other application offerings.

The geography hierarchy includes geography, geography type, geography usage, master reference geography hierarchy and user defined zones.

If you delete a geography level, all the children in that geography hierarchy are also deleted. For example, under a state you have defined zones using a range of postal codes. Later, you delete the state because you no longer support that state in your business. All the zones defined within that state are also deleted.

Geography Validation
After defining the geography hierarchy, you need to specify the geography validations for the country.

You can choose which address style format you would like to use for the country, and for each selected address style format you can map geography types to address attributes. You can also select which geography types to include in geography or tax validation, and which geography types will display in a list of values during address entry in other user interfaces. The geography validation level for the country, such as error or warning, can also be selected. Geography validation determines the geography mapping and validation for a country’s address styles, as well as the overall geography validation control for a country.
The No Styles Format address style format is the default address style format for a country. By defining the mapping and validation for this format you will ensure that validations can be performed for any address in the country. After the No Styles Format is defined you can set up additional mapping for specific address styles.

For each address style format, you can define the following:

- Map to attribute
- Enable list of values
- Tax validation
- Geography validation
- Geography validation control

**Attribute Mapping**

For every address style format, you can map each geography type to an address attribute. For example, you can map the State geography type to the State address attribute for the United States, or map the State geography type to the County address attribute for the United Kingdom. The geography types that appear are based on how the country structure is defined. The list of address attributes that appear are based on address formats delivered with the application, or your customer defined address formats.

**Note:** You only need to map geography types that you want to use for geography or tax validation purposes.

**Enable List of Values**

Once a geography type is mapped to an attribute, then you can specify whether the geography type will appear in a list of values during address entry in user interfaces. It is very important to review carefully if you want to enable a list of values. You should only enable a list of values if you have sufficient geography data imported or created for that geography. If the setup for master geography data is incomplete, then the geography data is either not imported or created. As a result, the list of values for the address attribute doesn't list any geography data.

Once you have enabled a list of values for an address attribute, you can only select the geography data available for the geography type. This means that if a specific geography value isn't available in the geography hierarchy, you can't create an address with a different geography value.

**Note:** Enable List of Values applies to the UI only. It doesn't apply to import, web services, nor REST APIs. For these, all of the required geography types must have a value in the request when creating or updating an address.

**Tax Validation**

You can also specify whether a geography type will be included in tax validation. For example, for the United States North America address style format you specify that County, State, and City are used for tax validation. This will mean that when a transaction involves an address with the North America address style, the address must have the correct county, state, and city combination based on the geography hierarchy data, to be considered valid for tax calculation.

**Geography Validation**

You must set up geography validation for those geography elements that you plan to use in your application. Setting up validation also helps users fill in missing address information, and validate addresses during entry. For example, you can have users select states or other address elements from lists to ensure accuracy during entry, and you can have the application fill in missing values. For example, when the user enters a Postal Code, the application can retrieve the city and state.
You can specify whether a geography type will be included in geography validation. For example, when the user enters a United States address using the North America address style format, the address must have the correct country, state, and postal code combination based on geography hierarchy data to be considered geographically valid.

If an address element is mapped to a geography type, but not selected for geography validation usage, then during address entry suggested values are provided for the address element, but the address element isn’t be validated.

You need to verify that the default mapping between Geography Type and Map to Attribute is valid in the Geography Mapping and Validation region and update it if required when you define geography validation.

After setting geography validation, all features that directly and indirectly depend upon geographies are impacted. For example, multiple applications such as ERP, CX, and SCM that use geographies are impacted.

Oracle recommends that you use the following valid mapping for the countries that Loqate supports:

<table>
<thead>
<tr>
<th>Country Name</th>
<th>Country Code</th>
<th>Geography Type</th>
<th>Map to Attribute</th>
</tr>
</thead>
<tbody>
<tr>
<td>Andorra</td>
<td>AD</td>
<td>Country</td>
<td>Country</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Parroquia</td>
<td>State</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Settlement</td>
<td>City</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Postal Code</td>
<td>Postal code</td>
</tr>
<tr>
<td>Angola</td>
<td>AO</td>
<td>Country</td>
<td>Country</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Provincia</td>
<td>Province</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Municipio</td>
<td>County</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Comuna</td>
<td>City</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Localidad</td>
<td>Additional address attribute 2</td>
</tr>
<tr>
<td>Argentina</td>
<td>AR</td>
<td>Country</td>
<td>Country</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Province</td>
<td>Province</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Department</td>
<td>County</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Municipality</td>
<td>City</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Postal Code</td>
<td>Postal code</td>
</tr>
<tr>
<td>Australia</td>
<td>AU</td>
<td>Country</td>
<td>Country</td>
</tr>
<tr>
<td></td>
<td></td>
<td>State</td>
<td>State</td>
</tr>
<tr>
<td></td>
<td></td>
<td>City</td>
<td>City</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Postal Code</td>
<td>Postal code</td>
</tr>
<tr>
<td>Austria</td>
<td>AT</td>
<td>Country</td>
<td>Country</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Bundesland</td>
<td>State</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Bezirk</td>
<td>County</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Gemeinde</td>
<td>City</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Postal Code</td>
<td>Postal code</td>
</tr>
<tr>
<td>Belgium</td>
<td>BE</td>
<td>Country</td>
<td>Country</td>
</tr>
<tr>
<td>Country Name</td>
<td>Country Code</td>
<td>Geography Type</td>
<td>Map to Attribute</td>
</tr>
<tr>
<td>------------------------</td>
<td>--------------</td>
<td>--------------------------------</td>
<td>-------------------------------</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Gewest</td>
<td>Additional address attribute 1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Provincie</td>
<td>Province</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Gemeente</td>
<td>City</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Postal Code</td>
<td>Postal code</td>
</tr>
<tr>
<td>Bolivia</td>
<td>BO</td>
<td>Country</td>
<td>Country</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Departamento</td>
<td>Additional address attribute 1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Provincia</td>
<td>Province</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Canton</td>
<td>City</td>
</tr>
<tr>
<td>Bosnia and Herzegovina</td>
<td>BA</td>
<td>Country</td>
<td>Country</td>
</tr>
<tr>
<td></td>
<td></td>
<td>District</td>
<td>Additional address attribute 1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Kanton</td>
<td>Province</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Općine</td>
<td>County</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Nasalje</td>
<td>City</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Postal Code</td>
<td>Postal code</td>
</tr>
<tr>
<td>Brazil</td>
<td>BR</td>
<td>Country</td>
<td>Country</td>
</tr>
<tr>
<td></td>
<td></td>
<td>State</td>
<td>State</td>
</tr>
<tr>
<td></td>
<td></td>
<td>City</td>
<td>City</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Postal Code</td>
<td>Postal code</td>
</tr>
<tr>
<td>Bulgaria</td>
<td>BG</td>
<td>Country</td>
<td>Country</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Oblast</td>
<td>Additional address attribute 1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Obština</td>
<td>Province</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Settlement</td>
<td>City</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Postal Code</td>
<td>Postal code</td>
</tr>
<tr>
<td>Canada</td>
<td>CA</td>
<td>Country</td>
<td>Country</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Province</td>
<td>Province</td>
</tr>
<tr>
<td></td>
<td></td>
<td>City</td>
<td>City</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Postal Code</td>
<td>Postal code</td>
</tr>
<tr>
<td>Cayman Islands</td>
<td>KY</td>
<td>Country</td>
<td>Country</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Island</td>
<td>State</td>
</tr>
<tr>
<td></td>
<td></td>
<td>District</td>
<td>City</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Postal Code</td>
<td>Postal code</td>
</tr>
<tr>
<td>Chile</td>
<td>CL</td>
<td>Country</td>
<td>Country</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Region</td>
<td>State</td>
</tr>
<tr>
<td>Country Name</td>
<td>Country Code</td>
<td>Geography Type</td>
<td>Map to Attribute</td>
</tr>
<tr>
<td>-------------------</td>
<td>--------------</td>
<td>-----------------------</td>
<td>----------------------</td>
</tr>
<tr>
<td>China</td>
<td>CN</td>
<td>• Country&lt;br&gt;• Province&lt;br&gt;• City&lt;br&gt;• Postal Code</td>
<td>• Country&lt;br&gt;• Province&lt;br&gt;• City&lt;br&gt;• Postal code</td>
</tr>
<tr>
<td>Croatia</td>
<td>HR</td>
<td>• Country&lt;br&gt;• Zupanije&lt;br&gt;• Grad&lt;br&gt;• Postal Code</td>
<td>• Country&lt;br&gt;• Province&lt;br&gt;• City&lt;br&gt;• Postal code</td>
</tr>
<tr>
<td>Cuba</td>
<td>CU</td>
<td>• Country&lt;br&gt;• Provincia&lt;br&gt;• Municipio&lt;br&gt;• City&lt;br&gt;• Postal Code</td>
<td>• Country&lt;br&gt;• Province&lt;br&gt;• County&lt;br&gt;• City&lt;br&gt;• Postal code</td>
</tr>
<tr>
<td>Cyprus</td>
<td>CY</td>
<td>• Country&lt;br&gt;• Periochi&lt;br&gt;• Dimos&lt;br&gt;• Postal Code</td>
<td>• Country&lt;br&gt;• Province&lt;br&gt;• City&lt;br&gt;• Postal code</td>
</tr>
<tr>
<td>Czech Republic</td>
<td>CZ</td>
<td>• Country&lt;br&gt;• Kraj&lt;br&gt;• Okres&lt;br&gt;• Obec&lt;br&gt;• Postal Code</td>
<td>• Country&lt;br&gt;• State&lt;br&gt;• County&lt;br&gt;• City&lt;br&gt;• Postal code</td>
</tr>
<tr>
<td>Denmark</td>
<td>DK</td>
<td>• Country&lt;br&gt;• Amt&lt;br&gt;• Settlement&lt;br&gt;• Postal Code</td>
<td>• Country&lt;br&gt;• Province&lt;br&gt;• City&lt;br&gt;• Postal code</td>
</tr>
<tr>
<td>Dominican Republic</td>
<td>DO</td>
<td>• Country&lt;br&gt;• Provincia&lt;br&gt;• Municipio&lt;br&gt;• Town&lt;br&gt;• Postal Code</td>
<td>• Country&lt;br&gt;• Province&lt;br&gt;• County&lt;br&gt;• City&lt;br&gt;• Postal code</td>
</tr>
<tr>
<td>Ecuador</td>
<td>EC</td>
<td>• Country</td>
<td>• Country</td>
</tr>
<tr>
<td>Country Name</td>
<td>Country Code</td>
<td>Geography Type</td>
<td>Map to Attribute</td>
</tr>
<tr>
<td>-------------</td>
<td>--------------</td>
<td>----------------</td>
<td>------------------</td>
</tr>
<tr>
<td>Estonia</td>
<td>EE</td>
<td>- Province</td>
<td>- Province</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Canton</td>
<td>- County</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- City</td>
<td>- City</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Postal Code</td>
<td>- Postal code</td>
</tr>
<tr>
<td>Finland</td>
<td>FI</td>
<td>- Country</td>
<td>- Country</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Maakond</td>
<td>- State</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Vald</td>
<td>- City</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Postal Code</td>
<td>- Postal code</td>
</tr>
<tr>
<td>France</td>
<td>FR</td>
<td>- Country</td>
<td>- Country</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Region</td>
<td>- Additional address attribute 1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Department</td>
<td>- State</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Commune</td>
<td>- City</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Postal Code</td>
<td>- Postal code</td>
</tr>
<tr>
<td>Germany</td>
<td>DE</td>
<td>- Country</td>
<td>- Country</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Bundesland</td>
<td>- State</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Kreis</td>
<td>- County</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Gemeinde</td>
<td>- City</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Postal Code</td>
<td>- Postal code</td>
</tr>
<tr>
<td>Great Britain</td>
<td>GB</td>
<td>- Country</td>
<td>- Country</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- County</td>
<td>- State</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Township</td>
<td>- City</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Postal Code</td>
<td>- Postal code</td>
</tr>
<tr>
<td>Greece</td>
<td>GR</td>
<td>- Country</td>
<td>- Country</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Periferia</td>
<td>- State</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Nomi</td>
<td>- County</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Dimotika</td>
<td>- City</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Postal Code</td>
<td>- Postal code</td>
</tr>
<tr>
<td>Guadalupe</td>
<td>GP</td>
<td>- Country</td>
<td>- Country</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Commune</td>
<td>- City</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Postal Code</td>
<td>- Postal code</td>
</tr>
<tr>
<td>Country Name</td>
<td>Country Code</td>
<td>Geography Type</td>
<td>Map to Attribute</td>
</tr>
<tr>
<td>-------------</td>
<td>--------------</td>
<td>----------------</td>
<td>------------------</td>
</tr>
<tr>
<td>Guam</td>
<td>GU</td>
<td>• Country</td>
<td>• Country</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• State</td>
<td>• State</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• County</td>
<td>• County</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Municipality</td>
<td>• City</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Village</td>
<td>• Additional address attribute 2</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Postal Code</td>
<td>• Postal code</td>
</tr>
<tr>
<td>Guernsey</td>
<td>GG</td>
<td>• Country</td>
<td>• Country</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• City</td>
<td>• City</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Parishes</td>
<td>• Additional address attribute 2</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Villages</td>
<td>• Additional address attribute 3</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Postal Code</td>
<td>• Postal Code</td>
</tr>
<tr>
<td>Hungary</td>
<td>HU</td>
<td>• Country</td>
<td>• Country</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Megye</td>
<td>• Additional address attribute 1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Jaras</td>
<td>• Province</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Telepules</td>
<td>• County</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Settlement</td>
<td>• City</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Postal Code</td>
<td>• Postal code</td>
</tr>
<tr>
<td>Iceland</td>
<td>IS</td>
<td>• Country</td>
<td>• Country</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Jaras</td>
<td>• Province</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Telepules</td>
<td>• County</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Settlement</td>
<td>• City</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Postal Code</td>
<td>• Postal code</td>
</tr>
<tr>
<td>India</td>
<td>IN</td>
<td>• Country</td>
<td>• Country</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• State</td>
<td>• State</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• City</td>
<td>• City</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Postal Code</td>
<td>• Postal code</td>
</tr>
<tr>
<td>Indonesia</td>
<td>ID</td>
<td>• Country</td>
<td>• Country</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Province</td>
<td>• Province</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Regency</td>
<td>• County</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• City</td>
<td>• City</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Postal Code</td>
<td>• Postal code</td>
</tr>
<tr>
<td>Ireland</td>
<td>IE</td>
<td>• Country</td>
<td>• Country</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Province</td>
<td></td>
</tr>
<tr>
<td>Country Name</td>
<td>Country Code</td>
<td>Geography Type</td>
<td>Map to Attribute</td>
</tr>
<tr>
<td>--------------</td>
<td>--------------</td>
<td>---------------------------------</td>
<td>---------------------------------------</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Post County, Post Town, Locality</td>
<td>Additional address attribute 1, State, City, Additional address attribute 2</td>
</tr>
<tr>
<td>Isles of Man</td>
<td>IM</td>
<td>Country, Locality, Settlement, Postal Code</td>
<td>Country, City, Additional address attribute 2, Postal code</td>
</tr>
<tr>
<td>Israel</td>
<td>IL</td>
<td>Country, District, Subdistrict, City, Postal Code</td>
<td>Country, State, County, City, Postal code</td>
</tr>
<tr>
<td>Italy</td>
<td>IT</td>
<td>Country, Regione, Provincia, Comune, Postal code</td>
<td>Country, Additional address attribute 1, Province, City, Postal code</td>
</tr>
<tr>
<td>Jamaica</td>
<td>JM</td>
<td>Country, Parish, Settlement</td>
<td>Country, State, City</td>
</tr>
<tr>
<td>Japan</td>
<td>JP</td>
<td>Country, Prefecture, City, Postal Code</td>
<td>Country, State, City, Postal code</td>
</tr>
<tr>
<td>Jordan</td>
<td>JO</td>
<td>Country, Muhafazat, Liwa, Tajma, Postal Code</td>
<td>Country, State, County, City, Postal code</td>
</tr>
<tr>
<td>Kenya</td>
<td>KE</td>
<td>Country, County, Division</td>
<td>Country, State, City</td>
</tr>
<tr>
<td>Country Name</td>
<td>Country Code</td>
<td>Geography Type</td>
<td>Map to Attribute</td>
</tr>
<tr>
<td>-------------</td>
<td>-------------</td>
<td>---------------------------------</td>
<td>-----------------------------------</td>
</tr>
<tr>
<td>Latvia</td>
<td>LV</td>
<td>• Settlement</td>
<td>• Additional address attribute 2</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Country</td>
<td>• Country</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Rajons</td>
<td>• State</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Pilseta</td>
<td>• City</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Postal Code</td>
<td>• Postal code</td>
</tr>
<tr>
<td>Liechtenstein</td>
<td>LI</td>
<td>• Country</td>
<td>• Additional address attribute 1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Wahlkreis</td>
<td>• State</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Gemeinde</td>
<td>• City</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• District</td>
<td>• Postal code</td>
</tr>
<tr>
<td>Lithuania</td>
<td>LT</td>
<td>• Country</td>
<td>• Country</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• County</td>
<td>• State</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Municipality</td>
<td>• County</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Ward</td>
<td>• City</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Postal Code</td>
<td>• Postal code</td>
</tr>
<tr>
<td>Luxembourg</td>
<td>LU</td>
<td>• Country</td>
<td>• Country</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• District</td>
<td>• Additional address attribute 1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Canton</td>
<td>• State</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Commune</td>
<td>• County</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Settlement</td>
<td>• City</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Postal Code</td>
<td>• Postal code</td>
</tr>
<tr>
<td>Malaysia</td>
<td>MY</td>
<td>• Country</td>
<td>• Country</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• State</td>
<td>• State</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• District</td>
<td>• County</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Subdistrict</td>
<td>• City</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Postal Code</td>
<td>• Postal code</td>
</tr>
<tr>
<td>Malta</td>
<td>MT</td>
<td>• Country</td>
<td>• Country</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Region</td>
<td>• State</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Local Council</td>
<td>• City</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Postal Code</td>
<td>• Postal code</td>
</tr>
<tr>
<td>Martinique</td>
<td>MQ</td>
<td>• Country</td>
<td>• Country</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Region</td>
<td>• State</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Department</td>
<td>• County</td>
</tr>
<tr>
<td>Country Name</td>
<td>Country Code</td>
<td>Geography Type</td>
<td>Map to Attribute</td>
</tr>
<tr>
<td>-------------</td>
<td>--------------</td>
<td>----------------</td>
<td>------------------</td>
</tr>
<tr>
<td>Mexico</td>
<td>MX</td>
<td>• Commune • Postal Code</td>
<td>• City • Postal code</td>
</tr>
<tr>
<td>Netherlands</td>
<td>NL</td>
<td>• Country • Province • Municipality • Town • Postal Code</td>
<td>• Country • Province • County • City • Postal code</td>
</tr>
<tr>
<td>New Zealand</td>
<td>NZ</td>
<td>• Country • Region • Town • Postal Code</td>
<td>• Country • State • City • Postal code</td>
</tr>
<tr>
<td>Norway</td>
<td>NO</td>
<td>• Country • Fylke • Kommune • Postal Code</td>
<td>• Country • Province • City • Postal code</td>
</tr>
<tr>
<td>Oman</td>
<td>OM</td>
<td>• Country • Muhafazah • District • City</td>
<td>• Country • State • County • City</td>
</tr>
<tr>
<td>Peru</td>
<td>PE</td>
<td>• Country • Region • Provincia • Distrito • Postal Code</td>
<td>• Country • Province • County • City • Postal code</td>
</tr>
<tr>
<td>Poland</td>
<td>PL</td>
<td>• Country • Wojewodztwo • Powiat • Gmina • Postal Code</td>
<td>• Country • Province • County • City • Postal code</td>
</tr>
<tr>
<td>Country Name</td>
<td>Country Code</td>
<td>Geography Type</td>
<td>Map to Attribute</td>
</tr>
<tr>
<td>--------------</td>
<td>--------------</td>
<td>----------------------</td>
<td>-------------------------------------</td>
</tr>
<tr>
<td>Portugal</td>
<td>PT</td>
<td>• Country, Distrito, Concelho, Settlement, Postal Code</td>
<td>• Country, Province, County, City, Postal code</td>
</tr>
<tr>
<td>Puerto Rico</td>
<td>PR</td>
<td>• Country, Commonwealth, Municipio, Barrio, Postal Code</td>
<td>• Country, State, County, City, Postal code</td>
</tr>
<tr>
<td>Qatar</td>
<td>QA</td>
<td>• Country, Municipality, Zone</td>
<td>• Country, State, City</td>
</tr>
<tr>
<td>Reunion Island</td>
<td>RE</td>
<td>• Country, Region, Department, Commune, Postal Code</td>
<td>• Country, State, County, City, Postal code</td>
</tr>
<tr>
<td>Romania</td>
<td>RO</td>
<td>• Country, Regiune, Judet, Settlement, Comuna, Postal Code</td>
<td>• Country, Additional address attribute 1, Province, County, City, Postal code</td>
</tr>
<tr>
<td>Russia</td>
<td>RU</td>
<td>• Country, Federal_District, Federal_Subject, Oblast, Postal Code</td>
<td>• Country, Additional address attribute 1, State, City, Postal code</td>
</tr>
<tr>
<td>San Marino</td>
<td>SM</td>
<td>• Country, Comune, Postal Code</td>
<td>• Country, State, Postal code</td>
</tr>
<tr>
<td>Singapore</td>
<td>SG</td>
<td>• Country, Region</td>
<td>• Country, State</td>
</tr>
<tr>
<td>Country Name</td>
<td>Country Code</td>
<td>Geography Type</td>
<td>Map to Attribute</td>
</tr>
<tr>
<td>--------------</td>
<td>--------------</td>
<td>---------------------------------</td>
<td>-----------------------------------</td>
</tr>
<tr>
<td>Slovakia</td>
<td>SK</td>
<td>• District</td>
<td>• City</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Postal Code</td>
<td>• Postal code</td>
</tr>
<tr>
<td>Slovenia</td>
<td>SI</td>
<td>• Country</td>
<td>• Country</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Kraj</td>
<td>• Province</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Okres</td>
<td>• County</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Obec</td>
<td>• City</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Postal Code</td>
<td>• Postal code</td>
</tr>
<tr>
<td>South Africa</td>
<td>ZA</td>
<td>• Country</td>
<td>• Country</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Province</td>
<td>• Province</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• District Municipality</td>
<td>• County</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Local Municipality</td>
<td>• City</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Postal Code</td>
<td>• Postal code</td>
</tr>
<tr>
<td>South Korea</td>
<td>KR</td>
<td>• Country</td>
<td>• Country</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Jibang</td>
<td>• State</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Siti</td>
<td>• City</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Postal Code</td>
<td>• Postal code</td>
</tr>
<tr>
<td>Spain</td>
<td>ES</td>
<td>• Country</td>
<td>• Country</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Autonomous Community</td>
<td>• Additional address attribute 1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Province</td>
<td>• Province</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• City</td>
<td>• City</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Postal Code</td>
<td>• Postal code</td>
</tr>
<tr>
<td>Sri Lanka</td>
<td>LK</td>
<td>• Country</td>
<td>• Country</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Province</td>
<td>• Province</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• District</td>
<td>• County</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Divisional Secretariat</td>
<td>• City</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Postal Code</td>
<td>• Postal code</td>
</tr>
<tr>
<td>Swaziland</td>
<td>SZ</td>
<td>• Country</td>
<td>• Country</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• District</td>
<td>• Province</td>
</tr>
<tr>
<td>Country Name</td>
<td>Country Code</td>
<td>Geography Type</td>
<td>Map to Attribute</td>
</tr>
<tr>
<td>---------------------</td>
<td>--------------</td>
<td>---------------------------------</td>
<td>-----------------------------------</td>
</tr>
<tr>
<td>Note:</td>
<td></td>
<td></td>
<td>This country maybe labeled</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Eswatini in Manage Territories.</td>
</tr>
<tr>
<td>Sweden</td>
<td>SE</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Switzerland</td>
<td>CH</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Taiwan</td>
<td>TW</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Thailand</td>
<td>TH</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Tunisia</td>
<td>TN</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Turkey</td>
<td>TR</td>
<td></td>
<td></td>
</tr>
<tr>
<td>United Arab Emirates</td>
<td>AE</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Note:**
This country maybe labeled Eswatini in Manage Territories.
### Geographies

<table>
<thead>
<tr>
<th>Country Name</th>
<th>Country Code</th>
<th>Geography Type</th>
<th>Map to Attribute</th>
</tr>
</thead>
</table>
| United States | US           | • Country  
• State  
• County  
• City  
• Postal Code | • Country  
• State  
• County  
• City  
• Postal code |
| Uruguay      | UY           | • Country  
• Departamento  
• City  
• Postal Code | • Country  
• State  
• City  
• Postal code |
| Vatican City | VA           | • Country  
• Municipal  
• Settlement  
• Postal Code | • Country  
• Province  
• City  
• Postal code |
| Vietnam      | VN           | • Country  
• Region  
• Tihn  
• Quan  
• Thank Pho  
• Postal Code | • Country  
• Additional address attribute 1  
• Province  
• County  
• City  
• Postal code |

**Note:** For either the tax or geography validation, don’t skip more than one consecutive level unless you’re certain that the selected geography types can uniquely identify geographies. For example, the United States country structure is: State, County, City, and Postal Code, and you want to select just State and Postal Code for geography or tax validation. However, for the combination of California and 94065, the city can be either Redwood Shores or Redwood City. In this case, you should also select at least the City geography type for geography or tax validation.

### Geography Validation Control

You can select the geography validation level for a country. Validation will check if the entered address maps to the geography hierarchy data available for the country, and the geography validation control determines whether you can save an address that didn’t pass validation during address entry. For example, if the validation level is **Error**, then an address can’t be saved if the values don’t match the geography hierarchy data.

These are the geography validation levels you can choose:

- **Error** - only completely valid addresses can be saved, with all mandatory address elements entered.
- **No Validation** - all addresses can be saved including incomplete and invalid addresses.
Regardless of the result of validation, the validation process will try to map any address attribute to a geography of the country, and store any mapping it could establish based on the available data. This is called Geography Name Referencing and it's executed as part of validation. The result of this referencing is used in several business processes in the application to map an address to a specific geography or zone. Therefore, Geography Name Referencing is the process of validating and mapping address elements of existing location table records against master reference geographies. For example, CA value in the STATE column of the HZ_LOCATIONS table is mapped to the master reference geography of CA (California).

The Geography Dimension value in territories is derived from sell-to addresses of sales accounts. To use geography dimensions in territories, you must validate the geography elements in the addresses, such as state, city, and postal code. You can validate the address by enabling geography validation for each country using the Manage Geographies task. Perform the following in the Manage Geographies task:

- Enable at least one level in the geography hierarchy for geography validation.
- Enable geography validation for all geography levels that you intend to use for territory definition for each country.
- If needed, enable a list of values containing specific geography elements. This will help users search and select appropriate geography values during addresses entry and eliminate all possibilities of wrong address entry.

You can set geography validation control to Error in the Manage Geography Validation page. This ensures that users can only use valid geography elements in addresses.

**Note:** If you have already created addresses before setting up geography validation for a country, you must enable geography validation and then execute the Run Maintain Geography Name Referencing task for that country. This validates all your geography elements.

### Setting Up Geography Validation

You must set up geography validation to enable geography setup, help users fill in missing address information, and validate address information. For example, if you enter the postal code you can retrieve the rest of the address, such as, city and state.

For example, an organization named Vision Corp., wants its salespeople to use a list of values to enter the states in their addresses. Also, it plans to set up territories at the state level. So validation must be set up at the state level.

To define geography validation for Vision Corp.:

1. In the Setup and Maintenance work area, search for the Manage Geographies task.
2. Click **Go to Task**. The Manage Geographies page appears.
3. Search for a country. For example, you can search by entering either the country name United States or the two letter ISO code US, and clicking Search. Search for a country. For example, you can search by entering either the country name United States or the two letter ISO code US, and clicking **Search**.
4. Select the country, such as United States, in the Search Results area.
5. Click the **Go to Task** button in the Validation Defined column.

   The Manage Geography Validation page appears. The geography types available for the country are shown in the Geography Mapping and Validation region.

6. Ensure that the **No Styles Format** address style is selected. You define validation for the No Styles Format address style so that the validations are performed for all addresses in the country.
7. Select **Enable List of Values** in the Geography Mapping and Validation region to display the geography type as list of values during address entry in user interfaces. For example, for Vision Corp, select **Enable List of Values** for State.

This ensures correct values are entered for states, so that territory assignments work.

**Note:** You should only enable a list of values if you have sufficient geography data for that geography type.

8. Select **Geography Validation** for a geography type to include it in geography validation. For example, for Vision Corp, select **Geography Validation** for State.

You must enable geography validation for all geography levels that you intend to use for territory definition. The territory assignments may fail if the geography data used isn't validated. If Vision Corp decided to set up territories at the postal code level, it would have to set up validation for state, city, county, and postal code.

**Note:** If an address element isn't selected for geography validation usage, then during address entry suggested values will be provided for the address element, but the address element isn't validated.

9. Select the appropriate geography validation control level to determine whether you can save an address that fails validation during address entry. For example, Vision Corp. wants to save all addresses including incomplete and invalid addresses, so select **No validation** in the Geography Validation Level for Country list.

**Note:** If Vision Corp decided to save only valid addresses, it would have to set the geography validation control level to **Error** in the Geography Validation Level for Country list.

10. Click **Save and Close**.

### Best Practices for Geography Validation

After geography data setup, you must configure geography validations.
Here are some best practices to configure geography validation:

- The configuration of geography validation rules depends upon your application needs. If you want to ensure that only valid addresses must are allowed:
  a. Navigate to Manage Geographies, search for a country, and click Validation Defined.
  b. Set Geography Validation based on the application requirements.

  **Note:** For either the tax or geography validation, don't skip more than one consecutive level unless you're certain that the selected geography types can uniquely identify geographies. For example, the United States country structure is: State, County, City, and Postal Code, and you want to select just State and Postal Code for geography or tax validation. However, for the combination of California and 94065, the city can be either Redwood Shores or Redwood City. In this case, you should also select at least the City geography type for geography or tax validation.
  c. Set the Geography Validation Level for Country in the Geography Validation Control section to Error.

- If you require validated addresses for your downstream applications:
  a. Go to Manage Geographies, search for a country, and click Validation Defined.
  b. The best practice is Enable List of Values and setup validation for all geography levels and geography types.
  c. Run the Validate Geographies of Addresses Against Master Geographies scheduled process to review address validation results.

- To ensure that the addresses are validated and there are no downstream impacts:
  a. Go to Manage Administrator Profile Values and set the Number of workers for a given Geography Name Referencing request (HZ_GNR_NUM_OF_WORKERS) profile option to 5.
  b. Run the Validate Geographies of Addresses Against Master Geographies scheduled process with Parameters: Location Table Name: HZ_LOCATIONS, Run Type: ALL, Country Code: [Country code for which Geography Name Referencing (GNR) needs to be generated].
  c. Run the Validate Geographies of Addresses Against Master Geographies scheduled process with Parameters: Location Table Name: PER_ADDRESSES_F, Run Type: ALL, Country Code: [Country code for which GNR needs to be generated].
  d. You can then use the report: https://cloudcustomerconnect.oracle.com/posts/b1e16b06ae to identify if the existing addresses are incorrect. Correct these addresses as a onetime activity.

Manage Geography Structures, Hierarchies, and Validation

You can add geography structure by first defining the geography types using the Manage Geographies task. You can then create geography hierarchy and geography validations also using the Manage Geographies task.

This example shows how you can configure the geography structure, geography types within the structure, geography hierarchy, and geography validation for a country geography, using the United Kingdom country geography as an illustration.

The following table summarizes the key decisions for this scenario.

<table>
<thead>
<tr>
<th>Decisions to Consider</th>
<th>In This Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Copy an existing country structure?</td>
<td>No, create a new country structure.</td>
</tr>
</tbody>
</table>
Decisions to Consider | In This Example
--- | ---
What is the structure of the geography types? | Create geography types with the following ranking structure:
  1. County
  2. Post Town

What is the geography hierarchy? | Create the following hierarchy:
  1. Country of United Kingdom
  2. County of Berkshire
  3. Post Town of Reading

Which address style format will you use when mapping geography validations? | The default address style format called the No Styles Format.

Are you using Oracle Fusion Tax for tax purposes? | No, don’t select Tax Validation for the geography types.

Define the Geography Structure
You can add the County and Post Town geography types to the United Kingdom geography structure.

1. On the Manage Geographies page, enter GB in the Code field. Click Search.
2. On the Manage Geographies page, click Structure Defined.
3. On the Manage Geography Structure page, click the Create button next to the Copy Country Structure From field.
4. In the Geography Structure section, select the County list item in the Add Geography Type field.
5. Click Add.
6. Select the Post Town list item in the Create and Add Geography Type field.
7. Click Add.
8. Click Save and Close.
   **Note:** You can’t modify or delete a geography type.

Define the Geography Hierarchy
You can add the geographies for the County and Post Town geography types using the geography hierarchy user interfaces to create the geography hierarchy for United Kingdom. You can also use Import Management to import geography hierarchies using a CSV or XML file.

1. On the Manage Geographies page, enter GB in the Code field. Click Search.
2. On the Manage Geographies page, click Hierarchy Defined.
   **Note:** If there are many child geographies for the selected parent geography, a message asking you to refine the search criteria is displayed. The child geographies are displayed after you refine the search criteria. If there are many search results, you may have to further refine the search criteria. The maximum number of child geographies that can be displayed is controlled by the ORA_HZ_GEO_HIERARCHY_LIMIT profile option. You can change the value of this profile option by navigating to the Setup and Maintenance work area, click the Tasks menu, and search for Manage Administrative Profile Values task. Search for the ORA_HZ_GEO_HIERARCHY_LIMIT profile option and change the value.
3. In the Geography Hierarchy section, click United Kingdom to highlight the table row, and click Create.
4. In the Create County page, Primary and Alternate Names section, enter Berkshire in the Name field.
5. Click Save and Close.
6. In the Geography Hierarchy section, click Berkshire to highlight the table row, and click Create.
7. In the Create Post Town page, Primary and Alternate Names section, enter Reading in the Name field.
8. Click Save and Close.

Define the Geography Validations

You can define the geography mapping and validation for the United Kingdom default address style format to specify the geography validations for the geography types you added to United Kingdom. You can then map the geography types to attributes, enable the geography types for Lists of Values and Geography Validation, and set the geography validation level.

1. On the Manage Geographies page, click Validation Defined.
2. In the Address Style section, click No Styles Format to highlight the table row.
3. For the County geography type, click the County list item in the Map to Attribute field.
4. Select the Enable List of Values and Geography Validation options.
5. For the Post Town geography type, click the City list item in the Map to Attribute field.
6. Select the Geography Validation option.
7. In the Geography Validation Control section, select Error in the Geography Validation Level for Country list.
8. Click Save and Close.

Considerations While Working With Master Geographies

Considerations for working with master geographies:

- You can update master geographies using the Manage Geographies page, but you can’t update master geographies using Import Management.
- Countries are predefined so you can’t delete them. You can delete the geography levels of a country in the geography hierarchy, such as state, city, and so on using the Manage Geographies page.
- If you delete the geography levels of a country in the geography hierarchy, such as state, city, and so on, you must manage the impact of these changes in the downstream applications, such as SCM, ERP, HCM, and so on.
- If you delete a geography level, all the children in that geography hierarchy are also deleted. For example, if you define city and postal codes under a state, and you later delete the state, all the cities and postal codes under this state are also deleted.

Manage Geography Lookups

You can manage geography lookups using the Manage Geography Lookups.

Perform these steps:

1. Click Navigator > My Enterprise > Setup and Maintenance work area and go to the following:
   - Offering: Sales
   - Functional Area: Sales Foundation
   - Task: Manage Geography Lookups
2. On the Manage Geography Lookups page, click any of the following lookups:
### Geographies

<table>
<thead>
<tr>
<th>Lookup Type</th>
<th>Meaning</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>HZ_GEOGRAPHY_USAGE</td>
<td>Geography Validation Purpose</td>
<td>Purpose of geography validation, for example, tax. This lookup type can’t be edited.</td>
</tr>
<tr>
<td>HZ_GEO_DISPLAY_ONLY</td>
<td>Zone Definition</td>
<td>Interface elements used to define zones. This lookup type can’t be edited.</td>
</tr>
<tr>
<td>HZ_GEO_GNR_RUN_TYPE</td>
<td>Geography Name Referencing Program Run Type</td>
<td>You can specify the type of records that must be processed using the geography name referencing (Validate Geographies of Addresses Against Master Geographies) scheduled process. This lookup type can't be edited.</td>
</tr>
<tr>
<td>HZ_GEO_IDENTIFIER_TYPE</td>
<td>Geography Identifier Type</td>
<td>Identifier type for geography, for example, name or code. This lookup type can’t be edited.</td>
</tr>
<tr>
<td>HZ_GEO_POSTAL_CODE_RANGE_FLAG</td>
<td>Postal Code Range Provided</td>
<td>Values indicate whether a postal code range was used to define a set of postal codes. This lookup type can’t be edited.</td>
</tr>
<tr>
<td>HZ_GEO_DATA_PROVIDER</td>
<td>Geography Information Provider</td>
<td>Names of the source of geography information. You can add new geography providers.</td>
</tr>
<tr>
<td>HZ_GEO_IDENTIFIER_SUBTYPE</td>
<td>Geography Identifier Subtype</td>
<td>Identifier sub type for geography, for example, primary. You can specify the primary and secondary names and codes for geographies.</td>
</tr>
</tbody>
</table>

3. View or edit the values as applicable.
4. Click Save and Close to return to the list of lookups.
5. Click Done to exit the page.

### Manage Territory Geography Splits

You must group territory geographies into group zones to manage territory geography level splits. Grouping the territory geographies involves two steps, selecting the geography level based on which you need grouping and initiating the grouping.
Select the Geography Level for Grouping
You can perform these steps to select the geography level based on which you want to create the group zones:

1. Sign in as a set up user such as Application Implementation Consultant.
2. In the Setup and Maintenance work area, go to the following:
   - Offering: Customer Data Management
   - Functional Area: Enterprise Profile
   - Task: Manage Geographies
3. Search for the country for which you want to enable territory geography level grouping.
5. Select the Subject to Grouping check box corresponding to the geography type level for which you want to enable grouping.

You must select the geography level that suits your business requirements. For example, if your product delivery is based on postal code, and your territory geographies don’t have higher levels of master geographies such as counties and cities, then you may have postal code splits. In this case you must select postal code as the geography type level for grouping.

**Note:** You can enable grouping for only one level at a time.

6. Click Save and Close.

Initiate Grouping
Here are the steps to initiate grouping:

1. In the Setup and Maintenance work area, go to the following:
   - Offering: Sales
   - Functional Area: Territories
   - Task: Manage Territory Geographies

   The Manage Territory Geographies page opens.
2. Click Initiate Grouping.
3. Click OK in response to the warning message and confirm the process.

**Note:** You can’t automatically un-group the grouped territory geographies. You can manually undo the grouping process by recreating territory geography hierarchy either through the UI or import process.

The geography level that you selected for grouping appears as an expandable Group Zone when the grouping is complete is shown in the following figure.

4. Click Save and Close.
How Territory Geographies are Grouped

This topic describes how we can overcome the problem of territory geography splits by grouping them into group zones.

You do a territory geography grouping when any of your territory geography levels has multiple splits. A territory geography splits occur when the lower level master geographies are added to territory geography hierarchy, while skipping the higher level master geographies. This may cause multiple occurrences of the lower geography level members in a territory geography hierarchy.

For example, postal code split happens when a postal code overlaps across many master geography levels such as cities and counties. Suppose that the business firm Vision Corp. delivers its product according to the postal codes. If counties and cities aren't included in the territory geography hierarchy of Vision Corp., then the end user can see the multiple occurrences of the postal code 97229.

When there is a territory geography level split, and if you want to group the split geographies, first you must specify the master geography level for which you want the grouping to be performed, then initiate grouping. When grouping is performed, all the splits of the selected master geography level get grouped under a new group zone. In the previous example, if you select postal code in the master geographies as the level for grouping and initiate the grouping process, then the 12 postal code splits for the postal code 97229 gets grouped together under one group zone named 97229. So, the Territory Manager user can define territories on a clean list of postal codes or their ranges, although some of those postal codes would in fact be the groupings of the postal code splits. The grouped splits are hidden for the Territory Manager user.

Best Practices for Managing Geography Mismatches

This topic employs a couple of use cases to illustrate the best practices for setting up Master Reference Geographies for sales customers using the Oracle Account and Contact Enrichment by Dun & Bradstreet (D&B) for data enrichment and the Oracle Address, Email, and Phone Verification for address, email, and phone number verification.

When you perform the real-time enrichment of accounts or contacts using the Oracle Account and Contact Enrichment by Dun & Bradstreet (D&B), if there's a geography data mismatch between the predefined master geography data and the Dun and Bradstreet (D&B) data, then the Service enriches the accounts and contacts data but you can’t edit or save the enriched data unless the master geography data mismatches are resolved. In addition, you can verify the enriched address using the Oracle Address, Email, and Phone Verification, however, in case of mismatches between Oracle Account and Contact Enrichment by Dun & Bradstreet (D&B) (Loqate) and predefined master geography data you can’t save the verified address.

The second use case describes the setup required to enable address verification and to avoid data conflicts between the Oracle Address, Email, and Phone Verification and master reference geography data.

Use Case 1

You’re a sales customer using master reference geographies for territory assignments or tax calculation and have purchased Oracle Account and Contact Enrichment by Dun & Bradstreet (D&B) for data enrichment and Oracle Address, Email, and Phone Verification. In this case, while the Loqate geography reference data is configured as master
geography, Tax calculation is being done using Vertex master geography data. Also, address validation is enabled based on the customer’s requirement.

**Best Practice**: Review geography mapping for the countries where you do business. If the geography mapping for a specific country isn’t mapped according to the country-specific address attributes, update the mapping. Oracle recommends performing enrichment before verifying address.

Suppose that you’re doing real time enrichment of account or contact. If there’s a geography data mismatch between the predefined master geography and the D&B data, the Oracle Account and Contact Enrichment by Dun & Bradstreet (D&B) still enriches the accounts and contacts data but can’t edit or save the enriched account or contact unless the master geography data mismatches are resolved. However, you can verify the enriched address using the Oracle Address, Email, and Phone Verification.

To save a verified address that has master geography data mismatch, you must add alternative names for the mismatched hierarchy elements in master geography. The following are the steps to add alternative name for the mismatched hierarchy element:

1. In the Setup and Maintenance work area, go to the following:
   - Offering: Customer Data Management
   - Functional Area: Enterprise Profile
   - Task: Manage Geographies
2. On the Manage Geographies page, search for the country by the name or country code, for example US.
3. Click the Go to Task button in the Hierarchy Defined column. The Manage Geographies Hierarchy page for the particular country appears.

   **Note**: If there are many child geographies for the selected parent geography, a message asking you to refine the search criteria is displayed. The child geographies are displayed after you refine the search criteria. If there are many search results, you may have to further refine the search criteria. The maximum number of child geographies that can be displayed is controlled by the ORA_HZ_GEO_HIERARCHY_LIMIT profile option. You can change the value of this profile option by navigating to the Setup and Maintenance work area, click the Tasks menu, and search for Manage Administrative Profile Values task. Search for the ORA_HZ_GEO_HIERARCHY_LIMIT profile option and change the value.

4. Highlight the mismatched hierarchy element, for example California State, and click the Edit icon.
5. Click the Add icon on the Edit page.
6. Add an alternative name CA for the California state geography element.
7. Click Save and Close

Once the alternative name is added for the mismatched hierarchy element in master geography, you can save the enriched address.

**Use Case 2**

You're a sales customer who doesn’t use geographies for territory assignment or tax calculation and has purchased Oracle Account and Contact Enrichment by Dun & Bradstreet (D&B) for data enrichment and the Oracle Address, Email, and Phone Verification for address verification. To enable address verification and to avoid data conflicts between the Oracle Address, Email, and Phone Verification and master reference geography data you must do the following setups:

- Deselect the Enable List of Values option in the Geography Mapping and Validation region to avoid Oracle Address, Email, and Phone Verification data conflicts with master reference geography data. By deselecting this option you can avoid any UI level validation against master geographies while adding address.
• Select Geography Validation Level for Country as No validation to verify address data by Oracle Address, Email, and Phone Verification.

Perform the following steps on the Manage Geography Validation page to enable address verification and to avoid data conflicts between the Oracle Address, Email, and Phone Verification and master reference geography data:

1. In the Setup and Maintenance work area, go to the following:
   o Offering: Customer Data Management
   o Functional Area: Enterprise Profile
   o Task: Manage Geographies

2. On the Manage Geographies page, search for the country by the name or country code, for example US.
3. Click the Go to Task button in the Validation Defined column. The Manage Geography Validation page appears.
4. Deselect the Enable List of Values check boxes for all the geography attributes to avoid any UI level validation against master geographies while entering the addresses. If the Enable List of Values check boxes are selected then, in case of data conflicts, Geography Naming References records aren't created.

**Note:** If any of the Geography Types listed isn't applicable to the selected country's territory structure, then you must deselect the geography validation for that type.

If you're planning to create territories based on a particular Geography Type, such as County, then you must deselect all the Geography Validation levels under that Geography Type (in this case City and Postal Code) based on which you want to create the territory.

**Tip:** Review the Address Style Formats that are selected on the Manage Geography Validation page. The review is required because on the Account or Contact Simplified UI page, address attributes are displayed based on the address formats and verified or enriched addresses are saved in Oracle Applications Cloud based on the selected address formats.

### Related Topics

- Overview of Zone Types and Zones

**Overview of Zone Types and Zones**

Geography hierarchy is a data model that creates conceptual parent-child relationships between geographies.

Geography hierarchies can be classified as follows:

- **Master Reference Geography Hierarchy:** This refers to the predefined geography hierarchy and is considered as the source of truth. It is defined by widely recognized administrative or political boundaries such as States, Provinces, Counties, Cities, and so on. This hierarchy can be obtained from a supplier or manually entered. This geography hierarchy is the source when validating addresses or importing data. Examples are the State of California, the Province of Alberta, The Country of India, and so on.

- **User Defined Geography Hierarchy:** This refers to geography hierarchy defined by the user. This geography hierarchy may be created using the Master Reference Geography, obtained from a supplier, or entered manually. A user-defined geography hierarchy can have:
  - Zone Types
Zone Types
Zone types categorize and group zones together, for example, the zone types of Income Tax and Shipping Regions.

Zone types need to be created before you define a zone for the geographical boundary. You can create a zone type which will contain geographical boundaries from anywhere in the world, or you can create a zone type that will only contain geographies from within a specified country. When you create a zone type that's bounded by a country you can define which geography types or geographies you will be able to choose when you create a zone.

Zones
Zones are geographical boundaries for a zone type, for example, the San Jose Tax zone. Zones are based on the master reference geography hierarchy data.

Zones are created within a zone type, and you can associate geographies to define the zone. For example, for the Shipping Regions zone type you can create a West Coast zone which has the state of California as one of its geographies. Within a geography you can specify a postal range. So, for the state of California, for example, you can specify that the zone spans from postal code 90001 to 90011.

Zones Created in Master Geographies
Here is the list of zones created using master geographies in each product offering and the tasks to load them:

<table>
<thead>
<tr>
<th>Product Offering</th>
<th>Task Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Territory Geographies</td>
<td>Manage Territory Geographies</td>
</tr>
<tr>
<td>Tax</td>
<td>Manage Tax Zone Types</td>
</tr>
<tr>
<td>Shipping</td>
<td>Manage Shipping Zones</td>
</tr>
<tr>
<td>Compensation</td>
<td>Compensation Zones</td>
</tr>
</tbody>
</table>

**Note:** There are no bulk loaders for loading these zones.

For more information about creating zone types and zones, see the Related Topics section.

**Related Topics**
- Manage Zone Types and Zones for Shipping and Tax
- Configure Compensation Zone Types and Zones
Import Geographies and Zones

How You Import Geographies

A geography, such as Tokyo or Peru, describes a boundary on the surface of the earth.

You can use the following options when importing geographies:

- Oracle-licensed geography reference data
- Import Management

**Note:** The processing time for importing geography data can vary based on several variables, such as, the volume of data to be loaded and it could take several hours to complete.

Oracle-Licensed Geography Reference Data

You can import Oracle-licensed data from Loqate, for those countries where the data is available. For more information about the supported countries, see the List of Available Countries with Loqate Geography Reference Data topic. You can import geography data using the **Manage Geographies** task. Search for the country, and select **Import Geography Data** from the **Actions** menu. If the licensed data isn't available or already set up for a particular country, then the **Import Geography Data** action is disabled.

**Note:** Customers who are licensed to use HCM Cloud Payroll for the United States or Canada must import their geography data from Vertex. For more information, see the United States and Canada Payroll implementation and administering guides.

**Note:** Note the following while working with geography data: By exporting this "Geography" data from the Oracle environment to Your environment, You agree that (a) Oracle is granting You only a restricted right to download the exported data specifically for Your use with the Oracle Fusion services, (b) this data may not be used, transferred, or uploaded for any other purposes; and (c) except for the restricted right granted in (a), all provisions of the Oracle Cloud Services Agreement (CSA) or Schedule C, as applicable to You, remain in full force and effect, including specifically section 3.4 thereof.

Import Management

The Import Management process reads the data included in your XML or text file and imports the data into the application.

To access Import Management functionality, go to **Navigator > Tools > Import Management**

For more information, see the Import Your Geography Data topic.
List of Available Countries with Loqate Geography Reference Data

Oracle Applications Cloud provides third-party Loqate geography data for import. Here's the list of countries for which the Loqate geography data is available for import.

<table>
<thead>
<tr>
<th>Country Name</th>
<th>Country Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>Andorra</td>
<td>AD</td>
</tr>
<tr>
<td>Angola</td>
<td>AO</td>
</tr>
<tr>
<td>Argentina</td>
<td>AR</td>
</tr>
<tr>
<td>Australia</td>
<td>AU</td>
</tr>
<tr>
<td>Austria</td>
<td>AT</td>
</tr>
<tr>
<td>Belgium</td>
<td>BE</td>
</tr>
<tr>
<td>Bolivia</td>
<td>BO</td>
</tr>
<tr>
<td>Bosnia and Herzegovina</td>
<td>BA</td>
</tr>
<tr>
<td>Brazil</td>
<td>BR</td>
</tr>
<tr>
<td>Bulgaria</td>
<td>BG</td>
</tr>
<tr>
<td>Canada</td>
<td>CA</td>
</tr>
<tr>
<td>Cayman Islands</td>
<td>KY</td>
</tr>
<tr>
<td>Chile</td>
<td>CL</td>
</tr>
<tr>
<td>Country Name</td>
<td>Country Code</td>
</tr>
<tr>
<td>----------------</td>
<td>--------------</td>
</tr>
<tr>
<td>China</td>
<td>CN</td>
</tr>
<tr>
<td>Croatia</td>
<td>HR</td>
</tr>
<tr>
<td>Cuba</td>
<td>CU</td>
</tr>
<tr>
<td>Cyprus</td>
<td>CY</td>
</tr>
<tr>
<td>Czech Republic</td>
<td>CZ</td>
</tr>
<tr>
<td>Denmark</td>
<td>DK</td>
</tr>
<tr>
<td>Dominican Republic</td>
<td>DO</td>
</tr>
<tr>
<td>Ecuador</td>
<td>EC</td>
</tr>
<tr>
<td>Estonia</td>
<td>EE</td>
</tr>
<tr>
<td>Finland</td>
<td>FI</td>
</tr>
<tr>
<td>France</td>
<td>FR</td>
</tr>
<tr>
<td>Germany</td>
<td>DE</td>
</tr>
<tr>
<td>Great Britain</td>
<td>GB</td>
</tr>
<tr>
<td>Greece</td>
<td>GR</td>
</tr>
<tr>
<td>Guadalupe</td>
<td>GP</td>
</tr>
<tr>
<td>Guam</td>
<td>GU</td>
</tr>
<tr>
<td>Guernsey</td>
<td>GG</td>
</tr>
<tr>
<td>Hungary</td>
<td>HU</td>
</tr>
<tr>
<td>Iceland</td>
<td>IS</td>
</tr>
<tr>
<td>India</td>
<td>IN</td>
</tr>
<tr>
<td>Indonesia</td>
<td>ID</td>
</tr>
<tr>
<td>Country Name</td>
<td>Country Code</td>
</tr>
<tr>
<td>--------------</td>
<td>--------------</td>
</tr>
<tr>
<td>Ireland</td>
<td>IE</td>
</tr>
<tr>
<td>Isles of Man</td>
<td>IM</td>
</tr>
<tr>
<td>Israel</td>
<td>IL</td>
</tr>
<tr>
<td>Italy</td>
<td>IT</td>
</tr>
<tr>
<td>Jamaica</td>
<td>JM</td>
</tr>
<tr>
<td>Japan</td>
<td>JP</td>
</tr>
<tr>
<td>Jordan</td>
<td>JO</td>
</tr>
<tr>
<td>Kenya</td>
<td>KE</td>
</tr>
<tr>
<td>Latvia</td>
<td>LV</td>
</tr>
<tr>
<td>Liechtenstein</td>
<td>LI</td>
</tr>
<tr>
<td>Lithuania</td>
<td>LT</td>
</tr>
<tr>
<td>Luxembourg</td>
<td>LU</td>
</tr>
<tr>
<td>Malaysia</td>
<td>MY</td>
</tr>
<tr>
<td>Malta</td>
<td>MT</td>
</tr>
<tr>
<td>Martinique</td>
<td>MQ</td>
</tr>
<tr>
<td>Mexico</td>
<td>MX</td>
</tr>
<tr>
<td>Netherlands</td>
<td>NL</td>
</tr>
<tr>
<td>New Zealand</td>
<td>NZ</td>
</tr>
<tr>
<td>Norway</td>
<td>NO</td>
</tr>
<tr>
<td>Oman</td>
<td>OM</td>
</tr>
<tr>
<td>Peru</td>
<td>PE</td>
</tr>
</tbody>
</table>
### Geographies

<table>
<thead>
<tr>
<th>Country Name</th>
<th>Country Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>Poland</td>
<td>PL</td>
</tr>
<tr>
<td>Portugal</td>
<td>PT</td>
</tr>
<tr>
<td>Puerto Rico</td>
<td>PR</td>
</tr>
<tr>
<td>Qatar</td>
<td>QA</td>
</tr>
<tr>
<td>Reunion Island</td>
<td>RE</td>
</tr>
<tr>
<td>Romania</td>
<td>RO</td>
</tr>
<tr>
<td>Russia</td>
<td>RU</td>
</tr>
<tr>
<td>San Marino</td>
<td>SM</td>
</tr>
<tr>
<td>Singapore</td>
<td>SG</td>
</tr>
<tr>
<td>Slovakia</td>
<td>SK</td>
</tr>
<tr>
<td>Slovenia</td>
<td>SI</td>
</tr>
<tr>
<td>South Africa</td>
<td>ZA</td>
</tr>
<tr>
<td>South Korea</td>
<td>KR</td>
</tr>
<tr>
<td>Spain</td>
<td>ES</td>
</tr>
<tr>
<td>Sri Lanka</td>
<td>LK</td>
</tr>
<tr>
<td>Swaziland</td>
<td>SZ</td>
</tr>
<tr>
<td>Sweden</td>
<td>SE</td>
</tr>
<tr>
<td>Switzerland</td>
<td>CH</td>
</tr>
<tr>
<td>Taiwan</td>
<td>TW</td>
</tr>
<tr>
<td>Thailand</td>
<td>TH</td>
</tr>
<tr>
<td>Tunisia</td>
<td>TN</td>
</tr>
</tbody>
</table>
Chapter 5

Geographies

<table>
<thead>
<tr>
<th>Country Name</th>
<th>Country Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>Turkey</td>
<td>TR</td>
</tr>
<tr>
<td>United Arab Emirates</td>
<td>AE</td>
</tr>
<tr>
<td>United States</td>
<td>US</td>
</tr>
<tr>
<td>Uruguay</td>
<td>UY</td>
</tr>
<tr>
<td>Vatican City</td>
<td>VA</td>
</tr>
<tr>
<td>Vietnam</td>
<td>VN</td>
</tr>
</tbody>
</table>

Replace Existing Master Geography Data with Revised Oracle-Licensed Geography Data

You must import and set up reference geography data for the countries where you do business.

Using the Oracle-licensed geography reference data, you no longer have to source geography data from a third party. You can import Oracle-licensed data from Loqate, including the country structure and hierarchy information, either to create a new geography setup or replace your existing geography data.

All customers with the exception of United States and Canada HCM Payroll customer, can use the information in this section to replace existing geography data with Loqate geography data. You can follow these steps if you're using Nokia or any other geography data and now want to move to Loqate geography data.

Before you begin, perform the following steps:

- Backup existing geography data including customizations, if any.
- Backup territory geographies.
- Perform impact analysis by contacting the support team to identify the use of geography IDs downstream.

**Note:** Before deleting the geography data, make sure that GEOGRAPHY_ID isn't referenced in any downstream applications such as TAX, FIN, Legal, and so on. Geography data is used across Oracle Cloud applications such as Human Capital Management, TAX, and Legal. Global Single Instance POD users share the same geography data and before deleting geography data, the geography usage POD analysis is required. The Oracle Support team can help you identify the downstream impact.

Create an Export File of All Territories

In case you have implemented Customer Data Management along with the sales functionality, you must export all territories before deleting the master geography data because removing the master geography data invalidates the territory definitions that are based on the Geography dimension. You can either export the definitions of all territories to a file or make manual corrections. If there are a large number of territories, export the territories definition to a file for
the territories import process. However, if there are very few affected territories, then you can choose to either export the territories definition to a file or make corrections manually.

This procedure is applicable only if there are territories defined using the Geography dimension.

Perform the following steps to create an export file of all territories.

1. From the Territories and Quotas work area, click View Active Territories in the Tasks pane.
2. In the View Active Territories page, select the territory at the highest level.
3. Click the Actions list, and select Export, and then Export Selected Territory Hierarchy.
4. In the Warning dialog box, click OK.
5. Click the Actions list and select Export, and then View Export Status.
6. Review the status of the export job and verify if it has completed successfully.
7. In the Exported Data File column, click the .zip file against your export job, and click Save. All the territories are exported to a compressed file on your system.
8. Click OK.
9. Click Done in the View Active Territories page.

Delete the Territory Geography Data

A territory definition has references to the territory geography data and master geography data. Territory geography data is based on the master geography data, in case you have implemented Customer Data Management along with the sales functionality, you must delete the territory geography data prior to deleting the master geography data. When you delete the territory geography data, all territories that are defined using geography dimension become invalid.

This procedure is applicable only if territory geographies are defined.

Perform the following steps to delete the territory geography data.

1. In the Setup and Maintenance work area, go to the following:
   o Offering: Sales
   o Functional Area: Territories
   o Task: Manage Territory Geographies
2. On the Manage Territory Geographies page, click View All Hierarchies.
3. Select the highest level node for the country for which you want to replace the master geography data and click the Delete icon.
4. In the Warning dialog box, click OK.
5. In the Confirmation dialog box, click OK. The parent node of the territory geography data and its children are deleted.
6. Repeat steps 3 to 5 to delete all the higher nodes in the territory geography data.
7. Click Save and Close.

The Territory Management application retains a copy of the dimension members referenced in the territory definitions. This copy is updated when you trigger the Load and Activate process from the Enable Dimensions and Metrics task. Therefore, although the territory geography data is deleted, the territory definitions may appear to remain valid.

Delete the Master Geography Data

Delete the existing geography data one country at a time. We recommend that you raise a service request for assistance in deleting the geography data.

Delete Geography Structure
If you have created a geography structure, it prevents the geography imports from working or working as desired. For example, if the geography structure exists, the Import Geography option may not be enabled for a country in Manage Geographies even if Loqate predefined geography data is available for that country and the geography hierarchy doesn’t exist yet.

**Note:** If any geography hierarchy was created manually, it must be deleted first.

If the geography structure was created manually, you can follow these steps to delete it. However, we recommend that you raise a service request for assistance in deleting the geography structure.

1. In the Setup and Maintenance work area, go to the following:
   - Offering: Customer Data Management
   - Functional Area: Enterprise Profile
   - Task: Manage Geographies
2. On the Manage Geographies page, enter either the country name or the two-letter ISO code (for example, US), and click Search.
3. Select the country in the search results and click **Actions > Manage Geography Structure**.
4. In the Manage Geography Structure page, delete each level of the structure.
5. Click Save and Close.

You can now proceed to importing geography data.

**Note:** If other setup or transaction data exists that’s based on the geography data, replacement procedures for that setup must also be followed.

### Import Oracle-Licensed Geography Reference Data

Use this procedure to import Loqate geography data in Manage Geographies one country at a time. If the country data you want isn't supported by Loqate geography seed data and point the Loqate supported country list here, then the Import Geography Data action is disabled.

The geography data is provided by Loqate and is third-party content. As per Oracle policy, this software and documentation may provide access to or information about content and services from third parties. Oracle and its affiliates aren't responsible for and expressly disclaim all warranties of any kind with respect to third-party content and services. Oracle and its affiliates aren't responsible for any loss, costs, or damages incurred due to your access to or use of third-party content, products, or services.

Perform the following steps to import Oracle-licensed geography reference data.

1. In the Setup and Maintenance work area, go to the following:
   - Offering: Customer Data Management
   - Functional Area: Enterprise Profile
   - Task: Manage Geographies
2. On the Manage Geographies page, enter either the country name or the two-letter ISO code (for example, US), and click **Search**.
3. Select the country in the search results.
4. Click the **Actions** list, and select **Import Geography Data**.
5. In the Warning dialog box, click **OK**.
In the Confirmation dialog box, click **OK**.

The import of larger countries may require several hours to complete.

You can track the progress of the import process by selecting Scheduled Processes from the Navigator.

---

**Note:** To access the Scheduled Processes work area, you must be signed in as a user with the Employee abstract role. The initial user doesn't have this role assigned, but the other users you created do.

After the import is complete, you can search for the country again in the Manage Geographies page. Check marks now appear in the **Structure Defined** and **Hierarchy Defined** columns indicating the import completed successfully.

Next, click the **Validation Defined** icon to define the validations, enable List of Values, and choose address style format for a country as set up before. For more information, see the Geography Validation topic.

The **Geocoding Defined** and **Address Cleansing Defined** columns are used for additional features which you must license from Oracle and set up separately.

- Geocoding makes it possible to display customers in the vicinity of a mobile address. You set up **Geocoding Enabled** for those countries where you're using Around Me functionality in CX Sales Cloud Mobile.
- Cleansing makes it possible to validate addresses down to the street level.

Add any geography customizations.

---

**Run the Geography Name Referencing Process**

The Geography Name Referencing (GNR) process validates address elements in location tables, such as HZ_LOCATIONS, against the master geography data.

**Note:** Note: You can't update existing data, such as effective start date, in the GNR process tables for the locations.

Perform the following steps to run the GNR process.

1. Navigate to **Tools > Scheduled Processes** work area.
2. On the Overview page, click **Actions > Schedule New Process**.
3. Click the **Name** list and search for **Validate Geographies of Addresses Against Master Geographies**, and then click **OK**.
4. Click **OK** in the Schedule New Process dialog box.
5. In the Process Details dialog box, enter the following details:
   - **Location Table Name**: HZ_LOCATIONS
   - **Run Type**: ALL
   - **Usage Code**: GEOGRAPHY
6. Enter the country code in the Country Code field.
7. Click **Submit**.
8. In the Confirmation dialog box, click **OK**.
9. Click **Close**.
10. In the Scheduled Processes page, click the **Refresh** icon.
11. Verify if the status of the process has completed successfully.

Find the locations failing in Geography Name References using: https://cloudcustomerconnect.oracle.com/posts/b1e16b06ae. Fix Geography Name References failures by updating addresses with the latest geography data.
Recreate and Load the Territory Geography Data

In case you have implemented Customer Data Management along with the sales functionality, you can recreate the territory geography data, after the master geography data is imported, using either of the following methods:

- Import process: If you created the original territory geography data using the import process, then use the same import file to recreate the territory geography structure. For more information about importing the territory geography data using Import Management, see Import Your Sales Territory Data in the Oracle CX Understanding Import and Export Management for CX Sales and B2B Service guide.

- Manual creation process: You can manually recreate the territory geography data structures, as they existed before their deletion, using the Manage Territory Geographies task. For more information about creating zones and adding geographies to a zone, see Managing Territory Geographies in the Related Topics section.

After you have recreated the territory geography data, perform the following steps to load the data.

1. In the Setup and Maintenance work area, go to the following:
   - Offering: Sales
   - Functional Area: Territories
   - Task: Enable Dimensions and Metrics

2. On the Enable Dimensions and Metrics page, click the Actions list, and select Load and Activate. The process loads the territory geography data to make dimension members available for selection when defining territories.

3. In the Confirmation dialog box, click OK.

4. Click Done.

Restore the Invalid Territory Definitions

After recreating the territory geography hierarchies and running the Load and Activate option from the Enable Dimensions and Metrics task, the geography dimensions are populated with the new geography members. The geography members in the territory appear as invalid because your territories still reference the old copies of the dimension members that were deleted. The new members aren't referenced automatically by the territories. You must re-reference the territory definitions from the old geography dimension members to the new ones.

You can restore the invalid territory definitions by either importing the previously created export file or making manual corrections to the territories.

To restore valid territory definitions using territories import:

1. Open the export file you saved in the Creating an Export File of All Territories step. The compressed file contains four CSV files.
2. Open TERR_HEADER.CSV file.
3. Enter REPLACE in the Action column for all territories that are based on geography dimension.
4. Save the file in CSV format and compress it together with three other CSV files.
5. From the Territories and Quotas work area, click View Active Territories in the Tasks pane.
6. Click the Actions list, and select Import to Proposal, and then Import Territories.
7. Select the newly created compressed file and click OK.
8. Click the Actions list and select Import to Proposal, and then View Import Status.
9. Review the status of the export job and verify if it has completed successfully.
10. Click OK.
11. From the Tasks pane, click Manage Territory Proposals.
12. In the Manage Territory Proposals page, on the Current Territory Proposals table, search for the proposal with your import file name.
13. Click the import file name to open the territory proposal.
14. Click Edit Coverage to verify that the territory definitions are valid.
15. Verify that there are no values listed as invalid in the Selected Dimension Members section.
16. Click Save and Close.
17. Click Activate. The territory proposal of your import file is activated.

To restore valid territory definitions through manual corrections:

1. From the Territories and Quotas work area, click Manage Territory Proposals in the Tasks pane.
2. In the Manage Territory Proposals page, click the Create icon.
3. In the Create Territory Proposals dialog box, enter a name and click Save and View.
4. In the Territory Proposals page, add all the territories with the Geography dimension value other than the value Any to the proposal.
5. Select a territory and click Edit Coverage.
6. In the Edit Coverage page, select Geography from the Dimensions list. The invalid dimension members are displayed in the Selected Dimension Members pane.
7. Expand the values in the Available Dimension Members section or search for the member that has the same name as the one marked invalid in the Selected Dimension Members pane.
8. Select one or more new geography dimension members from Available Dimension Members pane and click Add icon to the Selected Dimension Members pane.
9. Click the Remove icon to remove the invalid members from the Selected Dimension Members pane.
10. Click Save and Close.
11. Repeat steps 4 to 10 for all territories that were based on Geography dimension.
12. Click Activate. After the activation process is complete, your territory definitions are valid again and are referencing to the new geography data.

Although this method is always applicable, it's most appropriate when you have to restore territory definitions for a smaller number of territories.

To run the batch assignment process for opportunities:

1. From Navigator, click Scheduled Processes.
2. In the Schedule Processes page, click Schedule New Process.
3. In the Schedule New Process dialog box, search for the Request Revenue Territory Assignment process and select it.
4. Click OK.
5. In the Process Details dialog box, enter OpenOpportunitiesByCreationDate in the View Criteria Name field. This selects all revenue lines belonging to open opportunities that were created in the last ‘X’ days.
6. Enter BindOptyCreationDateFrom= followed by the date.
   For example, if BindOptyCreationDateFrom=2014-01-01, then all open opportunities which were created between 1st January 2014 till the current date, are processed.
7. Click Submit to schedule the process.
8. In the Confirmation dialog box, make a note of the process identifier for monitoring the process, and click OK.
9. Click Close.
10. In the Schedule Processes page, click the Refresh icon.
11. Review the status of the process job and verify if it has completed successfully.

   Note: Review a small subset of the open opportunities to confirm that the territory assignment is as expected.
To run the batch assignment process for sales accounts:

1. Ensure that the `ZCA_SA_AUTO_ASSIGN_ON_CREATE` and `ZCA_SA_AUTO_ASSIGN_ON_UPDATE` profile options are set to Yes in the Manage Customer Center Profile Options task.
2. From Navigator, click Customers.
3. In the Customers page, click Create Account.
4. In the Create Account page, enter a name and address of the sales account, and select the Address is sell to check box.
5. Click Save and Close.
6. From Navigator, click Customers.
7. In the Search pane, search for the name of the sales account you created and select it.
8. In the section Customer Information, select Sales Account Team. The details of the sales account and territories associated with the sales account are displayed.
   - This indicates that the sales account was created successfully and the batch assignment was run automatically to assign the matching territories to the sales account.

To run the batch assignment process manually from the Scheduled Processes page, perform the following steps.

1. From Navigator, click Scheduled Processes.
2. In the Schedule Processes page, click Schedule New Process.
3. In the Schedule New Process dialog box, search for the Request Account Assignment process and select it.
4. Click OK.
5. Enter SalesAccount_Work_Object in the Work Object Code field and SalesAccountTerritory_Candidate_Object in the Candidate Object Code field.
6. Select Territory in the Assignment Mode list.
7. Enter AllSalesAccountsVC in the View Criteria Name field. This selects all sales accounts.
8. Click Submit to schedule the process.
9. In the Confirmation dialog box, make a note of the process identifier for monitoring the process, and click OK.
10. Click Close.
11. In the Schedule Processes page, click the Refresh icon.
12. Review the status of the process job and verify if it has completed successfully.
   - **Note:** Review a small subset of the accounts to confirm that the territory assignment is as expected.

Verify that the downstream applications using geography data is working fine.

**Related Topics**
- Manage Territory Geographies
- Validate Geographies of Addresses Against Master Geographies
- Request Revenue Territory Assignment
- Request Account Assignment

### Create Countries

This procedure lists the steps to create countries in the application.

The countries are seeded in the application. If you're unable to find a specific country in the Manage Geographies page, then you can add it to the application.
Perform the following steps to create a new country.

1. In the Setup and Maintenance work area, go to the following:
   - Offering: Customer Data Management
   - Functional Area: Application Extensions
   - Task: Manage Territories
2. On the Manage Territories page, click the New icon.
3. Enter the following details:
   - Territory Code: Enter a unique code for the territory.
   - Territory Name: Enter a unique name for the territory.
   - Description: Enter a description for the territory.
4. Click Save and Close.

Note: After you have added a new country in the application, if you want to import the geography data for that country, then you must perform Step 5 to 10.

5. In the Setup and Maintenance work area, go to the following:
   - Offering: Customer Data Management
   - Functional Area: Enterprise Profile
   - Task: Manage Geographies
7. In the Create Country dialog box, select the name of the country and click Save.
8. Click Done.

Note: You can now import the geography data for the newly created country using Loqate geography data available in the application. In case geography data for your country isn't available from Loqate, you can purchase the geography data from a third-party data provider and import it using Import Management.

Related Topics
- Replace Existing Master Geography Data with Revised Oracle-Licensed Geography Data

Import Your Geography Data

You can use Import Management to create Geography records. You can also add alternate name or code to existing geographies with import. For more information see Example of Importing Geography Data in the Related Topics section.
To import Geography records, perform the following tasks:

1. Map your source data to Oracle Applications Cloud object attributes.
2. Create source Comma Separated Values (CSV) file for import.
3. Create the import activity.
4. Review the import results.

**How You Map Your Source Data to Object Attributes**

To import your Geography data into Oracle Applications Cloud, you must populate a .csv file with your source data and map that source data to target object attributes in Oracle Applications Cloud.

You need to do the following before creating the CSV file for data import:

- Identify how your source data attributes map to the target object attributes in Oracle Applications Cloud.
- Create Country Structure before importing Geography data. For information on how to create Country Structure, see Import Your Country Structure and Example of Importing Country Structure in Related Topics Section.
- Identify the target object attributes that are required in the CSV file for a successful import as mentioned in the table Required Attributes and Validations for the Geography Object below.

**Before You Start**

You must do some basic checks before starting your import. For example, make sure that:

- You have completed all the prerequisites for importing each attribute in your source data such as creating a country structure.

**Required Attributes and Validations for the Geography Object**

To import data successfully into Oracle Applications Cloud, your CSV file must include the required attributes. Ensure that you provide values for the attributes. The following table lists the required attributes for importing new Geography records, prerequisite setup tasks for the attributes, and specific validations, if any, for Geography import:

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Description</th>
<th>Prerequisite Setup Task/ Import Validations</th>
<th>Creating a Geography Record</th>
</tr>
</thead>
<tbody>
<tr>
<td>CountryCode</td>
<td>The code of the country to which the geography belongs.</td>
<td>This is validated against the country structure to check if the structure is defined for this country.</td>
<td>Required</td>
</tr>
<tr>
<td>PrimaryGeographyName</td>
<td>The primary name of the geography.</td>
<td>This is validated against the name of country if geography type is ‘Country’ or LevelNumber is 1.</td>
<td>Required</td>
</tr>
<tr>
<td>RecordTypeCode</td>
<td>The record type code that represents the intent of the import data. The values are:</td>
<td>No Validation</td>
<td>Required</td>
</tr>
<tr>
<td></td>
<td>- 0 - indicates the geography that already exists in the base table.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Attribute</td>
<td>Description</td>
<td>Prerequisite Setup Task/ Import Validations</td>
<td>Creating a Geography Record</td>
</tr>
<tr>
<td>-----------------</td>
<td>------------------------------------------------------------------------------</td>
<td>---------------------------------------------</td>
<td>-----------------------------</td>
</tr>
<tr>
<td>LevelNumber</td>
<td>The level number of the geography in the hierarchy. For example, Country is at Level 1 and State (California) is at Level 2.</td>
<td>The level should exist in the country structure.</td>
<td>Required</td>
</tr>
<tr>
<td>SourceID</td>
<td>The source ID for the geography, along with the parent source ID is used to identify the geography parent and child relationship within the source file data and the interface table data.</td>
<td>None</td>
<td>Required</td>
</tr>
<tr>
<td>ParentSourceID</td>
<td>The parent source ID for the geography, along with the source ID is used to identify the geography's parent and child relationship with records within the source file data. This should be null for the country record, as Country is at the top of the hierarchy.</td>
<td>None</td>
<td>Required</td>
</tr>
</tbody>
</table>

You can view the Geography object and attributes in the Manage Import Objects page of the Import Management flow. You can find attribute information like type, length, description, and so on, on this Manage Import Objects page.

**Note:** Keep a note of the following:

- You can't update geographies via import. Alternatively, you can add alternate name or alternate code for a country from the UI.

- Before adding a new alternate name, make sure that the alternate name does not exist with the same value for any other geography name.

- You can enable high-volume import for the Geography import object in the Manage Import Objects page.

- `PrimaryGeographyCodeType` and `PrimaryGeographyCode` can't be added after `PrimaryGeographyName` is created via import. You must create them together. Alternatively, you can add `primaryGeographyCodeType` and `PrimaryGeographyCode` from the UI after the import is complete.

### Create the Source CSV File

You include the data that you want to import into CX Sales and B2B Service in a source CSV file.

You can use the templates available in the Import Objects UI page to create the source CSV file. To download a template:

1. Go to **Navigator > Tools > Import Management > Import Objects**.
2. Select the **Geography** object in the table and click **Download**.

You can now edit the downloaded file and provide valid values for the required attributes.

**Note:** For help in populating the CSV file and to avoid any issues in entering values, see the topic Potential Issues When Opening CSV Files With Excel in Related Topics section.

### Create the Import Activity

After you have the CSV file ready, create an import activity to import the information. To create an import activity:

1. Go to **Navigator > Tools > Import Management > Import Queue**.
2. Click **Create Import Activity** in the **Manage Imports** page.
3. In the **Enter Import Options** page, provide a name for the import activity, and select Geography from the **Object** drop-down list.
4. Select the CSV file in the **File Name** field, and click **Next**.
5. The source and target attributes are automatically mapped in the **Map Fields** page. Review and edit the mappings if required.
6. Check the file for unmapped columns or data format issues by clicking **Validate Data**. Click **Next**.
7. Review the import details on the **Review and Submit** page, and click **Submit** when you’re ready.

### Review the Import Results

Check if your import succeeded on the **Manage Imports** page. This page shows the status of all active, completed, and unsuccessful imports. To check the status of the import activity:

1. Go to **Navigator > Tools > Import Management > Import Queue**.
2. Click All Imports and search for the import activity that you created earlier.
3. Check the **Status** column for the import activity. The import is successful if the status displays as **Completed**. You can drill down on the import activity to go to the **Import Status** page which provides the status details of the import activity.

**Note:** Geography names aren't translatable and are always displayed in the same language in which they were loaded irrespective of the language of the signed in user. If you need different options of display, you can use the alternative names option.

### Related Topics

- Import Your Country Structure Data
- Import Data
- Potential Issues When Opening CSV Files in Excel
- Example of Importing Country Structure Data
- Example of Importing Geography Data

### Example of Importing Geography Data

This example demonstrates how to import data using Import Management.
In this example, you have a source file containing geography data that you want to import into the application to make the geography data available for real time address validation and tax purposes. A geography is any region with a boundary around it, regardless of its size. It might be a state, a country, a city, a county, or a ward.

Summary of the Tasks
You perform the following steps to create an import activity and activate the import:

1. Determine what information is in the source file.
2. Create and schedule the import activity.

Before You Start

1. You use the country structure of a country to define which geography types are part of the country. For more information about an example of importing a country structure, see the topic "Example of Importing Country Structure Data".
2. Ensure that Source ID values are unique for each row of data within a single import.
3. Ensure that all the parents of a child geography are included in your data file so that the child geography can be added. For example, if you originally imported US, CA, and San Francisco, and now you want to import the city of San Jose in CA, then your data file must include US, CA, and San Jose.
4. Check that your source data file has the correct values for the geography data that you have already loaded. For example, if your initial import included the value US for country and CA as state, and in a subsequent import you have California as a state, then your geography import creates two state records (CA and California) in the application data, with the US as the country parent.

Determine the Information in the Source File
The source geography data files must include a unique Source ID value for each row of data and Parent Source ID value for the parent of that row of data. You include the data that you want to import into CX Sales and B2B Service in a source CSV file. A sample input CSV file for country as US is shown in this table.

<table>
<thead>
<tr>
<th>RecordTypeCode</th>
<th>PrimaryGeography</th>
<th>CountryCode</th>
<th>LevelNumber</th>
<th>SourceId</th>
<th>ParentSourceId</th>
<th>LanguageCode</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>United States</td>
<td>US</td>
<td>1</td>
<td>1</td>
<td>&lt;blank&gt;</td>
<td>US</td>
</tr>
<tr>
<td>1</td>
<td>California</td>
<td>US</td>
<td>2</td>
<td>11</td>
<td>1</td>
<td>US</td>
</tr>
<tr>
<td>1</td>
<td>San Mateo</td>
<td>US</td>
<td>3</td>
<td>111</td>
<td>11</td>
<td>US</td>
</tr>
<tr>
<td>1</td>
<td>Redwood City</td>
<td>US</td>
<td>4</td>
<td>1111</td>
<td>111</td>
<td>US</td>
</tr>
<tr>
<td>1</td>
<td>94065</td>
<td>US</td>
<td>5</td>
<td>11111</td>
<td>1111</td>
<td>US</td>
</tr>
</tbody>
</table>

Here is a sample CSV file to import geographies with alternate name and code for country India:

<table>
<thead>
<tr>
<th>RecordType</th>
<th>PrimaryGeography</th>
<th>CountryCode</th>
<th>LevelNumber</th>
<th>SourceId</th>
<th>ParentSourceId</th>
<th>IdentifierType</th>
<th>IdentifierSubT</th>
<th>IdentifierValue</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>India</td>
<td>IN</td>
<td>1</td>
<td>1</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Implementing Customer Data Management for CX Sales and B2B Service

Chapter 5
Geographies

<table>
<thead>
<tr>
<th>RecordType</th>
<th>PrimaryGeographyName</th>
<th>CountryCode</th>
<th>LevelNumber</th>
<th>SourceId</th>
<th>ParentSourceId</th>
<th>IdentifierType</th>
<th>IdentifierSubType</th>
<th>IdentifierValue</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Karnataka</td>
<td>IN</td>
<td>2</td>
<td>2</td>
<td>1</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>Bengaluru</td>
<td>IN</td>
<td>3</td>
<td>3</td>
<td>2</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Bengaluru</td>
<td>IN</td>
<td>3</td>
<td>3</td>
<td>2</td>
<td>NAME</td>
<td>Standard_Name</td>
<td>Bangalore</td>
</tr>
<tr>
<td>1</td>
<td>Whitefield</td>
<td>IN</td>
<td>4</td>
<td>4</td>
<td>3</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>560066</td>
<td>IN</td>
<td>5</td>
<td>5</td>
<td>4</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>560066</td>
<td>IN</td>
<td>5</td>
<td>5</td>
<td>4</td>
<td>CODE</td>
<td>ISO_COUNTRY_CODE</td>
<td>91</td>
</tr>
</tbody>
</table>

**Note:** Keep a note of the following:

- The hierarchy is modeled in the CSV file using the SourceId and ParentSourceId. The ParentSourceId for the Country Record (level Number 1) is always null.

- If defining an alternate name (RecordTypeCode = 2) for any level below the country (LevelNumber >1), ensure that the SourceId and ParentSourceId columns match the values for the original record respectively.

- You can't update geographies via import. Alternatively, you can add alternate name or alternate code for a country from the UI.

- Before adding a new alternate name, make sure that the alternate name doesn’t exist with the same value for any other geography name. You can check the existing values for alternate names in the Manage Geographies task page under Hierarchy Defined.

- You can find the list of IdentifierSubTypes in Manage Geography Lookups page in the UI.

- PrimaryGeographyCodeType and PrimaryGeographyCode can't be added after PrimaryGeographyName is created via import. You must create them together. Alternatively, you can add PrimaryGeographyCodeType and PrimaryGeographyCode from the UI after the import is complete.

You must create a source file (CSV) file with the attributes and import it using import management as shown in this table.

<table>
<thead>
<tr>
<th>Attribute Name</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>RecordTypeCode</td>
<td>1</td>
<td>The record type code that represents the intent of the import data. The values are:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- 0 - indicates the geography that already exists in the base table.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- 1 - indicates the intent to create a new geography.</td>
</tr>
<tr>
<td>Attribute Name</td>
<td>Value</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------</td>
<td>-----------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>PrimaryGeographyName</td>
<td>India</td>
<td>• 2 - indicates the intent to add an alternate identifying name or code to an existing geography. This is the primary geography name. This will be marked as the primary name for the Geography and also displayed in the Manage Geographies Page.</td>
</tr>
<tr>
<td>CountryCode</td>
<td>IN</td>
<td>This indicates the Country Code for the country for which you're importing data.</td>
</tr>
<tr>
<td>LevelNumber</td>
<td>2</td>
<td>The level number of the geography in the hierarchy. For example, Country is at Level 1 and State (California) is at Level 2.</td>
</tr>
<tr>
<td>SourceId</td>
<td>2</td>
<td>The source ID for the geography, along with the parent source ID is used to identify the geography parent and child relationship within the source file data and the interface table data.</td>
</tr>
<tr>
<td>ParentSourceId</td>
<td>1</td>
<td>The parent source ID for the geography, along with the source ID is used to identify the geography's parent and child relationship with records within the source file data. This should be null for the country record, as Country is at the top of the hierarchy.</td>
</tr>
<tr>
<td>IdentifierType</td>
<td>Name</td>
<td>The type of the identifier. It can be either Name or Code.</td>
</tr>
<tr>
<td>IdentifierSubtype</td>
<td>Standard_Name or Standard_Code</td>
<td>The IdentifierSubtype can be Standard_Name or Secondary_Name. The default value is Standard_Name. The valid Sub Types for Type &quot;CODE&quot; are FIPS_CODE, GEO_CODE, ISO_COUNTRY_CODE, PRIMARY_CITY, or UNKNOWN</td>
</tr>
<tr>
<td>IdentifierValue</td>
<td>Bangalore</td>
<td>The value of the identifier.</td>
</tr>
</tbody>
</table>

You can create an import activity, enter the import details, and schedule the import.

1. Go to **Navigator > Tools > Import Management > Import Queue**.
2. Click **Create Import Activity** in the **Manage Imports** page.
3. In the **Enter Import Options** page, provide a name for the import activity, and select **Geography** from the Object drop-down list.
4. Select the CSV file in the **File Name** field, and click **Next**.

**Note:** In the **Advanced Options** section, the option **Enable High-Volume Import** is selected by default. This mode is designed to import millions of records at once.
5. The source and target attributes are automatically mapped in the Map Fields page. Review and edit the mappings if required.
6. Check the file for unmapped columns or data format issues by clicking Validate Data. Click Next.
7. Review the import details on the Review and Submit page, and click Submit.

Import Your Country Structure Data

You can use Import Management to create Country Structure records. It is recommended you use Import Management only if you're importing high-volume third-party data.

If you 're importing licensed data from one of our vendors, then you can create the country structure by navigating to Setup and Maintenance > Manage Geographies Task page.

To import Country Structure records, perform the following tasks:

1. Map your source data to Oracle Applications Cloud object attributes.
2. Create source Comma Separated Values (CSV) file for import.
3. Create the import activity.
4. Review the import results.

How You Map Your Source Data to Target Object Attributes

To import your Country Structure data into Oracle Applications Cloud, you need to populate a CSV file with your source data and map that source data to target object attributes in Oracle Applications Cloud.

You need to do the following before creating the CSV file for data import:

- Identify how your source data attributes map to the target object attributes in Oracle Applications Cloud.
- Identify the target object attributes that are required in the CSV file for a successful import.

Required Attributes and Validations for Country Structure Object

To import data successfully into Oracle Applications Cloud, your CSV file must include values for the required attributes. This table lists the required attributes for importing new Country Structure records, prerequisite setup tasks for the attributes, and specific validations, if any, for Country Structure import:

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Description</th>
<th>Prerequisite Setup Task/ Import Validations</th>
<th>Creating a Country Structure Record</th>
</tr>
</thead>
<tbody>
<tr>
<td>CountryCode</td>
<td>The code for the country for which the country structure is applicable.</td>
<td>The GeographyType has to be &quot;Country&quot; and the LevelNumber has to be “1” for a country.</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td></td>
<td>You can't pass different country codes when importing a record.</td>
<td></td>
</tr>
<tr>
<td>GeographyType</td>
<td>Geopolitical divisions such as Country, State, City, and so on. For example, for US the different geography types would be State, County, City, and Postal Code. For India, the different geography types would be State, District, City, and Postal Code. For Mexico,</td>
<td>The country has to be present.</td>
<td>Yes</td>
</tr>
</tbody>
</table>
Implementing Customer Data Management for CX Sales and B2B Service

Chapter 5
Geographies

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Description</th>
<th>Prerequisite Setup Task / Import Validations</th>
<th>Creating a Country Structure Record</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>LevelNumber</td>
<td>You need these to create parent-child relationships between geography types for your country. The values can be 1, 2, 3, and so on.</td>
<td>To define a country, you must specify the LevelNumber as 1.</td>
<td>Yes</td>
</tr>
</tbody>
</table>

You can view the Country Structure object and its attributes in the Manage Import Objects page of the Import Management flow. You can find attribute information like type, length, description, and so on, on the Manage Import Objects page. You can view the list of valid values for country codes in the UI by navigating to the Manage Geographies task and searching with % as the Country Code value. For more information on Geographies, see Overview of Geographies, Geographic Entities, and Locations in the Related Topics section.

**Note:** Note the following:
- The import job will fail if you try to load any already existing country structure. Delete the existing country structure in the UI in Manage Geographies Tasks and import again.
- You can't load additional lower geography structure levels for an existing country structure while importing geography country structure. You can add additional geography levels in the UI for an existing country structure in the Manage Geographies task page.

Create the Source CSV File
You include the data that you want to import into Oracle Applications Cloud in a source CSV file. You can use the templates available in the Import Objects UI page to create the source CSV file. To download a template:

1. Go to **Navigator > Tools > Import Management > Import Objects**.
2. Select the **Country Structure** object in the table and click **Download**.

You can now edit the downloaded file and provide values for the required attributes.

**Note:** For help in populating the CSV file and to avoid any issues in entering values, see the topic Potential Issues When Opening CSV Files With Excel in Related Topics section.

Create the Import Activity
After you have the CSV file ready, create an import activity to import the information. To create an import activity:

1. Go to **Navigator > Tools > Import Management > Import Queue**.
2. Click **Create Import Activity** in the Manage Imports page.
3. In the **Enter Import Options** page, provide a name for the import activity, and select Country Structure from the **Object** drop-down list.
4. Select the CSV file in the **File Name** field, and click **Next**.
5. You would see that the source and target attributes are automatically mapped in the **Map Fields** page. Review and edit the mappings if required.
6. Click **Validate Data** to check the file for unmapped columns or data format issues. Click **Next**.
7. Review the import details on the **Review and Submit** page, and click **Submit** when you're ready.
Review the Import Results

Check if your import succeeded on the Manage Imports page. This page shows the status of all active, completed, and unsuccessful imports. To check the status of the import activity:

1. Go to Navigator > Tools > Import Management > Import Queue.
2. Click All Imports and search for the import activity that you created earlier.
3. Check the Status column for the import activity. The import is successful if the status displays as Completed. You can drill down on the import activity to go to the Import Status page which provides the status details of the import activity. Here, you can download and review the successfully imported user data records, the mapping details used for import activity, and the data file that you provided in CSV format.

Related Topics
• Overview of Geographies, Geographic Entities, and Locations
• Geography Validation
• Import Data
• Potential Issues When Opening CSV Files in Excel

Example of Importing Country Structure Data

You use the country structure of a country to define which geography types are part of the country and how the geography types are hierarchically related within the country.

For example, you can create geography types called State, City, and Postal Code. Then you can rank the State geography type as the highest level within the country, the City as the second level, and the Postal Code as the lowest level within the country structure.

To add a country structure using import management, your source file must contain information about the country to which the country structure belongs. You can view the list of valid values for country codes in the UI by navigating to the Manage Geographies task and searching with % as the Country Code value. You also need to specify the level at which the geography types need to be placed. By default, all countries are at Level 1. You create the country structure by increasing the level number as you go down the country structure. You place the geography types such as states, provinces, and so on at Level 2, districts or counties at Level 3, and so on. To add a country structure, your source file must include the values that let the import process identify the existing records.

Sample Input CSV File
You include the data that you want to import into CX Sales and B2B Service in a source CSV file. Here is a sample input CSV file for country as US:

<table>
<thead>
<tr>
<th>CountryCode</th>
<th>LevelNumber</th>
<th>GeographyType</th>
</tr>
</thead>
<tbody>
<tr>
<td>US</td>
<td>1</td>
<td>COUNTRY</td>
</tr>
<tr>
<td>US</td>
<td>2</td>
<td>STATE</td>
</tr>
<tr>
<td>US</td>
<td>3</td>
<td>COUNTY</td>
</tr>
<tr>
<td>CountryCode</td>
<td>LevelNumber</td>
<td>GeographyType</td>
</tr>
<tr>
<td>-------------</td>
<td>-------------</td>
<td>---------------</td>
</tr>
<tr>
<td>US</td>
<td>4</td>
<td>CITY</td>
</tr>
<tr>
<td>US</td>
<td>5</td>
<td>POSTAL CODE</td>
</tr>
</tbody>
</table>

Here is another input CSV file for importing the country structure for India.

<table>
<thead>
<tr>
<th>CountryCode</th>
<th>LevelNumber</th>
<th>GeographyType</th>
</tr>
</thead>
<tbody>
<tr>
<td>IN</td>
<td>1</td>
<td>COUNTRY</td>
</tr>
<tr>
<td>IN</td>
<td>2</td>
<td>STATE</td>
</tr>
<tr>
<td>IN</td>
<td>3</td>
<td>DISTRICT</td>
</tr>
<tr>
<td>IN</td>
<td>4</td>
<td>CITY</td>
</tr>
<tr>
<td>IN</td>
<td>5</td>
<td>POSTAL CODE</td>
</tr>
</tbody>
</table>

In case you want to import the country structure for Mexico, your input CSV file would look like this:

<table>
<thead>
<tr>
<th>CountryCode</th>
<th>LevelNumber</th>
<th>GeographyType</th>
</tr>
</thead>
<tbody>
<tr>
<td>MX</td>
<td>1</td>
<td>COUNTRY</td>
</tr>
<tr>
<td>MX</td>
<td>2</td>
<td>STATE</td>
</tr>
<tr>
<td>MX</td>
<td>3</td>
<td>MUNICIPALITY</td>
</tr>
<tr>
<td>MX</td>
<td>4</td>
<td>LOCALITY</td>
</tr>
<tr>
<td>MX</td>
<td>5</td>
<td>POSTAL CODE</td>
</tr>
</tbody>
</table>

In this example, we are importing the Country Structure for US. You must create a source file (CSV) file with the attributes as shown in this table and import it using Import Management.

<table>
<thead>
<tr>
<th>Attribute Name</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CountryCode</td>
<td>US</td>
<td>The code for the country for which the country structure is applicable.</td>
</tr>
</tbody>
</table>
Oracle Fusion Cloud Sales Automation
Implementing Customer Data Management for CX Sales and B2B Service

Chapter 5
Geographies

### Attribute Name | Value | Description
--- | --- | ---
LevelNumber | 1 | The level number of the geography in the hierarchy. For example, Country is at Level 1 (Top level) and State (California) is at Level 2. You need these to create parent-child relationships between geography types for your country.

GeographyType | COUNTRY | Geopolitical divisions such as Country, State, City, and so on. For example, for US the different geography types would be State, County, City, and Postal Code. For India, the different geography types would be State, District, City, and Postal Code. For Mexico, it would be State, Municipality, Locality, and Postal Code.

Create an import activity to import the information. To create an import activity:

1. Go to **Navigator > Tools > Import Management > Import Queue**.
2. Click **Create Import Activity** in the **Manage Imports** page.
3. In the **Enter Import Options** page, provide a name for the import activity, and select **Country Structure** from the Object drop-down list.
   
   **Note:** In the **Advanced Options** section, the option **Enable High-Volume Import** is selected by default. This mode is designed to import millions of records at once.

4. Select the CSV file in the **File Name** field, and click **Next**.
5. The source and target attributes are automatically mapped in the **Map Fields** page. Review and edit the mappings if required.
6. Check the file for unmapped columns or data format issues by clicking **Validate Data**. Click **Next**.
7. Review the import details on the **Review and Submit** page, and click **Submit**.

### How You Import and Export Territory Geography Zones

Territory geography zones are geographical boundaries that you can set up to replicate your organization's regions, such as a Pacific Northwest sales region.

You can set up territory geography zones in one application instance, and then after the territory geography zones are defined you can export the territory zones and import them into another application instance.

To define your territory geography zones and then import your territory zones into another application instance, you must complete the following steps:

1. Import the master reference geography data into the application.
2. Define your territory geography zones using the Manage Territory Geographies task.
3. Export the territory geography zones.
4. Import the territory geography zones into another application instance.

### Import the Master Reference Geography Data

Firstly, you must import the master reference geography data. Master reference geography data includes geography elements, such as country, state, and city, and is required for any geographical information that you store in the
Define Your Territory Geography Zones
After the master reference geography data has been imported, you can then create your territory geography zones in the application using the Manage Territory Geographies task in Setup and Maintenance. For more information, see the Manage Territory Geographies topic in the Related Topics section.

Export the Territory Geography Zones
After you have completed importing the master reference geography data and defining your territory geography zone tasks, you can create a configuration package to export the territory zone data. For more information, refer to the Exporting Setup Data demo listed in the related topics section.

Import the Territory Geography Zones
After you have downloaded your configuration package for your territory geography zone setup, you can import the territory zones into another application instance.

Note: Ensure that you import your master reference geography data into the new application instance before you import the configuration package.

Related Topics
- Geography Hierarchy
- Manage Territory Geographies

Set Up Geocoding

Geocoding
This topic explains geocoding and how to enable this option in the application.

Geocoding is the process of finding latitude and longitude coordinates from geographic data such as street addresses or postal codes. Once these coordinates are available, you can use the spatial services feature to identify points of interest, such as customer and contact addresses, in the vicinity. The application integrates the Geocoding feature with eLocation (http://elocation.oracle.com/maps_oracle_dot_com_main.html), which is a Geocoding service provided by Oracle.

By default, the Geocoding option is turned off in the application. You can enable the Geocoding option by going to the Setup and Maintenance work area and performing the following:

- Offering: Customer Data Management
- Functional Area: Enterprise Profile
- Task: Manage Geographies
If the Geocoding feature is enabled, the feature can be scheduled to run at regular time intervals. This ensures that newly created or updated locations are picked up and geocoded whenever you create or update an address using the user interface, web services, bulk import, or using import management.

Related Topics
- What are Spatial Services?
- Set Up Geocoding

Set Up Geocoding

This procedure lists the steps to set up geocoding in Oracle Cloud applications.

Geocoding is a process that determines the latitude and longitude coordinates for a location. By default, geocoding is turned off in the application. You can use geocoding to display customers in the vicinity of a mobile address.

Enable Geocoding for a Country

To enable geocoding for a country, complete these steps:

1. In the Setup and Maintenance work area, go to the following:
   - Offering: Customer Data Management
   - Functional Area: Enterprise Profile
   - Task: Manage Geographies
2. On the Manage Geographies page, search for the country for which you want to enable geocoding. You can either search by the country name or country code.
3. Click Search. The search results for the matching country names are displayed.
4. Select the country for which you want to enable the geocoding option.
5. Select Geocoding Defined for the country.

Populate Location Latitude and Longitude Information

Once geocoding is enabled, you can schedule this feature to run at regular time intervals so that newly created or updated locations are picked up and geocoded. To schedule the geocoding feature to run at regular intervals, complete these steps:

1. Navigate to Tools > Scheduled Processes work area.
3. Click the Name list and search for Populate Location Latitude and Longitude Information, and then click OK.
4. Enter the parameters such as Start Date and End Date, and click Submit.

Related Topics
- Geocoding
- Populate Location Latitude and Longitude Information
Use Web Services to Populate Location Attributes for the Around Me Feature

Use this procedure to populate location attributes using Web services for the Around Me feature in countries that aren't supported by the eLocation service. The Around Me feature enables you to quickly locate information about your surroundings.

This feature uses your current location to run a proximity search on objects with location information, such as contacts, opportunities, and customers.

Create an Address with the Location Attributes Using the LocationService Web Service

Perform the following steps to create an address with location attributes, such as latitude and longitude, using the createLocation operation.

1. Extract the Web Services URL
   a. Sign in to the Oracle Enterprise Manager Applications Control using the WebLogic Server credentials.
   b. Select Oracle Fusion Customer Relationship Management from the navigation tree, and then select Fusion Applications.
   c. From the tree, select CrmCommonApp, and then select CrmCommonApp (CRMCommonServer_1).
   d. In the Web Services pane, click Test for the LocationServiceSoapHttpPort port.
   e. In the Test Web Service pane, copy the URL of a WSDL that appears in the WSDL field until "?wsdl", and then paste to a notepad.

2. Derive the Payload
   a. Launch the WSDL URL in a Web browser to open the LocationService endpoint page.
   b. In the LocationServiceSoapHttpPort pane, select createLocation from the Operation list.
   c. In the Location pane, complete the fields, as shown in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Country</td>
<td>CN</td>
</tr>
<tr>
<td>Address1</td>
<td>Chaoyang District</td>
</tr>
<tr>
<td>City</td>
<td>Shanghai</td>
</tr>
<tr>
<td>Postal Code</td>
<td>200233</td>
</tr>
<tr>
<td>State</td>
<td>China</td>
</tr>
</tbody>
</table>
### Geographies

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>CreatedByModule</td>
<td>AMS</td>
</tr>
<tr>
<td>Latitude</td>
<td>20.36789</td>
</tr>
<tr>
<td>Longitude</td>
<td>-39.34444</td>
</tr>
</tbody>
</table>

**Note:** Deselect all the other parameters in this Location pane. Also, deselect LocationProfile, OriginalSystemReference, and LocationInformation options.

d. Click the **XML Source** option.
   **Note:** This option appears next to the Operation list.

e. Copy the XML source and paste to a notepad.

#### 3. Call the Web Service

a. Open the **Oracle Fusion Service Tester** page.
b. In the WebService URL field, paste the WSDL URL that you derived from Step 5 of the Extracting the Web Services URL section.
c. Enter the user name and password credentials.
d. In the **Payload** pane, paste the XML source that you derived from Step 5 of the Deriving the Payload section.
e. Click **Invoke**. The Output Payload pane displays the output payload.

#### 4. Test the Web Service

a. Sign in to the **Oracle Fusion Applications Home** Page.
b. Navigate to the Customer Center work area.
c. Search the address that you added.
d. Click the **Addresses** section.
e. From the **Actions** list, select the **View Geography Information** option.
f. Verify the latitude and longitude details.

---

**Update the Location Attributes of an Address Using the LocationService Web Service**

Perform the following steps to update the location attributes of an address, such as latitude and longitude, using the updateLocation operation.

1. **Extract the Web Services URL**
   a. Sign in to the **Oracle Enterprise Manager Applications Control** using the WebLogic Server credentials.
b. Select **Oracle Fusion Customer Relationship Management** from the navigation tree, and then select **Oracle Fusion Applications**.
c. From the tree, select **CrmCommonApp**, and then select **CrmCommonApp (CRMCommonServer_1)**
d. In the Web Services pane, click **Test** for the **LocationServiceSoapHttpPort** port.
e. In the Test Web Service pane, copy the URL of a WSDL that appears in the WSDL field until "?wsdl", and then paste to a notepad.
2. Derive the Payload

   a. Launch the WSDL URL in a Web browser to open the LocationService endpoint page.
   b. In the LocationServiceSoapHttpPort pane, select `updateLocation` from the Operation list.
   c. In the Location pane, complete the fields, as shown in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>LocationId</td>
<td>300100078489616</td>
</tr>
<tr>
<td>Latitude</td>
<td>30.36789</td>
</tr>
<tr>
<td>Longitude</td>
<td>-40.34444</td>
</tr>
</tbody>
</table>

   Note: Enter the location ID that was generated in Step 1 of the Testing the Results section.

   d. Click the `XML Source` option.

      Note: This option appears next to the Operation list.

   e. Copy the XML source and paste to a notepad.

3. Call the Web Service

   a. Open the Oracle Fusion Service Tester page.
   b. In the WebService URL field, paste the WSDL URL that you derived from Step 5 of the Extracting the Web Services URL section.
   c. Enter the user name and password credentials.
   d. In the Payload pane, paste the XML source that you derived from Step 5 of the Deriving the Payload section.
   e. Click Invoke. The Output Payload pane displays the output payload.

4. Test the Web Service

   a. Sign in to the Oracle Fusion Applications Home Page.
   b. Navigate to the Customer Center work area.
   c. Search the address that you updated.
   d. Click the Addresses section.
   e. From the Actions list, select the View Geography Information option.
   f. Verify the latitude and longitude details.
How You Set up Address Cleansing

Address cleansing validates, corrects, and standardizes address information that you enter in the application. Address cleansing, unlike geography validation, validates both the geography attributes and the address line attributes.

To use the address cleansing functionality, you need to have license for the customer data quality application, because the feature is delivered using data quality integration.

You can specify the real-time address cleansing level for each country by choosing either of these options:

- **None**: Specifies no real time address cleansing.
- **Optional**: Provides option to cleanse addresses.

Once you have enabled address cleansing for a country, a **Verify Address** icon appears at address entry points in the application. Click the icon to perform address cleansing and receive a corrected, standardized address. If the application doesn't find a matching address, then an alert message is displayed.

FAQs for Loqate Support

How to Import Nokia Geography Data

We recommend that you use Loqate geography data. However, if you need to use Nokia data for one or more countries for business reasons you can do so.

By default, Import Geography Data task invokes Loqate geography data.

**Note**: Oracle doesn't support any Nokia geography data fixes.

Perform these steps to import Nokia geography data:

1. Set the profile value of the **ORA_HZ_ENABLE_DAAS_LOQATE** profile option to No in the Setup and Maintenance work area by going to the following:
   - Offering: Sales
   - Functional Area: Sales Foundation
   - Task: Manage Administrator Profile Values
2. Import the Nokia geography data for a country as follows:
   a. Navigate to the Manage Geographies task in the Setup and Maintenance work area by going to the following:
      - Offering: Sales
      - Functional Area: Sales Foundation
- Task: Manage Geographies
  b. On the Actions menu, Click Import Geography Data for a country.

| Note: | The Import Geography Data action is disabled for a country if the geography data for that country isn't available from Loqate or if the country data is already imported using either Loqate, Nokia, or any third party geography data. |

After the geography data is loaded, the data provider name (Loqate or Nokia) is displayed in the Hierarchy Defined section in Manage Geographies.

### How many countries does Loqate support?

Loqate supports 82 countries. Any additional country support beyond the 82 must be logged as an enhancement request. To log the enhancement request, go to Idea Lab.

**Related Topics**
- Idea Lab

### Will I be charged for Loqate data?

There's no charge or licensing requirement for Loqate geography data.

### I am an existing customer, how will I be impacted? Can I import both Loqate and Nokia geography data?

No. You can import either Loqate or Nokia geography data, but you can't import from both providers for a single country. We recommend that you use Loqate geography data because Loqate supports 82 countries including existing 62 Nokia supported countries.

If you're already using Nokia geography data, you can select one of these two options:

- Option 1: You need not do anything and continue to use Nokia geography data. Oracle doesn't support any Nokia geography data fixes.
- Option 2: You can replace Nokia geography data with Loqate geography data. This is a manual process today. You must follow manual steps and work closely with the support team to import new Loqate geography data. For more information about this process, see Replace Existing Master Geography Data with Revised Oracle-Licensed Geography Data section in this chapter.
How often are updates to Oracle licensed geography reference data available? How will I be informed about new countries that are supported by Oracle-licensed geography reference data?

The geography data is updated on a quarterly basis but the update of the latest geography data refresh isn’t automated. You will be informed about the geography data refresh using release readiness documents.

How is the Geography Data updated? Are updates available for all countries at the same time or only some countries are updated at a time?

When you import the geography data for a country after Release 18C for the first time you would get the latest Loqate geography data. But if your Loqate geography data is more than three months old, you have to uptake the latest Loqate geography data by following Replace Existing Master Geography Data with Revised Oracle-Licensed Geography Data section in this chapter.

Can I import Vertex or other third-party geography data in Manage Geographies?

Yes, you can continue to import geography data of your choice. Oracle provides support for Loqate geography data out of the box.

Can I import geography data for multiple countries in one import job?

No. You can submit only one import job for a country. After submitting the import job, you can search for a different country and submit another import job for that country. Currently, you can only search and import Loqate data for one country at a time using the Manage Geographies task in Setup and Maintenance menu.

Can I get support for a country that is not part of the list of supported countries in Manage Geographies?

You can contact Oracle Support to request for a country that is not supported in Manage Geographies.
FAQs for Define Geographies

How You Search Geographies in the Language You Prefer

You can search geographical data using the language that you prefer.

For example, when you load geography data for Canada in English and French. When you search this data using say Postal Code H4A 0A1, the following is the search result:

When you search this data using say Postal Code H4A 0A1, the following is the search result:

- H4A 0A1, Montreal, QC
- H4A 0A1, Montreal, Quebec
- H4A 0A1, Montréal, QC
- H4A 0A1, Montréal, Quebec

You may want the search results to be displayed in the language you prefer. So, if you set the language as English, the following must be displayed:

- H4A 0A1, Montreal, QC
- H4A 0A1, Montreal, Quebec

And if you set the language as French, the following must be displayed:

- H4A 0A1, Montréal, QC
- H4A 0A1, Montréal, Quebec

This can be done after setting up the profile option Filter Geographies Using User Language (HZ_GEO_FILTER_BY_USER_LANG). You must first define the profile option HZ_GEO_FILTER_BY_USER_LANG and specify the language you want to use.

1. Create the profile option as follows:
   a. Click Navigator > My Enterprise > Setup and Maintenance > Search and search for Manage Profile Options.
   b. Click Create new profile option icon and enter the following:
      - Profile Option Code: HZ_GEO_FILTER_BY_USER_LANG
      - Profile Display Name: Filter Geographies Using User Language
      - Application: Trading Community Model
      - Module: Trading Community Model
      - Description: provide the description
      - Start Date: specify a date
   c. Click Save and close.
   d. In Profile Option Levels table, select Enabled and Updateable for the site level.
   e. Click Save and Close.
2. Set the default value for the profile option as follows:
   a. Click Navigator > My Enterprise > Setup and Maintenance > Search and search for Manage Administrator Profile Values.
   b. Search HZ_GEO_FILTER_BY_USER_LANG as the profile option code.
   c. Add new Site level profile value.
   d. Specify the new profile in the following format:
      
      `<COUNTRY_CODE1>:<GEOGRAPHY_LEVEL1>, <GEOGRAPHY_LEVEL2>;<COUNTRY_CODE2>:<GEOGRAPHY_LEVEL1>`
      
      Where Geography Level values start with value 1 for country and increment for each level that's defined in the country's geography structure setup.
      
      For example, the following are the geography levels for Canada:
      
      Country - 1, State - 2, Province - 3, City - 4, Postal Code - 5
      
      Similarly, the following are the geography levels for United States:
      
      Country - 1, State - 2, County - 3, City - 4, Postal Code - 5
      
      Example 1: If you want to filter data for Canadian Cities, then the profile value is CA:3 where CA is the country code for Canada and 3 is geography level value for City.
      
      Example 2: If you want to filter data for both State and Cities for United States, then value should be US:2,4
      
      Example 3: If you want to filter data for multiple countries as given in both example 1 and example 2, then use semi colon as delimiter, like CA:3;US:2,4
   e. Click Save and Close.

Why is Import Geography Data Disabled in Manage Geographies?

Import Geography Data is disabled for a country if the geography data for that country isn't available from Loqate or if the geography structure or hierarchy is already defined for that country. For example, Pakistan isn't supported currently in the supported list of 82 countries. If you try to import geography data for Pakistan after defining geography structure or geography hierarchy for it, Pakistan would be greyed out in the import list.

| Note: | If the hierarchy is defined, delete the geography hierarchy data first and then the geography structure.

When do I define address cleansing?

When address data entered into the application must conform to a particular format, to achieve consistency in the representation of addresses. For example, making sure that the incoming data is stored following the correct postal address format.
Why can't I update a geography structure by copying an existing country structure?

You can only update a geography structure by adding existing geography types, or by creating new geography types and then adding them to the geography structure.

You can only copy an existing country structure when you're defining a new country structure.

How many levels in a geography structure can I define?

We recommend that you add up to six levels, starting with country at level 1, while defining geography structures. If you add more than six levels containing list of values or validations, then the sixth level and above may not work as expected in the Address UI of accounts, contacts, suppliers, persons, and so on.

Why can't I delete a level of the country geography structure?

If a geography exists for a country geography structure level then you can't delete the level.

For example, if a state geography has been created for the United States country geography structure, then the State level can't be deleted in the country geography structure.

Can I add any geography to the geography hierarchy?

Yes. However, the geography type for the geography that you want to add must be already added to the country geography structure.

Can I edit a specific geography in the geography hierarchy?

Yes. In the Manage Geography Hierarchy page you can edit details such as the geography's date range, primary and alternate names and codes, and creating geographies within the hierarchy such as adding a postal code for a city. Click Navigator > My Enterprise > Setup and Maintenance. Click the Tasks menu and click Search. Search for Manage Geographies and open it. Search for a country by Country Name or Country Code. Click Hierarchy Defined. Search and select the required geography. Click Action > Create > Edit.

Can I add alternative names and codes for an existing country?

Yes. You can add alternative names and codes. Click Navigator > My Enterprise > Setup and Maintenance. Click the Tasks menu and click Search. Search for Manage Geographies and open it. Search for a country by Country Name or
What happens if I add or update the details of a country?

Any change in the country details is reflected in pages associated with geographies such as Manage Territories, addresses list of values in the Account and Contact UI, and so on. However, the list of countries in the Manage Geographies isn’t updated.

How can I add a geography that's at a lower level to any geography in a geography hierarchy?

Select the geography that you want to create a geography at lower level, and then click the Create icon. This lets you create a geography for a geography type that's one level lower to the geography type you selected. The structure of the country's geography types are defined in the Manage Geography Structure page.

How can I verify whether the third-party geography structure and hierarchy I imported are available in the application?

You can track the progress of the geography structure and hierarchy import process by navigating to the Scheduled Processes page and viewing the status of the third-party geography data import process.

Once the process completes, the status changes to Succeeded. You can then verify the newly imported geography structure and hierarchy in the Setup and Maintenance work area by navigating to the following: offering: Customer Data Management; functional area: Enterprise Profile; task: Manage Geographies, where you first loaded the third-party geography data.

**Note:** Before you load geography data for a country from a third party provider, ensure that no geography structure or hierarchy is saved for that country. If geography structure or hierarchy data is already available, the load process fails.

How can I enable geocoding?

You can enable geocoding for a country by turning the Geocoding option for that country in the Setup and Maintenance work area.

Navigate to the following:

- offering: Customer Data Management
- functional area: Enterprise Profile
• task: Manage Geographies

Search for the country for which you want to enable geocoding and click the **Geocoding Defined** icon. If geocoding is enabled for a country, the Geocoding Defined icon displays a check mark.

Once you have enabled geocoding for a country, you must run the Run Geocode Generation scheduled process on the Run Geocode Generation task. Before you run the job, however, ensure that you have specified the country code of the country for which you want to generate the geocodes.

**Where can I view the geocode values of a location?**

You can search for and view the geocode values of a party's location in the Party Center and the Customer Center pages.

Navigate to the Addresses section of the party's profile and click either **View, Columns, Latitude** and **View, Columns, Longitude**, or **View, Columns, Manage Columns, Latitude** and **Longitude**. This displays the latitude and longitude, or geocode values, associated with the location of the party.

**Note:** Geocode information display is available only when geocoding is enabled for the country to which the address belongs.

**Related Topics**
- Geocoding

**What are Spatial Services?**

Spatial services allow users to find points of interest such as customers, contacts, and so on using the latitude and longitude coordinates of an address.

The Oracle Fusion Mobile Sales application provides these services for sales representatives to discover accounts and contacts around their location.

**Where can I update and view the geography name reference information for parties?**

To view the geography name reference information associated with parties, you need to ensure that you have created an address for the party. You can create or update party addresses in the Organizations, Persons, and Groups work areas.

Once you have updated an address, you must either wait for the Run Geocode Generation scheduled process to run automatically as scheduled or start geocode generation manually from the Setup and Maintenance work area by navigating as follows:

- offering: Customer Data Management
Once the Run Geocode Generation job has updated the geography information for the country associated with the party you updated, you can search for and view the geography name reference information associated with the party in the Organizations, Persons, and Groups work areas. Navigate to the person, organization, or group whose address you want to verify and click **Actions, View Geography Information**. This displays a dialog box that displays the updated geography information, complete with address values enhanced using geography name reference.

**Note:** Geography name reference enriched geography information display is available only when geography validation is enabled for the country to which the address belongs.

**How can I save an address that didn't pass geography validation?**

Search and select for the country name in the Manage Geographies page, and then click the **Validation Defined** option. In the Manage Geography Validation page, select **No Validation** in the Geography Validation Level for Country drop-down list. This option saves addresses that don't pass the geography validation, including incomplete and invalid addresses.
6 Personally Identifiable Information

How You Protect Personally Identifiable Information

The data or information that’s used to uniquely identify a contact, or locate a person is called personally identifiable information (PII). Examples are social security number, addresses, bank account numbers, phone numbers, and so on.

This information is considered confidential and sensitive, and must be protected to prevent unauthorized use of personal information for the purposes of legal regulation, financial liability, and personal reputation. For example, only authorized users must be allowed access to the social security numbers of people stored in a system.

In Oracle Applications Cloud, the PII data is secured and can be accessed only by the following job roles with the exception of mobile phone data:

- Sales Administrator
- Enterprise Scheduler Job Application Identity for CRM
- Oracle Data Integrator Application Identity for CRM
- Web Services Application Identity for CRM

Mobile phone data is accessible to all seeded job roles. However, if access to mobile phone data is needed for custom job roles, the IT Security Manager must assign the required PII data policies to the custom job role in the Security Console. The IT Security Manager can also add data policies for other PII data to seeded job roles.

The following table lists the PII attributes that are secured in Oracle Applications Cloud.

<table>
<thead>
<tr>
<th>PII Attribute</th>
<th>Table Name</th>
<th>Privilege Title</th>
</tr>
</thead>
<tbody>
<tr>
<td>Taxpayer Identification Number (Social Security Number)</td>
<td>HZ_PERSON_PROFILES</td>
<td>View Trading Community Person Social Security</td>
</tr>
<tr>
<td>Taxpayer Identification Number (Social Security Number)</td>
<td>HZ_PERSON_PROFILES</td>
<td>Manage Trading Community Person Social Security</td>
</tr>
<tr>
<td>Citizenship Number</td>
<td>HZ_CITIZENSHIP</td>
<td>View Trading Community Person Citizenship Number</td>
</tr>
<tr>
<td>Citizenship Number</td>
<td>HZ_CITIZENSHIP</td>
<td>Manage Trading Community Person Citizenship Number</td>
</tr>
<tr>
<td>Home Address</td>
<td>HOME Address is identified by party site use defined in SITE_USE_TYPE field of the HZ_PARTY_SITE_USES table</td>
<td>View Trading Community Person Address</td>
</tr>
</tbody>
</table>

Note: You can search privileges in Security Console using the Privilege Titles listed in the following table.
How You Work with Protected Information

In Oracle Cloud applications, your access to protected information depends on your job role. In case you don’t have access to the information you need to work with, contact the IT security manager for the necessary privileges.

Securing and protecting customer information against data breaches, data theft, or unauthorized access is an increasing concern in any enterprise. To address this issue, Oracle Applications Cloud provides restricted access to information that’s considered private to an individual, also known as Personally Identifiable Information (PII).

PII is any information that uniquely identifies an individual, such as personal phone number, personal email address, personal address, citizenship number, or Social Security Number (SSN). You can use PII data to uniquely identify, contact, or locate an individual, or you can use it with other sources to uniquely identify a person. For example, a SSN uniquely and directly identifies an individual, whereas a telephone area code identifies a set of people.

The attributes that are identified as PII are as follows:

- Home Address

### Table: Personally Identifiable Information

<table>
<thead>
<tr>
<th>PII Attribute</th>
<th>Table Name</th>
<th>Privilege Title</th>
</tr>
</thead>
<tbody>
<tr>
<td>Home Address</td>
<td>HOME Address is identified by party site use defined in SITE_USE_TYPE field of the HZ_PARTY_SITEUSES table</td>
<td>Manage Trading Community Person Address</td>
</tr>
<tr>
<td>Home Phone</td>
<td>HZ_CONTACT_POINTS rows with contact_point_purpose value PERSONAL</td>
<td>View Trading Community Person Contact</td>
</tr>
<tr>
<td>Home Phone</td>
<td>HZ_CONTACT_POINTS rows with contact_point_purpose value PERSONAL</td>
<td>Manage Trading Community Person Contact</td>
</tr>
<tr>
<td>Mobile Phone</td>
<td>HZ_CONTACT_POINTS rows with phone_type or phone_line_type value MOBILE</td>
<td>View Trading Community Person Mobile Phone Number</td>
</tr>
<tr>
<td>Mobile Phone</td>
<td>HZ_CONTACT_POINTS rows with phone_type or phone_line_type value MOBILE</td>
<td>Manage Trading Community Person Mobile Phone Number</td>
</tr>
<tr>
<td>Home Email</td>
<td>HZ_CONTACT_POINTS rows with contact_point_purpose value PERSONAL</td>
<td>View Trading Community Person Contact</td>
</tr>
<tr>
<td>Home Email</td>
<td>HZ_CONTACT_POINTS rows with contact_point_purpose value PERSONAL</td>
<td>Manage Trading Community Person Contact</td>
</tr>
<tr>
<td>Additional Identifiers</td>
<td>All rows that belong to PERSON party in HZ_ADDTNL_PARTY_IDS</td>
<td>View Trading Community Person Additional Identifier</td>
</tr>
<tr>
<td>Additional Identifiers</td>
<td>All rows that belong to PERSON party in HZ_ADDTNL_PARTY_IDS</td>
<td>Manage Trading Community Person Additional Identifier</td>
</tr>
</tbody>
</table>
• Home Phone Number
• Personal Email Address
• Taxpayer Identification Number (Social Security Number)

In Oracle Applications Cloud, access to the PII data is restricted to a set of job roles. If you need to work with PII data for business purposes, then contact the IT security manager for the necessary privileges.

Related Topics
• Export Data

Manage Personally Identifiable Information

As a setup user, you can manage PII information in Oracle Applications Cloud.

In this example, you will add or update personally identifiable information (PII) data for your contacts. Before you can add or update the PII data, you must expose the PII attributes from Application Composer in an active sandbox.

Activate a Sandbox

1. Sign in as a setup user such as Sales Administrator.
2. From the Administration group in the Settings and Actions menu, select Manage Sandboxes.
3. Click Actions and then click New.
4. Enter a name in the Sandbox Name field.
5. Click Save and Close.
6. In the Confirmation dialog box, click OK.
7. In the Manage Sandboxes dialog box, select the sandbox you just created and click the Set as Active button.

Expose PII Attributes from Application Composer

The Taxpayer Identification Number and Home Phone PII attributes can be exposed from the Application Composer.

1. Navigate to Application Composer.
2. From the Objects View, select Standard Objects, Contact, and then Pages. Ensure Simplified Pages is selected.
3. To add the Taxpayer Identification Number and Home Phone PII attributes to the Create Contact page:
   a. In the Create Contact section, select Standard Layout and click the Edit icon.
   b. In the Create Contact region, click the Edit icon.
   c. Move the Taxpayer Identification Number and Home Phone PII attributes from the Available Fields list to the Selected Fields list to add to the Create Contact page.
   d. Click Save and Close.
   e. Click Done.
4. To add the Taxpayer Identification Number and Home Phone PII attributes to the Edit Contact page:
   a. In the Edit Contact section, select Standard Layout and click the Edit icon.
   b. Click the Profile tab to add the custom field.
Add and Update PII Data

1. Navigate to Contacts.
2. In the Contacts page, enter the name of the contact and click the Search icon.
3. In the Edit Contact page of the contact, click the Profile tab.
4. Enter the PII data such as the Taxpayer Identification Number and Home Phone, and click Save and Close.
5. In the Contacts page, click the Create Contact button.

   Note: You can proceed to create a contact or click Cancel to exit without saving.

Publish the Sandbox

You can publish a sandbox after you have tested and verified that the modifications done in that sandbox are ready to be moved to the mainline metadata.

1. Select a sandbox link that appears on the page and click the More link.
2. In the Sandbox Details dialog box, click the Publish button.
3. Click Yes in the Publish confirmation message box.
4. Close the Manage Sandboxes dialog box.
5. From the Settings and Actions menu, click Sign Out.

Related Topics
- How You Protect Personally Identifiable Information
- Manage Personally Identifiable Information

Assign PII Privileges Using Security Console

As an IT Security Manager, you can create a custom job role and assign data policies required to access PII information. Perform the following steps to create a custom role and assign PII privileges to the custom role.

In this example, as an IT Security Manager, you will create a custom job role based on the existing Sales Representative role and assign PII privileges to access the Social Security data. After this, you must assign the custom job role to the users you want to assign PII privileges. For more information on assigning job roles to users, see the Oracle CX Securing CX Sales and B2B Service guide.

Assign Job Roles

1. From the Navigator, click Tools - Security Console.
2. On the Security Console, ensure that Expand Toward is set to Privileges.
3. Enter sales representative in the Search field and select the Job Role in the results.
4. In the Search Results, click the actions button and select **Copy Role**.
5. In the Copy Options window, select **Copy top role** and click **Copy Role**. The Copy Role page is displayed.
6. In the Basic Information page, enter the Role name and Role Code such as Sales Representative Custom PII and ZBS_SALES_REPRESENTATIVE_JOB_CUSTOM_PII.
7. Click Next.
8. Click Next.
9. In the Data Security Policies page, you must create four data security policies with the details provided in the following table. To create a data security policy, click **Create Data Security Policy**.

<table>
<thead>
<tr>
<th>Policy Name</th>
<th>Database Resource</th>
<th>Data Set</th>
</tr>
</thead>
<tbody>
<tr>
<td>Grant on Trading Community Party. This lets you view and read all Social Security information.</td>
<td>Trading Community Party.</td>
<td>Select All Values from the Data Set list. In the Actions list, select View Trading Community Person Social Security.</td>
</tr>
<tr>
<td>Grant on Trading Community Party. This lets you manage all Social Security information.</td>
<td>Trading Community Party.</td>
<td>Select All Values from the Data Set list. In the Actions list, select Manage Trading Community Person Social Security.</td>
</tr>
</tbody>
</table>

**Note:** You don’t have to create separate data security policies for View and Manage Trading Community Person Social Security privileges. You can create one data security policy for these two privileges or all PII privileges. You can’t combine these two PII privileges and add them to data security policies that were created for other privileges. You must create PII privileges as separate data security policies.

10. Click Next.
11. Click Next.
12. Click Next.
13. In the Summary and Impact Report page, click **Save and Close**.

**Related Topics**
- How You Protect Personally Identifiable Information
- Manage Personally Identifiable Information
7 Source Systems

How You Set up Source Systems

This topic explains source systems and how to set up a source system.

You can set up source systems to help users to identify the source of the import data. You can specify whether the source system is a spoke system, such as a legacy system, or a purchased system, such as data from a third party provider. You can also specify what types of entities the source system contains. For example, you can specify that a source system contains customer data.

You can configure the following for a source system:

- Source system code, name, and description
- Source system type
- Enable for Items, Trading Community Members, Order Orchestration and Planning, and Assets

Source System Code, Name, and Description

You can create a source system code to uniquely identify the source system. Source system codes are used by the application to create references between source IDs and the application database IDs.

| Note: Ensure you update the source system code before you create the source system. |

Source System Type

You must set up a source system as either a spoke system or a purchased system.

Enable for Items, Trading Community Members, Order Orchestration and Planning, and Assets

You can select one or more of the following entity types to import from the source system into the application database:

- Items
- Trading Community Members
- Order Orchestration and Planning
- Assets

You must enable the correct entity types because each import UI filters source systems based on their entity type. For example, if you set up a source system for Trading Community Members, Items, and Assets, then the source system can be selected as a data source only in this UI and not in different UI.
Set Up Source Systems

You set up source systems to import data into the application from other systems and identify the source of the data that you’re importing.

**Note:** You must setup source systems before importing your organization (account) and person (contact) data. The next step is to setup source system confidence to determine the relative reliability of a particular organization (account) or person (contact) attribute (standard or custom) from a particular source system. This allows the preservation of data from the most reliable source in the master record during the merge operation. See the topic: Manage Source System Confidence.

You can specify whether the source system is a spoke system, such as a legacy system, or a purchased system, such as data from a third party provider. You can also specify what types of entities can be imported from a source system. For example, you can enable a source system for importing trading community members such as organizations (accounts) and persons (contacts).

**Note:** You can select multiple source references in the Manage Source System Entities task to allow multiple source system records to map to a single record.

For example, consider Vision Corp., a software company which acquires a couple of software companies, First Software and Softgear, and their customers. So we will have to setup the following three source systems:

- Vision Corp.
- Softgear
- First Software

Here is how you can go about setting up these source systems:

1. In the Setup and Maintenance work area, navigate to the following:
   - Offering: Customer Data Management
   - Functional Area: Trading Community Foundation
   - Task: Manage Trading Community Source Systems
2. From the Actions menu, click Create. The Create Source System UI page appears.
3. Enter the following information:
   - Code: VC
   - Name: Vision Corp.
   - Type: Spoke
4. Enable the source system for Trading Community Members. You can enable it for other entity types also depending on your business requirements.
5. Click Save and Create Another.
6. Enter the following information:
   - Code: SG
   - Name: Softgear
**Source System Entities**

Source system entities are entities that you can import using a specified source system, such as addresses and parties.

When you import data from a source system, all the entities in the source system data are also imported. You can select multiple source references in the Manage Source System Entities task to allow multiple source system records to map to a single record.

*Related Topics*

- Source System Entities

**Define Source System Confidence**

A source system confidence level is used as criteria in survivorship rules for comparing information from different source systems. You can set the source confidence score per source system for attributes in the Person and Organization objects.

To define a source system confidence:

1. In the Setup and Maintenance work area, navigate to the following:
   - Offering: Customer Data Management
   - Functional Area: Customer Hub
   - Task: Manage Source System Confidence
2. From the Actions menu, click New.
3. On the Define Source System Confidence page, click the Object Type list and select an object type.
4. Select and move the attributes for which you want to set the source system confidence scores from the Available Attributes list to the Selected Attributes list.
5. Click the New icon to define the source confidence score for different systems.
6. Select a source system code from the Source System Code list.
7. Enter a value in the **Source Confidence** field. The value of the source system confidence can range from 0 to 100.

8. Click **Save and Close**.

9. On the Manage Source System Confidence page, click the **Search** button. The attribute for which you set the source system confidence appears along with the corresponding source system and their source confidence values.

10. Click **Save and Close**.

**Related Topics**
- **Source System Confidence Levels**

### Manage Source System Confidence Levels

Source system confidence levels indicate the reliability of a particular source system for specific attributes. You can add and delete source system confidence levels in the Manage Source System Confidence page.

To add a source system:

1. Navigate to the **Manage Source System Confidence** page from Setup and Maintenance.
2. Click **New** in the **Actions** menu.
3. In the Define Source System Confidence page, select the object type for which you want to define source system confidence levels.
4. Select the attributes for which you want to define source system confidence level.
5. In the Source System Code table, select the source system code that you want to associate with the selected attributes.
6. Enter the confidence level for the source system. This confidence level is applied to selected attributes in the source system.

You can similarly associate other source systems with the attributes you selected and specify new confidence levels as required.

### FAQs for Define Source Systems

**What happens if I reuse the same source system and source system reference combination?**

If you try to create the same combination of the same source system and source system reference for any party record, an error is displayed that a record with the value already exists and that you must enter a unique value. The combination of source system and source system reference value must always be unique.
What happens if I allow multiple source system references?

When you import data from a source system, you can merge multiple or duplicate source system records and create one record in the application. This is referred to as allowing multiple source system reference.

If you don't allow multiple source system references, then for every source system record, a duplicate record is created in the application.
8 Party Usages

How You Define Party Usage

Party usages describe how a party is used by the implementing organization. For example, a person in the business community may be a consumer or contact. You can create rules to determine how a party usage can be associated with party.

You can define the following types of rules for a party usage:

- Assignment rules
- Exclusivity rules
- Incompatibility rules
- Transition rules

Assignment rules

Assignment rules define how the party usage can and can't be assigned to parties. You can allow unconditional party usage assignment, enable the assignment to be created manually, or be updated by an administrator.

Alternatively, you can also restrict the manual assignment and update of a party usage, which means that the party usage can only be created or updated by a business event. For example, the Customer party usage is assigned to a party when you create an account for the party.

You can also specify whether the party usage assignment can be created or updated when a relationship is assigned to a party. For example, when a contact has a relationship with an organization the party usage Organization Contact is assigned to the contact.

Exclusivity rules

Exclusivity rules restrict party usage assignment, so that the party usage can be assigned to a party only during a specified time period. For example, you can set up an exclusivity rule that the party usage Manufacturer can be assigned to parties only between January 1, 2011 and February 1, 2011.

Incompatibility rules

Incompatibility rules specify which party usages can't be assigned concurrently to a party during a specific time period. For example, an incompatibility rule can specify that the party usage Sales Account usage can't be assigned to a party with a Sales Prospect usage, during January 1, 2011 and December 31, 2030.

Transition rules

Transition rules specify which party usages can transition to the party usage you're creating or editing. Once a party transitions to the current party usage, the previous party usage is set with an end date. For example, when a party with the Prospective Partner party usage is assigned the Partner party usage, the Prospective Partner usage is set with an end date.
Manage Party Usages

Party Usages describe how parties can be used across the application in business flows. Use this procedure to create and edit party usages.

Create Party Usages

1. In the Setup and Maintenance work area, go to the following:
   - Offering: Customer Data Management
   - Functional Area: Trading Community Foundation
   - Task: Manage Party Usages
2. Click Actions > Create.
3. Specify the following information in the Overview section of the page:
   - Specify the code for the party usage. You can't change the code of an existing party usage.
   - Specify a name.
   - Select the type of party usage.
   - (Optional) Provide a description.
4. Specify the following information in the Assignment section of the page:
   - If you have identified business events that can create an assignment to a party, select Restrict Manual Assignment.
   - If the bulk import or manual assignment can create an assignment, select Unconditional Assignment.
   - (Optional) Provide descriptions.
5. Specify the following information in the Exclusivity Rules section, specify the from and to dates during which the party usage is assigned exclusively.
6. In the Incompatibility Rules section, select the party usages which can't be assigned along with the selected party usage. For example, you can specify for a prospect party usage that a party couldn't have a prospect usage and customer usage at the same time. You can also specify the time period during which the selected party usages can't be assigned.
7. In the Transition Rules section, specify the party usage which the selected party usage transitions to. You can also specify the time period when the transition starts and, optionally, ends. For example, when a party that currently has the applicant party usage is assigned the student party usage, the applicant usage is set with an end date.
8. Click Save and Close.
Chapter 8
Party Usages

Edit Party Usages

1. In the Setup and Maintenance work area, go to the following:
   - Offering: Customer Data Management
   - Functional Area: Trading Community Foundation
   - Task: Manage Party Usages

2. Click Actions > Edit.

3. Change the following information in the Overview section of the page:
   - Edit the name.
   - Edit the description as needed.

4. Select or clear the selection for the following information in the Assignment section of the page:
   - If you have identified business events that can create an assignment to a party, select Restrict Manual Assignment.
   - If the bulk import or manual assignment can create an assignment, select Unconditional Assignment.
     | Note: The Unconditional Assignment isn't available for predefined party usages.
   - If you want to restrict only business events that you identified to update an assignment to a party, select Restrict Manual Update.
   - Select Relationship Causes Assignment to allow an assignment to a party if a party relationship is created.
   - Edit or provide the descriptions.

5. Add or update from and to dates during which the party usage is assigned exclusively in the Exclusivity Rules section. Or, change or delete the existing dates.

6. Modify the party usages which can't be assigned along with the selected party usage in the Incompatibility Rules section. For example, you can specify for a prospect party usage that a party couldn't have a prospect usage and customer usage at the same time. You can also specify the time period during which the selected party usages can't be assigned. Or, change or delete the existing rules.

7. In the Transition Rules section, update the party usage which the selected party usage transitions to. You can also specify the time period when the transition starts and, optionally, ends. For example, when a party that currently has the applicant party usage is assigned the student party usage, the applicant usage is set with an end date. Or, change or delete existing transition rules.

8. Click Save and Close.

Party Usage Filter Rules

Party usage filter rule is a grouping of party usages and is used to search and filter parties in the user interface. In a party usage filter rule, you can specify the party usages to include and exclude in the rule.

You can also specify if the party usage assignments should be active or inactive.

For example, an Eligible Customers filter rule can include the Sales Prospect party usage, Sales Account, Legal Entity, and Customer party usages. The Eligible Customers filter rule can then be used in the user interface to view only eligible customers from the list of parties.
Note: You must compile a new filter rule before you can use it in the user interface.

Related Topics
- How can I compile a party usage filter rule?

Manage Party Usage Filter Rules

Party usage filter rules are a grouping of related party usages and are used within the application to filter parties. Use this procedure to create and edit party usage filter rules.

Create Party Usage Filter Rules

1. In the Setup and Maintenance work area, go to the following:
   - Offering: Customer Data Management
   - Functional Area: Trading Community Foundation
   - Task: Manage Party Usage Filter Rule
2. Click Actions > Create.
3. Specify the following information in the Overview section of the page:
   - Specify the code for the party usage filter rule.
   - Specify a name.
   - Provide a description.
4. In the Inclusion Rules section, select the active or inactive party usage assignments you want to be included. For example, a party usage filter rule called contacts would include the active assignments for the customer contact party usage, and the sales contact party usage.
5. In the Exclusion Rules section, select the active or inactive party usage assignments you want to be excluded. For example, a party usage filter rule for external parties would exclude the employee party usage active assignments. You can also specify party usage codes for soft exclusion.
6. Click Save and Close.

Edit Party Usage Filter Rules

1. In the Setup and Maintenance work area, go to the following:
   - Offering: Customer Data Management
   - Functional Area: Trading Community Foundation
   - Task: Manage Party Usage Filter Rule
2. Click Actions > Edit.
3. Edit the following information, as required, in the Overview section of the page:
   - Change the name of the Party Usage Filter Rule.
Modify the description of the Party Usage Filter Rule.

4. In the Inclusion Rules section, update the active or inactive party usage assignments you want to be included. For example, a party usage filter rule called contacts would include the active assignments for the customer contact party usage, and the sales contact party usage. Or, change the Selection Criteria field of existing inclusion rules. You can also delete inclusion rules that are no longer valid.

5. In the Exclusion Rules section, update the active or inactive party usage assignments you want to be excluded. For example, a party usage filter rule for external parties would exclude the employee party usage active assignments. You can also specify party usage codes for soft exclusion. Or, change the Selection Criteria field of existing exclusion rules. You can also delete exclusion rules that are no longer valid.

6. Specify or modify the effective date, the date from which the party usage filter rule must come into effect.

7. Click Run Tests to find out the number of parties that match the party usage filter rule.

8. Click **Save and Close**.

**FAQs for Define Party Usages**

**How can I compile a party usage filter rule?**

In the Party Usage Filter Rule page click Actions in the header section, and then click Compile Filter Rule.
9 Names and Identifiers

Additional Name Types

Define additional name types to capture alternative names for parties. For example, create an additional name type, NICK_NAME, to capture the nicknames of parties of the Person type.

While creating an additional name type, specify the party type to which it applies. Then, the additional name type is available as a naming option for all parties of that party type within the deploying company. You can use additional name types to capture language-specific names as well.

Manage Additional Name Types

Use this procedure to create and edit additional name types.

Create Additional Names

1. In the Setup and Maintenance work area, go to the following:
   - Offering: Customer Data Management
   - Functional Area: Trading Community Foundation
   - Task: Manage Additional Name Types
2. Click Actions > Create.
3. Specify or change the following fields:
   a. Select the Party Type, such as Person, which can have this additional name type.
   b. Type a short name for the additional name type, for example MAIDEN. This name type must be unique.
   c. Specify a descriptive name such as Maiden Name in the Additional Name field.
   d. (Optional) Specify a description for the additional name, for example, A Health Level Seven International name type for maiden name.
   e. Specify if this name is unique with the type. Define whether you can add multiple entries of the name type to a party. For example, select No to allow multiple nick names to be added to a person.
4. Click Save and Close.

Edit Additional Names

1. In the Setup and Maintenance work area, go to the following:
   - Offering: Customer Data Management
   - Functional Area: Trading Community Foundation
Task: Manage Additional Name Types

2. Search and select the additional name type that you want to edit. For example, you could try editing the MAIDEN additional name type that you created just now.
3. Click Actions > Edit.
4. Edit the following fields as required:
   - Additional Name
   - Description
5. Click Save and Close.

Identifier Types

You can create additional identifier types to provide extensions to party attributes. For example, you can create an additional identifier type to record a person’s passport number.

You can select which party types can use the additional identifier type. These party types can be account or contact, or both. You can also specify whether the value of an identifier type must be unique. For example, the passport number listed under each person’s profile must be unique.

Additional identifier types don’t automatically appear in the UI. To use identifier types in the application, you must call the Trading Community Member Name and Identifier Setup web service.

Manage Identifier Types

Use this procedure to create and edit additional identifier types.

Create Additional Identifier Types

1. In the Setup and Maintenance work area, go to the following:
   - Offering: Customer Data Management
   - Functional Area: Trading Community Foundation
   - Task: Manage Additional Identifier Types
2. Click Actions > Create.
3. Specify the following fields:
   - Select the Party Type, such as Organization, which can have this additional identifier type.
   - Type a short name for the additional identifier type, for example INDUSTRIAL_REFERENCE. This short name is used by the application to reference the additional identifier type and must be unique.
   - Specify a descriptive name such as Industrial Reference in the Additional Identifier field.
   - (Optional) Specify a description for the additional identifier type, for example, Industrial Reference Number.
Specify if this name is unique. Define whether you can add multiple entries of the identifier type to a party. For example, select No to allow multiple visa numbers to be added to a person.

4. Click **Save and Close**.

**Edit Additional Identifier Types**

1. In the Setup and Maintenance work area, go to the following:
   - Offering: Customer Data Management
   - Functional Area: Trading Community Foundation
   - Task: Manage Additional Identifier Types

2. Click **Actions > Edit**.

3. Edit the following fields as required:
   - Additional Identifier: Specify a descriptive name such as Industrial Reference.
   - Description: Specify a description for the additional identifier type, for example, Industrial Reference Number.

4. Click **Save and Close**.


10 Relationships

Relationships Types

A relationship type categorizes relationship phrases and roles that determine the nature and purpose of a relationship. A relationship type defines the aspects of a relationship, such as the roles of the subject and object, business rules, and phrases that describe the relationship.

A relationship uses the relationship type to define how a party is related to another party. You can manage relationship types from the Manage Relationship Types task.

The components of a relationship type are:

- Relationship phrase pair and role pair
- Relationship characteristics

Relationship Phrase Pair and Role Pair

A relationship type contains a relationship phrase pair and a role pair. These pairs define the mutual roles that the two parties play in a relationship, as shown in the following table.

<table>
<thead>
<tr>
<th>Pair</th>
<th>Purpose</th>
<th>Direction of Relationship Matters</th>
<th>Example for Employment Relationship Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Role Pair</td>
<td>Describes the roles of the entities.</td>
<td>No</td>
<td>Employee and Employer. For example, Bill has the role of an employee, and Oracle has the role of an employer.</td>
</tr>
<tr>
<td>Relationship Phrase Pair</td>
<td>Describes the roles of the entities in the relationship.</td>
<td>Yes</td>
<td>Employee of and Employer of. For example, Bill is employee of Oracle.</td>
</tr>
</tbody>
</table>

Relationship Characteristics

Relationship types include rules that define how you can use the relationship type.

When defining a relationship type, you can define the relationship to be one of the following:

- Circular
- Related to self

The following table explains these characteristics.
Relationship Characteristic | Description | Example
--- | --- | ---
Circular | The relationships between two parties forms a loop. | A competitor relationship type links two organization parties. In this scenario, ABC Corp is a competitor of XYZ Corp, and XYZ Corp is also a competitor of ABC Corp.
Related to self | The subject and the object of the relationship are the same. | A subsidiary relationship type links a subsidiary organization ABC to a parent organization XYZ. The parent organization XYZ, in turn, is linked to itself as a subsidiary using the same relationship type.

Related Topics
- Relationship Groups

Relationship Groups

Relationship groups categorize relationship phrase and role pairs for functional purpose. For example, you can assign the relationship phrase Subsidiary Of to a group, and assign the phrase Headquarters Of to a different group.

Uses of Relationship Groups

Relationship groups are used to determine which relationship roles and phrases are displayed in specific user interfaces of the Oracle applications. A relationship group can correspond to one or more Oracle Applications user interfaces. For example, you can configure an Oracle application to display only the relationship types that pertain to the Party Contacts information.

Related Topics
- Relationships Types

Manage Relationship Types

Create Relationship Types

You create a relationship type to define the aspects of a relationship, such as the roles of the subject and object, business rules, and phrases that describe the relationship.

In this example, you will create a relationship type, and add relationship roles and phrases to the relationship type. The following table lists the key decisions you must consider before creating a relationship.
Decisions to Consider | In This Example
--- | ---
What are the subject and object party types for the relationship? | The subject type and object type is organization.
Is the relationship circular? | Yes
Can the subject related to self in this relationship? | No

You must search for the relationship type to make sure it doesn't already exist, before you create a relationship type.

### Search for a relationship type

1. In the Setup and Maintenance work area, go to the following:
   - Offering: Customer Data Management
   - Functional Area: Trading Community Foundation
   - Task: Manage Relationship Types
2. On the Manage Relationship Types page, in the Search region, complete the fields, as shown in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Operator</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Relationship Type</td>
<td>Equals</td>
<td>Supplier</td>
</tr>
<tr>
<td>Subject Type</td>
<td>Equals</td>
<td>Organization</td>
</tr>
<tr>
<td>Object Type</td>
<td>Equals</td>
<td>Organization</td>
</tr>
</tbody>
</table>
3. Click **Search**.
   
   Review the search results to ensure that there is no existing relationship types for the criteria.

### Create a relationship type

1. In the Search Results region, click the **Create** icon to open the Create Relationship Type page.
2. On the Create Relationship Type page, in the Overview region, enter Supplier in the **Relationship Type** field.
3. Select the **Circular** check box.
4. In the Relationship Roles and Phrases region, click the **Create** icon to open the Create Relationship Role and Phrase Pair dialog box. When you create a relationship with a relationship phrase or role, the reverse direction is automatically created with the other phrase or role in the pair.
5. Complete the fields, in the Create Relationship Role and Phrase Pair dialog box, as shown in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Subject Type</td>
<td>Organization</td>
</tr>
<tr>
<td>Subject Phrase</td>
<td>Supplier of</td>
</tr>
<tr>
<td>Subject Role Singular</td>
<td>Supplier</td>
</tr>
<tr>
<td>Subject Role Plural</td>
<td>Suppliers</td>
</tr>
<tr>
<td>Object Type</td>
<td>Organization</td>
</tr>
<tr>
<td>Object Phrase</td>
<td>Buyer of</td>
</tr>
<tr>
<td>Object Role Singular</td>
<td>Buyer</td>
</tr>
<tr>
<td>Object Role Plural</td>
<td>Buyers</td>
</tr>
</tbody>
</table>

6. Click **OK**.
7. Click **Save and Close**.

Related Topics
- Relationships Types
- Relationship Groups
- Edit Relationship Types

Edit Relationship Types

You can manage relationship types from the Manage Relationship Types task. You update a relationship type, by adding relationship roles and phrases to the relationship type, or assigning the relationship to a group.

In this example, you will add a role and phrase pair to the relationship type Employment. You will also add the Employment relationship type to the Party Contacts group.
Edit a relationship type

1. In the Setup and Maintenance work area, go to the following:
   - Offering: Customer Data Management
   - Functional Area: Trading Community Foundation
   - Task: Manage Relationship Types

2. On the Manage Relationship Types page, in the Search region, enter Employment in the Relationship Type field.
3. Click Search.
4. In the Search Results region, select the Employment relationship type and Edit icon to open the Edit Relationship Type page.
5. On the Edit Relationship Type page, in the Relationship Roles and Phrases region, click the Create icon.
6. In the Create Relationship Role and Phrase Pair, complete the fields, as shown in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Subject Type</td>
<td>Organization</td>
</tr>
<tr>
<td>Subject Phrase</td>
<td>Has contract employees</td>
</tr>
<tr>
<td>Subject Role Singular</td>
<td>Contractor</td>
</tr>
<tr>
<td>Subject Role Plural</td>
<td>Contractors</td>
</tr>
<tr>
<td>Object Type</td>
<td>Person</td>
</tr>
<tr>
<td>Object Phrase</td>
<td>Contract Employee of</td>
</tr>
<tr>
<td>Object Role Singular</td>
<td>Contract Employee</td>
</tr>
<tr>
<td>Object Role Plural</td>
<td>Contract Employees</td>
</tr>
</tbody>
</table>

7. Click OK.
8. In the Relationship Groups region, click the Add Row icon.
9. In the Name list, select Party Contacts.
10. Click Save and Close.

Related Topics
- Relationships Types
- Relationship Groups
- Create Relationship Types
Restore Inactive Relationship Types

You may want to delete custom seed data such as custom relationship types when the relationship type is no longer used in your organization.

If you have accidently deleted these relationship types, as a sales admin, you can restore them. You can temporarily hide certain relationship types and also re-instate them back, if needed later.

When you delete a relationship type, it becomes inactive. You can restore the relationship type later by first searching for the inactive relationship and then restoring it in the Manage Relationship Types task.

1. In the Setup and Maintenance work area, go to the following:
   - Offering: Customer Data Management
   - Functional Area: Trading Community Foundation
   - Task: Manage Relationship Types

2. In the search section, select Inactive in the Status filter to search for inactive relationship types.

3. Select the required relationship type and click the Restore button.

   **Note:** The Restore button is available only when there are inactive relationship types.

**Results:**
The inactive relationship type is now active.

Manage Relationship Groups

**Manage Relationship Groups**

Relationship groups are used to categorize relationship roles and phrases, based on the user interfaces that they appear in.

In this example, you will create a group for relationship types that link an organization to an external organization.

**Create a relationship group**

1. In the Setup and Maintenance work area, go to the following:
   - Offering: Customer Data Management
   - Functional Area: Trading Community Foundation
   - Task: Manage Relationship Groups

2. On the Manage Relationship Groups page, in the Search Results region, click the **Create** icon to open the Create Relationship Group page.
3. Complete the fields, as shown in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Related External Organizations</td>
</tr>
<tr>
<td>Code</td>
<td>REL_EXT_ORGS</td>
</tr>
<tr>
<td>Description</td>
<td>Indicates a group of relationships that link the organization to external entities.</td>
</tr>
</tbody>
</table>

4. In the Relationship Roles and Phrases region, click the **Add Row** icon to add a relationship role and phrase pair.

5. For each relationship role and phrase pair, complete the fields, as shown in the following table.

<table>
<thead>
<tr>
<th>Subject Type</th>
<th>Subject Role</th>
</tr>
</thead>
<tbody>
<tr>
<td>Organization</td>
<td>Supplier</td>
</tr>
<tr>
<td>Organization</td>
<td>Competitor</td>
</tr>
</tbody>
</table>

6. Click **Save and Close**.

**Edit Relationship Group**

1. In the Setup and Maintenance work area, go to the following:
   - Offering: Customer Data Management
   - Functional Area: Trading Community Foundation
   - Task: Manage Relationship Groups

2. On the Manage Relationship Groups page, in the Search Results region, select a relationship group.

3. Modify the required values.

4. Click **Save and Close**.

**Related Topics**

- Relationship Groups
11 Classifications

Classification Components

The classifications model provides a flexible tool to categorize entities such as parties, projects, tasks, and orders. Classifications enable you to classify an entity, such as a party, the way it’s referenced within your organization.

The major components of classifications are:

- Classification categories
- Classification rules
- Classification codes
- Classification code hierarchy
- Entity assignment

Classification Categories

Classification categories provide the ability to classify entities under a broad subject area. For example, you can classify organizations based on the industries in which they operate. Classification categories are a logical grouping of one or more classification codes that define classification code rules.

Classification Rules

Classification categories can have rules that define how classifications are assigned to entities. When you set up classification categories, you can create specific rules. For example, allowing the parent classification code to be assigned to a party, and allowing multiple classification codes to be assigned to an entity.

Classification Codes

The individual values within the classification category are called classification codes. For example, the 1987 SIC classification category has a classification code of software that you can assign to a party in the software industry. You can organize classification codes into a hierarchical tree. The parent classification code appears as the highest level node of the tree and child classification codes branches off from the parent code or other classification codes.

Classification Code Hierarchy

You can create hierarchies of classification codes within a classification category. For example, you can set up IT as the classification category with hardware, keyboards, and printers as the classification codes. Then, you can set up hardware as the parent classification code at the highest level on the tree, with keyboards and printers as the child classification codes. You can create additional child classification codes, such as dot matrix, ink-jet, and laser under the printer classification code.

How You Manage Classification Codes and Classification Code Hierarchy

You can use the Manage Classification Categories task to create or update classification codes and to modify classification hierarchy.
Note: We recommend that you don’t use the Manage Trees and Tree Versions or Manage Standard Lookups tasks to update the classification information. This may result in invalid classification data. Classification based trees would have only one tree version with Active status. Using the Manage Trees and Tree Versions could result in tree to be in Draft status. And this would prevent it from being used correctly by applications like Territory Management. Therefore, you must use Manage Classification Categories for managing classifications hierarchy. If for some reason, it was changed to DRAFT, then you must activate it using the Manage Trees and Tree Versions task. On the Manage Trees and Tree Versions page, select the required tree, and click Actions > Set Status > Active. This option resets the tree back to ACTIVE status.

How You Manage Organization Type Field

You can define and manage classification categories using the Manage Classification Categories. You can create and manage classification code for the classification categories and manage the hierarchy of the classification codes. In this topic we discuss how to manage the Organization Type field.

1. In the Setup and Maintenance work area, go to the following:
   - Offering: Sales
   - Functional Area: Accounts and Contacts
   - Task: Manage Classification Categories
2. Search for the classification category ORGANIZATION_TYPE and select it.
3. Click Action > Edit.
4. On the edit page, you can edit an existing classification code or create a classification code. Do the following steps:
   - Do the following to add an existing classification code:
     i. Select a node as the parent tree, if any node exists, and click Actions > Add. Else, click simply Actions > Add.
     ii. Select Specific Value and select a data source to select one node. Else, select Values from referenced hierarchy to select a tree.
     iii. Specify the tree node details.
     iv. Click OK.
   - Do the following to create a classification code:
     i. Select a node as the parent, if any node exists, and click Actions > Create. Else, simply click Actions > Create.
     ii. Click Next.
     iii. Specify the classification code name, classification code meaning, and classification code description.
5. Click Save and Close.
FAQs for Define Classifications

What happens if I allow parent code assignment?

You can assign the parent classification code and its child classification codes to an object. The parent classification code is the highest level of the classification code tree.

If you don't allow parent classification codes to be assigned to an object, then you can only assign child classification codes, or codes that are under another classification code, to an object.

How can I delete classification codes?

You can delete classification codes using the Manage Classification Categories task. We recommend that you don't delete the classification categories using the Manage Standard Lookups task.

How You Manage Organization Type Field

You can define and manage classification categories using the Manage Classification Categories. You can create and manage classification code for the classification categories and manage the hierarchy of the classification codes. In this topic we discuss how to manage the Organization Type field.

1. In the Setup and Maintenance work area, go to the following:
   a. Offering: Sales
   b. Functional Area: Accounts and Contacts
   c. Task: Manage Classification Categories

2. Search for the classification category ORGANIZATION_TYPE and select it.

3. Click Action > Edit.
4. On the edit page, you can edit an existing classification code or create a classification code. Do the following steps:

- Do the following to add an existing classification code:
  1. Select a node as the parent tree, if any node exists, and click Actions > Add. Else, click simply Actions > Add.
  2. Select Specific Value and select a data source to select one node. Else, select Values from referenced hierarchy to select a tree.
  3. Specify the tree node details.
  4. Click OK.

- Do the following to create a classification code:
  1. Select a node as the parent, if any node exists, and click Actions > Create. Else, simply click Actions > Create.
  2. Click Next.
  3. Specify the classification code name, classification code meaning, and classification code description.

5. Click Save and Close.

What happens if I allow multiple class code assignment?

You can assign more than one classification code from the classification category to an object.

If you don't allow multiple classification codes to be assigned to an object, then you can assign only one classification code from the classification category to an object.

Can I update an existing entity assignment rule?

No. You can delete the entity assignment rule and create a new one.

Why can't I see some classification information in Customer Center?

Customer Center displays the classification and classification group information of a customer in the Classifications node. All classifications are categorized under classification categories.

For example, the 1987 SIC classification category has a classification code of software that you can assign to a party in the software industry.

Customer Center displays the classification information based on the classification categories configured in the Manage Classification Group task. You must configure all classification categories, and their codes, that you want to use in the task so that they can be displayed in the Customer Center. For example, you have imported a customer with a classification code that belongs to the category Major Industry Codes. However, if you don't add the classification
category Major Industry Codes in the Manage Classification Group page then the classification code isn't displayed in the Customer Center.
Chapter 12

Data Formats

Data Styles and Data Formats

Data Formats help you define address formats and name formats within your organization, and assign them to specific geographies. The application uses these formats to capture and validate party name and address information.

You must set up geography data, in addition to the address formats, to use geography-based validations for addresses.

Data Styles

You can define new styles for name and address to categorize a name and address style formats. A Data Style, such as Mailing Address or Concatenated Name, categorizes name and address style formats. The application uses Data Styles to identify a particular manner or situation for which an entity is formatted. For example, you can configure the application to display only certain name and address styles in the user interface.

Data Formats

You use Data Formats to ensure party address and party name data quality. The address formats are used to present the address elements in the country specific formatting, and help users during address entry. For example, HCM uses Supplemental Tax address format and other applications such as CX Sales, Accounts Receivable, and so on use Postal address Format. However, these formats are predefined for each application, and you can't change the format. Also note that you can't have more than one address format for a country of the same style. This An Address Format also specifies the scope of address validation. Address formats are linked to the geographic data for address verification, at the data-import level. For example, when creating or editing an address for a party, selecting a country displays the address format for that country.

The use of Name formats ensures that name components are stored in a decomposed manner. You can use Name formats to construct name representations from components in a variety of different styles. You can also store phonetic names that are required for certain geographies.

Data Formats simplify the storage of party address and party name, by storing them as components. You can use formats to validate addresses and name data, after setting up address and name format for a geography.

Related Topics

• Types of Data Formats

Types of Data Formats

Data Formats determine how names and addresses are displayed in the application.
There are two types of data formats.

- **Address format**: Address formats specify the layout of an address, such as the components in the address and their position in the layout. For example, an address format for US postal address can include address, city, state, and postal code in that order.

- **Name format**: Name formats specify how a name is displayed in the application, based on the usage, language, and country. A name format includes name elements, their position, and formatting. You can create a name style format for either an organization name or a person name.

Name and address formats vary depending on usage, country, and language. You can create name formats and address formats, modify them, and assign them to specific locales. This lets you create data formats for various countries, languages, and usages.

Additionally, you can create variations of the formats, with each variation having its own layout. For example, an address format may have variations such as general address, rural address, and military address.

**Related Topics**
- Data Styles and Data Formats

### Create an Address Style Format

This example shows how to create an address style format for a specified address style.

To create an address style format:

- Specify the address style format and address style
- Create the format variation layout
- Assign a locale

In this example, we will create an address style to format Canadian postal addresses.

#### Create the Address Style Format Name and Specify the Address Style

To create an address style format and specify the address style:

1. In the Setup and Maintenance work area, go to the following:
   - Offering: Customer Data Management
   - Functional Area: Trading Community Foundation
   - Task: Manage Address Formats

2. On the Manage Address Formats page, click Create from the actions menu.

3. On the Create Address Style Format page, complete the fields in the Overview section, as shown in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Code</td>
<td>CA_POSTAL_ADDR</td>
</tr>
</tbody>
</table>
4. Click Save.

Create the Format Variation Layout

To create a format variation layout:

1. In the Format section on the Create Address Style Format page, click the Format Layout tab.
2. In the Format Variation section, select Add from the Actions menu.
3. Enter a variation rank in the Variation field.

**Note:** You can’t change the Variation Number. If you’re specifying Create and Edit address forms, always use variation value as 1 irrespective of rank. If you’re specifying Read Only formatted address (either single line or more than one line), always use variation with highest rank.

4. In the Format Variation Layout section, select Add from the Action menu.
5. Complete the fields as shown in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Canadian Postal Address Format</td>
</tr>
<tr>
<td>Address Style</td>
<td>Postal Address</td>
</tr>
<tr>
<td>Default</td>
<td>No</td>
</tr>
<tr>
<td>Line 1</td>
<td>Position 1</td>
</tr>
<tr>
<td>Prompt</td>
<td>Address line 1</td>
</tr>
<tr>
<td>Address Element</td>
<td>Address line 1</td>
</tr>
<tr>
<td>Required</td>
<td>Yes</td>
</tr>
<tr>
<td>Uppercase</td>
<td>No</td>
</tr>
</tbody>
</table>
6. Create another address line as shown in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Line</td>
<td>2</td>
</tr>
<tr>
<td>Position</td>
<td>2</td>
</tr>
<tr>
<td>Prompt</td>
<td>City</td>
</tr>
<tr>
<td>Address Element</td>
<td>City</td>
</tr>
<tr>
<td>Required</td>
<td>Yes</td>
</tr>
<tr>
<td>Uppercase</td>
<td>Yes</td>
</tr>
</tbody>
</table>

7. Click **Expand** on the City address line, then enter the value **1** in **Blank Lines Before**.

8. You can create as many address lines as you require. Click **Expand** if you want to enter blank lines and delimiters before, or after, an address line. In this section, you can also use the Attribute Transform Function to specify how the country attribute value must be displayed. The Attribute Transform Function supports two functions:

- hz_format_pub.get_tl_territory_name(COUNTRY)
- hz_format_pub.get_neu_country_code(COUNTRY)

These functions are used only in display formats or read-only formats where the address data is formatted in a single field. Examples for such formats are overview pages and multiple addresses section in a list. Let's look at these functions in detail:

- hz_format_pub.get_tl_territory_name(COUNTRY): Converts a country code of a country into its name. For example, MX is converted to Mexico. The country is displayed in the language that's set in the user profile. If the profile value of the ORA_HZ_INCLUDE_REGIONAL_COUNTRY profile option is set to yes and the country name set in the user profile is the same as the country attribute value, then the country name is displayed. If the profile value of the ORA_HZ_INCLUDE_REGIONAL_COUNTRY profile option is set to no and the country name set in the user profile is the same as the country attribute value, the country name isn't displayed. To change the profile value, navigate to the following in the **Setup and Maintenance** work area:
  - Offering: Sales
  - Functional Area: Sales Foundation
  - Task: Manage Administrator Profile Values
Oracle Fusion Cloud Sales Automation
Implementing Customer Data Management for CX Sales
and B2B Service

Chapter 12
Data Formats

- `hz_format.pub.get_neu_country_code(COUNTRY)`: Converts a country code for North European countries into a code that's placed before the postal code in a formatted address. For example, for France F is placed before the postal code. B is used for Belgium, D for Germany, and so on.

  **Note:** For more information about territory codes and their prefix for North European postal codes, see Seeded Address Formats for Countries topic.

- `hz_format.pub.get_neu_country_code(COUNTRY)`: Converts a country code for North European countries into a code that's placed before the postal code in a formatted address. For example, for France F is placed before the postal code. B is used for Belgium, D for Germany, and so on.

**Note:** While creating a new address style format, make sure that the transform function is present for each component as in predefined address style formats. The transform function may impact translation.

Assign a Locale

An address style format is assigned to a geographic location. Locale provides mapping between territory code and address style format.

To assign an address style format to a locale:

1. In the Format section on the Create Address Style Format page, click the **Locale Assignment** tab.
2. Select **New** from the Actions menu.
3. Select the country for the address style format. You can assign multiple countries to the format.
4. Click **Save and Close**.

**Related Topics**

- How can I create an address style format layout?
- How can I create a variation of an Address Style Format?

Update Address Formats

This procedure lists the steps to update address formats.

Address formats specify the layout of an address, such as the components in the address and their position in the layout. For example, an address format for Canada postal address can include Address, City, Province, Postal Code, and Country in that order.

To update an address format, complete these steps:

1. In the Setup and Maintenance work area, go to the following:
   - **Offering**: Customer Data Management
   - **Functional Area**: Trading Community Foundation
   - **Task**: Manage Address Formats
   
   The Manage Address Formats page opens.
2. Select the country whose address format you want to update. For example, select Canada to update its address format.
3. Click **Search** to display the address formats for the country.
4. Select the address format you want to update to display the Edit Address Style Format page.
5. Click **Edit** to view the page in edit mode.
You can update the address components in the Format region.

**Note:** When any address format is assigned as the default other than the standard default address format, the Address section is displayed only for the countries which don't have the postal address format defined under Locale tab.

6. To update the address components, expand the address component to view options for each address component.
7. Click **Save and Close**.

---

**Seeded Address Formats for Countries**

The following table lists the countries for which seeded address formats are available.

This table contains the style format codes, territory codes, and attribute codes for these countries. The geographical attribute codes vary for each country.

<table>
<thead>
<tr>
<th>TERRITORY_SHORT_NAME</th>
<th>STYLE_FORMAT_CODE</th>
<th>TERRITORY_CODE</th>
<th>ATTRIBUTE_CODE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Argentina</td>
<td>POSTAL_ADDR_AR</td>
<td>AR</td>
<td>ADDRESS1</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>ADDRESS2</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>ADDRESS3</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>CITY</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>COUNTRY</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>POSTAL_CODE</td>
</tr>
<tr>
<td>Australia</td>
<td>POSTAL_ADDR_AU</td>
<td>AU</td>
<td>ADDRESS1</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>ADDRESS2</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>ADDRESS3</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>CITY</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>COUNTRY</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>POSTAL_CODE</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>STATE</td>
</tr>
<tr>
<td>Austria</td>
<td>POSTAL_ADDR_AT</td>
<td>AT</td>
<td>ADDRESS1</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>ADDRESS2</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>CITY</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>COUNTRY</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>POSTAL_CODE</td>
</tr>
<tr>
<td>TERRITORY_SHORT_NAME</td>
<td>STYLE_FORMAT_CODE</td>
<td>TERRITORY_CODE</td>
<td>ATTRIBUTE_CODE</td>
</tr>
<tr>
<td>---------------------</td>
<td>------------------</td>
<td>---------------</td>
<td>----------------</td>
</tr>
<tr>
<td>Belgium</td>
<td>POSTAL_ADDR_BE</td>
<td>BE</td>
<td>ADDRESS1</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>ADDRESS2</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>ADDRESS3</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>CITY</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>COUNTRY</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>POSTAL_CODE</td>
</tr>
<tr>
<td>Brazil</td>
<td>POSTAL_ADDR_BR</td>
<td>BR</td>
<td>ADDRESS1</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>ADDRESS2</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>CITY</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>COUNTRY</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>POSTAL_CODE</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>STATE</td>
</tr>
<tr>
<td>Canada</td>
<td>POSTAL_ADDR_CA</td>
<td>CA</td>
<td>ADDRESS1</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>ADDRESS2</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>ADDRESS3</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>CITY</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>COUNTRY</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>POSTAL_CODE</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>PROVINCE</td>
</tr>
<tr>
<td>Chile</td>
<td>POSTAL_ADDR_CL</td>
<td>CL</td>
<td>ADDRESS1</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>ADDRESS2</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>CITY</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>COUNTRY</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>POSTAL_CODE</td>
</tr>
<tr>
<td>China</td>
<td>POSTAL_ADDR_CN</td>
<td>CN</td>
<td>ADDRESS1</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>ADDRESS2</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>ADDR_ELEMENT_ATTRIBUTE2</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>CITY</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>COUNTRY</td>
</tr>
<tr>
<td>TERRITORY_SHORT_NAME</td>
<td>STYLE_FORMAT_CODE</td>
<td>TERRITORY_CODE</td>
<td>ATTRIBUTE_CODE</td>
</tr>
<tr>
<td>----------------------</td>
<td>-------------------</td>
<td>----------------</td>
<td>----------------</td>
</tr>
<tr>
<td>Colombia</td>
<td>POSTAL_ADDR_CO</td>
<td>CO</td>
<td>POSTAL_CODE</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>PROVINCE</td>
</tr>
<tr>
<td>Cuba</td>
<td>POSTAL_ADDR_CU</td>
<td>CU</td>
<td>ADDRESS1</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>ADDRESS2</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>CITY</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>COUNTRY</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>COUNTY</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>POSTAL_CODE</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>PROVINCE</td>
</tr>
<tr>
<td>Estonia</td>
<td>POSTAL_ADDR_EE</td>
<td>EE</td>
<td>ADDRESS1</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>ADDRESS2</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>CITY</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>COUNTRY</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>POSTAL_CODE</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>STATE</td>
</tr>
<tr>
<td>Finland</td>
<td>POSTAL_ADDR_N_EUR</td>
<td>FI</td>
<td>ADDRESS1</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>ADDRESS2</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>ADDRESS3</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>CITY</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>COUNTRY</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>POSTAL_CODE</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>STATE</td>
</tr>
<tr>
<td>France</td>
<td>POSTAL_ADDR_FR</td>
<td>FR</td>
<td>ADDRESS1</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>ADDRESS2</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>CITY</td>
</tr>
<tr>
<td>TERRITORY_SHORT_NAME</td>
<td>STYLE_FORMAT_CODE</td>
<td>TERRITORY_CODE</td>
<td>ATTRIBUTE_CODE</td>
</tr>
<tr>
<td>----------------------</td>
<td>------------------</td>
<td>---------------</td>
<td>----------------</td>
</tr>
<tr>
<td>Germany</td>
<td>POSTAL_ADDR_DE</td>
<td>DE</td>
<td>ADDRESS1</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>ADDRESS2</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>ADDRESS3</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>CITY</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>COUNTRY</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>POSTAL_CODE</td>
</tr>
<tr>
<td>Hong Kong</td>
<td>POSTAL_ADDR_HK</td>
<td>HK</td>
<td>ADDRESS1</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>ADDRESS2</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>ADDRESS3</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>CITY</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>COUNTRY</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>COUNTY</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>STATE</td>
</tr>
<tr>
<td>Hungary</td>
<td>POSTAL_ADDR_HU</td>
<td>HU</td>
<td>ADDRESS1</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>ADDRESS2</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>CITY</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>COUNTRY</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>POSTAL_CODE</td>
</tr>
<tr>
<td>India</td>
<td>POSTAL_ADDR_IN</td>
<td>IN</td>
<td>ADDRESS1</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>ADDRESS2</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>ADDRESS3</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>CITY</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>COUNTRY</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>POSTAL_CODE</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>STATE</td>
</tr>
<tr>
<td>Ireland</td>
<td>POSTAL_ADDR_IE</td>
<td>IE</td>
<td>ADDRESS1</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>ADDRESS2</td>
</tr>
<tr>
<td>TERRITORY_SHORT_NAME</td>
<td>STYLE_FORMAT_CODE</td>
<td>TERRITORY_CODE</td>
<td>ATTRIBUTE_CODE</td>
</tr>
<tr>
<td>------------------------------------------</td>
<td>-------------------</td>
<td>---------------</td>
<td>-----------------------------------------------------</td>
</tr>
<tr>
<td>Italy</td>
<td>POSTAL_ADDR_IT</td>
<td>IT</td>
<td>ADDRESS1, ADDRESS2, ADDRESS3, CITY, COUNTRY, POSTAL_CODE, STATE</td>
</tr>
<tr>
<td>Japan</td>
<td>POSTAL_ADDR_JP</td>
<td>JP</td>
<td>ADDRESS1, ADDRESS2, ADDRESS3, ADDRESS_LINES_PHONETIC, ADDR_ELEMENT_ATTRIBUTE2, CITY, COUNTRY, POSTAL_CODE, STATE</td>
</tr>
<tr>
<td>Korea, Democratic People's Republic of</td>
<td>POSTAL_ADDR_KP</td>
<td>KP</td>
<td>ADDRESS1, ADDRESS2, ADDR_ELEMENT_ATTRIBUTE2, ADDR_ELEMENT_ATTRIBUTE3, CITY, COUNTRY, PROVINCE</td>
</tr>
<tr>
<td>Korea, Republic of</td>
<td>POSTAL_ADDR_KR</td>
<td>KR</td>
<td>ADDRESS1</td>
</tr>
<tr>
<td>TERRITORY_SHORT_NAME</td>
<td>STYLE_FORMAT_CODE</td>
<td>TERRITORY_CODE</td>
<td>ATTRIBUTE_CODE</td>
</tr>
<tr>
<td>----------------------</td>
<td>-------------------------</td>
<td>----------------</td>
<td>---------------------------------------------</td>
</tr>
<tr>
<td>Luxembourg</td>
<td>POSTAL_ADDR_N_EUR</td>
<td>LU</td>
<td>ADDRESS1, ADDRESS2, ADDRESS3, CITY, COUNTRY, POSTAL_CODE, PROVINCE</td>
</tr>
<tr>
<td>Malaysia</td>
<td>POSTAL_ADDR_MY</td>
<td>MY</td>
<td>ADDRESS1, ADDRESS2, ADDRESS3, CITY, COUNTRY, POSTAL_CODE, STATE</td>
</tr>
<tr>
<td>Mexico</td>
<td>POSTAL_ADDR_MX</td>
<td>MX</td>
<td>ADDRESS1, ADDRESS2, ADDR_ELEMENT_ATTRIBUTE2, ADDR_ELEMENT_ATTRIBUTE3, CITY, COUNTRY, POSTAL_CODE, STATE</td>
</tr>
<tr>
<td>Netherlands</td>
<td>POSTAL_ADDR_NL</td>
<td>NL</td>
<td>ADDRESS1, ADDRESS2</td>
</tr>
<tr>
<td>TERRITORY_SHORT_NAME</td>
<td>STYLE_FORMAT_CODE</td>
<td>TERRITORY_CODE</td>
<td>ATTRIBUTE_CODE</td>
</tr>
<tr>
<td>----------------------</td>
<td>------------------</td>
<td>----------------</td>
<td>---------------</td>
</tr>
<tr>
<td>New Zealand</td>
<td>POSTAL_ADDR_NZ</td>
<td>NZ</td>
<td>ADDRESS1</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>ADDRESS2</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>ADDRESS3</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>CITY</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>COUNTRY</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>POSTAL_CODE</td>
</tr>
<tr>
<td>Norway</td>
<td>POSTAL_ADDR_N_EUR</td>
<td>NO</td>
<td>ADDRESS1</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>ADDRESS2</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>ADDRESS3</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>CITY</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>COUNTRY</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>POSTAL_CODE</td>
</tr>
<tr>
<td>Poland</td>
<td>POSTAL_ADDR_EUR</td>
<td>PL</td>
<td>ADDRESS1</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>ADDRESS2</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>ADDRESS3</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>CITY</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>COUNTRY</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>POSTAL_CODE</td>
</tr>
<tr>
<td>Romania</td>
<td>POSTAL_ADDR_N_EUR</td>
<td>RO</td>
<td>ADDRESS1</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>ADDRESS2</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>ADDRESS3</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>CITY</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>COUNTRY</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>POSTAL_CODE</td>
</tr>
<tr>
<td>Saudi Arabia</td>
<td>POSTAL_ADDR_SA</td>
<td>SA</td>
<td>ADDRESS1</td>
</tr>
<tr>
<td>TERRITORY_SHORT_NAME</td>
<td>STYLE_FORMAT_CODE</td>
<td>TERRITORY_CODE</td>
<td>ATTRIBUTE_CODE</td>
</tr>
<tr>
<td>---------------------</td>
<td>---------------------</td>
<td>----------------</td>
<td>---------------------------------------</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>ADDRESS2</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>CITY</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>COUNTRY</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>POSTAL_CODE</td>
</tr>
<tr>
<td>Singapore</td>
<td>POSTAL_ADDR_SG</td>
<td>SG</td>
<td>ADDRESS1</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>ADDRESS2</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>ADDRESS3</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>BUILDING</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>COUNTRY</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>POSTAL_CODE</td>
</tr>
<tr>
<td>South Africa</td>
<td>POSTAL_ADDR_ZA</td>
<td>ZA</td>
<td>ADDRESS1</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>ADDRESS2</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>ADDRESS3</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>ADDR_ELEMENT_ATTRIBUTE2</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>CITY</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>COUNTRY</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>POSTAL_CODE</td>
</tr>
<tr>
<td>Spain</td>
<td>POSTAL_ADDR_ES</td>
<td>ES</td>
<td>ADDRESS1</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>ADDRESS2</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>CITY</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>COUNTRY</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>POSTAL_CODE</td>
</tr>
<tr>
<td>Sweden</td>
<td>POSTAL_ADDR_SE</td>
<td>SE</td>
<td>ADDRESS1</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>ADDRESS2</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>ADDRESS3</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>CITY</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>COUNTRY</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>POSTAL_CODE</td>
</tr>
</tbody>
</table>

**Chapter 12: Data Formats**
<table>
<thead>
<tr>
<th>TERRITORY_SHORT_NAME</th>
<th>STYLE_FORMAT_CODE</th>
<th>TERRITORY_CODE</th>
<th>ATTRIBUTE_CODE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Switzerland</td>
<td>POSTAL_ADDR_CH</td>
<td>CH</td>
<td>ADDRESS1</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>ADDRESS2</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>CITY</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>COUNTRY</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>POSTAL_CODE</td>
</tr>
<tr>
<td>United Arab Emirates</td>
<td>POSTAL_ADDR_AE</td>
<td>AE</td>
<td>ADDRESS1</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>ADDRESS2</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>CITY</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>COUNTRY</td>
</tr>
<tr>
<td>United Kingdom</td>
<td>POSTAL_ADDR_GB</td>
<td>GB</td>
<td>ADDRESS1</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>ADDRESS2</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>ADDRESS3</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>CITY</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>COUNTRY</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>POSTAL_CODE</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>STATE</td>
</tr>
<tr>
<td>United States</td>
<td>POSTAL_ADDR_US</td>
<td>US</td>
<td>ADDRESS1</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>ADDRESS2</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>CITY</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>COUNTRY</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>POSTAL_CODE</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>STATE</td>
</tr>
<tr>
<td>Uruguay</td>
<td>POSTAL_ADDR_S_AM</td>
<td>UY</td>
<td>ADDRESS1</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>ADDRESS2</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>ADDRESS3</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>CITY</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>COUNTRY</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>POSTAL_CODE</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>PROVINCE</td>
</tr>
</tbody>
</table>
The following table lists North European countries and their prefixes for postal codes:

<table>
<thead>
<tr>
<th>Territory Short Name</th>
<th>Territory Code</th>
<th>Prefix for North European Postal Codes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Austria</td>
<td>AT</td>
<td>A</td>
</tr>
<tr>
<td>Belgium</td>
<td>BE</td>
<td>B</td>
</tr>
<tr>
<td>Germany</td>
<td>DE</td>
<td>D</td>
</tr>
<tr>
<td>Finland</td>
<td>FI</td>
<td>FIN</td>
</tr>
<tr>
<td>Faroe Islands</td>
<td>FO</td>
<td>FR</td>
</tr>
<tr>
<td>France</td>
<td>FR</td>
<td>F</td>
</tr>
<tr>
<td>Italy</td>
<td>IT</td>
<td>I</td>
</tr>
<tr>
<td>Liechtenstein</td>
<td>LI</td>
<td>FL</td>
</tr>
<tr>
<td>Luxembourg</td>
<td>LU</td>
<td>L</td>
</tr>
<tr>
<td>Norway</td>
<td>NO</td>
<td>N</td>
</tr>
<tr>
<td>Portugal</td>
<td>PT</td>
<td>P</td>
</tr>
<tr>
<td>Romania</td>
<td>RO</td>
<td>R</td>
</tr>
<tr>
<td>Sweden</td>
<td>SE</td>
<td>S</td>
</tr>
<tr>
<td>Holy See (Vatican City State)</td>
<td>VA</td>
<td>I</td>
</tr>
</tbody>
</table>

Create a Name Style Format

In this example, we create a name style format, define its format variation layout, and assign United States to it.

Note that the application selects a name style format to display name components based on your Locale Assignment preferences. You can set either Country or both Country and Language as locale. However, you can’t set only Language as locale.
When both Country and Language are set as locale, the application displays name components based on the language settings of your current session. For example, suppose you have the following two name style codes created under the Concatenated Name format:

- **Style Code 1:**
  - Country: China
  - Language: Simplified Chinese

- **Style Code 2:**
  - Country: China
  - Language: English

When you set your country preference to China and session language to English, you get the contact name formatted with Style Code 2. However, when you set your country preference to China and session language to Simplified Chinese, you get the contact name formatted with Style Code 1.

If no locale exists for a country and language setting, the default name style code (the name style code with Default Format for Style option set to Yes) is used.

Note that the name format takes effect only when you create a new contact or when you update the name of an existing contact. The application doesn’t translate contact names.

### Create the name style format

To create a name style format:

1. On the Manage Name Formats page, click **Create** from the Actions menu. The Create Name Style Format page is displayed.
2. In the Overview region, complete the fields as shown in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Code</td>
<td>CONCAT_NAME_US</td>
</tr>
<tr>
<td>Name</td>
<td>United States Concatenated Name Format</td>
</tr>
<tr>
<td>Name Style</td>
<td>Concatenated Name</td>
</tr>
<tr>
<td>Default Format for Style</td>
<td>No</td>
</tr>
</tbody>
</table>

**Note:** Set the Default Format for Style option to Yes to specify the name style format that you’re creating as the default format for the selected name style, Concatenated format.

3. In the Format Variation region, click **Add Row** from the Actions menu. A blank row is added to the Format Variation table.
4. Enter 1 in the Variation Rank field of the blank row.
5. In the Format Variation Layout region, click **Create** from the Actions menu. A blank row is added to the Format Variation Layout table.

6. Complete the fields as shown in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Line</td>
<td>1</td>
</tr>
<tr>
<td>Position</td>
<td>1</td>
</tr>
<tr>
<td>Prompt</td>
<td>Person First Name</td>
</tr>
<tr>
<td>Name Element</td>
<td>First Name</td>
</tr>
<tr>
<td>Required</td>
<td>No</td>
</tr>
<tr>
<td>Uppercase</td>
<td>No</td>
</tr>
</tbody>
</table>

**Note:** You can create as many name parts as you require. Click **Expand** to enter blank lines and delimiters before or after a name part. In this section, you can use Attribute Transform Function to specify how the country attribute value must be displayed. Use the following one of the following functions:

- `hz_format_pub.get_tl_territory_name(COUNTRY)`: Converts a country code of a country into its name. For example, MX is converted to Mexico. The country is displayed in the language that's set in the user profile. If the country set in the user profile is the same as the country attribute value, the country name isn't displayed.
- `hz_format_pub.get_neu_country_code(COUNTRY)`: Converts a country code for North European countries into a code that's placed before the postal code in a formatted address. For example, for France F is placed before the postal code. B is used for Belgium, D for Germany, and so on.

For more information about territory codes and their prefix for North European postal codes, see Seeded Address Formats for Countries topic.

7. Click **Create** from the Actions menu to create another variation layout as shown in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Line</td>
<td>2</td>
</tr>
<tr>
<td>Field</td>
<td>Value</td>
</tr>
<tr>
<td>------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Position</td>
<td>2</td>
</tr>
<tr>
<td>Prompt</td>
<td>Person Last Name</td>
</tr>
<tr>
<td>Name Element</td>
<td>Last Name</td>
</tr>
<tr>
<td>Required</td>
<td>No</td>
</tr>
<tr>
<td>Uppercase</td>
<td>No</td>
</tr>
</tbody>
</table>

8. On the **Locale Assignments** tab, click **Actions > Create**, and complete the fields as shown in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Country</td>
<td>United States</td>
</tr>
<tr>
<td>Language</td>
<td>American English</td>
</tr>
</tbody>
</table>

**Note:** The application selects a name style format to display name components based on your Locale Assignment preferences. You can set either Country or both Country and Language as locale. However, you can't set only Language as locale. If no locale exists for a country and language setting, the default name style code (the name style code with the Default Format for Style option set to Yes) is used.

9. Click **Save and Close**.

**Related Topics**
- How can I create a name style format layout?
- How can I create another variation of a Name Style Format?

**FAQs for Define Data Formats**

**How can I create an address style format layout?**

Click New in the Manage Address Formats page and add address lines in the Format Variation Layout section. If you require more than one address style format layout, then you can create a format variation and add a different address format layout.
How can I create a variation of an Address Style Format?

You can create different variations of an address style format, with each variation having its own layout. For example, a country's postal address may have variations such as general postal address, rural address, and military address. When you create an address style format, the layout defined for the format is assigned as the default variation. Click **Add** in the Format Variation region of the Edit Address Style Format page, for the address style format, to add a variation of the Address style. For each address style format variation, you can enter a variation rank to define the priority of the variation.

How can I create a name style format layout?

Click **New** in the Manage Name Formats page and add line entries for each part of the full name in the Format Variation Layout section, within the Create Name Style Format page. If you require more than one name style format layout, then you can create a format variation and add a different name format layout.

How can I create another variation of a Name Style Format?

You can create different variations of a name style format, with each variation having its own layout. For example, different regions in a country may have different name style formats. Click **Add** in the Format Variation region in the Edit Name Style Format page, for the name style format, to add a variation of the name style. For each name style format variation, you can enter a variation rank to define the priority of the variation.
13 Contact Points

Telephone Numbering Plan

A telephone numbering plan defines the pattern of digits for a country phone number. It defines the country-specific components of phone numbers, display format styles, and codes. The codes include country codes, international prefixes, area codes within a country, and mobile prefixes.

You can specify country-specific mobile prefixes to determine if a phone number is mobile or not. You can also create multiple telephone number display formats for a country. For example, for the US phone format, you define the phone country code as 01, fixed area code as three numbers in length, and subscriber number as seven digits in length. You can create a telephone format for domestic display, such as (999) 999-9999, and a format for international display, such as 999-999-9999.

Update Telephone Numbering Plans

You can update telephone number plans from the Manage Phone Numbering Plans page. You can't edit the country information if the country has area codes, mobile prefixes, or phone formats defined.

To update telephone number plans:

1. In the Setup and Maintenance work area, go to the following:
   - Offering: Customer Data Management
   - Functional Area: Trading Community Foundation
   - Task: Manage Phone Numbering Plans

   The Manage Phone Numbering Plans page opens.

2. Search for the country whose telephone number plan you want to update. For example, to search for the United States, select United States in the Country Code list or enter 1 in the Phone Country Code field.

3. Select the country and click Edit to view the Edit Phone Numbering Plan page.

4. You can edit the following country-specific phone information in the Scheme section:
   - Trunk Prefix: The code to dial before long distance numbers within the country, for example 1 for the US.
   - International Prefix: The code to dial before international numbers when calling from the country that you're setting up, for example 011 for the US.
   - Subscriber Number Length: The length of the subscriber number for countries where the subscriber length is fixed.
   - Area Code Length: The length of the area code for countries where the area code length is fixed.

5. You can edit the following regional phone number information for the country in the Regional Information section:
   - Area Codes: Lets you define area codes that you want to use for the country.
Mobile Prefixes: Lets you define mobile prefixes that you want to use for this country. Mobile prefixes contain the area code and possible prefixes of the subscriber number. For example, the mobile prefix of 650506 consists of the 650 area code and the 506 subscriber number prefix.

Telephone Number Formats: Lets you define multiple telephone number display formats for a country.

6. Click **Save and Close** to save your updates.

**Related Topics**

- Why can't I update the country information section in the Edit Telephone Numbering page?

---

## How Telephone Number Plans Setup Fits in with other Setup Tasks

Telephone Numbering Plans define the telephone number format for a country. You can define multiple formats for a country depending on the requirements.

Phone number format, along with the other country-specific location information such as address and name formats, defines geographic-specific data formats. You can manage telephone number plans in the Manage Telephone Numbering Plans page.

The application uses the telephone number formats to display phone number in the appropriate style, and to validate phone numbers. You can define country-specific components of phone numbers, display format styles, and area codes. The application uses the phone formats to correctly parse phone numbers and determine the correct format style for displaying phone numbers in user interfaces.

The application validates phone numbers for a country, based on the format defined for the country. The phone numbers are also validated against a common set of rules that apply to all countries. You can also enter time zone information for a country, at the country code and area code level. The time zone information is validated against the time information defined for the country.

---

## FAQs for Define Contact Points

### Why can't I update the country information section in the Edit Telephone Numbering page?

You can't update the country information if regional information such as area codes, mobile prefixes, and phone formats are defined for the country.

**Related Topics**

- Update Telephone Numbering Plans
How can I assign relationships when creating a contact point for a contact or an account?

When you create a contact point either for a contact in the Contact’s Profile page or for an account in the Account's Contacts page, you can select the associated relationships using the Customer Relationship LOV.
14 Import Your Data

Data Import Options

You can import your data from an external application into Oracle Applications Cloud in several different ways, including using public web services.

Which import method you use depends on the type of data you’re importing, the volume of data, and technical requirements. If you’re integrating one cloud service with other cloud services, then you must use additional import methods as described in the appropriate guides.

When you’re importing data for a particular object, you must make sure that any prerequisite objects already exist in the application. For example, if you’re importing contacts for an account, then the account must already exist in the application. If one import job depends on the contents of another import job, then complete the prerequisite job before starting the dependent job. For example, if you’re importing both accounts and opportunities, then import accounts before importing opportunities.

The following table lists the import methods and references to further information.

<table>
<thead>
<tr>
<th>Import Method</th>
<th>Description</th>
<th>When to Use</th>
<th>How to Access</th>
<th>For More Information</th>
</tr>
</thead>
</table>
| Quick Import Excel Macros     | You can use the import macros to speed up and simplify the import of up to 5000 records at a time for some objects. They validate your data entries, provide list of values, and automatically populate constant values. The macros create data files that are automatically imported using Import Management. You can import the following objects using import macros:  
  - Sales Users  
  - Products and product groups  
  - Accounts  
  - Contacts  
  - Account Hierarchy  
  - Leads  
  - Opportunities | These are best to import data in your initial deployment.  
The macros are targeted to the simple proof of concept sales automation use case covered in the Importing Sales Users chapter of the Getting Started with Your Sales Implementation guide. For example, the import macros assume that you’re importing account, contact, and lead records for one country at a time. The macros generate log files with information about the File Import job, and these log files can also serve as a learning tool for more complex import. | You can download the Excel macros and any required mapping files from the Getting Started with Your Implementation: Quick Import Macros (Document ID 2229503.1) article on My Oracle Support. | The chapters in the Getting Started with Your Sales Implementation guide provide detailed instructions and video tutorials for using the macros.  
For instructions on how to add your own fields to the macros, see, How to Configure Quick Import Macro for importing Employee Resources (Doc ID 2364229.1) article on My Oracle Support. |
<p>| Import Management             | Import Management improves definition, error                                | Use Import Management for importing outside                                                                                                                                                    | Click Import Management in the Navigator.                                                                                      | See the Understanding Import and Export                                                                                   |</p>
<table>
<thead>
<tr>
<th>Import Method</th>
<th>Description</th>
<th>When to Use</th>
<th>How to Access</th>
<th>For More Information</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>handling, and performance for importing flat files (.CSV). For example, Import Management has drag and drop mapping capabilities and validates the first ten records in your data file before you import to ensure the data meets the import constraints of the various attributes. Import Management is available for importing data for the following application objects and their child objects: • Access Groups • Account • Action • Action Plan • Activity • Address • Asset • Attachment • Business Plan • Campaign • Case • Classification • Classification Code • Competitor • Consumer • Contact • Contract • Contests • Country Structure • Deal Registration • Hierarchy • Hierarchy Member • Household • Hub Source System Reference • Incentive Rule Assignments • Incentive Rule Attribute Values</td>
<td>the scope of the Getting Started with Your Implementation guide.</td>
<td>Management guide for instructions on using the import.</td>
<td></td>
</tr>
</tbody>
</table>
## Import Your Data

<table>
<thead>
<tr>
<th>Import Method</th>
<th>Description</th>
<th>When to Use</th>
<th>How to Access</th>
<th>For More Information</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• Incentive Rules</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Incentive Transaction</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Interaction</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• MDF Budget</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• MDF Claim</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• MDF Request</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Note</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Objective</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Opportunity</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Organization</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Partner</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Partner Program</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Person</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Price Book Header</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Product</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Product Group</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Program Enrollment</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Promotion</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Queue</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Relationship</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Resource</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Resource Capacity</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Sales Lead</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Sales Order</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Sales Territory</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Sales Territory Quota</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Self-Service Role</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Service Request</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Standard Text</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Standard Text Folder</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Standard Text User Variable</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Subscription</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Template</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Template Action</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Territory Geographies</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Any additional objects you create</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

External Data Loader Client: Command-line tool that’s used to import high-Use this import method for importing very large-You can download the client from Oracle Support-Instructions for using the client are available in the

---

Oracle Fusion Cloud Sales Automation
Implementing Customer Data Management for CX Sales and B2B Service
<table>
<thead>
<tr>
<th>Import Method</th>
<th>Description</th>
<th>When to Use</th>
<th>How to Access</th>
<th>For More Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Volume Flat Source</td>
<td>Import Method</td>
<td>data files for the objects supported by Import Management.</td>
<td>Document 23252491 (External Data Loader Client) on My Oracle Support.</td>
<td>document and in the client itself.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>The chapter Import Data Using External Data Loader Client in the guide Understanding Import and Export Management for CX Sales and B2B Service provides information about using the External Data Loader Client.</td>
</tr>
<tr>
<td>Web Services</td>
<td>Web services are available for external client applications to start and monitor import jobs. You can manage Import Management jobs using REST web services, and File Import jobs using SOAP web services.</td>
<td>Use web services to manage import jobs to import directly from an external application.</td>
<td>Public APIs are available for both the Import Management/REST services and the File Import/SOAP services. The following REST APIs are available for import: Import Activities, Import Activity Maps, Import Export Objects Metadata The SOAP service is called the File Import Activity Service.</td>
<td>For REST API documentation, see the REST API for CX Sales and B2B Service guide. For SOAP API documentation, see the SOAP Web Services for CX Sales and B2B Service guide.</td>
</tr>
<tr>
<td>High-Volume Import</td>
<td>The high-volume import mode is designed to import millions of records at once. This mode doesn't trigger any custom logic configured through the application composer. This option is available for the following objects and their child objects: Account, Asset, Classification Code, Contact, Contract, Contract Line, Country Structure, Custom Object (custom top level objects and custom child objects), Geography</td>
<td>Use this import mode for importing very large number of records for the objects supported.</td>
<td>You can access High-Volume Import either using REST services or using External Data Loader Client. When importing using REST, set the “High-volume” attribute to enable this mode of import. When importing using the External Data Loader Client, set the command-line parameter “-high-volume” to enable this mode of import.</td>
<td>For REST API documentation, see the REST API for CX Sales and B2B Service guide. The chapter Import Data Using External Data Loader Client in the guide Understanding Import and Export Management for CX Sales and B2B Service provides information about using the External Data Loader Client.</td>
</tr>
</tbody>
</table>
## Import Your Data

<table>
<thead>
<tr>
<th>Import Method</th>
<th>Description</th>
<th>When to Use</th>
<th>How to Access</th>
<th>For More Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Hierarchy</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Hierarchy Member</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Household</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Hub Source System Reference</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Incentive Transaction</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Organization</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Person</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Sales Territory Quota</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Territory Geographies</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Note:** Object work flows can't be invoked using Import Management.

The following figure provides an architectural overview of the different import methods:

- File Import uses the SOA architecture to import data into Oracle CX Sales.
- Quick Import uses the REST Web services to import data into Oracle CX Sales. When you import data using the quick import Excel macros, you're creating an import activity in Import Management using the REST web services. The macro import creates the same import activity and uses the same mapping as you do when you initiate the import from the application. You can monitor each import in the macro or in the application itself.
- Both Import Management and the External Data Loader Client use the same scheduled processes for import. When you import very large files using the client, the REST APIs create multiple processes to respect the Import Management file size limit.
- To import from an external application, use the SOAP and REST web services directly.
Import Options and Flow

Related Topics

Import Attachments

You can import attachments associated with any supported object.
Supported Objects and File Types

The following objects support importing attachments:

- Account
- Activity
- Asset
- Business Plan
- Contact
- Custom Object
- Deal Registration
- Household
- Message
- Objective
- Opportunity
- Opportunity Revenue
- Partner
- Partner Program
- Product
- Sales Lead
- Sales Lead Product
- Service Request

The following file types are supported for attachment files:

- CSV
- DOC
- DOCX
- JPG
- PDF
- PNG
- PPTX
- TIF
- TEXT
- XLSX
- XML
- ZIP

How to Create ZIP File

To import an attachment, you must create a ZIP file that contains the source data file and optionally one or more attachment files. Make sure you always name the source file as 'Attachment.CSV'. You must mention each of the
attachment file names in the Attachment.CSV file. The Attachment.zip file has the structure shown in the following image:

Here are the examples for the attachment.csv file shown in purple box in the image above:

<table>
<thead>
<tr>
<th>Pk1Value</th>
<th>ObjId</th>
<th>FileName</th>
<th>Url</th>
</tr>
</thead>
<tbody>
<tr>
<td>100100004247330</td>
<td></td>
<td>Clouds.jpg</td>
<td><a href="http://www.yahoo.com">http://www.yahoo.com</a></td>
</tr>
<tr>
<td>100100004247330</td>
<td>100100004247330</td>
<td></td>
<td></td>
</tr>
<tr>
<td>100100004247330</td>
<td></td>
<td>Taxdocs.docx</td>
<td></td>
</tr>
</tbody>
</table>
Chapter 14
Import Your Data

<table>
<thead>
<tr>
<th>Pk1Value</th>
<th>ObjectPuid</th>
<th>FileName</th>
<th>Url</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>CDRM_6493</td>
<td></td>
<td><a href="http://www.google.com">http://www.google.com</a></td>
</tr>
<tr>
<td></td>
<td>CDRM_6493</td>
<td>Holidays.pdf</td>
<td></td>
</tr>
</tbody>
</table>

Pk1Value and ObjectPuid column values uniquely identify an existing object record. FileName indicates the name of attachment files. Url indicates the value of URL attachment to import.

**Note:** The attachment ZIP file name can include characters such as parenthesis ( ), ampersand (&), dots (.), and apostrophe (') only. You shouldn't have more than one period (.) in your attachment name. Also, the rootname.extension shouldn't be more than 80 characters.

An attachment can only be associated with an existing record of the object. A single record can be associated with multiple attachments by having multiple rows in the CSV file. You can import any number of attachments in an import job, but the ZIP file should not exceed 250 MB in size.

**Note:** A record in the CSV file can't have values for both FileName and Url columns. You can pass either the Primary key or the PUID for an object record. If you pass both Primary key and PUID values, then Primary key will be considered and PUID will be ignored.

How to Import Attachments

To import attachments:

1. Click **Tools > Import Management**.
2. On the **Manage Imports** page, click **Create Import Activity**.
3. On the Enter Import Options page, enter a name for your import. From the **Object** drop-down list select **Attachment**.
4. In the **Attachment Object** drop-down list that appears, select the object associated with the attachment.
5. Select the ZIP file that you created in the previous section.
6. Click **Next**. On the **Map Fields** page, click the **Apply** button next to the **Import Mapping** drop-down list to map the source and target attributes automatically.
7. Click **Next** to navigate to the **Review and Submit** page.

Review the import activity configuration and click **Submit** to activate the import. The **Manage Imports** page shows the status of the submitted import. The topic Import Data in the related topics section contains more details about the import process.

**Related Topics**
- Import Data
Import Data

Use Import Management from the Tools work area, to import data from text files. You can create, update, or delete records through import.

Use this topic as a guide to importing data. The import options and other details differ by the type of data that you’re importing. Before importing, understand how the data in your file maps to the attributes in Oracle Applications Cloud and what values are expected in the import file. The data records in the CSV source file may not be processed in the listed order. To learn how to monitor the status of your import, see the topic How You Monitor Your Import Activities in the Related Topics section.

**Note:** Don't submit duplicate import jobs for the same import object as they create duplicate object records.

To help you get started, you can use the example import object templates described in the related topics.

Import Data from a File

To import data:

1. Click **Tools > Import Management**.
2. On the **Manage Imports** page, click the **Create Import Activity** button.
3. On the **Enter Import Options** page provide values for each field as shown in the following table:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description of the value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the import.</td>
</tr>
<tr>
<td>Object</td>
<td>Object that you’re importing.</td>
</tr>
</tbody>
</table>

If you can't find your object, then search for it by clicking the **Search** link. In the **Search and Select** dialog box, enter the object name in the **Object** text box and click the **Search** button. Select your object from the result list and click **OK**.

You can also use the advanced search option by clicking the **Advanced** button. Here you can search based on various filter criteria such as object name, Attachment supported, creation date, and so on.

If the object you’re importing isn't listed then verify if you have the roles and privileges required to import the object. For information on the roles, see the topic Roles Required for Import and Export Management referenced in the Related Topics section.

| Attachment Object | To import an attachment for an existing object record in the database select the Attachments object from the **Object** drop-down list. Next select the object from the **Attachment Object** drop-down list. |

For more details on importing attachments, review the topic Import Attachments.
File Name

Browse and select a text file in CSV format. The first row of the source file is treated as the header row. Provide a file name within 40 characters.

Note:
If your source file has more than 50,000 records, then you must manually split the file into several smaller files with less than 50,000 records each. The file import page only permits 50,000 records for each import job. Alternatively, you can use the External Cloud Data Loader Client, which can accept files with more than 50,000 records. See the My Oracle Support (support.oracle.com) document External Data Loader Client (document ID 2325249.1) for more information about this tool.

Import Object Hierarchy

To import a hierarchy of objects, such as child and grandchild objects, click on the Import Object Hierarchy link after you upload the source file for the parent object. Next select the Enabled check box for the child object you want to import, and select the related source file.

4. Optionally, to set additional import configurations, click the Advanced Options section. Here you can configure settings under Source File, Import Options, or Create Schedule sections.

   a. In the Source File and Import Options regions, some of the options in the following table might not be available depending on the object that you’re importing:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Import Mode</td>
<td>You can specify whether you want to create and update records or update them only.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Update and create records</strong> - a new record is created if a matching record isn't found. This is the default option.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Create records</strong> - all the records in the file are new records which have to be created. If there are any existing matching records, then they're marked as errors.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Delete records</strong> - all the records in the file are deleted.</td>
</tr>
<tr>
<td>Enable High-Volume Import</td>
<td>The high-volume import mode is designed to import millions of records at once. This mode doesn't trigger any custom logic configured through the application composer. For a list of supported objects, see the topic Data Import Options.</td>
</tr>
<tr>
<td></td>
<td>By default, this mode is enabled for the supported objects.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> If ZCA_FILE_IMPORT_ENABLE_CUSTOM_BUSINESS_LOGIC is set to “Yes”, then you won't be able to use High Volume import.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Enable Survivorship</td>
<td>Survivorship on update is available for Account, Organization, Contact, and Person. The check box is visible if the attribute survivorship is configured on the objects. You can use high-volume import mode, only when the survivorship configuration uses only Source Confidence. You can’t use the high-volume import mode when Data Quality Rules are enabled.</td>
</tr>
<tr>
<td>Notification email</td>
<td>The email of the individual who receives import processing notifications. The user submitting the import receives an email notification automatically. To have more than one email recipient, separate the email addresses with a semicolon. If you don’t want to receive the notification, then set the profile option ORA_ZCA_IMPEXP_ENABLE_EMAIL_NOTIFY to ‘N’ at user level.</td>
</tr>
<tr>
<td>Enable Custom Business Logic</td>
<td>If you select this check box, then any custom triggers and validations configured for the object are enabled. This may affect import performance, because of configurations. Hence, disable this option for better performance.</td>
</tr>
<tr>
<td></td>
<td>To enable this check box by default, set the profile option ZCA_FILE_IMPORT_ENABLE_CUSTOM_BUSINESS.Logic to ‘Yes’ by navigating to the Manage Administrator Profile Values task.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> If ZCA_FILE_IMPORT_ENABLE_CUSTOM_BUSINESS.Logic is set to “Yes”, then you won’t be able to use High Volume import.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This selection has no effect on events and object workflows, and is applicable only on triggers and validations.</td>
</tr>
<tr>
<td>Delimiter</td>
<td>If your file doesn’t use a comma to separate values, then select the correct delimiter in the <strong>Delimiter</strong> drop-down list. Possible values are:</td>
</tr>
<tr>
<td></td>
<td>- Caret Symbol</td>
</tr>
<tr>
<td></td>
<td>- Closing Curly Bracket</td>
</tr>
<tr>
<td></td>
<td>- Closing Parenthesis</td>
</tr>
<tr>
<td></td>
<td>- Closing Square Bracket</td>
</tr>
<tr>
<td></td>
<td>- Colon</td>
</tr>
<tr>
<td></td>
<td>- Comma</td>
</tr>
<tr>
<td></td>
<td>- Exclamatory Mark</td>
</tr>
<tr>
<td></td>
<td>- Minus</td>
</tr>
<tr>
<td></td>
<td>- Opening Curly Bracket</td>
</tr>
<tr>
<td></td>
<td>- Opening Parenthesis</td>
</tr>
<tr>
<td></td>
<td>- Opening Square Bracket</td>
</tr>
</tbody>
</table>
### Option | Description
--- | ---
Pipe Symbol | 
Plus | 
Question Mark | 
Semi-Colon | 
Star Symbol | 
Tilde Symbol | 
Decimal Separator | The decimal separator used in your import file. |
Date Format | The format of the date fields in your file. |
Time Stamp Format | The format of the time fields in your file. |
File Encoding | The format in which your source file is encoded. The possible values are: Chinese Simplified - GB, CP936, Chinese Traditional - CP950, Eastern European - Win, CPI250, Greek - MS Windows, CP932, Japanese - Shift- JIS, CP932, Unicode - UTF-16, Unicode- UTF-16BE, Mac, Unix, Unicode - UTF-16LE, MS Windows, Unicode - UTF-8, Western European - Win, CP1252. **Note:** The above mentioned encoding formats are the only ones supported. Importing file with any other format, such as ANSI, will cause unexpected characters to be imported.

**b.** In the Create Schedule region, schedule the import to run immediately or at a future date. If you select a future date, then provide the date and time to start the import.

You can save the Advanced Options for subsequent reuse by clicking on the Save advance options link in the UI. The options will be retained till you click on the Reset link and reset the options to application defaults.

**Note:** All fields except Import Mode, Enable Custom business Logic, Enable High-Volume Import, Enable Survivorship Logic, Schedule Mode, and Schedule Start Time will be saved.

5. Click **Next.** The Map Fields page shows the first row of the data from your source file. By default, the application tries to automatically map each of the source file columns to the appropriate target object attribute.
If some of the columns in your file couldn’t be mapped, then drag the target attribute onto the **Attribute Display Name** column under the **Source File** region.

The data in unmapped columns aren't imported.

You can save your import map by clicking on **Save As** in the Create Import Activity page. You can use the saved map for future imports. You can view your saved maps by clicking on the **Import Mapping** dropdown in the Create Import Activity page.

Also, you can select and then edit your saved maps for the specific objects in the Import Objects page.

6. You select a predefined mapping from the list of available mappings under the **Import Mapping** drop-down list. If you're reusing an import mapping, then both the source and target columns are already populated.

Leave the **Attribute Display Name** field blank for any column that you don't want to import.

Click **Validate Data** to check the field mapping.

7. In the case of hierarchical import, you can see the mapping information for child objects in the subsequent tabs. Note that data validation isn't done for these objects.

8. Click **Next**. On the **Review and Submit** page, review the import activity configuration. If you had not run the prevalidation on the **Map Fields** page, then you get a notification message to run the validation process. You can view any unmapped columns of parent or child objects on this page.

9. Click **Validate Data** to check the data in your source file. Validation errors, if any, are displayed on the Mapping Validation screen. If you get warnings about unmapped columns, then you can ignore these columns, and proceed to submit the import job. Validations are for informational purposes and applicable only for low-volume imports.

**Note:** In import activity with single CSV hierarchical records, explicit validation from the mapping UI isn't supported. For example, while importing the sales territory object, if there are matching values for the attributes ParentUniqueTerritoryNumber and UniqueTerritoryNumber, then validation isn't supported.

**Note:** During the import validation process on the Mapping page, the following custom triggers aren't supported:

- After Changes Posted to Database
- Before Delete in Database
- Before Insert in Database
- Before Update in Database
- Before Rollback

10. Click **Submit** to queue the import.

Note that business events aren't fired when using Import Management.
Automating and Scheduling Import Jobs

You can automate import jobs using the import REST services. The import REST services let you manage import activities, manage activity maps, and export object metadata. You can use an external scheduler that uses these REST services to run recurring import jobs, create and run import activities, manage maps, and review object metadata.

You can use the Oracle WebCenter Content Document Transfer Utility to manage the import files used by the scheduler. You can download the Oracle WebCenter Content Document Transfer Utility by navigating to the My Oracle Support (support.oracle.com) document Oracle WebCenter Content Document Transfer Utility Readme (document ID 1624063.1). Once downloaded, you can run the tool by navigating to the ridc folder after extraction.

For detailed instructions on automating and scheduling file import using REST API, see Oracle CX Sales and B2B Service: Automating and Scheduling File Import Activity Using REST API (Doc ID 2308691.1) article on My Oracle Support (support.oracle.com).

Set Up Event Notifications for Resources

In file-based data import, the SendCredentialsEmailFlag attribute allowed the import to specify the notification setting for each employee resource. You can do this in Import Management using the User Category option but this applies to all resources in a single import.

To set up notifications for all events:

1. Navigate to Tools > Security Console on the home page.
2. Click the User Categories tab.
3. Click DEFAULT. Click the Notifications tab.
4. Click the Edit button. If you want to turn on all notifications, then select the Enable Notifications check box under the Notification Preferences heading.
5. Click the Save button.
6. Click the Done button.

To set up notifications for a specific event:

1. Navigate to Tools > Security Console on the home page.
2. Click the User Categories tab.
3. Click DEFAULT. Click the Notifications tab.
4. Click the Edit button.
5. If you want to turn on a specific event notifications, click the template for the desired event.
6. On the Template Information page, select the Enabled check box and click Save and Close.
7. Click the Save button.
8. Click the Done button.

Import FCLs and DCLs

You must pass #NULL value for the FCL field in order to nullify a value for an FCL using Import Management.

Here is an example to nullify TargetGlobalPJDdetailFlag1_c field:

<table>
<thead>
<tr>
<th>PartyId</th>
<th>TargetGlobalPJDetailFlag1_c</th>
</tr>
</thead>
<tbody>
<tr>
<td>100000001527765</td>
<td>#NULL</td>
</tr>
</tbody>
</table>
How You Enable Survivorship During Import

Survivorship on update is available for the following four Import Management objects:

- Account
- Organization
- Contact
- Person

You include the data that you want to import into CX Sales and B2B Service in a source CSV file. This CSV file depends upon the object you want to import. Before you start importing, check that the CSV file contains the SourceSystem value. For more information, see Import Your Account Data, Import Your Contact Data, Import Your Person Data, and Import Your Organization Data topics in this guide.

Enable Survivorship

After you have the CSV file ready, create an import activity to import the account information and enable survivorship as follows:

1. Go to Navigator > Tools > Import Management > Import Queue.
2. Click Create Import Activity in the Manage Imports page.
3. In the Enter Import Options page, provide a name for the import activity, and select either Account, Organization, Contact, or Person from the Object drop-down list.
4. Click to expand Advanced Options section.
5. Select Enable survivorship logic.

Note: This option is available only if the selected import object is Account, Organization, Contact, or Person and attribute survivorship has been already configured. High-Volume import mode is supported, if the survivorship configuration only uses Source Confidence. If Data Quality Rules are enabled, High-Volume mode import isn't available.

You can continue to import and review the import results.

You can then import data. For more information on how to import data, see Import Data topic in Related Topics section.
Import Data

Import Your Account Data

You can use Import Management to create, update, or delete your account data.

You can import account records using these steps:

1. Map your source account data to Oracle Applications Cloud object attributes. This way the import process would know where to insert each of the information bits.
2. Create the source CSV file with the account data you want to import.
4. Check the import results to know if the import went well.

How You Map Your Source Data to Target Object Attributes

You import account data into Oracle Applications Cloud from a CSV file containing your source data that’s mapped to target Oracle Applications Cloud object attributes.

You need to do the following before creating the .csv file for data import:

- Identify how your source data attributes map to the target object attributes in Oracle Applications Cloud.
- Ensure prerequisite steps are complete, such as understanding what attributes are required for importing your objects.
- Understand your options for uniquely identifying the records.
- Ensure parent records exist before importing child records.
- Identify the target object attributes that are required in the .csv file for a successful import.

Note: You can enable automatic territory-based assignment after sales accounts are imported. You can enable this feature by turning the profile option ZCA_BATCH_ASSIGN_ON_BULK_IMPORT ON. If the profile option is disabled, then you must manually run a batch assignment or assign each sales account individually.

To better manage your account information, the account object has the following child objects:

- Address
- Classification
- Relationship
- Sales Team Member
Note: You can’t set an attribute value to NULL in high-volume import (import management with the option Enable High-Volume Import selected). However, when updating a record, you can change an attribute value from NOT NULL to NULL.

If you’re importing account records with attributes specific to the parent account object or along with single child record details (like phone, email, address, and so on), then you can include the child record details in the same .csv file for account object. However, if you’re importing multiple records of any child object, then you must create multiple .csv files to import— one for each child which has multiple records that you’re importing. For example, if you’re importing 5 emails, 5 phones, and 5 addresses for an account, then you must create three import files - one for Account object, one for Contact Point object (phone and email), and one for Address object. There are separate help topics describing how to import each of these child objects. For more information, see the related topics section.

Note: High-volume import for accounts now supports hierarchy management and generation.

Before You Start
You must do some basic checks before starting your import. For example, make sure that:

- You have completed all the prerequisites for importing each attribute in your source data. For example, when using source system reference information to identify your account records, the source system of the account object should be enabled for parties using the Manage Trading Community Source Systems task.
- You have all parent records in place before importing child records. For example, when importing the address of an account, ensure the account exists.

Select a Unique Identifier for Your Records
All records must be unique in the application. You can use one of these to identify records:

- Public unique identifiers: If you’re creating records, then you can provide an easily understandable public unique identifier. These are, usually, denoted with 'Number' and visible in the business object’s UI. PUID attributes are usually named <object> Number. If you’re updating a record with a Number attribute, then use the Number attribute to identify the record. For account object, the attribute is PartyNumber and shows up in the UI as Party Number. For more information about public unique identifiers, see the topic "How You Use Alternate Keys to Import Records" in Related Topics section.
- Source system and source system reference: Source system is an identifier for the external system, and source system reference is a unique identifier within the external system. If you’re importing new accounts or are updating accounts that have source system reference data, then provide the source system and source system reference values. For account object, these are SourceSystem and SourceSystemReferenceValue and show up as Party Source System and Party Source System Reference Value in the UI.

Review Required Attributes and Validations for Account Object
To import data successfully into Oracle Applications Cloud, your CSV file must include the required attributes. Make sure that you provide valid values for these attributes so that they pass import validations inbuilt into the application.

This table lists the required attributes for account records, prerequisite setup tasks and specific validations, if any:
<table>
<thead>
<tr>
<th>Attribute</th>
<th>Description</th>
<th>Prerequisite Setup Tasks or Import Validations</th>
<th>Creating an Account Record</th>
<th>Updating an Existing Account Record</th>
<th>Deleting an Existing Account Record</th>
</tr>
</thead>
<tbody>
<tr>
<td>SourceSystem</td>
<td>The source system for the sales account.</td>
<td>Know the source system.</td>
<td>Conditionally Required</td>
<td>Conditionally Required</td>
<td>Conditionally Required</td>
</tr>
<tr>
<td></td>
<td></td>
<td>To view source systems, use the Manage Trading Community Source System task.</td>
<td>To identify an account record, use one of these:</td>
<td>To identify an account record, use one of these:</td>
<td>To identify an account record, use one of these:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• SourceSystem</td>
<td>• SourceSystem</td>
<td>• SourceSystem</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>and SourceSystemReferenceValue</td>
<td>and SourceSystemReferenceValue</td>
<td>and SourceSystemReferenceValue</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• PartyNumber</td>
<td>• PartyNumber</td>
<td>• PartyNumber</td>
</tr>
<tr>
<td>SourceSystemReferenceValue</td>
<td>The reference number or text representing the source system unique ID for the party (account or contact) to which the sales profile belongs.</td>
<td>Know the source system reference value.</td>
<td>Conditionally Required</td>
<td>Conditionally Required</td>
<td>Conditionally Required</td>
</tr>
<tr>
<td></td>
<td></td>
<td>To view the source systems reference, use the Manage Trading Community Source System task.</td>
<td>To identify an account record, use one of these:</td>
<td>To identify an account record, use one of these:</td>
<td>To identify an account record, use one of these:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• SourceSystem</td>
<td>• SourceSystem</td>
<td>• SourceSystem</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>and SourceSystemReferenceValue</td>
<td>and SourceSystemReferenceValue</td>
<td>and SourceSystemReferenceValue</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• PartyNumber</td>
<td>• PartyNumber</td>
<td>• PartyNumber</td>
</tr>
<tr>
<td>PartyNumber</td>
<td>The public unique identifier of the party.</td>
<td>The party must exist.</td>
<td>Conditionally Required</td>
<td>Conditionally Required</td>
<td>Conditionally Required</td>
</tr>
<tr>
<td></td>
<td></td>
<td>You get a list of all party IDs and party numbers by exporting the Party object.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>OrganizationName</td>
<td>The name of the party of the Organization party type.</td>
<td>Organization names are listed in the Resource Directory.</td>
<td>Required</td>
<td>Conditionally Required</td>
<td>Conditionally Required</td>
</tr>
<tr>
<td>OwnerPartyId</td>
<td>The identifier of the account owner.</td>
<td>This attribute is required only in import management, but optional in high-volume import.</td>
<td>Required</td>
<td>Not Required</td>
<td>Not Required</td>
</tr>
</tbody>
</table>

**Note:** Provide a valid value for the **DataFox Company ID** import attribute to integrate DataFox with CX Sales and B2B Service.

**Note:** When deleting or updating accounts, you must ensure that the account related to the party number provided has the Sales Account usage. If you provide the party number of an account that doesn't have the Sales Account usage, then the relationships for that account are also deleted. For example, if you provide the party number ORA17292 that doesn't have a Sales Account usage, then the related partners, contacts, and so on are also deleted.

For the extension child objects of account, RecordName field isn't unique. Hence you can't update the records only by passing RecordName.
You can use the profile option ORA_HZ_IMPORT_MULTI_ADDRESS_TYPE to control how address types are entered. By default, this profile option is set to Yes, so you can enter multiple address types, during high-volume import of Account, Contact, and Household objects. You can disable this profile option to improve the import performance. When you set this profile option to No, you can enter only a single address type.

**Note:** When importing accounts or legal entities, you can retrieve duplicates using the Customer Data Management Duplicates LOV only if you have licensed the data quality functionality. Once licensed, you must rebuild the keys for your matching configuration using the Manage Enterprise Data Quality Matching Configurations task. After the keys are rebuilt, the matching functionality uses the settings in the match configuration to identify duplicates.

Go to **Navigator > Tools > Import Management > Import Objects** to see all the attributes of the account object. The page also lists attribute information like type, length, description, and so on.

### Create the Source CSV File

You include the data that you want to import into CX Sales and B2B Service in a source CSV file. You can use the templates available in the Import Objects UI page to create the source CSV file. To download a template:

1. Go to **Navigator > Tools > Import Management > Import Objects**.
2. Select the **Account** object in the table and click **Download**.

You can now edit the downloaded file and provide valid values for the required attributes.

Providing the ZIP and Country Code values in the import CSV file won’t automatically populate the State/County/City fields. Values for these fields should be separately provided in the import file.

**Note:** For help in populating the CSV file and to avoid any issues in entering values, see the topic Potential Issues When Opening CSV Files With Excel in Related Topics section.

### Create the Import Activity

After you have the CSV file ready, create an import activity to import the account information. To create an import activity:

1. Go to **Navigator > Tools > Import Management > Import Queue**.
2. Click **Create Import Activity** in the Manage Imports page.
3. In the **Enter Import Options** page, provide a name for the import activity, and select Account from the **Object** drop-down list.
4. Select the CSV file in the **File Name** field, and click **Next**.
5. You would see that the source and target attributes are automatically mapped in the **Map Fields** page. Review and edit the mappings if required.
6. Check the file for unmapped columns or data format issues by clicking **Validate Data**. Click **Next**.
7. Review the import details on the **Review and Submit** page, and click **Submit** when you’re ready.

### Review the Import Results

Check if your import succeeded on the **Manage Imports** page. This page shows the status of all active, completed, and unsuccessful imports. To check the status of the import activity:

1. Go to **Navigator > Tools > Import Management > Import Queue**.
2. Click All Imports and search for the import activity that you created earlier.
3. Check the **Status** column for the import activity. The import is successful if the status displays as **Completed**. You can drill down on the import activity to go to the **Import Status** page which provides the status details of the import activity.

**Note:** After importing your data successfully, you need to run a couple of post processing jobs for duplicate identification, duplicate resolution, and account assignment. For more information on import management post processing jobs, see the topic: Import Management Post Processing for Accounts and Contacts.

When importing accounts using high-volume import, you can now load the account hierarchy data. Use the following attributes to import accounts using high-volume import:

- `ParentAccountPartyId`
- `ParentAccountPartyNumber`
- `ParentAccountSourceSystem`
- `ParentAccountSourceSystemReferenceValue`

**Note:** This is available only for low volume data and should not be used for high volume data.

You can load account hierarchy data. To load the account hierarchy data:

1. Load the account data without providing values for the parent attributes mentioned above.
2. Load the account hierarchy using the Hierarchy and Hierarchy Member import objects.

**Related Topics**

- **Import Data**
- **How You Use Alternate Keys to Import Records**
- **Potential Issues When Opening CSV Files in Excel**
- **How You Enable Automatic Account Assignment**

## Import Your Contact Data

You can use the Import Management to create, update, or delete contact records.

You can import contact records using these steps:

1. Map your source contact data to Oracle Applications Cloud object attributes. This way the import process would know where to insert each of the information bits.
2. Create the source CSV file with the contact data you want to import.
4. Check the import results to know if the import went well.

### How You Map Your Source Data to Target Object Attributes

To import your contact data into Oracle Applications Cloud, you must populate a .csv file with your source data and map that source data to target object attributes in Oracle Applications Cloud.
You must do the following before creating the .csv file for data import:

- Identify how your source data attributes map to the target object attributes in Oracle Applications Cloud.
- Ensure prerequisite steps are complete, such as understanding what attributes are required for importing your objects.
- Understand your options for uniquely identifying the records.
- Ensure parent records exist before importing child records.
- Identify the target object attributes that are required in the .csv file for a successful import.

To better manage your contact information, the contact object has the following child objects:

- Address
- Classification
- Relationship
- Sales Team Member

**Note:** You can't set an attribute value to NULL in optimized import (standard import with the option Enable High-Volume Import selected). However, when updating a record, you can change an attribute value from NOT NULL to NULL.

If you want to import only a few records, then you can create a single CSV file for all contact attributes. However if you want to import a large number of records, then you may decide to create multiple CSV files, one for each of the contact child objects. Note that you must have imported the CSV file for contact object successfully before trying to import the CSV files for the child objects. There are separate help topics describing how to import each of these child objects. For more information, see the related topics section.

**Before You Start**

You must do some basic checks before starting your import. For example, make sure that:

- You have completed all the prerequisites for importing each attribute in your source data.
- You have all parent records in place before importing child records.

**Select a Unique Identifier for Your Records**

All records must be unique in the application. You can use one of these to identify records:

- Public unique identifiers: If you're creating records, then you can provide an easily understandable public unique identifier. These are, usually, denoted with 'Number' and visible in the business object's UI. PUID attributes are usually named `<object>` Number. If you're updating a record with a Number attribute, then use the Number attribute to identify the record. For more information about public unique identifiers, see the topic "How You Use Alternate Keys to Import Records" in Related Topics section.
- Source system and source system reference: Source system is an identifier for the external system, and source system reference is a unique identifier within the external system. If you’re importing new contacts or are updating contacts that have source system reference data, then provide the source system and source system reference values.
### Required Attributes and Validations for the Contact Object

To import data successfully into Oracle Applications Cloud, your .csv file must include the required attributes. Ensure that you provide valid values for the attributes.

This table lists the required attributes for contact records, prerequisite setup tasks and specific validations, if any:

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Description</th>
<th>Prerequisite Setup Task or Import Validations</th>
<th>Creating a Contact Record</th>
<th>Updating an Existing Contact Record</th>
<th>Deleting an Existing Contact Record</th>
</tr>
</thead>
</table>
| **SourceSystem**    | The code representing the source system for the contact.                    | Identify the source system or configure source systems either by using the Manage Trading Community Source System task, or by importing the source system information into Oracle Applications Cloud using the Source System Reference import object. | Conditionally Required For uniquely identifying a contact record, provide one of the following reference information:  
  • SourceSystem and SourceSystemReferenceValue  
  • PartyNumber | Conditionally Required For uniquely identifying a contact record, provide one of the following reference information:  
  • SourceSystem and SourceSystemReferenceValue  
  • PartyNumber | Conditionally Required For uniquely identifying a contact record, provide one of the following reference information:  
  • SourceSystem and SourceSystemReferenceValue  
  • PartyNumber |
| **SourceSystemReferenceValue** | The reference number or text representing the source system unique ID for the contact. | Identify the source system or configure source systems either by using the Manage Trading Community Source System task, or by importing the source system information into Oracle Applications Cloud using the Source System Reference import object. | Conditionally Required For uniquely identifying a contact record, provide one of the following reference information:  
  • SourceSystem and SourceSystemReferenceValue  
  • PartyNumber | Conditionally Required For uniquely identifying a contact record, provide one of the following reference information:  
  • SourceSystem and SourceSystemReferenceValue  
  • PartyNumber | Conditionally Required For uniquely identifying a contact record, provide one of the following reference information:  
  • SourceSystem and SourceSystemReferenceValue  
  • PartyNumber |
| **PartyNumber**     | The public unique identifier of the contact.                                 | No prerequisite tasks                          | Conditionally Required                                                                  | Conditionally Required             | Conditionally Required             |
| **FirstName**       | First name of a person party.                                               | No prerequisite tasks                          | Required                                                                                | Not required                       | Not required                       |
| **LastName**        | Last name of a person party.                                                | No prerequisite tasks                          | Required                                                                                | Not required                       | Not required                       |

**Note:** For the **Time Zone** import attribute, specify the time zone of the contact to know the preferred time to call or send e-mail to the contact.
You can use the profile option ORA_HZ_IMPORT_MULTI_ADDRESS_TYPE to control how address types are entered. By default this profile option is set to Yes, so you can enter multiple address types, during high-volume import of Account, Contact, and Household objects. You can disable this profile option to improve the import performance. When you set this profile option to No, you can enter only a single address type.

Go to Navigator > Tools > Import Management > Import Objects, to see all the attributes of the contact object. The page also lists attribute information like type, length, description, and so on.

Create the Source CSV File

You include the data that you want to import into CX Sales and B2B Service in a source CSV file. You can use the templates available in the Import Objects UI page to create the source CSV file. To download a template:

1. Go to Navigator > Tools > Import Management > Import Objects.
2. Select the Contact object in the table and click Download.

You can now edit the downloaded file and provide valid values for the required attributes.

Providing the ZIP and Country Code values in the import CSV file won’t automatically populate the State/County/City fields. Values for these fields should be separately provided in the import file.

| Note: | For help in populating the CSV file and to avoid any issues in entering values, see the topic Potential Issues When Opening CSV Files With Excel in Related Topics section. |

Create the Import Activity

After you have the CSV file ready, create an import activity to import the contact information. To create an import activity:

1. Go to Navigator > Tools > Import Management > Import Queue.
2. Click Create Import Activity in the Manage Imports page.
3. In the Enter Import Options page, provide a name for the import activity, and select Contact from the Object drop-down list.
4. Select the CSV file in the File Name field, and click Next.
5. You would see that the source and target attributes are automatically mapped in the Map Fields page. Review and edit the mappings if required.
6. Check the file for unmapped columns or data format issues by clicking Validate Data. Click Next.
7. Review the import details on the Review and Submit page, and click Submit when you're ready.

Review the Import Results

Check if your import succeeded on the Manage Imports page. This page shows the status of all active, completed, and unsuccessful imports. To check the status of the import activity:

1. Go to Navigator > Tools > Import Management > Import Queue.
2. Click All Imports and search for the import activity that you created earlier.
3. Check the Status column for the import activity. The import is successful if the status displays as Completed. You can drill down on the import activity to go to the Import Status page which provides the status details of the import activity.

| Note: | After importing your data successfully, you need to run a couple of post processing jobs for duplicate identification, duplicate resolution, and account assignment. For more information on import management post processing jobs, see the topic: Import Management Post Processing for Accounts and Contacts. |
Import Your Country Structure Data

You can use Import Management to create Country Structure records. It is recommended you use Import Management only if you’re importing high-volume third-party data.

If you’re importing licensed data from one of our vendors, then you can create the country structure by navigating to **Setup and Maintenance > Manage Geographies Task** page.

To import Country Structure records, perform the following tasks:

1. Map your source data to Oracle Applications Cloud object attributes.
2. Create source Comma Separated Values (CSV) file for import.
3. Create the import activity.
4. Review the import results.

How You Map Your Source Data to Target Object Attributes

To import your Country Structure data into Oracle Applications Cloud, you need to populate a CSV file with your source data and map that source data to target object attributes in Oracle Applications Cloud.

You need to do the following before creating the CSV file for data import:

- Identify how your source data attributes map to the target object attributes in Oracle Applications Cloud.
- Identify the target object attributes that are required in the CSV file for a successful import.

Required Attributes and Validations for Country Structure Object

To import data successfully into Oracle Applications Cloud, your CSV file must include values for the required attributes. This table lists the required attributes for importing new Country Structure records, prerequisite setup tasks for the attributes, and specific validations, if any, for Country Structure import:

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Description</th>
<th>Prerequisite Setup Task / Import Validations</th>
<th>Creating a Country Structure Record</th>
</tr>
</thead>
<tbody>
<tr>
<td>CountryCode</td>
<td>The code for the country for which the country structure is applicable.</td>
<td>The GeographyType has to be “Country” and the LevelNumber has to be “1” for a country. You can’t pass different country codes when importing a record.</td>
<td>Yes</td>
</tr>
<tr>
<td>GeographyType</td>
<td>Geopolitical divisions such as Country, State, City, and so on. For example, for US the different geography types would be State, County, City, and Postal Code. For India, the different geography types would be State, District,</td>
<td>The country has to be present.</td>
<td>Yes</td>
</tr>
</tbody>
</table>
You can view the Country Structure object and its attributes in the Manage Import Objects page of the Import Management flow. You can find attribute information like type, length, description, and so on, on the Manage Import Objects page. You can view the list of valid values for country codes in the UI by navigating to the Manage Geographies task and searching with % as the Country Code value. For more information on Geographies, see Overview of Geographies, Geographic Entities, and Locations in the Related Topics section.

**Note:** Note the following:
- The import job will fail if you try to load any already existing country structure. Delete the existing country structure in the UI in Manage Geographies Tasks and import again.
- You can't load additional lower geography structure levels for an existing country structure while importing geography country structure. You can add additional geography levels in the UI for an existing country structure in the Manage Geographies task page.

### Create the Source CSV File

You include the data that you want to import into Oracle Applications Cloud in a source CSV file.

You can use the templates available in the Import Objects UI page to create the source CSV file. To download a template:

1. Go to **Navigator > Tools > Import Management > Import Objects**.
2. Select the **Country Structure** object in the table and click **Download**.

You can now edit the downloaded file and provide values for the required attributes.

**Note:** For help in populating the CSV file and to avoid any issues in entering values, see the topic Potential Issues When Opening CSV Files With Excel in Related Topics section.

### Create the Import Activity

After you have the CSV file ready, create an import activity to import the information. To create an import activity:

1. Go to **Navigator > Tools > Import Management > Import Queue**.
2. Click **Create Import Activity** in the **Manage Imports** page.
3. In the **Enter Import Options** page, provide a name for the import activity, and select Country Structure from the **Object** drop-down list.
4. Select the CSV file in the **File Name** field, and click **Next**.
5. You would see that the source and target attributes are automatically mapped in the **Map Fields** page. Review and edit the mappings if required.
6. Click **Validate Data** to check the file for unmapped columns or data format issues. Click **Next**.
7. Review the import details on the Review and Submit page, and click Submit when you’re ready.

Review the Import Results
Check if your import succeeded on the Manage Imports page. This page shows the status of all active, completed, and unsuccessful imports. To check the status of the import activity:

1. Go to Navigator > Tools > Import Management > Import Queue.
2. Click All Imports and search for the import activity that you created earlier.
3. Check the Status column for the import activity. The import is successful if the status displays as Completed. You can drill down on the import activity to go to the Import Status page which provides the status details of the import activity. Here, you can download and review the successfully imported user data records, the mapping details used for import activity, and the data file that you provided in CSV format.

Related Topics
- Overview of Geographies, Geographic Entities, and Locations
- Geography Validation
- Import Data
- Potential Issues When Opening CSV Files in Excel

Example of Importing Country Structure Data
You use the country structure of a country to define which geography types are part of the country and how the geography types are hierarchically related within the country.

For example, you can create geography types called State, City, and Postal Code. Then you can rank the State geography type as the highest level within the country, the City as the second level, and the Postal Code as the lowest level within the country structure.

To add a country structure using import management, your source file must contain information about the country to which the country structure belongs. You can view the list of valid values for country codes in the UI by navigating to the Manage Geographies task and searching with % as the Country Code value. You also need to specify the level at which the geography types need to be placed. By default, all countries are at Level 1. You create the country structure by increasing the level number as you go down the country structure. You place the geography types such as states, provinces, and so on at Level 2, districts or counties at Level 3, and so on. To add a country structure, your source file must include the values that let the import process identify the existing records.

Sample Input CSV File
You include the data that you want to import into CX Sales and B2B Service in a source CSV file. Here is a sample input CSV file for country as US.

<table>
<thead>
<tr>
<th>CountryCode</th>
<th>LevelNumber</th>
<th>GeographyType</th>
</tr>
</thead>
<tbody>
<tr>
<td>US</td>
<td>1</td>
<td>COUNTRY</td>
</tr>
<tr>
<td>US</td>
<td>2</td>
<td>STATE</td>
</tr>
<tr>
<td>US</td>
<td>3</td>
<td>COUNTY</td>
</tr>
</tbody>
</table>
Here is another input CSV file for importing the country structure for India.

<table>
<thead>
<tr>
<th>CountryCode</th>
<th>LevelNumber</th>
<th>GeographyType</th>
</tr>
</thead>
<tbody>
<tr>
<td>IN</td>
<td>1</td>
<td>COUNTRY</td>
</tr>
<tr>
<td>IN</td>
<td>2</td>
<td>STATE</td>
</tr>
<tr>
<td>IN</td>
<td>3</td>
<td>DISTRICT</td>
</tr>
<tr>
<td>IN</td>
<td>4</td>
<td>CITY</td>
</tr>
<tr>
<td>IN</td>
<td>5</td>
<td>POSTAL CODE</td>
</tr>
</tbody>
</table>

In case you want to import the country structure for Mexico, your input CSV file would look like this:

<table>
<thead>
<tr>
<th>CountryCode</th>
<th>LevelNumber</th>
<th>GeographyType</th>
</tr>
</thead>
<tbody>
<tr>
<td>MX</td>
<td>1</td>
<td>COUNTRY</td>
</tr>
<tr>
<td>MX</td>
<td>2</td>
<td>STATE</td>
</tr>
<tr>
<td>MX</td>
<td>3</td>
<td>MUNICIPALITY</td>
</tr>
<tr>
<td>MX</td>
<td>4</td>
<td>LOCALITY</td>
</tr>
<tr>
<td>MX</td>
<td>5</td>
<td>POSTAL CODE</td>
</tr>
</tbody>
</table>

In this example, we are importing the Country Structure for US. You must create a source file (CSV) file with the attributes as shown in this table and import it using Import Management.

<table>
<thead>
<tr>
<th>Attribute Name</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CountryCode</td>
<td>US</td>
<td>The code for the country for which the country structure is applicable.</td>
</tr>
</tbody>
</table>
Create an import activity to import the information. To create an import activity:

1. Go to Navigator > Tools > Import Management > Import Queue.
2. Click Create Import Activity in the Manage Imports page.
3. In the Enter Import Options page, provide a name for the import activity, and select Country Structure from the Object drop-down list.

   **Note:** In the Advanced Options section, the option Enable High-Volume Import is selected by default. This mode is designed to import millions of records at once.

4. Select the CSV file in the File Name field, and click Next.
5. The source and target attributes are automatically mapped in the Map Fields page. Review and edit the mappings if required.
6. Check the file for unmapped columns or data format issues by clicking Validate Data. Click Next.
7. Review the import details on the Review and Submit page, and click Submit.

### Import Your Geography Data

You can use Import Management to create Geography records. You can also add alternate name or code to existing geographies with import. For more information see Example of Importing Geography Data in the Related Topics section.

To import Geography records, perform the following tasks:

1. Map your source data to Oracle Applications Cloud object attributes.
2. Create source Comma Separated Values (CSV) file for import.
3. Create the import activity.
4. Review the import results.

### How You Map Your Source Data to Object Attributes

To import your Geography data into Oracle Applications Cloud, you must populate a .csv file with your source data and map that source data to target object attributes in Oracle Applications Cloud.
You need to do the following before creating the CSV file for data import:

- Identify how your source data attributes map to the target object attributes in Oracle Applications Cloud.
- Create Country Structure before importing Geography data. For information on how to create Country Structure, see Import Your Country Structure and Example of Importing Country Structure in Related Topics Section.
- Identify the target object attributes that are required in the CSV file for a successful import as mentioned in the table Required Attributes and Validations for the Geography Object below.

Before You Start
You must do some basic checks before starting your import. For example, make sure that:

- You have completed all the prerequisites for importing each attribute in your source data such as creating a country structure.

Required Attributes and Validations for the Geography Object
To import data successfully into Oracle Applications Cloud, your CSV file must include the required attributes. Ensure that you provide values for the attributes. The following table lists the required attributes for importing new Geography records, prerequisite setup tasks for the attributes, and specific validations, if any, for Geography import:

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Description</th>
<th>Prerequisite Setup Task/ Import Validations</th>
<th>Creating a Geography Record</th>
</tr>
</thead>
<tbody>
<tr>
<td>CountryCode</td>
<td>The code of the country to which the geography belongs.</td>
<td>This is validated against the country structure to check if the structure is defined for this country.</td>
<td>Required</td>
</tr>
<tr>
<td>PrimaryGeographyName</td>
<td>The primary name of the geography.</td>
<td>This is validated against the name of country if geography type is ‘Country’ or LevelNumber is 1.</td>
<td>Required</td>
</tr>
<tr>
<td>RecordTypeCode</td>
<td>The record type code that represents the intent of the import data. The values are:</td>
<td>No Validation</td>
<td>Required</td>
</tr>
<tr>
<td></td>
<td>• 0 - indicates the geography that already exists in the base table.</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• 1 - indicates the intent to create a new geography.</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• 2 - indicates the intent to add an alternate identifying name or code to an existing geography.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>LevelNumber</td>
<td>The level number of the geography in the hierarchy. For example, Country is at Level 1 and State (California) is at Level 2.</td>
<td>The level should exist in the country structure.</td>
<td>Required</td>
</tr>
</tbody>
</table>
Import Your Data

### Attribute | Description | Prerequisite Setup Task / Import Validations | Creating a Geography Record
---|---|---|---
SourceID | The source ID for the geography, along with the parent source ID is used to identify the geography parent and child relationship within the source file data and the interface table data. | None | Required
ParentSourceID | The parent source ID for the geography, along with the source ID is used to identify the geography’s parent and child relationship with records within the source file data. This should be null for the country record, as Country is at the top of the hierarchy. | None | Required

You can view the Geography object and attributes in the Manage Import Objects page of the Import Management flow. You can find attribute information like type, length, description, and so on, on this Manage Import Objects page.

**Note:** Keep a note of the following:

- You can't update geographies via import. Alternatively, you can add alternate name or alternate code for a country from the UI.
- Before adding a new alternate name, make sure that the alternate name does not exist with the same value for any other geography name.
- You can enable high-volume import for the Geography import object in the Manage Import Objects page.
- PrimaryGeographyCodeType and PrimaryGeographyCode can't be added after PrimaryGeographyName is created via import. You must create them together. Alternatively, you can add primaryGeographyCodeType and PrimaryGeographyCode from the UI after the import is complete.

### Create the Source CSV File

You include the data that you want to import into CX Sales and B2B Service in a source CSV file.

You can use the templates available in the Import Objects UI page to create the source CSV file. To download a template:

1. Go to **Navigator > Tools > Import Management > Import Objects**.
2. Select the **Geography** object in the table and click **Download**.

You can now edit the downloaded file and provide valid values for the required attributes.

**Note:** For help in populating the CSV file and to avoid any issues in entering values, see the topic **Potential Issues When Opening CSV Files With Excel** in Related Topics section.
Create the Import Activity

After you have the CSV file ready, create an import activity to import the information. To create an import activity:

1. Go to Navigator > Tools > Import Management > Import Queue.
2. Click Create Import Activity in the Manage Imports page.
3. In the Enter Import Options page, provide a name for the import activity, and select Geography from the Object drop-down list.
4. Select the CSV file in the File Name field, and click Next.
5. The source and target attributes are automatically mapped in the Map Fields page. Review and edit the mappings if required.
6. Check the file for unmapped columns or data format issues by clicking Validate Data. Click Next.
7. Review the import details on the Review and Submit page, and click Submit when you’re ready.

Review the Import Results

Check if your import succeeded on the Manage Imports page. This page shows the status of all active, completed, and unsuccessful imports. To check the status of the import activity:

1. Go to Navigator > Tools > Import Management > Import Queue.
2. Click All Imports and search for the import activity that you created earlier.
3. Check the Status column for the import activity. The import is successful if the status displays as Completed. You can drill down on the import activity to go to the Import Status page which provides the status details of the import activity.

Note: Geography names aren’t translatable and are always displayed in the same language in which they were loaded irrespective of the language of the signed in user. If you need different options of display, you can use the alternative names option.

Related Topics
- Import Your Country Structure Data
- Import Data
- Potential Issues When Opening CSV Files in Excel
- Example of Importing Country Structure Data
- Example of Importing Geography Data

Example of Importing Geography Data

This example demonstrates how to import data using Import Management.

In this example, you have a source file containing geography data that you want to import into the application to make the geography data available for real time address validation and tax purposes. A geography is any region with a boundary around it, regardless of its size. It might be a state, a country, a city, a county, or a ward.

Summary of the Tasks

You perform the following steps to create an import activity and activate the import:

1. Determine what information is in the source file.
2. Create and schedule the import activity.

**Before You Start**

1. You use the country structure of a country to define which geography types are part of the country. For more information about an example of importing a country structure, see the topic “Example of Importing Country Structure Data”.
2. Ensure that Source ID values are unique for each row of data within a single import.
3. Ensure that all the parents of a child geography are included in your data file so that the child geography can be added. For example, if you originally imported US, CA, and San Francisco, and now you want to import the city of San Jose in CA, then your data file must include US, CA, and San Jose.
4. Check that your source data file has the correct values for the geography data that you have already loaded. For example, if your initial import included the value US for country and CA as state, and in a subsequent import you have California as a state, then your geography import creates two state records (CA and California) in the application data, with the US as the country parent.

**Determine the Information in the Source File**

The source geography data files must include a unique Source ID value for each row of data and Parent Source ID value for the parent of that row of data. You include the data that you want to import into CX Sales and B2B Service in a source CSV file. A sample input CSV file for country as US is shown in this table.

<table>
<thead>
<tr>
<th>RecordTypeCode</th>
<th>PrimaryGeography</th>
<th>CountryCode</th>
<th>LevelNumber</th>
<th>SourceId</th>
<th>ParentSourceId</th>
<th>LanguageCode</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>United States</td>
<td>US</td>
<td>1</td>
<td>1</td>
<td>&lt;blank&gt;</td>
<td>US</td>
</tr>
<tr>
<td>1</td>
<td>California</td>
<td>US</td>
<td>2</td>
<td>11</td>
<td>1</td>
<td>US</td>
</tr>
<tr>
<td>1</td>
<td>San Mateo</td>
<td>US</td>
<td>3</td>
<td>111</td>
<td>11</td>
<td>US</td>
</tr>
<tr>
<td>1</td>
<td>Redwood City</td>
<td>US</td>
<td>4</td>
<td>1111</td>
<td>111</td>
<td>US</td>
</tr>
<tr>
<td>1</td>
<td>94065</td>
<td>US</td>
<td>5</td>
<td>11111</td>
<td>1111</td>
<td>US</td>
</tr>
</tbody>
</table>

Here is a sample CSV file to import geographies with alternate name and code for country India:

<table>
<thead>
<tr>
<th>RecordType</th>
<th>PrimaryGeography</th>
<th>CountryCode</th>
<th>LevelNumber</th>
<th>SourceId</th>
<th>ParentSourceId</th>
<th>IdentifierType</th>
<th>IdentifierSubT</th>
<th>IdentifierValue</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>India</td>
<td>IN</td>
<td>1</td>
<td>1</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>Karnataka</td>
<td>IN</td>
<td>2</td>
<td>2</td>
<td>1</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>Bengaluru</td>
<td>IN</td>
<td>3</td>
<td>3</td>
<td>2</td>
<td>NAME</td>
<td>Standard_Name</td>
<td>Bangalore</td>
</tr>
<tr>
<td>1</td>
<td>Whitefield</td>
<td>IN</td>
<td>4</td>
<td>4</td>
<td>3</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Chapter 14
Import Your Data

<table>
<thead>
<tr>
<th>Attribute Name</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>RecordTypeCode</td>
<td>1</td>
<td>The record type code that represents the intent of the import data. The values are:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• 0 - indicates the geography that already exists in the base table.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• 1 - indicates the intent to create a new geography.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• 2 - indicates the intent to add an alternate identifying name or code to an existing geography.</td>
</tr>
<tr>
<td>PrimaryGeographyName</td>
<td>India</td>
<td>This is the primary geography name. This will be marked as the primary name for the Geography and also displayed in the Manage Geographies Page.</td>
</tr>
</tbody>
</table>
### Attribute Name | Value | Description
--- | --- | ---
CountryCode | IN | This indicates the Country Code for the country for which you're importing data. 
LevelNumber | 2 | The level number of the geography in the hierarchy. For example, Country is at Level 1 and State (California) is at Level 2. 
SourceId | 2 | The source ID for the geography, along with the parent source ID is used to identify the geography parent and child relationship within the source file data and the interface table data. 
ParentSourceId | 1 | The parent source ID for the geography, along with the source ID is used to identify the geography’s parent and child relationship with records within the source file data. This should be null for the country record, as Country is at the top of the hierarchy. 
IdentifierType | Name | The type of the identifier. It can be either Name or Code. 
IdentifierSubtype | Standard_Name or Standard_Code | The IdentifierSubtype can be Standard_Name or Secondary_Name. The default value is Standard_Name. The valid Sub Types for Type "CODE" are FIPS_CODE, GEO_CODE, ISO_COUNTRY_CODE, PRIMARY_CITY, or UNKNOWN 
IdentifierValue | Bangalore | The value of the identifier. 

You can create an import activity, enter the import details, and schedule the import.

1. Go to **Navigator > Tools > Import Management > Import Queue**.
2. Click **Create Import Activity** in the **Manage Imports** page.
3. In the **Enter Import Options** page, provide a name for the import activity, and select **Geography** from the Object drop-down list.

**Note:** In the **Advanced Options** section, the option **Enable High-Volume Import** is selected by default. This mode is designed to import millions of records at once.

4. Select the CSV file in the **File Name** field, and click **Next**.
5. The source and target attributes are automatically mapped in the **Map Fields** page. Review and edit the mappings if required.
6. Check the file for unmapped columns or data format issues by clicking **Validate Data**. Click **Next**.
7. Review the import details on the **Review and Submit** page, and click **Submit**.
Import Your Hierarchy Data

You can use the import functionality to create or update Hierarchy records.

The hierarchies supported are:

- Customer hierarchy
- Dun and Bradstreet hierarchy
- Trading Community Party hierarchy

To import Hierarchy records, perform the following tasks:

1. Map your source data to Oracle Applications Cloud object attributes.
2. Create source Comma Separated Values (.csv) file for import.
3. Create the import activity.
4. Review the import results.

How You Map Your Source Data to Target Object Attributes

To import your Hierarchy data into Oracle Applications Cloud, you need to populate a CSV file with your source data and map that source data to target object attributes in Oracle Applications Cloud.

You need to do the following before creating the .CSV file for data import:

- Identify how your source data attributes map to the target object attributes in Oracle Applications Cloud.
- Ensure prerequisite steps are complete, such as understanding what attributes are required for importing your objects.
- Understand your options for uniquely identifying the records.
- Ensure parent records exist before importing child records.
- Identify the target object attributes that are required in the .CSV file for a successful import.

Before You Start

You must do some basic checks before starting your import. For example, make sure that:

- You have completed all the prerequisites for importing each attribute in your source data.
- You have all parent records in place before importing child records.

Select a Unique Identifier for Your Records

To import data into Oracle Applications Cloud, your CSV file must include some specific attributes that enable the import process to uniquely identify the records. The file import process uses the attribute values to automatically map your source data to the target object attributes in Oracle Applications Cloud.

The preferred option to uniquely identifying an object record is the Internal ID. If you're identifying a record that already exists in Oracle Applications Cloud, then you can use the internal ID of the record, a system-generated unique identifier. Attributes with "ID" in the attribute name are typically internal IDs. Use this option only if you're updating Hierarchies. You can determine the internal ID of a record by exporting Oracle Applications Cloud object data, or by doing a transactional database query. Using an internal ID typically provides better performance and reduces the import duration. For the Hierarchy object, the attributes are TreeStructureCode, TreeCode, TreeName, and TreeVersionName.
Required Attributes and Validations for Hierarchy Object

To import data successfully into Oracle Applications Cloud, your .CSV file must include the required attributes. Ensure that you provide valid values for the attributes.

The following table lists the required attributes for importing new Hierarchy records, required attributes for updating Hierarchy records, prerequisite setup tasks for the attributes, and specific validations, if any, for Hierarchy import:

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Description</th>
<th>Data Type</th>
<th>Data Length</th>
<th>Prerequisite Setup Task/Import Validations</th>
<th>Creating a Hierarchy Record</th>
<th>Updating an Existing Hierarchy Record</th>
</tr>
</thead>
<tbody>
<tr>
<td>TreeStructureCode</td>
<td>Unique identifier for a tree structure.</td>
<td>Varchar2</td>
<td>30</td>
<td>Seeded data needs to be present.</td>
<td>Required</td>
<td>Required</td>
</tr>
<tr>
<td>TreeCode</td>
<td>User defined Identifier for the tree code.</td>
<td>Varchar2</td>
<td>30</td>
<td>No validation</td>
<td>Required</td>
<td>Required</td>
</tr>
<tr>
<td>TreeName</td>
<td>Name of the tree</td>
<td>Varchar2</td>
<td>80</td>
<td>No validation</td>
<td>Required</td>
<td>Not Required</td>
</tr>
<tr>
<td>TreeVersionName</td>
<td>Version Name of the tree</td>
<td>Varchar2</td>
<td>80</td>
<td>No validation</td>
<td>Required</td>
<td>Not Required</td>
</tr>
<tr>
<td>LangCode</td>
<td>Indicates the code of the language into which the contents of the translatable columns are translated.</td>
<td>Varchar2</td>
<td>4</td>
<td>No validation</td>
<td>Required</td>
<td>Not Required</td>
</tr>
<tr>
<td>AsofDate</td>
<td>The date that's used to determine the tree version when you're updating a tree version.</td>
<td>Date</td>
<td></td>
<td>No validation</td>
<td>Optional</td>
<td>Required</td>
</tr>
</tbody>
</table>

You can view the Hierarchy object along with all its child objects and attributes in the Manage Import Objects page of the Import Management flow. You can find attribute information like type, length, description, and so on, on this page.

Create the Source CSV File

The .CSV file is provided as input to the file-based data import process. You must populate the .CSV file with the data you want to import into Oracle Applications Cloud.

You can either create a CSV file on your own or use templates available in preexisting mappings. To download a template, do the following:

1. Go to Navigator > Tools > Import Management > Import Objects.
2. Select the Hierarchy object in the table and click Download.
You can now edit the downloaded file and provide valid values for the required attributes.

**Note:** For help in populating the CSV file and to avoid any issues in entering values, see the topic Potential Issues When Opening CSV Files With Excel in Related Topics section.

### Create the Import Activity

To import data into Oracle Applications Cloud, you need to create an import activity and provide the CSV file as an input to the activity.

To create an import activity, do the following:

1. In the Navigator, under **Tools**, click **Import Management**.
2. In the **Manage Imports** page, click **Create Import Activity**.
3. In the **Create Import Activity: Enter Import Options** page, provide a name for the import activity, and select **Hierarchy** from the **Object** drop-down list.
4. In **File Name**, browse and upload the required .CSV file, and click **Next**.
5. In the **Create Import Activity: Map Fields** page edit the attribute mappings if required, and click **Next**.

**Note:** Click **Validate Data** to validate the mapping of the source file for unmapped columns and to check for data format issues.

6. In the **Create Import Activity: Review and Submit** page, click **Submit**.

**Note:** Initiate the Tree Flattening Service manually. Do one of the following:

- From the navigator, select **Scheduled Processes**. In the Schedule New Process dialog, search for **Party Hierarchy Generation** and click **OK**.
- From Setup and Maintenance, search and run the Trading Community Party Hierarchy Generation task.

### Review the Import Results

You can review the import results by checking for the import activity in the **Manage Import Activity** page. A file import activity is said to be successful when its status displays as **Completed**. To check the status of the import activity, do as follows:

1. In the Navigator, under **Tools**, click **Import Management**.
2. On the **Manage Imports** page, search for the import activity that you created using one of the search criteria, such as status, name, object, and so on.
3. Check the **Status** column for the import activity. The import is successful if the status displays as **Completed**. The other valid values for the import activity status are **Queued for import**, **Preparing data for import**, **Importing data**, **Completed with errors**, and **Unsuccessful**.

**Note:** On this page you can also quickly view the number and status of all active imports, completed imports, and unsuccessful imports that have been submitted.
Import Your Household Data

You can use Import Management to create or update Household records.

To import Household records, perform the following tasks:

1. Map your source data to Oracle Applications Cloud object attributes.
2. Create source Comma Separated Values (.csv) file for import.
3. Create the import activity.
4. Review the import results.

How You Map Your Source Data to Target Object Attributes

To import your Household data into Oracle Applications Cloud, you need to populate a CSV file with your source data and map that source data to target object attributes in Oracle Applications Cloud.

You need to do the following before creating the .CSV file for data import:

- Identify how your source data attributes map to the target object attributes in Oracle Applications Cloud.
- Ensure prerequisite steps are complete, such as understanding what attributes are required for importing your objects.
- Understand your options for uniquely identifying the records.
- Ensure parent records exist before importing child records.
- Identify the target object attributes that are required in the .CSV file for a successful import.

**Note:** You can’t set an attribute value to NULL in optimized import (standard import with the option **Enable High-Volume Import** selected). However, when updating a record, you can change an attribute value from NOT NULL to NULL.

Before You Start

You must do some basic checks before starting your import. For example, make sure that:

- You have completed all the prerequisites for importing each attribute in your source data.
- You have all parent records in place before importing child records.

Select a Unique Identifier for Your Records

To import data into Oracle Applications Cloud, your CSV file must include some specific attributes that enable the import process to uniquely identify the records. The file import process uses the attribute values to automatically map your source data to the target object attributes in Oracle Applications Cloud.
The preferred options to uniquely identify an object record are as follows:

- **Internal ID**: If you’re identifying a record that already exists in Oracle Applications Cloud, then you can use the internal ID of the record, a system-generated unique identifier. Attributes with "ID" in the attribute name are typically internal IDs. Use this option only if you’re updating Households. You can determine the internal ID of a record by exporting Oracle Applications Cloud object data, or by doing a transactional database query. Using an internal ID typically provides better performance and reduces the import duration. For the Household object, the attributes are OwnerPartyId and PartyId.

- **Public unique identifiers**: If you’re creating new records, then you can provide a user-friendly public unique identifier (attributes denoted with ‘Number’ and usually visible in the business object’s UI). If you update a record for which you have previously provided a Number attribute, or for which a Number attribute is visible in the object’s UI, you can use the Number attribute to identify the record. For the Household object, the attribute is PartyNumber.

### Required Attributes and Validations for Household Object

To import data successfully into Oracle Applications Cloud, your .CSV file must include the required attributes. Ensure that you provide valid values for the attributes.

The following table lists the required attributes for importing new Household records, required attributes for updating Household records, prerequisite setup tasks for the attributes, and specific validations, if any, for Household import:

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Description</th>
<th>Data Type</th>
<th>Data Length</th>
<th>Prerequisite Setup Task/ Import Validations</th>
<th>Creating a Household Record</th>
<th>Updating an Existing Household Record</th>
</tr>
</thead>
<tbody>
<tr>
<td>SourceSystem</td>
<td>The code representing the source system for the household</td>
<td>String</td>
<td>30</td>
<td>Identify the source system or configure source systems either by using the Manage Trading Community Source System task, or by importing the source system information into Oracle Applications Cloud using the Source System Reference import object.</td>
<td>Optional</td>
<td>Required</td>
</tr>
<tr>
<td>SourceSystemReference</td>
<td>The reference number or text representing the source system unique ID for the household</td>
<td>String</td>
<td>240</td>
<td>Identify the source system or configure source systems either by using the Manage Trading Community Source System task, or by importing the source system information into Oracle Applications Cloud using the Source System</td>
<td>Optional</td>
<td>Required</td>
</tr>
</tbody>
</table>
You can use the profile option ORA_HZ_IMPORT_MULTI_ADDRESS_TYPE to control how address types are entered. By default this profile option is set to Yes, so you can enter multiple address types, during high-volume import of Account, Contact, and Household objects. You can disable this profile option to improve the import performance. When you set this profile option to No, you can enter only a single address type.

You can view the Household object along with all its child objects and attributes in the Manage Import Objects page of the Import Management flow. You can find attribute information like type, length, description, and so on, on this page.

Create the Source CSV File

You include the data that you want to import into CX Sales and B2B Service in a source CSV file.

You can use the templates available in the Import Objects UI page to create the source CSV file. To download a template:

1. Go to Navigator > Tools > Import Management > Import Objects.
2. Select the Household object in the table and click Download.

You can now edit the downloaded file and provide valid values for the required attributes.

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Description</th>
<th>Data Type</th>
<th>Data Length</th>
<th>Prerequisite Setup Task/ Import Validations</th>
<th>Creating a Household Record</th>
<th>Updating an Existing Household Record</th>
</tr>
</thead>
<tbody>
<tr>
<td>PartyNumber</td>
<td>The public unique identifier of the party.</td>
<td>String</td>
<td>30</td>
<td>Optional</td>
<td>Required</td>
<td>Optional</td>
</tr>
<tr>
<td>PartyId</td>
<td>The public unique identifier of the party</td>
<td>Long</td>
<td>18</td>
<td>Identify the party number value by exporting the Household object.</td>
<td>Optional</td>
<td>Required</td>
</tr>
<tr>
<td>Name</td>
<td>The name of the household</td>
<td>String</td>
<td>360</td>
<td>Identify the organization name of the resource by navigating to the Resource Directory.</td>
<td>Required</td>
<td>Conditionally required</td>
</tr>
<tr>
<td>OwnerPartyId</td>
<td>Indicates the party ID of the resource who’s designated as the owner of the household</td>
<td>Long</td>
<td>18</td>
<td>None.</td>
<td>Conditionally required.</td>
<td>Conditionally required.</td>
</tr>
</tbody>
</table>

Note: For help in populating the CSV file and to avoid any issues in entering values, see the topic Potential Issues When Opening CSV Files With Excel in Related Topics section.
Create the Import Activity

After you have the CSV file ready, create an import activity to import the information. To create an import activity:

1. Go to **Navigator > Tools > Import Management > Import Queue**.
2. Click **Create Import Activity** in the **Manage Imports** page.
3. In the **Enter Import Options** page, provide a name for the import activity, and select Household from the **Object** drop-down list.
4. Select the CSV file in the **File Name** field, and click **Next**.
5. You would see that the source and target attributes are automatically mapped in the **Map Fields** page. Review and edit the mappings if required.
6. Check the file for unmapped columns or data format issues by clicking **Validate Data**. Click **Next**.
7. Review the import details on the **Review and Submit** page, and click **Submit** when you’re ready.

Review the Import Results

Check if your import succeeded on the **Manage Imports** page. This page shows the status of all active, completed, and unsuccessful imports. To check the status of the import activity:

1. Go to **Navigator > Tools > Import Management > Import Queue**.
2. Click All Imports and search for the import activity that you created earlier.
3. Check the **Status** column for the import activity. The import is successful if the status displays as **Completed**. You can drill down on the import activity to go to the **Import Status** page which provides the status details of the import activity.

Related Topics

- Import Data
- Potential Issues When Opening CSV Files in Excel

Import Your Hub Source System Reference Data

You can use Import Management to create or update Hub Source System Reference records.

To import Hub Source System Reference records, perform the following tasks:

1. Map your source data to Oracle Applications Cloud object attributes.
2. Create source Comma Separated Values (CSV) file for import.
3. Create the import activity.
4. Review the import results.

How You Map Your Source Data to Target Object Attributes

To import your Hub Source System Reference data into Oracle Applications Cloud, you need to populate a CSV file with your source data and map that source data to target object attributes in Oracle Applications Cloud.

You need to do the following before creating the CSV file for data import:

- Identify how your source data attributes map to the target object attributes in Oracle Applications Cloud.
- Ensure prerequisite setups are done, if applicable.
- Understand your options for uniquely identifying the records.
Before You Start
You must do some basic checks before starting your import. For example, make sure that:

- You have completed all the prerequisites for importing each attribute in your source data.
- You have all parent records in place before importing child records.

Select a Unique Identifier for Your Records
All records must be unique in the application. You can use one of these to identify records:

- Public unique identifiers: If you’re creating records, then you can provide an easily understandable public unique identifier. These are, usually, denoted with 'Number' and visible in the business object's UI. PUID attributes are usually named <object> Number. If you’re updating a record with a Number attribute, then use the Number attribute to identify the record. For more information about public unique identifiers, see the topic "How You Use Alternate Keys to Import Records" in Related Topics section.
- Source system and source system reference: Source system is an identifier for the external system, and source system reference is a unique identifier within the external system. If you’re importing new hub source system reference records or are updating hub source system reference records that have source system reference data, then provide the source system and source system reference values.

Required Attributes and Validations for Hub Source System Reference Object
To import data successfully into Oracle Applications Cloud, your CSV file must include the required attributes. Ensure that you provide valid values for the attributes. This table lists the required attributes for importing new Hub Source System Reference records, required attributes for updating Hub Source System Reference records, prerequisite setup tasks for the attributes, and specific validations, if any, for Hub Source System Reference import:

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Description</th>
<th>Prerequisite Setup Task/Import Validations</th>
<th>Creating a Hub Source System Reference Record</th>
<th>Updating an Existing Hub Source System Reference Record</th>
</tr>
</thead>
<tbody>
<tr>
<td>OwnerEntityId</td>
<td>Internal identifier or primary key of a record that exists in the OSC table</td>
<td>If provided, it has to be an active primary key value from the table name provided for the OwnerEntityObject.</td>
<td>If you export data from the OSC table provided for the OwnerEntityObject, provide the primary key data to this attribute. If you can't provide this data, provide valid values for the combination of ExistingSourceSystem and ExistingSourceSystemReference.</td>
<td>Not required</td>
</tr>
<tr>
<td>StartDateActive</td>
<td>The date on which the hub source system reference becomes valid.</td>
<td>If provided, this date should be earlier than the end date. If you don't specify a date, this defaults to the current date.</td>
<td>Optional</td>
<td>Optional</td>
</tr>
</tbody>
</table>
### Attribute

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Description</th>
<th>Prerequisite Setup Task/Import Validations</th>
<th>Creating a Hub Source System Reference Record</th>
<th>Updating an Existing Hub Source System Reference Record</th>
</tr>
</thead>
<tbody>
<tr>
<td>EndDateActive</td>
<td>The date on which the hub source system reference is no longer valid.</td>
<td>If provided, this date should be later than the start date. If you don’t specify a date, this defaults to 12/31/4712.</td>
<td>Optional</td>
<td>Optional</td>
</tr>
<tr>
<td>SourceSystem</td>
<td>Specifies the original source system name</td>
<td>This has to be present in the HZ_ORIG_SYSTEMS_B table with the status &quot;A&quot;.</td>
<td>Provide a valid value.</td>
<td>Conditionally required.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Provide one of the following:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>• SourceSystemReferenceId</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>• A combination of SourceSystem, SourceSystemReference and OwnerEntityObject</td>
</tr>
<tr>
<td>SourceSystemReferenceValue</td>
<td>Specifies the original source system reference text or number in the original source system</td>
<td>No validation</td>
<td>Provide a valid value.</td>
<td>Conditionally required.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Provide one of the following:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>• SourceSystemReferenceId</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>• A combination of SourceSystem, SourceSystemReference and OwnerEntityObject</td>
</tr>
<tr>
<td>OwnerEntityObject</td>
<td>Specifies the OSC table in which the record exists</td>
<td>This has to be a valid lookup code in the lookup type ORA_ZCH.Owner_ENTITY_OBJECT.</td>
<td>Provide a valid value.</td>
<td>Conditionally required.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Provide one of the following:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>• SourceSystemReferenceId</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>• A combination of SourceSystem, SourceSystemReference and OwnerEntityObject</td>
</tr>
<tr>
<td>SourceSystemReferenceId</td>
<td>Specifies the source system reference identifier. This is a primary key.</td>
<td>If provided, this has to be an active primary key value from the table HZ_ORIGIN_SYS_REFERENCES.</td>
<td>Not required</td>
<td>Conditionally required.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Provide one of the following:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>• SourceSystemReferenceId</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>• A combination of SourceSystem, SourceSystemReference and OwnerEntityObject</td>
</tr>
</tbody>
</table>
Oracle Fusion Cloud Sales Automation
Implementing Customer Data Management for CX Sales and B2B Service

Chapter 14
Import Your Data

### Attribute Table

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Description</th>
<th>Prerequisite Setup Task/Import Validations</th>
<th>Creating a Hub Source System Reference Record</th>
<th>Updating an Existing Hub Source System Reference Record</th>
</tr>
</thead>
<tbody>
<tr>
<td>ExistingSourceSystem</td>
<td>Specifies the original source system name of data that exists in Oracle Engagement Cloud</td>
<td>This has to be present in the HZ.ORIG.SYSTEMS.B table with status &quot;A&quot;.</td>
<td>If you can’t provide the OwnerEntityID, provide a combination of ExistingSourceSystem and ExistingSourceSystemReference values. Export the Source System Reference repository to obtain this value.</td>
<td>Not required</td>
</tr>
<tr>
<td>ExistingSourceSystemReference</td>
<td>Specifies the original source system reference of data that exists in Oracle Engagement Cloud</td>
<td>No validation</td>
<td>If you can’t provide the OwnerEntityID, provide a combination of ExistingSourceSystem and ExistingSourceSystemReference values. Export the Source System Reference repository to obtain this value.</td>
<td>Not required</td>
</tr>
</tbody>
</table>

You can view the Hub Source System Reference object along with all its child objects and attributes in the Manage Import Objects page of the Import Management flow. You can find attribute information like type, length, description, and so on, on this page.

**Note:** A lookup type ORA_ZCH_OWNER_ENTITY_OBJECT is now available. You can now use this lookup without specifying the underlying physical tables, when providing input data in the CSV import file. When you migrate from File-Based Data Import to Optimized or Import Management, the underlying physical tables are secured to external parties.

---

## Create the Source CSV File

You include the data that you want to import into CX Sales and B2B Service in a source CSV file. You can use the templates available in the Import Objects UI page to create the source CSV file. To download a template:

1. Go to Navigator > Tools > Import Management > Import Objects.
2. Select the Hub Source System Reference object in the table and click Download.

You can now edit the downloaded file and provide valid values for the required attributes.

**Note:** For help in populating the CSV file and to avoid any issues in entering values, see the topic Potential Issues When Opening CSV Files With Excel in Related Topics section.

## Create the Import Activity

After you have the CSV file ready, create an import activity to import the information. To create an import activity:

1. Go to Navigator > Tools > Import Management > Import Queue.
2. Click Create Import Activity in the Manage Imports page.
3. In the **Enter Import Options** page, provide a name for the import activity, and select Hub Source System Reference from the **Object** drop-down list.
4. Select the CSV file in the **File Name** field, and click **Next**.
5. You would see that the source and target attributes are automatically mapped in the **Map Fields** page. Review and edit the mappings if required.
6. Check the file for unmapped columns or data format issues by clicking **Validate Data**. Click **Next**.
7. Review the import details on the **Review and Submit** page, and click **Submit** when you're ready.

**Review the Import Results**

Check if your import succeeded on the **Manage Imports** page. This page shows the status of all active, completed, and unsuccessful imports. To check the status of the import activity:

1. Go to **Navigator** > **Tools** > **Import Management** > **Import Queue**.
2. Click All Imports and search for the import activity that you created earlier.
3. Check the **Status** column for the import activity. The import is successful if the status displays as **Completed**. You can drill down on the import activity to go to the **Import Status** page which provides the status details of the import activity.

**Related Topics**
- Import Data
- Potential Issues When Opening CSV Files in Excel
- How You Use Alternate Keys to Import Records

**Import Your Organization Data**

You can use Import Management to create or update Organization records.

To import Organization records, perform the following tasks:

1. Map your source data to Oracle Applications Cloud object attributes.
2. Create source Comma Separated Values (CSV) file for import.
3. Create the import activity.
4. Review the import results.

**How You Map Your Source Data to Target Object Attributes**

To import your Organization data into Oracle Applications Cloud, you need to populate a CSV file with your source data and map that source data to target object attributes in Oracle Applications Cloud.

You need to do the following before creating the CSV file for data import:

- Identify how your source data attributes map to the target object attributes in Oracle Applications Cloud.
- Ensure prerequisite setups are done, if applicable.
- Understand your options for uniquely identifying the records.
- Ensure parent records exist before importing child records.
- Identify the target object attributes that are required in the CSV file for a successful import.
- Ensure that you don't insert duplicate addresses while importing, to avoid redundant data.
Before You Start

You must do some basic checks before starting your import. For example, make sure that:

- You have completed all the prerequisites for importing each attribute in your source data.
- You have all parent records in place before importing child records.

Select a Unique Identifier for Your Records

All records must be unique in the application. You can use one of these to identify records:

- Public unique identifiers: If you're creating records, then you can provide an easily understandable public unique identifier. These are, usually, denoted with 'Number' and visible in the business object's UI. PUID attributes are usually named <object> Number. If you're updating a record with a Number attribute, then use the Number attribute to identify the record. For more information about public unique identifiers, see the topic "How You Use Alternate Keys to Import Records" in Related Topics section.
- Source system and source system reference: Source system is an identifier for the external system, and source system reference is a unique identifier within the external system. If you're importing new organizations or are updating organizations that have source system reference data, then provide the source system and source system reference values.

Required Attributes and Validations for Organization Object

To import data successfully into Oracle Applications Cloud, your CSV file must include the required attributes. Ensure that you provide valid values for the attributes. This table lists the required attributes for importing new Organization records, required attributes for updating Organization records, prerequisite setup tasks for the attributes, and specific validations, if any, for Organization import:

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Description</th>
<th>Prerequisite Setup Task/Import Validations</th>
<th>Creating an Organization Record</th>
<th>Updating an Existing Organization Record</th>
</tr>
</thead>
<tbody>
<tr>
<td>SourceSystem</td>
<td>The original source system name</td>
<td>Know the source system.</td>
<td>Conditionally Required</td>
<td>Conditionally Required</td>
</tr>
<tr>
<td></td>
<td></td>
<td>To view source systems, use the Manage Trading Community Source System task.</td>
<td>To identify an organization record, use one of these:</td>
<td>To identify an organization record, use one of these:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>- Combination of SourceSystem and SourceSystemReferenceValue</td>
<td>- Combination of SourceSystem and SourceSystemReferenceValue</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>- PartyNumber</td>
<td>- PartyNumber</td>
</tr>
<tr>
<td>SourceSystemReferenceValue</td>
<td>The identifier in the original source system</td>
<td>Know the source system reference value.</td>
<td>Conditionally Required</td>
<td>Conditionally Required</td>
</tr>
<tr>
<td></td>
<td></td>
<td>To view the source systems reference, use the Manage Trading Community Source System task.</td>
<td>To identify an organization record, use one of these:</td>
<td>To identify an organization record, use one of these:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>- Combination of SourceSystem and SourceSystemReferenceValue</td>
<td>- Combination of SourceSystem and SourceSystemReferenceValue</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>- PartyNumber</td>
<td>- PartyNumber</td>
</tr>
<tr>
<td>PartyNumber</td>
<td>The public unique identifier of the party.</td>
<td>Know party number.</td>
<td>Conditionally Required</td>
<td>Conditionally Required</td>
</tr>
<tr>
<td>Attribute</td>
<td>Description</td>
<td>Prerequisite Setup Task/ Import Validations</td>
<td>Creating an Organization Record</td>
<td>Updating an Existing Organization Record</td>
</tr>
<tr>
<td>-------------------</td>
<td>------------------------------------------------------------------------------</td>
<td>------------------------------------------------------------------------------------------------------------</td>
<td>----------------------------------</td>
<td>------------------------------------------</td>
</tr>
<tr>
<td>OrganizationName</td>
<td>The name of the party of the Organization party type.</td>
<td>To obtain a list of all party IDs and party numbers, export the Party object.</td>
<td>Required</td>
<td>Conditionally Required</td>
</tr>
<tr>
<td>PartyUsageCode</td>
<td>Specifies the party usage code to which the organization is associated</td>
<td>The organization names are listed in the Resource Directory.</td>
<td>Required</td>
<td>Not required</td>
</tr>
<tr>
<td>CleanlinessScore</td>
<td>The overall score for the account or contact record for the category Cleanliness</td>
<td>No validation.</td>
<td>Optional</td>
<td>Optional</td>
</tr>
<tr>
<td>CompletenessScore</td>
<td>The overall score for the account or contact record for the category Completeness</td>
<td>No validation.</td>
<td>Optional</td>
<td>Optional</td>
</tr>
<tr>
<td>DataConfidenceScore</td>
<td>The overall data confidence score that indicates the level of data quality for a record</td>
<td>No validation.</td>
<td>Optional</td>
<td>Optional</td>
</tr>
<tr>
<td>DatafoxCompanyId</td>
<td>A unique identifier for the “Datafox” company</td>
<td>No validation.</td>
<td>Optional</td>
<td>Optional</td>
</tr>
<tr>
<td>DuplicateIndicator</td>
<td>Signifies the duplicate status of the record that's determined as follows:</td>
<td>No validation.</td>
<td>Optional</td>
<td>Optional</td>
</tr>
<tr>
<td></td>
<td>• A null value indicates that the record isn’t a duplicate or hasn’t been evaluated.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• The record can also have one of 2 other values - DUPE (record is a duplicate) or LINK (record is linked to another record).</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>DuplicateScore</td>
<td>The overall score for the account or contact record for the category Duplicate</td>
<td>No validation.</td>
<td>Optional</td>
<td>Optional</td>
</tr>
<tr>
<td>EnquiryDuns</td>
<td>A unique identifier used to query the Dun and Bradstreet data. If the location is a branch,</td>
<td>No validation.</td>
<td>Optional</td>
<td>Optional</td>
</tr>
</tbody>
</table>
### Import Your Data

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Description</th>
<th>Prerequisite Setup Task/Import Validations</th>
<th>Creating an Organization Record</th>
<th>Updating an Existing Organization Record</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>in some countries the &quot;DUNS&quot; number of the headquarters is used to run the query. Otherwise, the &quot;DUNS&quot; number is considered.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>EnrichmentScore</td>
<td>The overall score for the account or contact record for the category <strong>Enrichment</strong></td>
<td>No validation</td>
<td>Optional</td>
<td>Optional</td>
</tr>
<tr>
<td>LastScoreUpdateDate</td>
<td>The date and time at which this record was updated by the source system in the last update source system column</td>
<td>No validation</td>
<td>Optional</td>
<td>Optional</td>
</tr>
<tr>
<td>RecencyScore</td>
<td>The overall score for the account or contact record for the category <strong>Recency</strong></td>
<td>No validation</td>
<td>Optional</td>
<td>Optional</td>
</tr>
<tr>
<td>ThirdPartyFlag</td>
<td>This option tracks if a party has a direct relationship with the organization using Oracle receivables or through a third party supplier. The value Y denotes third party relationship, while the value N denotes direct relationship. If Oracle Service is installed, the Third Party field in the Customers window is mandatory.</td>
<td>No validation</td>
<td>Optional</td>
<td>Optional</td>
</tr>
<tr>
<td>ValidatedFlag</td>
<td>Indicates if the party was validated. The value Y denotes a validated party, while the value N denotes a party that’s not validated.</td>
<td>No validation</td>
<td>Optional</td>
<td>Optional</td>
</tr>
<tr>
<td>ValidityScore</td>
<td>The overall score for the account or contact record for the category <strong>Validity</strong></td>
<td>No validation</td>
<td>Optional</td>
<td>Optional</td>
</tr>
</tbody>
</table>

You can view the Organization object along with all its child objects and attributes in the Manage Import Objects page of the Import Management flow. You can find attribute information like type, length, description, and so on, on this page.

### Create the Source CSV File

You include the data that you want to import into CX Sales and B2B Service in a source CSV file.
You can use the templates available in the Import Objects UI page to create the source CSV file. To download a template:

1. Go to Navigator > Tools > Import Management > Import Objects.
2. Select the Organization object in the table and click Download.

You can now edit the downloaded file and provide valid values for the required attributes.

Note: For help in populating the CSV file and to avoid any issues in entering values, see the topic Potential Issues When Opening CSV Files With Excel in Related Topics section.

Create the Import Activity
After you have the CSV file ready, create an import activity to import the information. To create an import activity:

1. Go to Navigator > Tools > Import Management > Import Queue.
2. Click Create Import Activity in the Manage Imports page.
3. In the Enter Import Options page, provide a name for the import activity, and select Organization from the Object drop-down list.
4. Select the CSV file in the File Name field, and click Next.
5. You would see that the source and target attributes are automatically mapped in the Map Fields page. Review and edit the mappings if required.
6. Check the file for unmapped columns or data format issues by clicking Validate Data. Click Next.
7. Review the import details on the Review and Submit page, and click Submit when you're ready.

Review the Import Results
Check if your import succeeded on the Manage Imports page. This page shows the status of all active, completed, and unsuccessful imports. To check the status of the import activity:

1. Go to Navigator > Tools > Import Management > Import Queue.
2. Click All Imports and search for the import activity that you created earlier.
3. Check the Status column for the import activity. The import is successful if the status displays as Completed. You can drill down on the import activity to go to the Import Status page which provides the status details of the import activity.

Related Topics
- Import Data
- Potential Issues When Opening CSV Files in Excel
- How You Use Alternate Keys to Import Records

Import Your Person Data
You can use the import functionality to create or update Person records.

You can import Person records using these steps:

1. Map your source data to Oracle Applications Cloud object attributes. This way the import process would know where to insert each of the information bits.
2. Create the source CSV file with the Person data you want to import.
4. Check the import results to know if the import went well.

**How You Map Your Source Data to Target Object Attributes**

You import Person data into Oracle Applications Cloud from a CSV file containing your source data that’s mapped to target Oracle Applications Cloud object attributes.

Before you create the source data file, you should:

- Know how your source data attributes map to the target object attributes in Oracle Applications Cloud. Match each column from the source file to an attribute in the Person import object.
- Finish all prerequisite steps, such as understanding what attributes are required for importing your objects.
- Know how you can uniquely identify the records.
- Check the target object attributes required in the CSV file for a successful import.
- Ensure that you don’t insert duplicate Person while importing, to avoid redundant data.

**Before You Start**

You must do some basic checks before starting your import. For example, make sure that:

- You have completed all the prerequisites for importing each attribute in your source data.
- You have all parent records in place before importing child records.

**Select a Unique Identifier for Your Records**

All records must be unique in the application. You can use one of these to identify records:

- Public unique identifiers: You can pass the PUID when creating Person records. If the PUID isn’t passed, it will be auto generated. You can optionally provide the PUID when creating Person records. If you’re updating records, then you can provide an easily understandable public unique identifier. These are, usually, denoted with ‘Number’ and visible in the business object’s UI. PUID attributes are usually named <object> Number. If you’re updating a record with a Number attribute, then use the Number attribute to identify the record. For more information about public unique identifiers, see the topic "How You Use Alternate Keys to Import Records" in Related Topics section.
- Source system and source system reference: Source system is an identifier for the external system, and source system reference is a unique identifier within the external system. If you’re importing new Persons or are updating Persons that have source system reference data, then provide the source system and source system reference values.

**Required Attributes and Validations for Person Object**

To import data successfully into Oracle Applications Cloud, your .CSV file must include the required attributes. Ensure that you provide valid values for the attributes.

This table lists the required attributes for Person records, prerequisite setup tasks and specific validations, if any:

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Description</th>
<th>Prerequisite Setup Task/Import Validations</th>
<th>Creating a Person record</th>
<th>Updating an Existing Person record</th>
</tr>
</thead>
<tbody>
<tr>
<td>PartyId</td>
<td>The internal ID for the Person type party</td>
<td>When updating the record, this should already exist.</td>
<td>Not required</td>
<td>Conditionally required.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>To identify a person record, use one of these:</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
## Import Your Data

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Description</th>
<th>Prerequisite Setup Task/Import Validations</th>
<th>Creating a Person record</th>
<th>Updating an Existing Person record</th>
</tr>
</thead>
<tbody>
<tr>
<td>Country</td>
<td>The country code of the postal address</td>
<td>Identify valid country codes using the Setup and Maintenance, Manage Territories task.</td>
<td>Conditionally required A value is required only when you're creating an address for the Person record.</td>
<td>The attribute is neither required nor conditionally required.</td>
</tr>
<tr>
<td>AddressNumber</td>
<td>The internal unique identifier that's internally generated when creating an address</td>
<td>No validation</td>
<td>This is a PUID for Address. If a value is passed, it will be imported. Otherwise, it will be auto-generated.</td>
<td>Pass the AddressNumber.</td>
</tr>
<tr>
<td>OrganizationPartyNumber</td>
<td>The party number of the organization to which the person is related</td>
<td>This should already exist.</td>
<td>Not required</td>
<td>Not required</td>
</tr>
<tr>
<td>DeceasedFlag</td>
<td>The option that indicates whether the person imported is deceased</td>
<td>Y or N The default value is N.</td>
<td>Not required</td>
<td>Not required</td>
</tr>
<tr>
<td>PartyNumber</td>
<td>The unique identifier of the party</td>
<td>Know the party number. To obtain a list of all party IDs and party numbers, export the Person object.</td>
<td>This is a PUID for Person. If a value is passed, it will be imported. Otherwise, it will be auto-generated.</td>
<td>Conditionally required To identify a person record, use one of these: Combination of SourceSystem and SourceSystemReferenceValue PartyNumber PartyId</td>
</tr>
<tr>
<td>FirstName</td>
<td>The first name of the person</td>
<td>No validation</td>
<td>Required. A value is required for the FirstName, MiddleName, or LastName.</td>
<td>Not required</td>
</tr>
<tr>
<td>MiddleName</td>
<td>The middle name of the person</td>
<td>No validation</td>
<td>Required. A value is required for the FirstName, MiddleName, or LastName.</td>
<td>Not required</td>
</tr>
<tr>
<td>LastName</td>
<td>The last name of the person</td>
<td>No validation</td>
<td>Required. A value is required for the FirstName, MiddleName, or LastName.</td>
<td>Not required</td>
</tr>
<tr>
<td>Attribute</td>
<td>Description</td>
<td>Prerequisite Setup Task/Import Validations</td>
<td>Creating a Person record</td>
<td>Updating an Existing Person record</td>
</tr>
<tr>
<td>--------------------</td>
<td>------------------------------------------------------------------------------</td>
<td>------------------------------------------------------------------------------------------------------------</td>
<td>--------------------------</td>
<td>-----------------------------------</td>
</tr>
<tr>
<td>PartyUsageCode</td>
<td>Specifies the party usage code to which the person is associated</td>
<td>Select one of the following values:</td>
<td>Required</td>
<td>Not required</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• EXTERNAL_PAYEE</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• CONTACT</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• PAYMENT_ISSUING_AUTHORITY</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• PARTY_OF_INTEREST</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• VIRTUAL_ASSISTANT</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• FS_TECH</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>You can assign a limited set of unrestricted party usages through the Person import object. To create</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>persons of other types, use the specific import objects created for those purposes.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SourceSystem</td>
<td>The original source system name</td>
<td>Know the source system. To view source systems, use the Manage Trading Community Source System task.</td>
<td>Conditionally required</td>
<td>Conditionally required</td>
</tr>
<tr>
<td>SourceSystemReferenceValue</td>
<td>The identifier in the original source system</td>
<td>Know the source system reference value. To view source system reference, use the Manage Trading Community Source System task.</td>
<td>Conditionally required</td>
<td>Conditionally required</td>
</tr>
<tr>
<td></td>
<td></td>
<td>To identify a person record, use one of these:</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Combination of SourceSystem and SourceSystemReferenceValue</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• PartyNumber</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• PartyId</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Go to Navigator > Tools > Import Management > Import Objects, to see all the attributes of the Person object. The page also lists attribute information like type, length, description, and so on.

**Create the Source CSV File**

You include the data that you want to import into CX Sales and B2B Service in a source CSV file.

You can use the templates available in the Import Objects UI page to create the source CSV file. To download a template:

1. Go to Navigator > Tools > Import Management > Import Objects.
2. Select the Person object in the table and click Download.
You can now edit the downloaded file and provide valid values for the required attributes.

**Note:** For help in populating the CSV file and to avoid any issues in entering values, see the topic Potential Issues When Opening CSV Files With Excel in Related Topics section.

### Create the Import Activity

After you have the CSV file ready, create an import activity to import the Person information. To create an import activity:

1. Go to Navigator > Tools > Import Management > Import Queue.
2. On the Manage Imports page, click Create Import Activity.
3. In the Create Import Activity: Enter Import Options page, provide a name for the import activity, and select Person from the Object drop-down list.
4. Select the CSV file in the File Name field, and click Next.
5. You would see that the source and target attributes are automatically mapped in the Map Fields page. Review and edit the mappings if required.
6. Check the file for unmapped columns or data format issues by clicking Validate Data. Click Next.
7. Review the import details on the Review and Submit page, and click Submit when you're ready.

### Review the Import Results

Check if your import succeeded on the Manage Imports page. This page shows the status of all active, completed, and unsuccessful imports. To check the status of the import activity:

1. Go to Navigator > Tools > Import Management > Import Queue.
2. Click All Imports and search for the import activity that you created earlier.
3. Check the Status column for the import activity. The import is successful if the status displays as Completed. You can drill down on the import activity to go to the Import Status page which provides the status details of the import activity.

**Related Topics**
- How You Use Alternate Keys to Import Records
- Potential Issues When Opening CSV Files in Excel
- Why can't I see the people I just imported?
15 Export Your Data

About Export Management

You can use Export Management to move data out of Oracle Applications Cloud in the form of CSV files.

To export data, you start by creating an export activity. As part of the export activity, you select a parent object and its relevant child objects. You also must define filters on these objects to specify the records you want to export.

Scenarios for Export

You may want to export data in the following scenarios:

- You might want to move data out of Oracle Applications Cloud into another application. To perform this activity, you have to export the data into a ZIP file and import the exported data into the target application.
- You might want to format the data as per your requirements.
- You may want to identify the unique identifiers of an object such as Party ID or Party Number. You can use this information to update an object record.

You can schedule an export either immediately or at a future date. If you schedule it for a future date, then provide the start date and time while defining the export activity.

**Note:** Currently recurring export isn't supported. You can however use the Export REST resource to schedule recurring export activities through REST API. For more information see REST API for CX Sales and B2B Service.

Using Export Filters

You can define the conditions for the records to export in the export filter. The exported data sets contain only those records that match the specified filter criteria on the parent/child object. It is recommended that you use multiple filters to reduce the number of records to export.

You can create a filter by navigating to Tools > Export Management > Export Objects and clicking on the Display Name link for the export object. On the Manage Filters page, click the Create Filter button to create a filter. On the Script Edit page, enter the filter name, filter parameters, and the order by clause if required. You can reuse an existing filter by selecting a value from the Existing Filters drop-down list. Once you're done with your changes, click Validate Script and then click Save and Close to save your new filter. You can also create a filter while creating an export activity, on the Map Fields page.

You can delete a filter on the Manage Filters page, by clicking the delete icon for your filter under the Delete Filter column. Note that you can delete only the filters created by you and those that aren't used in an active export job.

Split Export Data

There are no limits to file size for exporting data. However, you can split the exported data set based on a split size. You can enable split from the UI by checking the Enable Split check box in the set up page and select the split size. The default is 100k. You can specify the split size in multiples of 100k records, ranging from 100k to 1000k. Each CSV file can
contain a maximum of 50k records. Hence, the exported data will be split into two CSV files after 50k records. The CSV files will then be zipped together and exported.

For example, if an export job fetches 300k records and split is enabled with a split size of 200k, then 2 export ZIP files will be generated. The first one will contain a total of 200k records which will be divided into 4 CSV files each with 50k records. The second ZIP file will contain a total of 100k records which will be divided into 2 CSV files each with 50k records.

**Related Topics**

- Export Data
- How You Monitor Export Activity

---

**Export Data**

This topic shows you how to export data using the Export Management option from the Tools work area.

To export data:

1. Click **Tools > Export Management**.
2. On the **Manage Exports** page, click the **Create Export Activity** button.
3. On the **Enter Export Options** page, enter values for each of the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description of the value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of the export activity.</td>
</tr>
<tr>
<td>Object</td>
<td>The object to export. You must select the parent or child object from the drop-down list. If you can't find an object in the drop-down list, then click the Search link. In the <strong>Search and Select</strong> dialog box, enter the object name in the <strong>Object</strong> text box and click the Search button. Select your object from the result list and click <strong>OK</strong>. You can also use the advanced search option by clicking the <strong>Advanced</strong> button. Here you can search based on various filter criteria such as object name, attachment supported, creation date, and so on.</td>
</tr>
</tbody>
</table>

**Note:**

If the object you’re exporting isn’t listed then verify if you have the roles and privileges required to export the object. For information on the roles, see the topic **Roles Required for Import and Export Management** referenced in the Related Topics section.

The object must not include any field with display name length greater than 120 characters. Your export job may fail if it includes a field with display name length greater than 120 characters.
Export Your Data

<table>
<thead>
<tr>
<th>Field</th>
<th>Description of the value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description</td>
<td>The optional description of the export activity.</td>
</tr>
<tr>
<td>File Name</td>
<td>The name of the export file to generate in ZIP format. This field is populated based on the object and date time stamp.</td>
</tr>
<tr>
<td>Export Attachments</td>
<td>Select to export the attachments related to the object. This option is enabled only if the selected object supports attachments.</td>
</tr>
</tbody>
</table>

4. Optionally to set additional export configurations, click the **Advanced Options** section. Here you can configure settings in the **Output File**, **Export Options**, or **Create Schedule** sections.

   - Following are the options in the Output File and Export Options regions:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Delimiter</td>
<td>If your file doesn’t use a comma to separate values, then select the correct delimiter in the <strong>Delimiter</strong> drop-down list. Possible values are:</td>
<td>Comma</td>
</tr>
<tr>
<td></td>
<td>- Caret Symbol</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Closing Curly Bracket</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Closing Parenthesis</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Closing Square Bracket</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Colon</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Comma</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Exclamatory Mark</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Minus</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Opening Curly Bracket</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Opening Parenthesis</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Opening Square Bracket</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Pipe Symbol</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Plus</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Question Mark</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Semi-Colon</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Star Symbol</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Tilde Symbol</td>
<td></td>
</tr>
<tr>
<td>Escape Special Characters</td>
<td>If selected, then RFC4180 format is used, and quotes are escaped with another set of quotes.</td>
<td>Deselected</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
<td>Default Value</td>
</tr>
<tr>
<td>-------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>---------------------</td>
</tr>
<tr>
<td>Decimal Separator</td>
<td>The decimal separator used in your export file. Possible values are Comma and Period.</td>
<td>Period</td>
</tr>
<tr>
<td>Date Format</td>
<td>The format of the date fields in your file. Possible values are:</td>
<td>US - MM/DD/YYYY</td>
</tr>
<tr>
<td></td>
<td>- EU-YYYY/MM/DD</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- ISO 8601 - YYYY-MM-DD</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- UK/Canada - DD/MM/YYYY</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- US - MM/DD/YYYY</td>
<td></td>
</tr>
<tr>
<td>Time Stamp Format</td>
<td>The format of time fields in your file. Possible values are:</td>
<td>US - MM/DD/YYYY</td>
</tr>
<tr>
<td></td>
<td>- Canada - DD/MM/YYYY hh:mm:ss PM</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- EU - YYYY/MM/DD 24:mm:ss</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- ISO 8601 - YYYY-MM-DDT hh:mm:ss sss+/hh:mm</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- UK - DD/MM/YYYY 24:mm:ss</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- US - MM/DD/YYYY hh:mm:ss PM</td>
<td></td>
</tr>
<tr>
<td>File Encoding</td>
<td>The format in which the characters within your source file are encoded. Possible values are:</td>
<td>Unicode - UTF - 8</td>
</tr>
<tr>
<td></td>
<td>- Chinese Simplified - GB, CP936</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Chinese Traditional - CP950</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Eastern European - Win, CP1250</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Greek - MS Windows, CP1253</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Japanese - Shift-JIS, CP932</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Unicode - UTF - 8</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Unicode - UTF - 16</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Unicode - UTF - 16BE, Mac, Unix</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Unicode - UTF - 16LE, MS Windows</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Western European - Win, CP1252</td>
<td></td>
</tr>
<tr>
<td>End of Line</td>
<td>The character used to indicate end of line in the export file. Possible values are:</td>
<td>Line Feed</td>
</tr>
<tr>
<td></td>
<td>- Carriage Return</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Carriage Return and Line Feed</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Line Feed</td>
<td></td>
</tr>
<tr>
<td>Quote Character</td>
<td>The character used to indicate a quote. This field is read-only.</td>
<td>N/A</td>
</tr>
<tr>
<td><strong>Option</strong></td>
<td><strong>Description</strong></td>
<td><strong>Default Value</strong></td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>------------------</td>
</tr>
<tr>
<td>Language Independent Header</td>
<td>Select to export column headers. If you're modifying the exported data manually, then exporting column headers help in automatic mapping during the reimport process.</td>
<td>N/A</td>
</tr>
<tr>
<td>Notification Email</td>
<td>The email to send export-processing notifications. The user submitting the export receives an email notification automatically. You use this field to specify any additional recipients. If you want to have more than one email recipient, separate the email addresses with a comma or semicolon. You can also specify a mailing list address so that a large number of recipients can be notified. If you don't want to receive the notification, then set the profile option ORA_ZCA_IMPEXP_ENABLE_EMAIL_NOTIFY to 'N' at user level.</td>
<td>N/A</td>
</tr>
<tr>
<td>Enable Split</td>
<td>Select to split the export data set based on a specified record count. On selecting this check box, you can see the <strong>Split Size</strong> drop-down list, with a default value of 100k. You can specify the split size in multiples of 100k records, ranging from 100k to 1000k. The exported data is split into multiple CSV files, and each file has a maximum of 50K records. You can further split the exported data into multiple ZIP files, based on the specified split size. For example, if your export job retrieves 300k records and split is enabled with a split size of 200k, then 2 export ZIP files are generated. The first ZIP file contains 200k records which is divided into 4 CSV files each with 50k records. The second ZIP file contains 100k records which is then divided into 2 CSV files each with 50k records.</td>
<td>N/A</td>
</tr>
</tbody>
</table>

- **In the Create Schedule region**, you can schedule the export to run either immediately or at a future date. If you select a future date, then provide the date and time to start the export.
You can save the Advanced Options for subsequent reuse by clicking on the Save advance options link in the UI. The options will be retained till you click on the Reset link and reset the options to application defaults.

**Note:** All fields except Schedule Mode and Schedule start time will be saved.

5. Click Next. On the Map Fields page you can see the exportable object, its child objects, and the associated attributes. The Export Mapping drop-down list shows the maps that were used in earlier export jobs. You can select an existing mapping from the drop-down list and click Apply.

You can save your export maps for future use by clicking on the pencil icon (Save As) in the Create Export Activity page. You can also mark your maps as private by checking the Private Map checkbox. Private maps can only be viewed and reused by the user who created and saved the map.

**Note:** Your maps will only be saved once the job is completed.

To select and apply your saved maps, check the My Maps checkbox, select the required map from the Export Mapping drop down and click Apply in the Create Export Activity page.

6. You can select the child objects to export by selecting the Enabled check box. Selecting the Enabled check box for a child object displays the associated attributes in the Available Fields section. You can select the attributes to export by double-clicking the attribute in the Available Fields list. Alternatively, you can move the attribute from Available Fields list to the Selected Fields list. If you select any formula fields for export, it might impact your export performance.

7. You must provide a filter criterion for at least the top-level object. To filter the records to export using conditions, click the Filter Name icon. On the Filter Name dialog box, you can create the filter for the export attributes using the operators AND, OR, >, <, =, and !=. On the Fields tab select the attribute and click the Insert button. In the Script Edit window, provide the filter conditions for the selected attribute. After creating the filter criteria script, click Validate Script. Click Save and Close to save the filter.

**Note:** You must use GeographyCode='TM' filter to export the Zone Hierarchies. To export both Zone Hierarchy information and Geography Country Information, you need to use filter GeographyCode='TM' Or CountryCode='DE'.

8. Click Next. On the Review and Submit page, review the export activity configuration. If you want to change any configuration, then click the Back button. Submit to activate the export activity. After the export activity completes, clicking the My Completed Exports infotile shows your export status. Click the ZIP file link in the Exported Data File column to download the exported file.

You can cancel the export by clicking the Cancel icon in the Manage Exports page when the job status is Paused, Queued for Export, Preparing data to Export, or Exporting Data.

**Note:** The cancel job option is available for the logged in user and the hierarchy user only when the profile option ORA_ZCA_IMPEXP_RESTRICT_USERACCESS is enabled.

**Note:** CSV String Escape: By default, the escape character is a " (double quote) for CSV-formatted files. If a value contains a comma, a newline character, or a double quote then the string must be enclosed in double quotes. For example: "Newline char in this field \n". A double quote must be escaped with another double quote. For example: "The double quote character "" is offensive."."
Note: By default, you can't view the Personally Identifiable Information (PII) such as mobile numbers in the exported data. To view this information, follow these steps:

1. Navigate to **Tools > Security Console**.
2. Search for the role **ORA_MOT_QUOTA_EXPORT_MANAGEMENT_DUTY**.
3. Edit role and click the **Data Security Policies** link.
4. Click the **Create Data Security Policy** button, and add a new data security policy on the database resource **Trading Community Contact Point** with the following details.
   - Policy Name: Custom Grant on Person Contact and Mobile Phone Data (you can provide any name)
   - Database Resource: HZ_CONTACT_POINTS
   - Data Set: All Values
   - Actions: View Trading Community Person Contact, View Trading Community Mobile Phone Number
5. Click OK to save and navigate to **Summary** step to review and save changes.

Related Topics
- How You Monitor Export Activity
- Export Queues
- Roles Required for Import and Export Management

Export Queues

This topic describes the different infotiles displayed on the Manage Exports page of the Export Queue tab.

Export Queue

The following infotiles are displayed on the **Manage Exports** page:

- **All Exports**: This infotile displays the count of active, completed, and unsuccessful exports submitted by all users. Click to see the exports created by all the users and in all possible statuses.
- **Active Exports**: This infotile displays the count of exports submitted by all users that are either in progress or in queued status. Click to see the active exports created by all the users.
- **My Completed Exports**: This infotile displays the count of exports submitted by the current user that are either successful or failed with warnings or errors. Click to see the completed exports created by the current user.
- **Unsuccessful Exports**: This infotile displays the count of unsuccessful exports submitted by all users. Click to see the unsuccessful exports created by all users.

Note: The export activity records appear in the queue for thirty days, after which they’re removed. The exported ZIP files and diagnostic files are removed from the server on the 7th day of the export.
Export Details
You can view more details about the exports on clicking the infotiles. The following details about the export are displayed:

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of the export job. Click to go to the Export Status page.</td>
</tr>
<tr>
<td>Object</td>
<td>The object exported.</td>
</tr>
<tr>
<td>Status</td>
<td>The status of the export job. For more information about the statuses, see the topic How You Monitor Export Activity in the related topics section.</td>
</tr>
<tr>
<td>Start Time</td>
<td>The start date and time of the export.</td>
</tr>
<tr>
<td>End Time</td>
<td>The end date and time of the export.</td>
</tr>
<tr>
<td>Submitted By</td>
<td>The user who submitted the export.</td>
</tr>
<tr>
<td>Exported data file</td>
<td>The link to download the exported data file in ZIP format.</td>
</tr>
</tbody>
</table>

You can filter the export using any of the columns in the preceding table. You must select the filter value from the Search drop-down list and enter the criteria in the adjacent text box.

Related Topics

How You Manage Export Objects
Export objects correlate with tables in Oracle Applications Cloud. Understand export objects and their attributes to manage the data that you want to export.

Supported Objects
You can export these objects and their child objects using Export Management:

- Access Groups
- Account
- Action
- Action Plan
- Activity
- Asset
• Assignment Rule Candidate
• Assignment Rule Condition
• Assignment Rule
• Assignment Rule Set
• Business Plan
• Campaign
• Case
• Competitor
• Contact
• Contract
• Contests
• Deal Registration
• Duplicate Resolution Request
• Geographies*
• Goals
• Household
• HRHelpDeskRequest
• Hub Source System Reference
• Inbound Message
• Incentive Rule Assignments
• Incentive Rule Attribute Values
• Incentive Rules
• Incentive Transaction
• Interaction
• KPI
• MDF Budget
• MDF Claim
• MDF Request
• Nonduplicate
• Note
• Objective
• Opportunity
• Organization
• Partner
• Partner Programs
• Price Book Header
• Product
• Product Group
• Program Enrollments
• Promotion
• Queue
• Relationship
• Resolution Link
• Resolution Request
• Resource
• Resource Capacity
• Sales Lead
• Sales Orders
• Sales Territory
• Sales Territory Quota
• Self-Service Role
• Service Request
• Standard Lookups
• Standard Text
• Standard Text Folder
• Standard Text User Variable
• Subscription
• Template
• Territory Geographies
• Transaction
• Trees

Note: Legal Note: By exporting the Geographies data from the Oracle environment to Your environment, You agree that (a) oracle is granting You only a restricted right to download the exported Geographies data specifically for Your use with the Oracle Fusion services, (b) the Geographies data may not be used, transferred, or uploaded for any other purposes; and (c) except for the restricted right granted in (a), all provisions of the Oracle Cloud Services Agreement (CSA) or Schedule C, as applicable to You, remain in full force and effect, including specifically section 3.4 thereof.

Export Object Details

Click Tools > Export Management > Export Objects. To see the details of an export object, select it on the Export Object Details page. Here are the details that you see about each exportable object:

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display Name</td>
<td>The object as it's called in the User Interface.</td>
</tr>
<tr>
<td>Language Independent Code</td>
<td>The internal name of the object.</td>
</tr>
<tr>
<td>Parent Object</td>
<td>The parent object of the selected object. If there are multiple parents for an object, they're shown separated by comma.</td>
</tr>
</tbody>
</table>
Export Your Data

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>View Hierarchy</td>
<td>Clicking on the View Hierarchy icon shows the hierarchy between the parent and child objects in a graphical format.</td>
</tr>
<tr>
<td>User Key</td>
<td>The attribute or the group of attributes that's used to uniquely identify a record.</td>
</tr>
<tr>
<td>Required Attributes</td>
<td>The attribute or the group of attributes for which values are required to create a record. These can't be NULL when updating a record.</td>
</tr>
</tbody>
</table>

**Target Attributes**

Here are the details that you see for each target attribute.

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display Name</td>
<td>Name of the target attribute in the User Interface.</td>
</tr>
<tr>
<td>Attribute Name</td>
<td>Internal or field name of the attribute.</td>
</tr>
<tr>
<td>Required</td>
<td>Indicates whether the attribute is mandatory or not.</td>
</tr>
<tr>
<td>Default Value</td>
<td>The default value for the attribute, if any.</td>
</tr>
<tr>
<td>Type</td>
<td>Data type of the target attribute.</td>
</tr>
<tr>
<td>Length</td>
<td>Maximum allowed length for the target attribute values.</td>
</tr>
<tr>
<td>Description</td>
<td>A short description of the target attribute.</td>
</tr>
</tbody>
</table>

**Export Inactive and Merged Data**

You can now export inactive and merged accounts, contacts, households, organizations, and persons using export management. You don’t need to rely on Data Model Queries to fetch the deleted or merged records anymore.

**Note:** To export inactive records you need to explicitly add the condition to the criteria, or else only the active records will be exported. For example, I for Inactive and M for merged. All associated Child records (active or inactive) will be exported irrespective of their status, if no criteria is added.
How You Monitor Export Activity

This topic explains how to monitor export activities and view their statuses.

View the Export Status

On the Manage Exports page, click the export activity name link to see additional information about the export activity. The Export Status page contains the following sections:

- Status Bar
- Details
- Export Attachments

The Export Status Bar

The status bar shows the progress of the export activity in a graphical format. It shows the following stages during the export process:

1. Queued for Export: The export request is queued for processing, and is waiting to begin execution.
2. Preparing data for Export: The data are loaded in the temporary staging table for further processing.
3. Exporting data: The data from the target objects are loaded into the export files (CSV).
4. Completing export activity: The export data have been loaded in the source files, and cleanup tasks, such as the generation of log files, are in progress.
5. Completed with errors: The export activity has completed with errors.
6. Completed with warnings: The export activity has completed with warnings.
7. Unsuccessful: The export activity was unsuccessful.

Activity and Record Details

The Activity Details section shows the name of the export activity, export job identifier, object exported, and the name of user who submitted the export. The section on date and time displays the start and end times, and the time taken to complete the export activity.

The Record Details section displays the number of records estimated, number of records exported, and the number of records with errors.

The object must not include any field with display name length greater than 120 characters. Your export job may fail if it includes a field with display name length greater than 120 characters.

Export Attachments

You can generate the diagnostics and log files from the Action menu. The Export Attachments section displays the list of files associated with this export activity in tabular format. The Actions column in this section lets you either download the file or view more details. These files include the diagnostics and log files generated.

Note: The export data is stored on the UCM server for some time before it's purged. The duration after which export data should be purged is set in the profile option ZCA_EXPORT_UCM_PURGE_DURATION. The default value is 30.
How You Monitor Export Activities Using REST APIs

This topic explains how to receive completion notification through REST resource and also avoid the need to constantly keep checking the export status.

To receive export completion notification through REST service, you must define the REST service endpoint in Application Composer. You can configure and register your REST endpoint to receive notifications whenever your export job completes.

Register an External REST Endpoint in Application Composer

To register an endpoint for notification:

1. Create and enter into a sandbox by navigating to Configuration > Sandboxes > Create Sandbox.
2. Navigate to Configuration > Application Composer > Web Services. Note that this option is available only when you're inside the sandbox.
3. You can edit the existing endpoints, or create a new endpoint such as ExternalEndPoint1, by clicking the Create icon.
4. Enter the name of the endpoint and the URL, and select the authentication scheme. For example, your URL can be in the format https://servername/ic/api/integration/v1/connections/cbveTest.
5. Select and configure the POST method by clicking the check box for POST. Currently only POST method is supported for the Export Notification feature.
6. Select and provide the code samples for the request and response payloads. Following is the sample for request and response payloads:

   ```json
   {  
     "items": [],  
     "count": 0,  
     "hasMore": false,  
     "limit": 25,  
     "offset": 0,  
     "links": [{  
       "rel": "self",  
       "href": "https://servername/ic/api/integration/v1/connections/cbveTest",  
       "name": "ExternalEndPoint1",  
       "kind": "collection"  
     }]
   }
   ```
7. Click Save and Close.
8. After making the changes, publish the sandbox to commit your changes.

Validate the Endpoint

You can validate the REST endpoint to ensure that your REST web service configuration in Web Services in Application Composer is correct and the export process can call the endpoint successfully. To validate your REST endpoint and set an endpoint as default:

1. Navigate to Tools > Export Management > Export Configuration > REST Notification.
2. Here, select REST Notification as the notification type, and select the endpoint you registered from the Notification Endpoint drop-down list. In our example, select ExternalEndPoint1.
3. To make this connection as the default one while creating export jobs, select the Set as default check box.
4. To validate, click the Payload Details section, and click the Validate REST Endpoint button. If your endpoint is valid, then you see one of the following response statuses in the Response text box:
   - 200
   - 201
   - 202
   - 204

   Any other response status indicates that the endpoint is invalid.

Create the Export Activity and Monitor the Status

1. Navigate to **Tools > Export Management > Create Export Activity**.
2. Create the export activity, enter the name, and select the object to export.
3. Click the **Advanced Options** section and select the notification endpoint `ExternalEndPoint1` from the **Notification Endpoint** drop-down list. If you don't want to receive the notification, then select a blank value in the drop-down list.
4. Click **Next** and select the attributes to export on the **Map Fields** page. Create a filter for at least the top-level object, and click Next. For more information on creating an export activity, see the topic Export Data.
5. Review your export configurations and submit the export job. Once you submit the export, you can monitor the status by accessing the configured endpoint.
6. Alternatively, you can verify whether the notification is submitted by downloading the log files. The last entry in the file indicates the status of notification.

Export Notification in REST

You can use the `RestNotification` attribute to specify your notification endpoint while creating your export activity using REST. For example, you can use the following sample payload to create your export activity:

```json
{
  "Name": "Account_Export",
  "ExportObject": "Account",
  "ExportFilterCriteria": "OrganizationName IS NOT NULL",
  "ExportFileName": "Account.zip",
  "Activate": "YES",
  "RestNotification": "ExternalEndPoint1"
}
```

The following table describes the behavior when you don't provide the REST notification endpoint.

<table>
<thead>
<tr>
<th>REST Notification Value</th>
<th>Endpoint Used for Export Job</th>
<th>REST Notification Behavior</th>
</tr>
</thead>
<tbody>
<tr>
<td>null</td>
<td>Default endpoint is selected</td>
<td>REST notification is sent to the default REST endpoint.</td>
</tr>
<tr>
<td>REST notification not passed</td>
<td>Default endpoint is selected</td>
<td>REST notification is sent to the default REST endpoint.</td>
</tr>
<tr>
<td>***</td>
<td>No REST endpoint is selected</td>
<td>No REST notification is sent.</td>
</tr>
</tbody>
</table>
Export Attachments

This topic explains how to export and download the object attachments to your local directory. You can export the attachments in two steps:

1. Export the object records and the attachment information based on the selected search criteria of the object.
2. Download the attachment files from the content management server using the External Data Loader Client tool.

Export the Object Records and the Attachment Information

To export the object records and the attachment information:

1. Click Tools > Export Management.
2. On the Manage Exports page, click the Create Export Activity button.
3. On the Enter Export Options page, enter the export activity information such as export name, export object, and the file name. For more information on exporting data, see the topic Export Data.
4. Select the Export attachment check box to enable exporting the object attachments. You can optionally enter the advanced configuration options. Click Next.
5. On the Map Fields page, you can select the attributes to export by dragging them from the Available Fields section to the Selected Fields section. The Export Mapping drop-down list shows the maps used in earlier export jobs. You can select an existing mapping from the drop-down list and click Apply. You can select the Enabled check box to export the child object attributes.
6. You must provide a filter criterion for at least the top-level object. To filter the records to export using conditions, click the Filter Name icon and enter the filter criteria for your object records. Click Next. On the Review and Submit page, review the export activity configuration and click Submit.
7. After the export activity completes, clicking the My Completed Exports infotile shows your export status. Click the ZIP file link in the Exported Data File column to download the exported file.

Download the Attachment Files

The ZIP file you downloaded in the previous step contains the following files:

- The attachment information CSV file - this file contains information about the attachment records such as content ID, REST resource URL, attachment file name, and so on.
- Attachment download instructions file - this HTML file contains the export details, and the sample EDLC command to download the attachments.

You can use the export command of EDLC to download the attachment files from the content management server to your directory. For example, use the following command to download your attachments exported from the previous step:

```java
java -jar oscdataloader.jar export -object Attachments -export-id {export-id} -username {username} -target-url {environment-url} -output-path {output-directory-path}
```

Following are the parameters used in the command:
<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>-objects</td>
<td>Indicates the object type exported. Currently this parameter supports only the value Attachments.</td>
</tr>
<tr>
<td>-export -id</td>
<td>Job ID of the export job.</td>
</tr>
<tr>
<td>-username</td>
<td>User name of the user submitting the export command. This must be the same user who submitted the export activity.</td>
</tr>
<tr>
<td>-target-url</td>
<td>URL of the environment.</td>
</tr>
<tr>
<td>-output-path</td>
<td>Directory path of the folder where the attachment files and reports are downloaded. The reports folder contains details about the attachment files exported, such as their status and error details if any. This should be an existing directory with read and write permissions for the user performing the export.</td>
</tr>
</tbody>
</table>

You can view the details of all available parameters and their descriptions using the command export -help.

**Related Topics**
- Export Data
- Overview of External Data Loader Client
- Command-Line Parameters
16 Configure Data Enrichment

Overview of Configuring Data Enrichment

You can use Oracle Account and Contact Enrichment by Dun & Bradstreet (D&B) for Sales to enrich your account and contact data.

Oracle Account and Contact Enrichment by Dun & Bradstreet (D&B) gets the most up-to-date data for over 300 million companies and over 100 million contacts worldwide. You can also use Oracle DataFox for data enrichment. For more information about DataFox, see Oracle DataFox documentation.

Data enrichment improves the quality of your existing account and contact data, and it also enriches the data with additional information. Sales representatives can enrich accounts and contacts in real-time in Sales, and data stewards can enrich data in bulk in CDM, using either batch data enrichment in the Data Enrichment work area or manually using bulk import and export. Additionally, you can download new account and contact data from Oracle Account and Contact Enrichment by Dun & Bradstreet (D&B).

How you Configure Batch Data Enrichment

The batch data enrichment option lets you enrich data in bulk by creating and submitting batch-processing jobs in the Data Enrichment work area. Configuring this enrichment process flow requires the completion of the following set-up steps:

1. Create a Oracle Account and Contact Enrichment by Dun & Bradstreet (D&B) user and assign appropriate privileges.
2. Configure Oracle CX Sales and B2B Service to Oracle Account and Contact Enrichment by Dun & Bradstreet (D&B) integration.

For more information about creating users, see the Related Topics section. Here are the steps that you can follow to configure Customer Data Management Cloud to Account and Contact Enrichment by Dun & Bradstreet Integration to do batch data enrichment in the Data Enrichment work area. Note that we use Manage Data Enrichment Integration task instead of the Manage Integration with Oracle Data as a Service task for configuring enrichment. The Manage Integration with Oracle Data as a Service task isn’t supported in later releases.

1. Sign in to Customer Data Management Cloud as a setup user.
2. Navigate to Setup and Maintenance.
3. Click the Tasks side panel to open it, and click Search.
4. Search for and go to the task: Manage Data Enrichment Integration.
5. Enter the following information on the Manage Data Enrichment Integration:

   Select OAuth Authentication on the DaaS Credentials section.

   For information about adding a confidential application and getting the Client ID and Secret, see Add a Confidential Application topic in the Administering Oracle Identity Cloud Service guide.

   **Note:** On the Client page of the Add Confidential Application wizard, in the Authorization section, select Resource Owner, Client Credentials, Authorization Code, and Refresh Token as Allowed Grant Types. Leave Redirect URL blank.

   **Note:** We strongly recommend that you use OAuth authentication method because Basic authentication isn’t supported in later releases. If you use Basic Authentication, don’t include the question mark special character (?) in the password. For URL, remove /data/ui from the end of the instance address listed in your Welcome email and in the Cloud Console.

   For URL, remove /data/ui from the end of the instance address listed in your Welcome email and in the Cloud Console.


6. Click Save and Close.

For more information on the setup process, see Batch Data Enrichment Setup in the Related Topics section.

### Enrich Sales Account and Contact Data

Customer Data Management comes with preconfigured mappings (automatic mapping) of data attributes to enrich sales account and contact data from Oracle Account and Contact Enrichment by Dun & Bradstreet (D&B) using the batch enrichment process. You can view this mapping of sales account and contact attributes with Oracle Account and Contact Enrichment by Dun & Bradstreet (D&B) attributes in Oracle Account and Contact Enrichment by Dun & Bradstreet (D&B). For more information about this predefined mapping, see the About Mappings topic in the Related Topics section.

You may want to map sales account or contact attributes with Oracle Account and Contact Enrichment by Dun & Bradstreet (D&B) attributes of your choice. For example, you may want to enrich the currency attribute of sales account or enrich the competitor company attribute of sales contact. If you want to enrich additional attributes that aren’t already mapped in the predefined mappings, you must create custom attributes and then create an import mapping using these custom attributes. Custom attributes are created using Application Composer. For more information about creating custom attributes, see the Configuring Applications Using Application Composer guide.

You can create one or more import mapping for each sales account and contact object. Customer Data Management provides a set of profile options for managing data enrichment of sales account and contact objects. You can use these profile options to select the import mapping for a sales account and contact object during data enrichment. All batch data enrichment requests and synchronization jobs use the selected import mapping.

**Note:** These settings don't impact real-time and account smart data. For more information, see the Configure Data Enrichment Attribute Mappings and Preferences in the Related Topics section.

To sum up:

- Create an import mapping.
- Select the import mapping for a sales account or contact object using its profile option.
Create an Import Mapping:

Prerequisite: Before you create an import mapping, you need a source file that contains the seeded mapping for account or contact. You can export account or contact data from Oracle Account and Contact Enrichment by Dun & Bradstreet (D&B) which can then be used as the source file for creating a new mapping.

1. Go to Navigator > Tools > Import Management
2. Click the Import Objects tab.
3. Select the required object. For example, you can select Account.
4. Click the Create Import Mapping button.
5. Specify a name in the File Import Mapping field.
6. Click Action > Select Source File.
   Select a template file that’s downloaded from Oracle Account and Contact Enrichment by Dun & Bradstreet (D&B).

   A list of Oracle Account and Contact Enrichment by Dun & Bradstreet (D&B) attributes in the source file is displayed in the Source File table under the Map Fields section.
7. Type the name of the required Oracle Account and Contact Enrichment by Dun & Bradstreet (D&B) attribute in the Search field of the Source File section.
   All attributes matching the search criteria are displayed under Column Header and their values are displayed under Example Value.
8. Similarly, type the name of the newly created custom CDM Cloud attribute in the Search field of the Target Attributes section.
9. Drag and drop the CDM Cloud attributes from the Target Attributes list to the Attribute Display Name field corresponding to the required Oracle Account and Contact Enrichment by Dun & Bradstreet (D&B) attribute. Repeat this step for all the required attributes.
10. Click Save and Close.

Select the Mapping Using Profile Options: After the import mappings are created, you can select the newly created mapping for data enrichment using a set of profile options.

Perform the following steps to access the profile options.

1. Click Navigator > My Enterprise > Setup and Maintenance work area.
2. Click the Tasks menu and click Search. Search for Manage Administrative Profile Values task and open it.
3. Search and set the following profile options as needed:
   - Account Enrichment Map (ORA_ZCH_ACCOUNT_BATCH_ENRICHMENT_IMPORT_MAP): select the import mapping for the Account object.
   - Additional Name Enrichment Map (ORA_ZCH_ADDITIONAL_NAME_BATCH_ENRICHMENT_IMPORT_MAP): select the import mapping for the Additional Name.
   - Additional Identifier Enrichment Map (ORA_ZCH_ADDITIONAL_IDENTIFIER_BATCH_ENRICHMENT_IMPORT_MAP): select the import mapping for the Additional Identifier object.
   - Classification Enrichment Map (ORA_ZCH_CLASSIFICATION_BATCH_ENRICHMENT_IMPORT_MAP): select the import mapping for the Classification object.
   - Address Enrichment Map (ORA_ZCH_ADDRESS_BATCH_ENRICHMENT_IMPORT_MAP): select the import mapping for the Address object.
   - ContactPoint Enrichment Map (ORA_ZCH_CONTACT_POINT_BATCH_ENRICHMENT_IMPORT_MAP): select the import mapping for the Contact Point object.
The profile value field for the these profile options displays a list of existing import mappings in addition to the Automatic Mapping. By default, the Automatic Mapping option is selected. You can select any import mapping that was already created. All the batch enrichment requests and synchronization jobs that are submitted from this point on use the newly selected mapping.

How you Configure Manual Data Enrichment

CDM comes with preconfigured mappings of data attributes to import account and contact data from Oracle Account and Contact Enrichment by Dun & Bradstreet (D&B). If you require additional attributes not in these mappings, you must create a custom mapping and manually import the data using that mapping.

For more information on creating a new mapping in Oracle Account and Contact Enrichment by Dun & Bradstreet (D&B), see Create a New Mapping in the Related Topics section.

For more information on manual data enrichment from Oracle Account and Contact Enrichment by Dun & Bradstreet (D&B), see Manual Data Enrichment in the Related Topics section.

Related Topics

- Batch Data Enrichment Setup
- Configure Oracle Account and Contact Enrichment by Dun & Bradstreet (D&B)
- Manual Data Enrichment
- About Mappings

Best Practices for Data Enrichment

Before you enrich accounts or contacts, you must perform some steps to ensure that enrichment goes through smoothly.

Here are the steps:

- Verify that there are no errors after mapping attributes on the Manage Oracle Data as a Service Attribute Mapping and Preferences setup task. If there are any errors, correct the mapping or reset them to defaults.
- If the attributes on the Manage Oracle Data as a Service Attribute Mapping and Preferences setup task are mapped to any lookup types, verify that the lookups are enabled on the Manage Standard Lookups page.

Specify the Industry Classification for Accounts

Use the following procedure to specify which industry classification category you want to use for accounts.

The classifications for the category you select appear in the list of values for the Industry field in the Account user interface. By default, the profile is set to CUSTOMER_CATEGORY.

1. Sign in as a setup user.
2. In the Setup and Maintenance work area, go to the following:
   ○ Offering: Sales
3. On the Manage Administrator Profile Values page, search for the Profile Option Code MOT_INDUSTRY_CLASS_CATEGORY.

4. Select the classification category from the Profile Value list. The available values are:
   - 1972 SIC
   - 1977 SIC
   - 1987 SIC
   - CUSTOMER_CATEGORY
   - NACE
   - NAF
   - NAICS_1997
   - NAICS_2002
   - NAICS_2017

5. Click Save and Close.

Manual Data Enrichment

You can manually enrich sales account and B2B contact data using the Oracle Account and Contact Enrichment by Dun & Bradstreet service.

For detailed steps, see the topics About Matching Records and Enrich Data in CX Sales in the Using Account and Contact Enrichment by Dun & Bradstreet guide.

Related Topics
- Manual Data Enrichment
Customer Hub Profile Options

Customer Hub profile options configure data access and processing for data governance, duplicate identification processes, data cleansing processes, and duplicate resolution requests.

You can set the Hub profile option values only at the site level using the predefined profile option definitions. The following table lists the Customer Hub profile options that you can configure in the Setup and Maintenance work area using the following:

- Offering: Customer Data Management
- Functional Area: Customer Hub
- Task: Manage Customer Hub Profile Options

<table>
<thead>
<tr>
<th>Profile Option Code</th>
<th>Profile Option Name</th>
<th>Description</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>ZCH_CLNS_PROC_BT_SIZE</td>
<td>Data Cleansing Process Batch Size</td>
<td>The transaction batch size for the data cleansing process. Set this value based on available system resources.</td>
<td>10000</td>
</tr>
<tr>
<td>ZCH_DEDUP_REQUEST_TYPE_OPTION</td>
<td>Resolution Request Type Default</td>
<td>The default request type for the duplicate resolution requests.</td>
<td>Merge</td>
</tr>
<tr>
<td>ZCH_DI_PROC_BT_SIZE</td>
<td>Duplicate Identification Process Batch Size</td>
<td>The transaction batch size for the duplicate identification process. It's used to group records in the batch and process each group in a loop as a separate transaction.</td>
<td>100</td>
</tr>
<tr>
<td>ZCH_USER_MERGE_REQUESTS</td>
<td>User Merge Requests</td>
<td>The processing options for merge requests.</td>
<td>Unspecified (NULL)</td>
</tr>
<tr>
<td>ZCH_ENABLE_SURVIVORSHIP</td>
<td>Survivorship Enabled</td>
<td>The option to enable survivorship rules for duplicate resolution.</td>
<td>Yes</td>
</tr>
<tr>
<td>ZCH_AUTO_LINK_THRESHOLD</td>
<td>Auto Link Threshold</td>
<td>The threshold for auto link. Data stewards review link requests with lower scores.</td>
<td>0</td>
</tr>
<tr>
<td>ZCH_AUTO_MERGE_THRESHOLD</td>
<td>Auto Merge Threshold</td>
<td>The threshold for auto merge. Data stewards review merge requests with lower scores.</td>
<td>100</td>
</tr>
</tbody>
</table>
### Manage Profile Options

<table>
<thead>
<tr>
<th>Profile Option Code</th>
<th>Profile Option Definition</th>
<th>Default Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ZCH_DI_MERGEREQ_REC_SIZE</td>
<td>Duplicate Set Record Number</td>
<td>10</td>
<td>The maximum number of records in a duplicate set that can be automatically converted to duplicate resolution requests.</td>
</tr>
</tbody>
</table>

You can set the following values for the User Merge Requests profile option:

- **Allow Processing Without Approval:** Merge requests are processed immediately without approval by data steward.
- **Process Subject to Approval:** Merge requests are reviewed by data steward, who can decide to approve or not.
- **Unspecified (NULL):** Merge requests are processed immediately without data steward approval. This indicates that the Customer Hub isn't configured. The option is enabled only if the user has the Submit Trading Community Merge Request and Enter Trading Community Merge Request privileges.

**Note:** Data stewards must review merges initiated from the Accounts and Contacts UI pages, Automerge web service, or the Duplicate Resolution Request service. Data stewards can review merge requests only if the User Merge Requests profile option is set to Process Subject to Approval, else the merge requests will error.

### Additional Profile Options

The following table lists customer hub profile options that require careful consideration before their profile values are changed.

To view the details of these profile options:

1. Click **Navigator > My Enterprise > Setup and Maintenance**
2. Click the Tasks menu and click **Search**. Search for **Manage Profile Options** task and open it.
3. Search using the profile option code.

To change the default values of these profile options:

1. Click **Navigator > My Enterprise > Setup and Maintenance work area**
2. Click the **Tasks** and click **Search**. Search for **Manage Administrator Profile Values** task and open it.
3. Search using the profile option code.
4. Change the profile value.

<table>
<thead>
<tr>
<th>Profile Option Code</th>
<th>Profile Option Definition</th>
<th>Default Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ORA_ZCH_AGREEMENT_EVALUATION</td>
<td>Evaluate Agreement Rules</td>
<td>No default value provided</td>
<td>This profile option controls whether agreement rules are honored during merge processing. Setting this option to N disables agreement rule checking. We recommend that you don't disable agreement rules. Disabling agreement rules can lead to orphan data and may cause issues for different application flows. You can add a new profile value row and specify Y or N.</td>
</tr>
</tbody>
</table>
### Profile Option Code | Profile Option Definition | Default Value | Description
--- | --- | --- | ---
ORA_ZCH_DEBUG | Customer Hub Debug Mode | No default value provided | This profile option enables detailed internal logging of the duplicate resolution processes. We recommend that you don’t enable this option unless specifically requested to do so by the Oracle support team.
You can add a new profile value row and specify Y or N.

ORA_ZCH_ENABLE_DEFAULT_SOURCE | Calculate Default Source System for Survivorship Rules | No default value provided | This profile option enables the calculation of default attribute source systems based on the earliest source system reference assignment for records that were created before attribute source history tracking was enabled.
You can add a new profile value row and specify Y to enable this feature.

ORA_ZCH_SETATTRIBUTE_OPTIONS | Attribute Survivorship Null Value Options | IGNORE_NULL_VALUE | This profile option controls whether a selected attribute survivorship rule can update the master record with a null value. For example, a record within a merge set has the highest source confidence level for a given field and also has a null value in that field, you can decide if a non-null value on the master record be replaced by the null value from the highest confidence source record. By default, survivorship processes don’t replace a non-null with a null even if the source of the null has the highest source confidence. If you would like a null value to propagate to the master record in this scenario, you should set this profile option to RETURN_NULL_VALUE.

ORA_ZCH_ALLOW_REMOVE_FEATURE | Remove Records From Merge Processing | N | This profile option is used to enable the Remove button in the duplicate resolution override flow. The Remove button lets you remove specific records from being handled by the merge process. We recommend that you don’t change this profile option because using the Remove capability can lead to orphan records which may have adverse affects on other business processes.
## Manage Profile Options

<table>
<thead>
<tr>
<th>Profile Option Code</th>
<th>Profile Option Definition</th>
<th>Default Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ORA_ZCH_ACCOUNT_BATCH_ENRICHMENT_IMPORT_MAP</td>
<td>Account Enrichment Map</td>
<td>Automatic Mapping</td>
<td>This profile option is used to select the import mapping for the Account object during data enrichment. You can create the import mapping using Import Management. Note that the list of profile values includes the Automatic Mapping and one or more import mappings that are already created.</td>
</tr>
<tr>
<td>ORA_ZCH_ADDITIONAL_NAME_BATCH_ENRICHMENT_IMPORT_MAP</td>
<td>Additional Name Enrichment Map</td>
<td>Automatic Mapping</td>
<td>This profile option is used to select the import mapping for the Additional Name object during data enrichment. You can create the import mapping using Import Management. Note that the list of profile values includes the Automatic Mapping and one or more import mappings that are already created.</td>
</tr>
<tr>
<td>ORA_ZCH_ADDITIONAL_IDENTIFIER_BATCH_ENRICHMENT_IMPORT_MAP</td>
<td>Additional Identifier Enrichment Map</td>
<td>Automatic Mapping</td>
<td>This profile option is used to select the import mapping for the Additional Identifier object during data enrichment. You can create the import mapping using Import Management. Note that the list of profile values includes the Automatic Mapping and one or more import mappings that are already created.</td>
</tr>
<tr>
<td>ORA_ZCH_CLASSIFICATION_BATCH_ENRICHMENT_IMPORT_MAP</td>
<td>Classification Enrichment Map</td>
<td>Automatic Mapping</td>
<td>This profile option is used to select the import mapping for the Classification object during data enrichment. You can create the import mapping using Import Management. Note that the list of profile values includes the Automatic Mapping and one or more import mappings that are already created.</td>
</tr>
<tr>
<td>ORA_ZCH_ADDRESS_BATCH_ENRICHMENT_IMPORT_MAP</td>
<td>Address Enrichment Map</td>
<td>Automatic Mapping</td>
<td>This profile option is used to select the import mapping for the Address object during data enrichment. You can create the import mapping using Import Management. Note that the list of profile values includes the Automatic Mapping and one or more import mappings that are already created.</td>
</tr>
<tr>
<td>ORA_ZCH_CONTACT_BATCH_ENRICHMENT_IMPORT_MAP</td>
<td>Contact Enrichment Map</td>
<td>Automatic Mapping</td>
<td>This profile option is used to select the import mapping for the Contact object during data enrichment. You can create the import mapping using Import Management. Note that the list of profile values includes the Automatic Mapping and one or more import mappings that are already created.</td>
</tr>
</tbody>
</table>
Data Quality Profile Options

Data quality profile options configure data access and processing for duplicate identification processes and data cleansing processes.

The following table lists data quality profile options, descriptions, and default values.

To view the details of these profile options:

1. Click Navigator > My Enterprise > Setup and Maintenance work area.
2. Click the Tasks menu and click Search. Search for Manage Profile Options task and open it.
3. Search using the profile option code.

To change the default values of these profile options

1. Click Navigator > My Enterprise > Setup and Maintenance work area.
2. Click the Tasks menu and click Search. Search for Manage Administrator Profile Values task and open it.
3. Search using the profile option code.
4. Change the profile value.

<table>
<thead>
<tr>
<th>Profile Option Code</th>
<th>Profile Option Name</th>
<th>Default Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ORA_ZCQ_MAX_CANDIDATES</td>
<td>Interactive Duplicate Identification List Size</td>
<td>20</td>
<td>This profile option lets you limit the number of possible duplicates which may be returned by the interactive duplicate identification interface.</td>
</tr>
<tr>
<td>ORA_ZCQ_BATCHMATCH_DEBUG_LEVEL</td>
<td>Batch Duplicate Identification Debug Level</td>
<td>INFO</td>
<td>This profile option controls the level of diagnostic logging for batch duplicate identification processes.</td>
</tr>
<tr>
<td>Profile Option Code</td>
<td>Profile Option Name</td>
<td>Default Value</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------------------------</td>
<td>-----------------------------------------------------------------</td>
<td>---------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>ORA_ZCQ_LEVEL_OF_INDIRECTION</td>
<td>Indirect Duplicate Candidates Level</td>
<td>0</td>
<td>This profile option controls the extent to which indirect duplicate candidates are considered during duplicate identification.</td>
</tr>
</tbody>
</table>
| ORA_ZCQ_CONVERTER_FINEST_LOGGING            | Data Quality Match Value Conversion Logging                     | N             | This profile option controls the logging on the data quality match value conversion process. When this profile option is set to Y, data quality logs are written in the log file. |}

<table>
<thead>
<tr>
<th>Profile Option Code</th>
<th>Profile Option Name</th>
<th>Default Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ORA_ZCQ_CS_DATA_REFRESH_TIME_HRS</td>
<td>Refresh Duplicate Identification Custom Scoring Dictionary Cache</td>
<td>12</td>
<td>This profile option controls the frequency in hours for refreshing the custom scoring data dictionary cache.</td>
</tr>
<tr>
<td>ORA_ZCQ_CHUNK_SIZE_FOR_CLEANSE_BATCH</td>
<td>Address Cleansing Batch Transaction Size</td>
<td>200</td>
<td>This profile option controls the number of records that are saved per transaction during batch address cleansing.</td>
</tr>
<tr>
<td>ORA_ZCQ_ENABLE_ADDR_MATCH_OBJECT</td>
<td>Address Duplicate Identification Match Configuration Enabled</td>
<td>No</td>
<td>This profile option enables the display of inactive Address Duplicate Identification configuration in Manage Enterprise Data Quality Matching Configurations UI page. This profile option works with the Data Quality Caching and Refresh Enabled (ORA_ZCQ_ENABLE_CACHE) profile option.</td>
</tr>
<tr>
<td>ORA_ZCQ_ENABLE_CACHE</td>
<td>Data Quality Caching and Refresh Enabled</td>
<td>500</td>
<td>This profile option enables the caching and refresh of frequently used data, such as server address, in the data quality matching processes.</td>
</tr>
<tr>
<td>ORA_ZCQ_CUSTOMSCORING_CLUSTER_COUNT</td>
<td>Batch Duplicate Identification Custom Scoring Candidate Keys</td>
<td></td>
<td>Specify the number of match key candidates per driver record key during batch duplicate identification candidate selection for custom scoring.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td><strong>Note:</strong> This is an Oracle internal setting. We recommend that you don’t change this value unless instructed by Oracle Support.</td>
</tr>
</tbody>
</table>
## Foundation Profile Options

Trading community profile options configure various features such as geographies, Oracle Account and Contact Enrichment by Dun & Bradstreet (D&B), address formats, and so on.

The following table lists trading community profile options, descriptions, default values, and the impact these profile options have on different parts of the application.

To view the details of these profile options:

1. Click **Navigator > My Enterprise > Setup and Maintenance** work area.
2. Click the Tasks menu and click **Search**. Search for **Manage Administrator Profile Values** task and open it.
3. Search using the profile option code.

To change the default values of these profile options:

1. Click **Navigator > My Enterprise > Setup and Maintenance** work area.
2. Click the Tasks menu and click **Search**. Search for **Manage Administrator Profile Values** task and open it.
3. Search using the profile option code.
4. Change the profile value.

<table>
<thead>
<tr>
<th>Profile Option Code</th>
<th>Profile Option Name</th>
<th>Default Value</th>
<th>Description</th>
<th>Impact</th>
</tr>
</thead>
<tbody>
<tr>
<td>HZ_UPDATE_STD_ADDRESS</td>
<td>Update Standardized Addresses Enabled</td>
<td>No</td>
<td>Enable to allow the update addresses that are already standardized using postal information.</td>
<td>This profile option is applicable to Application UI and REST</td>
</tr>
<tr>
<td>HZ_POST_IMPORT_GNR_INVoke</td>
<td>Address Validation After Import</td>
<td>Y</td>
<td>Runs the Geography Name Referencing process after import. The recommended value for this profile option value is N. This helps improve the import performance. After setting this to N, GNR process isn’t invoked for every import in the following bulk uploads. Instead, you must schedule the Validate Geographies of Addresses Against Master Geographies scheduled process every week during off peak hours to run it at a periodic interval. For more information about the Validate Geographies of Addresses Against Master Geographies scheduled process, see Validate Geographies of Addresses Against Master Geographies.</td>
<td>This profile option is applicable to File-based Import (used in high volume import) and Import Management</td>
</tr>
<tr>
<td>Profile Option Code</td>
<td>Profile Option Name</td>
<td>Default Value</td>
<td>Description</td>
<td>Impact</td>
</tr>
<tr>
<td>---------------------</td>
<td>---------------------</td>
<td>---------------</td>
<td>-------------</td>
<td>--------</td>
</tr>
<tr>
<td>HZ_ORGANIZATION_PROFILE_INDEX_THRESHOLD</td>
<td>Organization Profile Index Threshold</td>
<td>10</td>
<td>Specify the number of profile history records above which organization profile history information will be automatically denormalized into a secondary table for improved performance.</td>
<td>This profile option is applicable to REST</td>
</tr>
<tr>
<td>HZ_INVOKE_OBJ_WF_ONTRACKING</td>
<td>Child Entity Rollup Enabled</td>
<td>Yes</td>
<td>Enable rollup of the child entity changes to the root object during event tracking. This invokes the root object workflow whenever the child entities change.</td>
<td>This profile option is applicable to Scheduled Process, Application UI, REST</td>
</tr>
<tr>
<td>HZ_GENERATE_PARTY_NUMBER</td>
<td>Party Number Generation</td>
<td>Auto numbering, update allowed</td>
<td>Select how a party number will be generated, and if you can update the number when creating or editing a person or organization party.</td>
<td>This profile option is applicable to Application UI, REST</td>
</tr>
<tr>
<td>HZ_ENABLE_EVENTTRACKING</td>
<td>Composite Event Tracking Enabled</td>
<td>Yes</td>
<td>Enable composite event tracking for customer and contact entities. This tracks changes to the entities, and raises an event whenever there is a change to the entities.</td>
<td>This profile option is applicable to Scheduled Process, Application UI, and REST</td>
</tr>
<tr>
<td>HZ_AUTO_SITE_NUMBERING</td>
<td>Site Use Identifier Generation</td>
<td>Auto numbering, update not allowed</td>
<td>Select how the site use identifier will be generated, and if you can update it when creating or editing an account site use.</td>
<td>This profile option is applicable to Application UI and REST</td>
</tr>
<tr>
<td>HZ_AUTO_LOGINTERACTIONS</td>
<td>Call Interaction Logging Enabled</td>
<td>No</td>
<td>Enable adding phone calls to the interactions log when the call action is used.</td>
<td>This profile option is applicable to Application UI and REST</td>
</tr>
<tr>
<td>ORA_HZ_RES_ENABLE_MGR_END_UNCOND</td>
<td>Enable End Dating Resource Manager Unconditionally</td>
<td>N</td>
<td>Allows organization membership end date for resource with managerial role without any validation. You need not move out all reports before moving manager out. Set the value to Y to enable this option.</td>
<td>This profile option is applicable to Application UI, REST, and Import Management (only Resource object)</td>
</tr>
<tr>
<td>ORA_HZ_PURGE_MIN_AGE</td>
<td>Minimum Threshold Value for Purge of Inactive Data</td>
<td>30</td>
<td>Specify the minimum number of days after which inactive records are to be purged.</td>
<td>This profile option is applicable to Application UI</td>
</tr>
</tbody>
</table>
## Manage Profile Options

<table>
<thead>
<tr>
<th>Profile Option Code</th>
<th>Profile Option Name</th>
<th>Default Value</th>
<th>Description</th>
<th>Impact</th>
</tr>
</thead>
<tbody>
<tr>
<td>ORA_HZ_INCLUDE_REGIONAL_COUNTRY</td>
<td>Regional Country in Address Formats Included</td>
<td>No</td>
<td>Enable address format functions to include regional country. You must set the value to yes to include regional country.</td>
<td>This profile option is applicable to Application UI</td>
</tr>
<tr>
<td>ORA_HZ_GEO_HIERARCHY_LIMIT</td>
<td>Purging of Inactive Data Enabled</td>
<td>100000</td>
<td>Specify the maximum number of nodes that each parent node can handle for any geography element.</td>
<td>This profile option is applicable to Application UI and Import Management (only for geography object)</td>
</tr>
<tr>
<td>ORA_HZ_ENABLE_PURGE</td>
<td>Purging of Inactive Data Enabled</td>
<td>N</td>
<td>Enables the purging of data that are in inactive state using the Manage Party Purge Activities task. You must specify filter criteria to purge inactive data using Manage Party Purge Activities task.</td>
<td>This profile option is applicable to Application UI</td>
</tr>
<tr>
<td>ORA_HZ_ENABLE_MPLCRI_ACTIVE_WORKER</td>
<td>Enable Current Active Worker Sync For MPLCRI Job</td>
<td>No</td>
<td>Enable current active worker sync for Maintain Party and Location Current Record Information batch job. If set to N, then current active workers won't get synced to person party.</td>
<td>This profile option is applicable to Scheduled Process</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>This profile option is associated with the Maintain Party and Location Current Record scheduled process. This profile option ORA_HZ_ENABLE_MPLCRI_ACTIVE_WORKER must be set to Y and the HRC_DISABLE_HCM_EVENTS_PROCESSING profile option must be set to Yes to sync active workers. For more information topic, see the Maintain Party and Location Current Record Information topic in the Understanding Scheduled Processing Guide.</td>
<td></td>
</tr>
<tr>
<td>ORA_HZ_ENABLE_DAAS_LOQATE</td>
<td>DaaS GBG</td>
<td>Loqate Data Import Enabled</td>
<td>Yes</td>
<td>Enable the import of DaaS GBG</td>
</tr>
<tr>
<td>ORA_HZ_DAAS_GEO_ENDPOINT</td>
<td>DaaS Geography Server Endpoint Information</td>
<td><a href="https://geo.daas.us-phoenix-1.ocs.oraclecloud.com">https://geo.daas.us-phoenix-1.ocs.oraclecloud.com</a></td>
<td>Specify the endpoint information, such as the host name and the port</td>
<td>This profile option is applicable to Application UI and REST</td>
</tr>
<tr>
<td>Profile Option Code</td>
<td>Profile Option Name</td>
<td>Default Value</td>
<td>Description</td>
<td>Impact</td>
</tr>
<tr>
<td>---------------------</td>
<td>---------------------</td>
<td>---------------</td>
<td>-------------</td>
<td>--------</td>
</tr>
<tr>
<td>HZ_TIMEZONE_</td>
<td>Time Zone Population</td>
<td>No</td>
<td>Enable update of contact records with time zone details from the Populate Location Latitude and Longitude Information scheduled process.</td>
<td>This profile option is applicable to Scheduled Process</td>
</tr>
<tr>
<td>POPULATION_ENABLED</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>HZ_SHARE_LOCATIONS</td>
<td>Location Sharing Mode</td>
<td>Share among all parties</td>
<td>Select if location can be shared among different persons and organizations.</td>
<td>This profile option is applicable to File-based Import. This profile option isn't applicable in Import Management.</td>
</tr>
<tr>
<td>HZ_RS_DEF_START_DATE</td>
<td>Resource Start Date Default</td>
<td>Current date</td>
<td>Select if the default start date will be the date when the resource is created, or the employment start date of the resource.</td>
<td>This profile option is applicable to Application UI. This profile option isn't applicable in Import Management and resource user REST.</td>
</tr>
<tr>
<td>HZ_Resource_Allow_</td>
<td>Application Composer for Resource Desktop Pages Enabled</td>
<td>No</td>
<td>Enable access to Oracle CX Sales Resource desktop pages in the Application Composer.</td>
<td>This profile option is applicable to Application UI</td>
</tr>
<tr>
<td>CUSTOMIZATION</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>HZ_LANG_FOR_COUNTRY_</td>
<td>Language for Country Display</td>
<td></td>
<td>Specify the default language used to translate the country name for international addresses. This is typically the language of the country where an item is mailed from.</td>
<td>This profile option is applicable to Application UI and REST</td>
</tr>
<tr>
<td>DISPLAY</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>HZ_GEOCODING_BATCH_</td>
<td>Geocoding Subprocess Batch Size</td>
<td>1000</td>
<td>Specify the maximum number of locations that each batch subprocess can handle for geocoding.</td>
<td>This profile option is applicable to Scheduled Process</td>
</tr>
<tr>
<td>SIZE</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>HZ_GENERATE_PARTY_</td>
<td>Party Site Number Generation</td>
<td>Auto numbering, update not allowed</td>
<td>Select how a party site number will be generated, and if you can update the site number when creating or editing a party site address.</td>
<td>This profile option is applicable to Application UI, and REST</td>
</tr>
<tr>
<td>SITE_NUMBER</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>HZ_GENERATE_CUSTOMER_</td>
<td>Customer Account Number Generation</td>
<td>Auto numbering, update not allowed</td>
<td>Select how a customer account number will be generated, and if you can update the number when creating or editing a customer account.</td>
<td>This profile option is applicable to Application UI, and REST</td>
</tr>
<tr>
<td>NUMBER</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Profile Option Code</td>
<td>Profile Option Name</td>
<td>Default Value</td>
<td>Description</td>
<td>Impact</td>
</tr>
<tr>
<td>-------------------------------------</td>
<td>---------------------------------------------</td>
<td>----------------------</td>
<td>-------------------------------------------------------------------------------------------------------</td>
<td>------------------------------------------------------------------------</td>
</tr>
<tr>
<td>HZ_GENERATE_CONTACT_NUMBER</td>
<td>Contact Number Generation</td>
<td>Auto numbering, update not allowed</td>
<td>Select how the contact number will be generated, and if you can update the number when creating or editing a contact.</td>
<td>This profile option is applicable to Application UI, and REST</td>
</tr>
<tr>
<td>HZ_ENABLE_VO_SECURITY</td>
<td>Enable VO-Based Security</td>
<td>No</td>
<td>Enable VO-based security and override the default EO based security for all objects that use the secured PartyEO.</td>
<td>This profile option is applicable to Application UI and REST</td>
</tr>
<tr>
<td>HZ_ENABLE_MULTIPLE_BU_CRM</td>
<td>Multiple Business Units Enabled</td>
<td>Yes</td>
<td>Enable the multiple business units feature for Oracle Fusion Customer Relationship Management.</td>
<td>This profile option is applicable to Application UI</td>
</tr>
<tr>
<td>HZ_ENABLE_ENTITYEVENTS</td>
<td>Entity Level Events Enabled</td>
<td>Yes</td>
<td>Enable entity level events for account, contact, and household entities.</td>
<td>This profile option is applicable to Scheduled Process, Application UI, and REST</td>
</tr>
<tr>
<td>HZ_ENABLE_CLICK_TO_DIAL</td>
<td>Click to Dial Enabled</td>
<td>Yes</td>
<td>Enable automated dialing by clicking on a phone number.</td>
<td>This profile option is applicable to Application UI</td>
</tr>
<tr>
<td>HZ_ENABLE_BUSI_VALID</td>
<td>Business Key Validation Enabled</td>
<td>No</td>
<td>Enable the business key validation rule to check for duplicate contact points, such as mobile, URL, and Email.</td>
<td>This profile option is applicable to REST</td>
</tr>
<tr>
<td>HZ_DEFAULT_NAME_STYLE</td>
<td>Name Style Default</td>
<td>Concatenated Name</td>
<td>Specify a default style for name formatting.</td>
<td>This profile option is applicable to Scheduled Process, Application UI, and REST</td>
</tr>
<tr>
<td>HZ_DEFAULT_BU_CRM</td>
<td>Customer Relationship Management Business Unit Default</td>
<td>Vision Operations</td>
<td>Specify the default business unit for Oracle Fusion Customer Relationship Management.</td>
<td>This profile option is applicable to REST</td>
</tr>
<tr>
<td>HZ_DEFAULT_ADDR_STYLE</td>
<td>Address Style Default</td>
<td>Postal Address</td>
<td>Specify a default style for address formatting.</td>
<td>This profile option is applicable to Application UI and REST</td>
</tr>
<tr>
<td>HZ_AUTOMATE_,RESOURCE_CREATION</td>
<td>Automated Resource Creation Enabled</td>
<td>No</td>
<td>Enable automatic creation of resource from employee creation process without user intervention.</td>
<td>This profile option is applicable to Application UI</td>
</tr>
<tr>
<td>Profile Option Code</td>
<td>Profile Option Name</td>
<td>Default Value</td>
<td>Description</td>
<td>Impact</td>
</tr>
<tr>
<td>-------------------------------------</td>
<td>----------------------------------------------------------</td>
<td>---------------</td>
<td>----------------------------------------------------------------------------</td>
<td>------------------------------------------------------------------------</td>
</tr>
<tr>
<td>HZ_ALLOW_MULTIPLE_SELLTO</td>
<td>Multiple Sell-to Addresses Enabled</td>
<td>No</td>
<td>Enable multiple sell-to address creation for a party, using the Data Import program. This profile option should not be used by customers.</td>
<td>This profile option is applicable to Application UI, and REST</td>
</tr>
<tr>
<td>HZ_ADDRESS_DISABLE_ALT_NAMES</td>
<td>Hide Alternate Address Names</td>
<td>No</td>
<td>Hide alternate names in the Address list of values. This option, when enabled, displays only the primary geography names for the address.</td>
<td>This profile option is applicable to Application UI</td>
</tr>
<tr>
<td>HZ_GNR_NUM_OF_WORKERS</td>
<td>Number of workers for a given Geography Name Referencing request</td>
<td>1</td>
<td>Determines the number of sub-processes for Validate Geographies of Addresses Against Master Geographies scheduled process.</td>
<td>This profile option is applicable to Scheduled Process</td>
</tr>
<tr>
<td>ZCA_SA_AUTO_ASSIGN_ON_UPDATE</td>
<td>Sales Account Automatic Assignment on Update Enabled</td>
<td>No</td>
<td>Enable automatic territory based assignment processing after a sales account is updated.</td>
<td>This profile option is applicable to Scheduled Process, Application UI, and REST</td>
</tr>
<tr>
<td>HZ_GNR_COMMIT_SIZE</td>
<td>Batch Size for committing records in Geography Name Referencing process</td>
<td>N/A</td>
<td>The Batch Size for committing records in Geography Name Referencing process</td>
<td>This profile option is applicable to Application UI, Scheduled Process, File-based Import, and Import Management.</td>
</tr>
<tr>
<td>ORA_HZ_IMPORT_MULTI_ADDRESS_TYPE</td>
<td>Import Processing for Multiple Address Types Enabled</td>
<td>Yes</td>
<td>Enable the processing of multiple address types for Account, Contact, Address, Organization, and Person objects.</td>
<td>This profile option is applicable to Import Management</td>
</tr>
<tr>
<td>ORA_HZ_RES_ENABLE_SKILLS</td>
<td>Skills Section in Resource Detail Page Enabled</td>
<td>No</td>
<td>Enable the skills section in the Resource Detail page of the Resource Directory and Manage Resources task. The valid values are YES and NO, and the default value is NO.</td>
<td>This profile option is applicable to Application UI</td>
</tr>
</tbody>
</table>
18 Duplicate Identification Setup

Overview of Duplicate Identification

Matching is a process that identifies the potential duplicates for account, contact, and address. You can identify the potential duplicate records in real-time when you create a customer record, and in batch mode for existing records.

Oracle provides the data matching solution for Oracle Cloud applications through integration of Oracle Enterprise Data Quality (EDQ). EDQ is a complete data quality product with capabilities such as profiling, standardization, matching and merging, which is also available as a standalone product.

Defining data matching involves setting up two components, matching and address cleansing. As part of implementing these components, you must perform the following related setup tasks in the Setup and Maintenance work area from the Data Quality Foundation functional area of the Customer Data Management offering:

- Manage Server Configurations
- Manage Enterprise Data Quality Matching Configurations

**Note:** You must set up the server configurations prior to implementing EDQ matching.

Enterprise Data Quality Server Configurations

Enterprise Data Quality (EDQ) server configurations are predefined configurations for EDQ integration. You can enable and disable a data quality management operation by selecting or deselecting the related EDQ server configuration.

EDQ Real-Time and Batch Basic Match Server is the predefined server configuration available for EDQ.

**EDQ Real-Time and Batch Basic Match Server**

Enable this configuration if you want to use the matching capabilities. Enabling this configuration lets you benefit from both real-time and batch matching features. Real-time matching is used to prevent entry of duplicate records. Batch data matching is used for identifying duplicates of existing records.

Enterprise Data Quality Matching Configurations

Enterprise Data Quality (EDQ) matching configurations comprise attributes and parameters for real-time and batch matching of entities to prevent duplicate entries and identify existing duplicates. EDQ real-time and batch matching are available for account and contact entities.
You have the option of using either the predefined ready-to-use configuration or copying and adapting it to your address matching requirements. The predefined EDQ matching configurations applicable for both real-time and batch matching are:

- Account Duplicate Identification
- Contact Duplicate Identification

These configurations are used to identify the duplicate account and contact entries. You can review and edit these predefined matching configurations to optimize the matching functionality to meet your needs.

EDQ Matching Process

In EDQ matching process, the record added or updated to the application for comparison is called a driver record. And, the records that are compared with the driver record are called the candidate records. Driver records are compared with each other, but candidate records are never compared with other candidates. The EDQ real-time matching process compares a single driver record against many candidates and returns possible duplicate records based on matching attributes and threshold. The batch matching process compares all driver records of the same type, such as account and contact, and identifies all possible matches within these sets of records.

The batch matching process runs in two modes, full batch and incremental batch. While the full batch mode matches all records against each other, the incremental mode matches a subset of records against all of their selected candidates. In batch matching, separate matching templates are provided that lets you specify different match rules. For example, you may want to minimize user intervention of adding customers in front end applications, and perform an exhaustive match on a regular basis.

The EDQ matching process for real-time and batch matching runs the EDQ Cluster Key Generation service and EDQ matching service for duplicate identification. The EDQ Cluster Key Generation service is called whenever a record is added or updated in an application. This service generates keys for records added as well as for the records that are updated in the application. These generated keys are stored in the application, which are then used to select the candidate records that may match to the data in the application.

The selected candidate records along with the driver record are returned to the EDQ matching service. Then, this service examines the records and decides which of the candidate records are a good match with the driving record. Once EDQ matching service arrives at the best match, it assigns a score to every duplicate record identified based on the strength of the match.

For more information about the EDQ matching process, see the Oracle Enterprise Data Quality Customer Data Services Pack Matching Guide at

[http://docs.oracle.com/cd/E48549_01/doc.11117/e40737/toc.htm](http://docs.oracle.com/cd/E48549_01/doc.11117/e40737/toc.htm)

Match Attributes

Match attributes define the attributes that are used for real-time and batch matching of the account and contact entities to identify duplicate entries. You use two types of attributes for matching:

- Match Identifier: Specifies the EDQ attribute that you want to use for matching
- Application Attributes: Specifies the application attribute that you want to use for matching

You can map the attributes in application with the corresponding EDQ attributes to create an attribute mapping. For example, for the Name EDQ attribute, you can select the Org.OrganizationName as the corresponding Organization attribute to create a mapping. You can define such attribute mappings for real-time matching, batch-data matching, or both.
When you map the attributes in the application with the corresponding EDQ attributes, you create a matching configuration setting for identifying duplicate entries. These settings are stored as matching keys in the application. Whenever you change the attribute mappings, you must regenerate matching key values for the new or updated accounts and contacts. You can regenerate matching key values using the Rebuild Keys option in the Edit Matching Configuration page.

Match Configuration Parameters

Matching configuration parameters are system-level parameters that control aspects of the data quality matching services.

The following parameters control matching operations for identification of duplicate entries such as account and contact in the database, between database and sets of data, such as import batches, or within sets of data to resolve them from merging or linking.

**Score Threshold**

- Parameter Value: Between 0 and 100. Default Value: 90
- Parameter Description: Specifies the score above which the matched records are returned by the matching service. Records equal to or greater than the score are considered as matches and the records with scores less than the threshold are rejected.

**Match Results Display Threshold**

| Note: This match configuration parameter is enabled only for real-time matching. |

- Parameter Value: Between 0 and 100. Default Value: 10
- Parameter Description: Controls the number of matched records that are returned by the real-time matching.

**Preview Configuration**

The Preview Configuration option lets you enter the following parameters to identify and view the duplicate matching records in real-time without rebuilding the keys.

- Cluster Key Level: Returns records based on the cluster key level.
- Score Threshold: Returns records based on score threshold.
- Maximum Candidates: Returns records based on maximum candidates.
- Match Results Display Threshold: Returns records based on the match results display threshold value.

**Review Configuration Results**

The Review Configuration Results option lets you check if the input account or contact entered for matching in the Edit Matching Configuration page returns the expected matched account or contact after the rebuilding of keys. Alternatively, in the Review Configuration Results page, you can enter the attribute information for one or more of the following matching configuration parameters that you want to match:

- Cluster Key Level: Returns records based on the cluster key level.
- Score Threshold: Returns records based on score threshold.
- Maximum Candidates: Returns records based on maximum candidates.
How You Manage Level of Indirection

You can control the level and number of indirect duplicates for a driver record using a user defined profile option ORA_ZCQ_LEVEL_OF_INDIRECTION. This profile option lets you include indirect duplicates. For example, look at a duplicate set having possible drivers A, C and candidates B, D as follows:

A - B
A - C
C - D

Here, we delete duplicate pair C-D because its winner C is a matched record of A-C. Hence, we lose D as a potential duplicate. This would possibly be identified as a duplicate only in the next batch run. However, we know that D is an indirect duplicate of A. If we set up the value of the profile option ORA_ZCQ_LEVEL_OF_INDIRECTION as 1, you can consider D as a matched record in the first batch run itself. Therefore, the duplicate sets would be as follows:

A - B
A - C
A - D (because D is now an indirect duplicate of A).

Let's understand how the profile option ORA_ZCQ_LEVEL_OF_INDIRECTION controls the level of indirect duplicates with another example where we have the duplicate pairs as A-B, A-C, C-D, D-E, and E-F. In this case, setting the profile option value as 1 would mean that only the first level of indirect duplicates which is C-D is considered as part of A's duplicate set, causing the A-D pair to be formed. However, if we set the profile option value as 2, it would also extend to second level of indirection. Therefore, A-D and also A-E would be the duplicate pairs identified because of the A-C, C-D, and D-E indirection sequence.

To control the level and thereby number of indirect duplicates for a driver record using the profile option ORA_ZCQ_LEVEL_OF_INDIRECTION, perform the following steps:

1. In the Setup and Maintenance work area, go to the Manage Administrator Profile Values task.
2. On the Manage Administrator Profile Values page, search for and select the profile option.
3. In the Profile Values section, click Add. A new row is added for you to specify the following conditions:
   - Profile Level: Specify the level at which the profile value is to be set. Select Site.
   - Profile Value: Select or enter the value, such as 1 or 2, depending on the required level of indirection.
4. Click Save and Close.

   **Note:** Changes in the profile values take effect for a user on the next sign in.

**Related Topics**

- Manage Enterprise Data Quality Matching Configurations
Manage Enterprise Data Quality Matching Configurations

You can perform the following tasks as part of managing Enterprise Data Quality (EDQ) matching configurations.

- Copying a predefined Enterprise Data Quality matching configuration
- Editing a copy of the predefined Enterprise Data Quality matching configuration

Copy a Predefined Enterprise Data Quality Matching Configuration

To copy or make a duplicate of a predefined Enterprise Data Quality matching configuration, complete these steps:

1. In the Setup and Maintenance work area, go to the following:
   - Offering: Customer Data Management
   - Functional Area: Data Quality Foundation
   - Task: Manage Enterprise Data Quality Matching Configurations
2. On the Manage Enterprise Data Quality Matching Configurations page, select the Account Duplicate Identification match configuration, and click Duplicate.
3. Click Yes in the Warning dialog box.
4. Click Save to save the copy of the predefined configuration.
   - **Note:** You must save the copy of the predefined configuration, if you want to edit it.
5. Repeat Steps 2 to 4 to create copies of the predefined configuration for the Contact Duplicate Identification match configurations.

Edit a Copy of the Predefined Enterprise Data Quality Matching Configuration

To edit a copy of the predefined Enterprise Data Quality matching configuration, complete these steps:

- **Note:** You can't edit the predefined Enterprise Data Quality configuration. You can only make a copy of it and edit it by following this procedure.

1. In the Setup and Maintenance work area, go to the following:
   - Offering: Customer Data Management
   - Functional Area: Data Quality Foundation
   - Task: Manage Enterprise Data Quality Matching Configurations
2. On the Manage Enterprise Data Quality Matching Configurations page, select the copy of Account Duplicate Identification match configuration that you created in Copying a Predefined Enterprise Data Quality Matching Configuration section, and click Edit.
3. Select the Active check box to set the Account Duplicate Identification match configuration as the active configuration.
Note: By default, the predefined configurations are always set to active. If there are one or more copies of the predefined configurations, then you can set any of them to active by selecting the Active check box. At any given point in time, only one configuration can be active.

Note: Also, note that the Usage option is set to Both, which indicates that the configuration is for both real-time and batch matching.

Note: You must rebuild keys before activating a new or copied configuration. For more information about Rebuilding Keys, see the Managing Key Generation section in this chapter.

4. Click Yes in the Warning dialog box to set this configuration as active.
5. In the Match Attributes section, perform the following steps:
   a. Select a row to edit the mapping, and click the drop-down button for the selected row.
   b. Select the relevant attribute from the list.
   c. If the list doesn't display the attribute that you want for the mapping, then click Search to search for the attribute.
   d. Select the relevant option and click OK.
6. Select a Cluster Key Level option. For example, select Typical.
7. In the Score Threshold field, enter a value between 0 and 100, such as 85. In the Match Results Display Limit field, enter a value between 0 and 100, such as 20.

Note: The Match Results Display Limit option isn't available for Batch.

8. Click Save.

Note: You can see the Automerge Threshold and Autolink Threshold values in the Batch tab. You can change these values in the Manage Customer Hub Profile Options page or override these values while creating the duplicate identification batch criteria rules.

Related Topics
- Enterprise Data Quality Matching Configurations
- Customer Hub Profile Options
- Automerge
- Create Duplicate Identification Batches and Define Subset Rules

Duplicate Identification Simplified Profile Options

How You Setup Duplicate Identification Simplified Profile Options

You can configure the duplicate identification simplified profile options in the Setup and Maintenance work area. Navigate as follows:

- Offering: Customer Data Management
Click the Duplicate Identification tab.

You can use these profiles options to specify:

**Tuning**

You can use this group of profile options to fine-tune the performance of your duplicate identification processes. The profile options under this category are:

- Enable Real-Time Key Generation
- Number of Batch Key Generation Jobs
- Number of Batch Matching Jobs
- Number of Real-Time Possible Duplicates

**Advanced Options**

You can use this set of profile options to configure diagnostic profile options that aren't related to the standard configuration activities. The profile options under this category are:

- Batch Duplicate Identification Debug Level
- Enable Fine Logging for Match Value Conversion

You can find more details about the duplicate identification simplified profile options in the individual topics about them.

### Enable Real-Time Key Generation

This setting controls whether CDM generates real-time business events for updating cluster keys whenever a customer record is created or modified. The underlying profile option is ORA_ZCQ_ENABLE_REALTIME_KEYGEN.

The options are:

- **Yes**: Specifies that the real-time business events trigger cluster key generation whenever a record is created or modified.
- **No**: Specifies that the real-time business events aren't triggered.

Consider these points when working with this setting:

- A recurring incremental batch key generation job is always required, regardless of this setting.
- Not all processes generate cluster key generation events, regardless of this setting. For example, file-based record creation and updating don't generate key generation events.
- We recommend that you review the best practices before changing this setting listed in the Related Topics section.
Number of Batch Key Generation Jobs

This setting controls whether CDM specifies the maximum number of batch cluster key generation child jobs. The underlying profile option ZCQ_BATCH_KEYGEN_NUMJOBS.

Number of Batch Matching Jobs

This setting controls whether CDM specifies the maximum number of batch duplicate identification child jobs. The underlying profile option ZCQ_BATCH_MATCH_NUMJOBS.

Number of Real-Time Possible Duplicates

This setting controls the maximum number of possible duplicates that can be presented through a real-time interface, such as the Possible Duplicated popup window in Customer Center or the response to the REST findDuplicates API. The underlying profile option is ORA_ZCQ_MAX_CANDIDATES.

Before changing the Number of Real-Time Possible Duplicates setting, you must consider these points:

- The default value of 20 candidates is usually an optimal balance of performance, completeness, and usability.
- Increasing the number of returned candidates above the default value may affect the performance of real-time interfaces.
- Possible Duplicates are returned in descending order of their match score, thus the highest quality match candidates are presented first.
- Keep in mind how many possible duplicates your users are likely to review.

Batch Duplicate Identification Debug Level

This setting controls whether CDM specifies the level of diagnostic logging for batch duplicate identification processes. The underlying profile option is ORA_ZCQ_BATCHMATCH_DEBUG_LEVEL. The options are:

- Debug: Specifies that the diagnostic logging for batch duplicate identification processes is debug.
- Informational: Specifies that the diagnostic logging for batch duplicate identification processes is collecting information.

Enable Fine Logging for Match Value Conversion
Duplicate Identification Setup

This setting controls whether CDM enables fine logging for the data quality match value conversion process. The underlying profile option is ORA_ZCQ_CONVERTER_FINEST_LOGGING. The options are:

- **Yes**: Specifies that the fine logging for the data quality match value conversion process is enabled.
- **No**: Specifies that the fine logging for the data quality match value conversion process isn’t enabled.

How You Validate the Customer Data Management Setup

Customer Data Management comes with validation processes that you can run to validate whether your setup is complete and consistent. The validation process audits your setup and reports back whether dependent setup options are logically consistent.

For example, you may have specified that Groovy scripts must be used to select master records on the Duplicate Resolution Options tab. But you may have forgotten to provide the Groovy scripts. The validation process can identify such inconsistencies in the setup. Validations help reduce the number of issues resulting from improper setup and recommend the actions needed to fix the issues.

You can run the validation processes, after you have configured the duplicate identification and duplicate resolution simplified profile options, in the Setup and Maintenance work area using the following:

- **Offering**: Customer Data Management
- **Functional Area**: Customer Hub
- **Task**: Manage Customer Data Management Options

1. Click the Validate Setup tab.
2. Click the Run Validation Process button.

The validation report displays:

- The list of rules that were validated.
- Their descriptions.
- The severity of errors.
- The recommended actions to fix them.

You can go back to the Duplicate Resolution Options or the Duplicate Identification Options tab to change the configurations as per the recommendations and rerun the validation on the Validate Setup tab until you are satisfied with the outcome.

Unique Identifiers and Elimination Identifiers

The duplicate identification setup process lets you configure up to three unique identifiers and three elimination identifiers as part of your matching configuration.
Unique identifiers and elimination identifiers are special match tokens that you can use for cases where the value of a single attribute conclusively determines whether a set of records are duplicates, without needing to consider any other attribute values. The meanings of these Unique identifiers and elimination identifiers fields are as follows:

- **Unique Identifiers** - any records that have the same non-null value for an attribute that has been defined as a unique identifiers are automatically identified as duplicates, regardless of any other attribute values
- **Elimination Identifiers** - any records that have different non-null values for an attribute that has been defined as an elimination identifiers are never identified as duplicates, regardless of any other attribute values

Both unique identifiers and elimination identifiers only evaluate non-null values, and matching is still possible between records that have a mixture of populated and null elimination identifier or unique identifier values. For example, two records may be identified as duplicates when one record has a value in an elimination identifier field, the other record has no value (null) for the elimination identifier field, and the records also match on other attributes such as name and address.

To better understand the difference between unique identifiers and elimination identifiers, consider the following requirements:

- We will always consider contacts that have the same email address to be duplicates. (This requirement could be handled with a unique identifier field)
- We will never consider contacts that have different email addresses to be duplicates. (This requirement could be handled with an elimination identifier field)

If you choose to use Custom Scoring as part of your duplicate identification configuration, keep the following in mind:

- Records with different non-null elimination identifier values are never identified as duplicates, regardless of any scoring rules. Elimination identifier fields should not be included in custom scoring rules, and adding elimination identifier fields to your custom scoring rules may lead to unpredictable or inconsistent matching results.
- The custom scoring rules for unique identifier fields must always be defined as a single-value exact match rule with a score of 100. The standard matching configuration comes seeded with default custom scoring rules for the three available unique identifier fields, and these default custom scoring rules should not be modified. Unique identifier fields are specifically designed for their function and adding unique identifier fields to any other custom scoring rules may lead to unpredictable or inconsistent matching results.

### Manage Custom Match Rules and Scoring

This topic describes how to enable the custom match rules and scoring functionality.

Use the following procedure to enable custom match rules for account and contact. Note that custom match rules are available only for account and contact.

1. In the Setup and Maintenance work area, go to the following:
   - Offering: Customer Data Management
   - Functional Area: Data Quality Foundation
   - Task: Manage Enterprise Data Quality Matching Configurations
2. On the Manage Enterprise Data Quality Matching Configurations page, drill down on the predefined or the user-defined matching configuration, for which you want to enable or disable custom match rules and scoring.
3. Scroll down to the **Scoring Type** drop-down list and select Custom from the Real-Time or Batch tabs on the Edit Match Configuration page.
Create Custom Match Rules

You can use the custom match rule and scoring functionality to create your own match rules and scores based on your business requirements.

Use the following procedure to create custom match rules.

1. In the Setup and Maintenance work area, go to the following:
   - Offering: Customer Data Management
   - Functional Area: Data Quality Foundation
   - Task: Manage Enterprise Data Quality Matching Configurations

2. On the Manage Enterprise Data Quality Matching Configurations page, drill down on the predefined or the user-defined matching configuration for which you want to create or update predefined rules.

3. Click Manage Match Rules on the Edit Match configuration page.

4. On the Manage Match Rules page click New. Alternatively, you can click Duplicate to create a new rule based on an existing predefined or user-defined match rule.

5. Enter the following values for the newly created or copied match rule:
   - **Rule Name**: The name of the new rule. There is no restriction for the rule name.
   - **Match Rule Score**: The score that you assign to the rule. The value must be between 1 and 100.
   - **Rule Attribute**: The standard or predefined attributes that must be used in the custom match rules. Specify an attribute name followed by either Exact or Fuzzy to find exact matches or closer to the attribute value matches. You can specify any number of rules separated by commas but you must ensure that the rule is logical. Ensure that the syntax and spelling are exact. The following are examples:
     - name:Exact,address:Exact,taxnumber:Exact
     - name:Exact,address:Fuzzy,taxnumber:Exact

6. Click Save or Save and Close.

Considerations for Selecting Sources of Match Rules and Scoring

The Customer Data Quality application comes with two options for match rules and scoring, predefined match rules (EDQ match rules) and custom match rules (Customer Data Management match rules).

You can use a drop-down button on the Enterprise Data Quality Matching Configuration page to select the match rules and scoring option best suited for your business requirements.

The predefined EDQ match rules include a single, view-only matching rule for each object such as account and contact. These match rules can’t be edited, scores can’t be changed, and no new rules can be added.

In case the predefined match rules aren’t suitable for your business requirements, you should enable custom match rules and scoring. You should be able to turn on custom scoring by selecting Custom from the Scoring Type drop-down.
list on the Manage Enterprise Data Quality Matching Configurations UI page. You can use this functionality to create your own match rules and scores.

How You Configure Synonyms and Skip-words Dictionary

You can use synonyms and skip-words to improve the quality of match results. Synonyms help you to map words that are used interchangeably in your industry.

For example, Tech maybe mapped to Technology. Skip-words help reduce noise words such as titles like Mr or Ms in names. These synonyms and skip-words dictionaries are pre-defined as lookup types. You can configure these dictionaries by modifying the lookup types. These lookup types let you tailor the match results by word replacement patterns that may be unique to your application.

**Note:** Synonyms are supported only for Person names, Organization Names, and Address lines 1 to 4.

You can add, edit, or remove words or patterns in the following out of the box lookup types:

- `ORA_ZCQ_CS_ACC_MAPPING_DATA`: Modify this lookup type to update the mapping of account data. For example, `Tech` indicates Technology.
- `ORA_ZCQ_CS_CON_MAPPING_DATA`: Modify this lookup type to update the mapping of contact data. For example, `Abbi` indicates Abigail.
- `ORA_ZCQ_CS_ADD_MAPPING_DATA`: Modify this lookup type to update the mapping of address data. For example, `Rd` indicates Road.
- `ORA_ZCQ_CS_ACC_STRIP_DATA`: Modify this lookup type to update the list of strip words for account data. For example, add `Org` to the list to remove it during data matches.
- `ORA_ZCQ_CS_ADD_STRIP_DATA`: Modify this lookup type to update the list of strip words for address data.
- `ORA_ZCQ_CS_CON_STRIP_DATA`: Modify this lookup type to update the list of strip words for contact data. For example, add Mr. or Ms. to the list to remove them during data matches.

**Note:** These lookups don't support these special characters `! " # $ % ' * - : ; @`

You can access the lookup types by following these steps:

1. Sign in as a setup user such as, Sales Administrator, Master Data Management Application Administrator, or Application Implementation Consultant.
2. Click **Navigator > Setup and Maintenance** work area.
3. Click the Tasks menu and click Search. Search for **Manage Standard Lookups** task and open it.
4. Type `ora_zcq_cs%` in the Lookup Type field and click Search.
   
   A list of lookup types is displayed.
5. Click to select a lookup type.

The details of the lookup are displayed. You can add, delete, or modify the lookup values as per your requirement.
Key Generation

The EDQ matching process for real-time and batch matching makes use of the EDQ Cluster Key Generation service and the EDQ matching service for duplicate identification. Successful key generation is critical to duplicate identification.

Key generation identifies similar parties and assigns a key to each. When a matching configuration is made active, the application passes a set of keys (subset of parties) to the EDQ matching service to process for duplicate identification.

The EDQ Cluster Key Generation service must be run whenever a record is added or updated in the application. This service generates keys for records added as well as for the records that are updated in the application. If keys aren't generated, duplicate identification fails.

How You Configure Key Generation

The duplicate identification process uses matching keys, which must be maintained through a key generation process. You need to set up a recurring, incremental key generation job for each active data quality matching configuration for batch duplicate identification. You also may want to configure real-time key generation for immediate matching of new data as soon as new data is entered.

How You Setup Recurring Incremental Key Generation (Required)

You can schedule incremental key generation for an active matching configuration using the schedule key generation option on the Edit Matching Configuration page. This generates keys for records that don't have a key or if the key time stamp is older than that of the records. You must incrementally generate matching key values for the new or updated accounts and contacts.

To assure your duplicate identification processes use up-to-date matching keys, check if the following setup tasks have been completed.

1. In the Setup and Maintenance work area, go to the following:
   - Offering: Customer Data Management
   - Functional Area: Data Quality Foundation
   - Task: Enterprise Data Quality Matching Configuration
2. Click the name of the required active match configuration.
3. Click Scheduled Key Generation.
4. Click Advanced.
5. Select Using a schedule option in the Advanced Options section.
6. Specify the frequency, the start date, and end date to run the scheduled process.
   - You may want to select a distant end-date to reduce how often you must run this task and to help assure that the recurring schedule doesn't lapse.
7. Click Submit.
   - The recurring incremental key generation scheduled process is submitted.
How You Specify Real-time Key Generation (Optional)

You may want to configure keys to be generated for immediate matching of new data as soon as new data is entered. For example, different users may be entering duplicate records at nearly the same time and you may want the keys to be generated immediately. Real-Time key generation process is available to handle such scenarios.

Follow these steps to enable real-time key generation:

1. Search and navigate to the Manage Administrator Profile Values task.
2. Search for the ORA_ZCQ_ENABLE_REALTIME_KEYGEN profile option.
3. Set the Site level profile option value to Yes.
4. Click Save and Close.

Best Practices for Real-Time Key generation

Here are guidelines to help you decide if real-time key generation is right for your business needs:

- Use Real-Time key generation only if an appropriately scheduled incremental key generation process doesn't support your business process needs.
- Certain processes, such as batch address cleansing, don't trigger real-time key generation events. Real-time key generation isn't sufficient to replace recurring incremental key generation, but it may be used as a complement for certain business scenarios.
- If possible, disable update events for higher-volume data creation and update processes, such as web service-based data integration flows.

To disable high-volume user accounts from generating update events:

1. Search and navigate to the Manage Administrator Profile Values task.
2. Search for the ZCA_PUBLIC_BUSINESS_EVENTS profile option.
3. Click Actions > New in the Profile Values section.
4. Specify the following values:
   - Set the Profile Level to User.
   - Select the User Name for which you want to suppress business events.
   - Set the Profile Value to No.
5. Click Save and Close.

How You Rebuild Keys

You must rebuild keys before activating a new configuration. You must rebuild keys if you change match configuration mappings or if you think that the keys are no longer valid because of updates to the records. You can regenerate matching key values using the Rebuild Keys option in the Edit Matching Configuration page.

How You Specify Real-time and Batch Key Generation Options

You can specify different key generation options for batch matching and real-time matching. Take for example the cluster key level parameter that has the values, limited, typical, or exhaustive. It's possible to select one value of this parameter, say limited, for batch matching and another, say exhaustive, for real-time matching, depending on how tightly you want the data quality engine to match records.
How You Review Key Generations Status

You can search for key generation jobs and review the status of each key generation job on the Manage Key Generation page. The following table describes the various possible key generation statuses for a matching configuration.

<table>
<thead>
<tr>
<th>Key Generation Status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pending</td>
<td>Key generation for the configuration is required.</td>
</tr>
<tr>
<td>Processing</td>
<td>Key generation for the configuration is in progress.</td>
</tr>
<tr>
<td>Review Required</td>
<td>Key generation for this configuration needs review.</td>
</tr>
<tr>
<td>Ready</td>
<td>Key generation for this configuration is complete.</td>
</tr>
</tbody>
</table>

Select Customer Identifying URLs During Duplicate Identification

The Duplicate Identification process evaluates the domain name portion of URLs to help determine whether a set of customer records are likely to be duplicates of each other.

You can ensure that distinct customer records aren't incorrectly classified as duplicates because a common domain name is present in the web contact points collection when that domain name doesn't actually identify the organization. For example, customer records can be given web contact points based on social websites, analyst websites, or other types of web resources that use a common domain name when referencing the customer in a query string or page-level locator. By registering those common domain names, the duplicate identification process doesn't consider those web contact points.

You can use the Manage Standard Lookups setup task and create new entries under the ORA_ZCQ_FILTER_DOMAINS lookup type for the required URLs.

You can add the URL details as follows:

1. Sign in as a setup user such as, Sales Administrator, Master Data Management Application Administrator, or Application Implementation Consultant.
2. Click **Navigator > Setup and Maintenance** work area.
3. Click the Tasks menu and click Search. Search for Manage Standard Lookups task and open it.
4. Type ORA_ZCQ_FILTER_DOMAINS in the Lookup Type field and click Search.
   - The details of the lookup are displayed.
5. In the Lookup Codes section, click **Action > New** and specify the URL details.
   - Specify the domain name in the Lookup Code field for the lookup. For example, type DATAFOX or TWITTER in the Lookup Code field. Also type the Meaning and Description for the lookup code.
6. Click **Save and Close**.
Identify Duplicates in Real-Time Using REST APIs and SOAP Web Services

This topic describes how to identify duplicates using REST APIs and SOAP Web services leveraging the Enterprise Data Quality (EDQ) engine.

Before you begin, perform these steps:

1. Enable **EDQ Real time and Batch Basic Match Server** in the Manage Data Quality Server Configurations page.
2. Identify the configuration code for the EDQ match configuration that you want to perform from the Setup and Maintenance work area by going to the following:
   - Offering: Customer Data Management
   - Functional Area: Data Quality Foundation
   - Task: Enterprise Data Quality Matching Configuration

**How You Identify Duplicates Using REST APIs**

To identify duplicates for accounts (organizations) in real-time using REST API, use the following URL:

```
crmRestAPI/resources/latest/accounts/action/findDuplicates
```

To identify duplicates for contacts (persons) in real-time using REST API, use the following URL:

```
crmRestAPI/resources/latest/contacts/action/findDuplicates
```

You must use the POST method of these APIs. For more information on findDuplicates, see the Identify Duplicate Accounts and Contacts section in the REST API for CX Sales and B2B Service guide. You can use your proprietary, or a third party, REST API client to use the findDuplicates custom action to identify duplicates.

For more information on working with REST API client, see the Work with your REST Client topic in the REST API for CX Sales and B2B Service guide.

**How You Identify Duplicates Using SOAP Web Services (Deprecated)**

To identify duplicates in real-time using SOAP Web services (deprecated), use the following URL:

```
https://servername/crmService/DQRealTimeService?WSDL
```

For more information on DQRealTimeService, see the Trading Community Real Time Data Quality section in the Oracle CX SOAP Web Services for CX Sales and B2B Service guide.

You can use your proprietary, or a third party, SOAP Web services client to use the DQRealTimeService to identify duplicates. Enter the URL and run the relevant operations listed here with appropriate payloads:

- matchPerson: Use this operation to identify duplicate persons.
- matchLocation: Use this operation to identify duplicate locations.
- matchOrganization: Use this operation to identify duplicate organizations.

For more information on Invoking SOAP Web Services, see the Invoking SOAP Web Services chapter in the Oracle CX SOAP Web Services for CX Sales and B2B Service guide.
FAQs for Duplicate Identification

What's the difference between matching configurations and matching server configurations?

Matching configurations include parameters that can be set at the matching configuration level and modified depending on cleansing strategy, data, and result requirements. You can use these configurations during real-time matching to prevent duplicate entries and during batch matching to identify existing duplicates.

Matching server configurations provide the address and port of the data quality server used to process match requests. These configurations show both matching configuration and server configuration level parameters along with their type and cardinality. The parameters set at the server level are applicable to all the matching configurations.

What's the difference between real-time duplicate prevention and duplicate identification?

Real-time duplicate prevention identifies all possible duplicate records that may exist in the database for an entered record. This prevents entering of duplicate entities, such as organization, person, or location, into the database.

Duplicate identification identifies potential duplicate entities already existing in the database using batch matching, and resolves the actual duplicates by merging or linking.
19 Data Verification Setup

Overview of Data Verification

Data verification includes verification of addresses, phones, and email addresses that are available in your application.

Address cleansing is a process that corrects, validates, and enhances address data, based on postal requirements. For example, you can correct misspelled city or street names; add missing elements, like full postal code or state. Likewise, if you enter valid values for city, state, and country, the data quality functionality automatically supplies a postal code value. Similarly, verification of phone numbers and email addresses ensures that the phone number and the email addresses exist.

Note that for data verification you require a separate license for the Oracle Address, Email, and Phone Verification. Oracle Address, Email, and Phone Verification, ensures that you have the correct postal addresses, that your emails don't bounce, and your calls go through.

The data verification functionality is available:

- Real-time, on the Create Organization (Create Account) or Create Person (Create Contact) UIs
- In batch mode in the Data Verification work area
- Import data of Accounts and Contacts

Configure Customer Data Management Cloud to Verification Services Integration

Complete these steps to configure Customer Data Management Cloud to Data Cloud Integration:

1. Sign in to Customer Data Management Cloud as a setup user.
2. Navigate to Setup and Maintenance.
3. Click the Tasks side panel to open it, and click Search.
4. Search for and go to the task: Manage Integration with Oracle Verification Services.
5. Enter the following information on the Manage Integration with Oracle Verification Services page:
   - Select OAuth Authentication.
   - For information about adding a confidential application and getting the Client ID and Secret, see Add a Confidential Application topic in the Administering Oracle Identity Cloud Service guide.
   - Note: If you use Basic Authentication, don't include the question mark special character (?) in the password. For URL, remove /data/ui from the end of the instance address listed in your Welcome email and in the Cloud Console.

   For URL, remove /data/ui from the end of the instance address listed in your Welcome email and in the Cloud Console.
Configure Customer Data Management Cloud to Verification Services Integration

Complete these steps to configure Customer Data Management Cloud to Data Cloud Integration:

1. Sign in to Customer Data Management Cloud as a setup user.
2. Navigate to Setup and Maintenance.
3. Click the Tasks side panel to open it, and click Search.
4. Search for and go to the task: Manage Integration with Oracle Verification Services.
5. Enter the following information on the Manage Integration with Oracle Verification Services page:
   - Select OAuth Authentication.
   - For information about adding a confidential application and getting the Client ID and Secret, see Add a Confidential Application topic in the Administering Oracle Identity Cloud Service guide.

   **Note:** On the Client page of the Add Confidential Application wizard, in the Authorization section, select Resource Owner, Client Credentials, Authorization Code, and Refresh Token as Allowed Grant Types. Leave Redirect URL blank.

   **Note:** We strongly recommend that you use OAuth authentication method because Basic authentication isn't supported in later releases. If you use Basic Authentication, don't include the question mark special character (?) in the password. For URL, remove /data/ui from the end of the instance address listed in your Welcome email and in the Cloud Console.

   For URL, remove /data/ui from the end of the instance address listed in your Welcome email and in the Cloud Console.

6. Click Save and Close.

Enable the Verification of Addresses, Emails, and Phone Numbers

This step is a prerequisite to verifying addresses, emails, and phone numbers. You can enable or disable address, phone, and email verification services in the Configure Verification Services page. The Address Verification service is enabled by default.

You can access Address, Email, and Phone Verification service only if you have already purchased Address Verification.
Note: Currently, email and phone validations aren't supported in Customer Data Management UI.

1. You can configure the Verification Services in the Setup and Maintenance work area using the following:
   - Offering: Customer Data Manager
   - Functional Area: Data Quality Verification Services
2. Click the Quick Setup icon.
   The Configure Verification Services page appears.
3. Select the verification services you want to enable.
4. Specify if the validity status of email and phone must be displayed.
5. (Optional) If you selected Yes in the previous step, specify the number of days since the last valid verification status was run that the verification status must be displayed. For example, if you set this value to 60, then 60 days after the last valid verification was run the verification status is displayed.
6. Click Save and Close.

Phone and Email Verification

Phone and email verification in addition to address verification is called data verification.

After subscribing to the Oracle Address, Email, and Phone Verification service, you can configure phone and email verification settings. You can then verify the data in your application contains an invalid phone number or email address. The application can't check if the phone numbers and emails you enter are valid for the specific person or account, of course, but it does assure that a phone number will actually dial and that an email won't bounce.

If you are using Sales and Customer Data Management in your Point of Delivery (POD), you may use phone and email address verification in both the applications. If you have phone or email address verification disabled in one of the applications, this verification feature is disabled in the other application too. For more information on phone and email verification in CX Sales, see the Related Links section.

Related Topics
- Verify Email Addresses and Phone Numbers
- Manually Override Email and Phone Verification Status
- Reverify Email Addresses and Phone Numbers

Address Cleansing Configuration

Address Cleansing Configurations

Address cleansing configurations comprise attributes and parameters for real-time and batch cleansing of addresses. You have the option of using either the predefined configuration shipped predefined or copying and adapting it to your address cleansing requirements.
For example, you may want the change default country to United Kingdom where the predefined default country is United States.

The predefined real-time address cleansing configuration is named as Address Verification and when done in bulk it's named as Address Cleansing. As part of defining and managing cleansing configurations, you can review and edit the predefined cleansing configuration.

Oracle Address, Email, and Phone Verification includes an online, interactive service to cleanse and validate addresses during the data entry process either through a UI or any other service creating address data into the registry. The real-time address cleansing service parses the input address and validates it against the country-specific postal address reference databases, such as United States Postal Service (USPS), Canada Post, and so on. The real-time address cleansing service runs in two modes:

- **Verify**: The verify mode lets you parse, verify, cleanse, transliterate, and format the input address data. This mode checks the reference data and returns the best match (1 to 1).
- **Search**: The search mode lets you search all installed data and return multiple results (1 to Many). Note that in search mode up to 20 records are returned for each record. These records are displayed in sorted order from the best potential search result to the least potential search result.

Address cleansing of bulk records performs address cleansing, verification, and standardization for a subset or entirety of the address records in the registry, or as part of a data import process. Batch address cleansing service can only be run in the Verify mode that parses and cleanses the input address data and enables output to be displayed in either native or Latin characters.

You can also specify if the output address must be displayed in native script. For example, if the addresses are in Arabic, the verified output can be displayed in English. This is supported for a native (local) language to Latin (English) output or from Latin to a native output. Note that requests in a non-Latin language can't have a verified output in another non-Latin language. For example, you can't search addresses in Arabic and get the verified output in Chinese. Both these languages are supported, but the transliteration between them isn't supported. For more information on this option, see the Search and Verify Address topic in the Related Topics section.

**Note**: For more information on address verification, see the Overview of the Address Verification Setup Process topic in the Related Topics section.

**Related Topics**
- Overview of the Address Verification Setup Process
- Search and Verify Address
- Loqate Address Coverage by Country

### Cleansing Attributes Mapping

This product uses the following attributes for address cleansing:

- **Address Attribute**: The application attribute used to describe the address submitted for address cleansing.
- **DaaS Attribute**: The Oracle Address, Email, and Phone Verification attribute that's mapped with the application address attribute for cleansing.

The mapping of the application data attributes with the corresponding Oracle Address, Email, and Phone Verification cleansing attributes to create cleansing configurations is called cleansing attributes mapping. You can determine what input address attribute you want to map to the Oracle Address, Email, and Phone Verification attribute for address...
cleansing. An Oracle Address, Email, and Phone Verification attribute is used to describe a distinct item of information that relates to a record. For example a City attribute might describe the city details of a Customer record. Once the mapping is established, the input address is verified, and cleansed.

In this example, the sample input data contains a part of the postal address and lacks the complete street address and state information as shown in the following table.

<table>
<thead>
<tr>
<th>Input Address Attribute</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Address1</td>
<td>8500 Normandale Lake Suite 710</td>
</tr>
<tr>
<td>City</td>
<td>Bloomington</td>
</tr>
<tr>
<td>Postal Code</td>
<td>55437</td>
</tr>
</tbody>
</table>

After the mapping, the input address is verified, validated, and corrected. The cleansed output address data is shown in the following table.

<table>
<thead>
<tr>
<th>Output Address Attribute</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Address1</td>
<td>8500 NORMANDALE LAKE BLVD</td>
</tr>
<tr>
<td>Address2</td>
<td>STE 710</td>
</tr>
<tr>
<td>City</td>
<td>BLOOMINGTON</td>
</tr>
<tr>
<td>State</td>
<td>MN</td>
</tr>
<tr>
<td>Postal Code</td>
<td>55437-3813</td>
</tr>
</tbody>
</table>

Cleansing Configuration Parameters

Cleansing configuration parameters are system-level parameters that control aspects of the cleansing services. The address cleansing configuration includes real-time and batch cleansing configuration parameters.

The following parameters control real-time and batch address cleansing, standardization, and validation operations for a subset or entirety of the address records in the database, or as part of a data import process.

**Default Country**

- Parameter Description: Used to specify the country to cleanse the address, if no identifiable country can be found in an input address. The default value for this parameter is United States.
Output Casing

- Parameter Value: Upper case, Lower case, Mixed case. Default Value: Mixed
- Parameter Description: Used to specify the letter case for an output address. For example, the Output Casing is set to Mixed, this 411 THEODORE FREMD AVE # 300 RYE NY 10580 input address is displayed as 411 Theodore Fremd Ave # 300 Rye NY 10580.

Minimum Verification Level

- Parameter Value: Between 1 and 5. Default Value: 4
- Parameter Description: Used to specify the level of verification to which the input data matches the available reference data during the verification process. The higher this value is set, the more precise the address verification. If you set Minimum Verification Level at 3, the area, locality, and thoroughfare or street information of the address must be matched with the reference data. If you set Minimum Verification Level at 5, the complete address is matched with the reference data. The verification level you set must be based on the addresses being cleansed. For example, if 80% of the addresses are from Uganda and the verification level set by Loqate for Uganda is L3. You can set the value to 3. However, if 80% the addresses are from the US, you may set it to 4. Therefore, this parameter is dependent on your business requirements. For more information on the verification level supported by Loqate for each country, see Loqate Address Coverage by Country in Related Topics section.

Minimum Verification Score

- Parameter Value: Between 0 and 100. Default Value: 80
- Parameter Description: Used to specify the similarity between the address entry and closest reference data match as a percentage between 0 (no match) and 100 (perfect match). This score indicates the percentage of changes allowed on the input address so that it matches the reference data. The default score 80 indicates that corrections are allowed on the input address but big changes that could be incorrect must be prevented. We recommend that you get a rough idea of the quality of the input data. You can then adjust this minimum verification score based on the quality of the input data. This score can also differ for each country.

Processing Mode

- Parameter Value: Search, Verify. Default: Search
- Parameter Description: Used to specify if the returned cleansed address is the best match (verify) or a set of close matches (search). This option is available only for real-time processing.

Address Verification Codes and Statuses

Before we proceed further to understand the remaining cleansing configuration parameters, let's understand the verification codes returned by Oracle Address, Email, and Phone Verification. When a source address is verified, Oracle Address, Email, and Phone Verification matches the complete record with the reference data and returns a process report code called Address Verification Code. This code contains details of before and after verification. It also contains what the service has changed in the record. An understanding of the Address Verification Code helps us to tweak the parameters to receive the best possible cleansed records.
Here is a sample address verification code:

<table>
<thead>
<tr>
<th>Verification</th>
<th>Parsing</th>
<th>Postal Code</th>
<th>Minimum Verification Score</th>
</tr>
</thead>
<tbody>
<tr>
<td>V1 4 2 3</td>
<td>I1 4 4 3</td>
<td>P3</td>
<td>0 9 2</td>
</tr>
</tbody>
</table>

1. Verification Status
- V = Verified
- P = Partially Verified
- A = Ambiguous

2. Post-Processed Verification Level (Min Verification Level)
- 1.
  - Parsing Status
  - (I = Identified or Parsed)
- 2. Lexicon Identification Match Level
- 3. Context Identification Match Level

The similarity between the input data and the closest reference data match. Scales between 0% and 100%, with 100% meaning complete similarity.

If the Minimum Verification Level is set to 4, all records that validate below level 4 are Reverted in the format: RXX. Reverted records are ignored. A standard verification result matches a complete record in the reference data and is reflected in the Address Verification Code with code V (VXX-IXX-PX-XXX). A verification code starting with V4 or V5 indicates a successful verification. V1, V2, and V3 suggest either lacking data in the source record, limited reference data coverage, or both.

Both Partial and Ambiguous matches indicate that the source record doesn't fully validate to a single complete record and returns an Address Verification Code starting with P or A respectively. It differs from a standard validation result because there is reference data available that could yield a valid result to the same level of the source record (or higher). With both codes, the processing could be improved with greater accuracy in the source record.

A record verifying to a partial match means the record that's returned could be matched to a higher level, if there was more information provided with the source record. Typically, the partial result is because there is very little information in the source record. In most use cases, a P4 provides a valid delivery point record, whereas P3, P2, and P1 don't.

When the source record has more than one potential match within the address hierarchy, the service reports an Ambiguous result along with the highest verifiable level. Typically, ambiguities only surface when a differentiating piece of information is missing or incomplete from the source record. In most use cases, an A4 result may get to the desired delivery point but should be treated with caution, or with low confidence. A3, A2, A1 results must be rejected, if intended for delivery.

**Example of Full Verification:**

<table>
<thead>
<tr>
<th>Field</th>
<th>Source Data</th>
<th>Reference Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sub Building</td>
<td>&lt;blank&gt;</td>
<td>U1, U2, U3, ..., U15</td>
</tr>
<tr>
<td>Premise</td>
<td>21</td>
<td>21</td>
</tr>
</tbody>
</table>
The returned Address Verification Code for this data is V44-I44-P6-100. The existence of a L4 address means that we have a full validation at L4 (Premise) and the presence of L5 records in the reference data is irrelevant. If the L4 record didn't exist in the reference data, the result would yield a P4.

**Example of Partial Verification:**

<table>
<thead>
<tr>
<th>Field</th>
<th>Source Data</th>
<th>Reference Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>Thoroughfare</td>
<td>Davidson St</td>
<td>Davidson St</td>
</tr>
<tr>
<td>Locality</td>
<td>&lt;blank&gt;</td>
<td>Port Douglas</td>
</tr>
<tr>
<td>Administrative Area</td>
<td>QLD</td>
<td>QLD</td>
</tr>
<tr>
<td>Postal Code</td>
<td>4877</td>
<td>4877</td>
</tr>
<tr>
<td>Country</td>
<td>Australia</td>
<td>Australia</td>
</tr>
</tbody>
</table>

The source address only partially matches the reference addresses. The returned Address Verification Code is P33-I33-P6-100. Even if there was only one premise available, the result would return a P3 because there would be a risk of a false positive. Note that if the reference data didn't have any premise numbers, the result would return a V3.

**Example of Ambiguous Verification**

<table>
<thead>
<tr>
<th>Field</th>
<th>Input Data</th>
<th>Reference Data 1</th>
<th>Reference Data 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Premise</td>
<td>40</td>
<td>40</td>
<td>40</td>
</tr>
<tr>
<td>Thoroughfare</td>
<td>Zaubernu</td>
<td>ZaubernuB</td>
<td>ZaubernuP</td>
</tr>
</tbody>
</table>
The returned Address Verification Code for this data is A22-I24-P3-100. The source data contains thoroughfare and premise address but no postal code. The A2 code declares that validation can only get to city level (L2) because of ambiguous information in the reference address. The premise number has validated, but it can't yield a V4 because of the ambiguity on another field. Before reviewing, the clues point to the thoroughfare in the source being the ambiguous entry. It was only identified (parsed). The reference data confirms two close, valid records match the source and hence an ambiguous result. If there were no close matches, the result would be a V2 or P2. Note that the Reference Data 1 and Reference Data 2 columns in the table only indicate the possible candidates but eventually only one output address is returned.

**Correct Partially Verified Addresses:** Determines if you want to correct the addresses entry that are partially verified. A partially verified address indicates that a close match was made between the input data and one or more available reference data. The reference data contains some additional information that isn't available in the input address.

When you select this option, you're allowing the correction of partially verified addresses. For example, Melrose Av, San Francisco CA 94131 may be corrected to Melrose Ave, San Francisco, CA, 94131-2820.

**Correct Ambiguous Addresses:** Determines if you want to correct the unclear addresses entry and resolve it to the correct address.

**Return Verified Address in Native Script:** Displays verified addresses in the native script of the country selected in the Default Country field. This is supported for a native (local) language to Latin (English) output or from Latin to a native output. Note that requests in a non-Latin language can't have a verified output in another non-Latin language.

**Review Configuration Results**

The Review Configuration Results option lets you check if the input address entered for cleansing in the Edit Cleansing Configuration page returns the expected cleansed address.

Alternatively, in the Review Configuration Results page, you can enter the attribute information for one or more of the following cleansing configuration parameters that you want to cleanse:

- **Minimum Verification Level:** Returns records based on the minimum verification level.
- **Minimum Verification Score:** Returns records based on the minimum verification score.
- **Processing Mode:** Returns records based on the processing mode.
- **Correct Partially Verified Addresses:** Specify if you want to correct the addresses that are partially verified.
- **Correct Ambiguous Addresses:** Specify if you want to correct unclear addresses and resolve it to the correct address.
- **Return Verified Address in Native Script:** Returns cleansed addresses in the native script of the selected country.
Then, verify if the records returned for the cleansed address meets your expectations.

Manage Address Cleansing Configurations

You can perform the following tasks as part of managing address cleansing configurations:

• Copying a predefined address cleansing configuration
• Editing a copy of the predefined address cleansing configuration

Copy a Predefined Address Cleansing Configuration
To copy or make a duplicate of a predefined address cleansing configuration, complete these steps:

1. In the Setup and Maintenance work area, go to the following:
   - Offering: Customer Data Management
   - Functional Area: Data Quality Foundation
   - Task: Manage Address Cleansing Configurations
2. On the Manage Address Cleansing Configurations page, select the Address Cleansing configuration, and click Duplicate.
3. Enter a name in the Name field and click Save to save your changes.

Edit a Copy of the Predefined Address Cleansing Configuration
To edit a copy of the predefined address cleansing configuration, complete these steps:

Note: You can't edit the predefined address cleansing configuration. You can only make a copy of it and edit it by following this procedure.

1. In the Setup and Maintenance work area, go to the following:
   - Offering: Customer Data Management
   - Functional Area: Data Quality Foundation
   - Task: Manage Address Cleansing Configurations
2. On the Manage Address Cleansing Configurations page, select the Address Cleansing configuration and click Edit.
3. Select the Active check box to set the address cleansing configuration as the active configuration.

Note: By default, the predefined configurations are always set to active. If there are one or more copies of the predefined configurations, then you can set any of them to active by selecting the Active check box. At any given point in time, only one configuration can be active.

Note: Also, note that the Usage option is set to Both, which indicates that the configuration is for both real-time and batch matching.
4. Click Yes in the Warning dialog box to set this configuration as active.
5. In the **Cleansing Attributes Mapping** section, select an attribute in the Address column, enter a corresponding attribute in the Attributes column, and then map it with the corresponding attributes in the Attributes column to create an attribute mapping.

6. In the **Cleansing Configuration Parameters** section, perform the following tasks:
   
   a. In the *Default Country* list, select the relevant country name.
   b. In the *Output Casing* list, select *Upper Case* to print the address in upper case.
   c. In the *Minimum Verification Level* list, select 4.
   d. In the *Minimum Verification Score* list, select 80.
   e. If you’re configuring real-time processing, select Search or Verify for *Processing Mode*. This option isn’t available for batch processing.
   f. Select the *Correct Partially Verified Addresses*.
   g. Select the *Correct Ambiguous Addresses*.
   h. Select Return Verified Address in Native Script to display verified addresses in the language native to the country selected in sub step a.

7. Click **Save** to save your changes.

---

**Related Topics**

- Address Cleansing Configurations

---

## How You Cleanse Addresses in Real-Time Using Web Services

This topic describes how to cleanse addresses using Web services leveraging Oracle Address, Email, and Phone Verification.

Before you start, perform these steps:

1. Identify the configuration code for the cleansing configuration that you want to use from the Setup and Maintenance work area by going to the following:
   
   - Offering: Customer Data Management
   - Functional Area: Data Quality Foundation
   - Task: Manage Address Cleansing Configurations

   The configuration code is displayed in the Manage Address Cleansing Configurations page.
2. To cleanse addresses in real-time using Web services, use the following URL:

https://servername/crmService/DQRealTimeService?WSDL

For more information on DQRealTimeService, see the Trading Community Real Time Data Quality section in the Oracle CX SOAP Web Services for CX Sales and B2B Service guide.

You can use your proprietary, or a third party, SOAP Web services client to use the DQRealTimeService Web service to cleanse addresses. Enter the URL and run the cleanseAddress operation with the appropriate payload.

For more information on Invoking SOAP Web Services, see the Invoking SOAP Web Services chapter in the Oracle CX SOAP Web Services for CX Sales and B2B Service guide.

How You Enable Search Mode for Oracle Address, Email, and Phone Verification

Oracle Address, Email, and Phone Verification comes with two processing modes for address verification, Verify and Search. You can use this functionality to verify an address in real-time while entering information on the create or edit pages of Accounts or Contacts.

Out of the box, the Verify mode is enabled. When the Verify mode is enabled and you verify addresses in real-time on the create or edit pages of Accounts or Contacts, the service returns a single verified address that matches the address information you entered on the page.

The search mode is available in address cleansing configuration as a processing mode. When the Search mode is enabled and you do real-time address verification on the Create or Edit Accounts or Contacts page, the service returns a list of the suggested verified addresses that match the address information you entered. You can then select the appropriate address from the list.

Configure Address Verification Processing Mode

You can configure the address verification process mode by performing the following tasks:

1. In the Setup and Maintenance work area, go to the following:
   - Offering: Customer Data Management
   - Functional Area: Data Quality Foundation
   - Task: Manage Address Cleansing Configurations

2. On the Manage Address Cleansing Configurations page, click Address Cleansing.

The Edit Address Cleansing Configuration: Address Cleansing page appears.
3. Select Search from the Processing Mode list in the Cleansing Configuration Parameters section.

   **Note:** You can select either Verify or Search mode from the Processing Mode list according to your requirements. Select Verify mode if you want only one verified address to be returned while verifying an address on the Create Accounts or Create Contacts page. Select Search mode to get a list of the suggested verified addresses that match the address you entered so that you can select the appropriate address from the list.

4. Click Save and Close.

Verify Search Mode on Account or Contact Creation Page
You can verify the functionality of the Search mode while creating a new account or contact. Perform the following steps to verify an address in the search mode while creating a new account:

1. Navigate to Accounts work area.
2. Click Create Account.
3. Enter Address Line 1, City, and State of the account that you want to create on the Create Accounts page.
4. Click Verify Address.

   **Note:** If you click Verify Address after populating all the fields in the Address section of the Create Address page, you will get only one verified address with the complete match.

5. Select the correct address by clicking Select for the appropriate address from the list of suggested verified addresses.
6. Click OK.

When you click OK the selected address gets populated in the Address section of the Create Account page.

7. Enter account details on the Create Account page.
8. Click Save and Close.

FAQs for Data Verification Setup

**What's the difference between cleansing configurations and cleansing server configurations?**

Cleansing configurations include parameters that can be set at the cleansing configuration level and modified depending on cleansing strategy, data, and result requirements.

You can use these configurations to cleanse address during data entry, and to cleanse and validate existing addresses to ensure data accuracy.

Cleansing server configurations provide the address and port of the data quality server used to process cleanse requests. There are no server configuration parameters for cleansing.
What's the difference between real-time address cleansing and batch address cleansing?

Real-time address cleansing is an online, interactive service to cleanse and validate addresses during the data entry process.

Batch address cleansing cleanses and validates addresses that already exist in the database or are imported into it.
20 Duplicate Resolution Setup

Duplicate Resolution Simplified Profile Options

How You Setup Duplicate Resolution Simplified Profile Options

You can configure the duplicate resolution simplified profile options in the Setup and Maintenance work area using the following:

- Offering: Customer Data Management
- Functional Area: Customer Hub
- Task: Manage Customer Data Management Options

You can use these profiles options to specify:

- Tuning
  You can use this group of profile options to fine-tune the performance of your duplicate resolution processes. These settings work together to provide multiple ways to optimize your performance based on your implementation scenario, project phase, and data shape. The profile options under this category are:
    - Maximum Concurrent Merge Jobs Setting
    - Merge Mode Setting
    - Merge Request Job Size Setting
    - Merge Scope Setting
    - Merge Request Notifications

- Duplicate Resolution Control
  Use the profile options belonging to this category to control the flow and level of automation of your duplicate resolution processes. These settings allow you to define where merge requests can originate and when data stewards need to be involved in duplicate resolution activities. The profile options under this category are:
    - Autolink Threshold Setting
    - Automerge Threshold Setting
    - Customer Center Merge Requests Setting
    - Default Resolution Type Setting
    - Data Steward Merge Handling
    - User Merge Handling Setting

- Merge Behavior
  You can use this set of profile options to configure how the merge process handles the records in a duplicate resolution request. These settings allow you to control the processing logic that governs the final outcome of a
merge request, such as which record is retained as the master and how the process derives its final attributes. The profile options under this category are:

- Agreement Rules Type Setting
- Attribute Selection Type Setting
- Enable Attribute Source Tracking Setting
- Master Record Selection Setting
- Merge Identical Child Records Setting
- Add Groovy to Attribute Selection Setting

You can find more details about the duplicate resolution simplified profile options in the individual topics about them.

Merge Scope

You can use the Merge Scope setting to specify the business areas to be processed during a merge. This setting optimizes the size of the merge memory and execution profile and application performance. The underlying profile option is ORA_ZCH_MERGE_SCOPE.

You can specify any of these areas as the merge scope:

- Customer data management specific areas: Merges Customer Data Management foundation entities such as Organizations, People, Addresses, Phone Numbers, and Email Addresses.
- Customer data management specific areas with restrictions: Merges the same entities as the CDM scope. However, processing throughput is maximized by not invoking survivorship rules, integration events, or extended processing logic. You can use this option for high-volume data initialization scenarios.
- All customer relationship management related areas: Merges Customer Data Management foundation entities and transfers CRM transactional data, such as Opportunities, Activities, or Service Requests, from duplicate records to the master record.
- All functional areas: Merges Customer Data Management foundation entities and all merge-enabled entities on the point of deployment.

Before specifying the merge scope, you should consider these points:

- Select the appropriate merge scope to get the best performance.
- When you use Customer Data Management specific areas with restrictions merge scope, you must only select compatible options for other settings:
  - Master Record Selection can't be survivorship rule.
  - Attribute Selection Type can't be Oracle business rules.
  - Agreement Rules Type can't be Oracle business rules.
Merge Mode

You can use the Merge Mode setting to select the optimized mode for merge to prevent the triggering of non-essential business events. This setting controls whether the merge uses preconfigured processing logic or workflows and generates integration events for Oracle Integration Cloud services.

Ideally, you should enable optimized mode for merge to improve application performance when:

- you’re not integrating merge events with external systems.
- you don’t need groovy scripts or object workflows to run when a master record is updated by a merge.

Merge Request Job Size

You can use the Merge Request Job Size to specify the number of merges that each merge job can handle.

A greater number of merge requests per merge job may increase merge processing throughput when the Merge Mode is optimized or the Merge Scope is set to Customer data management specific areas with restrictions. The underlying profile option is ORA_ZCH_MERGE_REQUEST_BATCH_SIZE_LIMIT.

Consider these points before specifying the merge request job size:

- The default value is 100 merge requests per merge job.
- Increasing the number of merge requests per merge job can be helpful during high-volume data initialization scenarios when processing the duplicate resolution queue is a high priority.
- The Merge Request Job Size setting and the Maximum Concurrent Merge Jobs setting work together to let you have a fine-grained control of the merge system.
- Setting no value (null) for the Merge Request Job Size setting distributes all pending merge requests to the available Merge Request Jobs. If the ratio of merge request to merge jobs is too high, system performance may be adversely affected.

Merge Request Notifications

Controls whether notifications are sent when duplicate resolution requests are assigned and processed.

The options are:

- Send notifications for new requests: User created merge requests are created with the Send Notifications parameter set to Yes.
- Don’t send notifications for new requests: User created merge requests are created with the Send Notifications parameter set to No.
- Don’t send any notifications: Merge notifications aren’t sent regardless of the Send Notifications parameter value on individual merge requests.
Consider these points:

- The Send Notifications parameter of merge requests created through the Duplicate Identification Batch process can be set at the Duplicate Identification Batch level.
- The Send Notifications parameter value of individual merge requests can be modified on the Duplicate Resolution list page.

### Maximum Concurrent Merge Jobs

You can use the Maximum Concurrent Merge Jobs setting to control the number of merge jobs that can be processed at any given time. If you don't set the maximum limit, all merge jobs are submitted for concurrent processing.

A greater number of concurrent merge jobs may clear a duplicate resolution request queue more quickly but may impact other processes and functions that use customer records. The underlying profile option is ORA_ZCH_MERGE_MAX_REQUEST_LIMIT.

Before specifying the limit for Maximum Concurrent Merge Jobs, you must consider these points:

- The default value is 10 concurrent merge jobs.
- Increasing the number of concurrent merge jobs can be helpful during high-volume data initialization scenarios when processing the duplicate resolution queue is a high priority.
- The Maximum Concurrent Merge Jobs setting and the Merge Request Job Size setting work together to let you control the merge system better.

### Default Resolution Type Setting

Controls which duplicate resolution process type are assigned to new duplicate resolution requests. The underlying profile option is ZCH_DEDUP_REQUEST_TYPE_OPTION.

The options are:

- Merge: New duplicate resolution requests are queued for merging the duplicates into one master record.
- Link: New duplicate resolution requests are queued for linking the duplicates to each other without merging the records. The records to remain active.
- Generic: The data steward selects the duplicate resolution process type before processing the resolution requests.

Consider these points:

- To implement automatic duplicate resolution request processing, you must select either Merge or Link for the Default Duplicate Resolution setting.
- A data steward can change the duplicate resolution request type while reviewing a duplicate resolution request.

### Automerger Threshold Setting

Defines the match score at or above which a duplicate resolution request of type Merge is processed without requiring a data steward to review the request. The underlying profile option is ZCH_AUTO_MERGE_THRESHOLD.
Consider these points:

- The highest possible match score is 100. So, if you set this value to 101, you can prevent automatic Merge processing.
- Use this setting only when the Default Duplicate Resolution type is Merge.

**Autolink Threshold Setting**

Defines the match score at or above which a duplicate resolution request of type Link is processed without requiring a data steward to review the request. The underlying profile option is ZCH_AUTO_LINK_THRESHOLD.

Consider these points:

- The highest possible match score is 100. So, if you set this value to 101, you can prevent any automatic Link processing.
- Use this setting only when the Default Duplicate Resolution type is Link.

**Customer Center Merge Requests Setting**

Controls whether you can submit merge requests directly from the Customer Center Account and Contact list pages.

Consider these points:

- If this option is enabled, the User Merge Handling setting controls whether or not those requests require a data steward's review before being processed.

**Data Steward Merge Handling Setting**

You can select the Data Steward Merge Handling setting to specify if a batch duplicate resolution request job automatically processes records or requires a review by a data steward.

The underlying profile option for this setting is ORA_ZCH_DS_MERGE_REQUESTS. The options for this setting are:

- Allow Processing Without Approval: batch duplicate resolution requests are automatically processed without any intervention from the data steward.
- Process Subject to Approval: Data steward reviews manually the batch duplicate resolution requests before processing.

Consider these points:

- Use the Create Resolution Request task in Party Center pages to create Manual merge requests.

**User Merge Handling Setting**

Controls whether manually created merge requests are processed automatically or require review by a data steward.
The underlying profile option is ZCH_USER_MERGE_REQUESTS. The options are:

- Allow Processing Without Approval: Manually created merge requests are processed automatically.
- Process Subject To Approval: Data steward reviews manually created merge requests before processing.

Consider these points:

- Use the Account and Contact list pages in Customer Center if Customer Center Merge Requests have been enabled to create Manual merge requests or create requests automatically using duplicate resolution web services.

**Master Record Selection Setting**

Controls the method used to identify which record in a duplicate set becomes the master during a merge.

The options are:

- Select master record using survivorship rule: Logic configured with Oracle business rules using the Manage Survivorship Rules setup task determines the master.
- Select the oldest record as master: The record with the earliest creation date is the master.
- Select the latest record as master: With the most recent creation date is the master.
- Select master based on duplicate identification results: Internal logic of the duplication identification process determines the master.
- Select master record using Data Quality Rules: Logic configured with Application Composer Data Quality Rules determines the master.

Consider these points:

- The Select the older record as master and Select the latest record as master options use optimized internal processes and may offer the best performance.
- Master Record Selection can't be survivorship rule or Data Quality Rules if the Merge Scope has been set to Customer data management specific areas with restrictions.
- The Duplicate Identification batch process identifies a preliminary master record, but the final determination of master record occurs within duplicate resolution processing per the Master Record Selection Setting. Select the Select master based on duplicate identification results option if you want to retain the master record selection from the duplicate identification results.

**Agreement Rules Type Setting**

Controls the method used to prevent records from being merged into other records incorrectly.

The underlying profile option is ZCH_AGREEMENT_TYPE. The options are:

- Default agreement rules: Only the seeded agreement rules are processed. These rules can't be edited or disabled.
- Default agreement rules with Oracle business rules: In addition to the default rules, merge incorporates logic written with Oracle business rules using the Manage Agreement Rules setup task.
- Default agreement rules with Data Quality Rules: In addition to the default rules, merge incorporates logic written with Application Composer Data Quality Rules.
Consider these points:

- You can't use Oracle business rules to configure agreement rules or Data Quality Rules to configure agreement rules, if you have set the Merge Scope to Customer data management specific areas with restrictions.

**Merge Identical Child Records Setting**

Controls whether the merge process merges or transfer certain types of child records when they have the same values. This setting currently controls the processing of addresses, phone contact points, and email contact points. The underlying profile option is ORA_ZCH_MERGE_IDENTICAL.

**Attribute Selection Type Setting**

Controls the method used to coalesce attribute values from the different records in a merge set onto the master record.

The underlying profile option is ZCH_SETATTRIBUTE_TYPE. The options are:

- **No attribute survivorship rules selected:** Merge only replaces null values on the master with non-null values from the duplicates.
- **Use source confidence with oldest record as the tie breaker:** In addition to replacing nulls with non-nulls, merge picks the attributes for the master based on the source confidence values configured using the Manage Source System Confidence setup task. In the case of multiple records in the duplicate set sharing the highest source confidence value for a given attribute, the value created at the earliest point in time is selected.
- **Use source confidence with newest record as the tie breaker:** In addition to replacing nulls with non-nulls, merge picks the attributes for the master based on the source confidence values configured using the Manage Source System Confidence setup task. In the case of multiple records in the duplicate set sharing the highest source confidence value for a given attribute, the value created at the most recent point in time is selected.
- **Use Oracle business rules:** In addition to replacing nulls with non-nulls, merge picks the attributes for the master based on logic configured with Oracle business rules using the Manage Survivorship Rules setup task.

Consider these points:

- The source confidence-based survivorship methods use optimized internal processes and may offer the best performance.
- The Attribute Selection Type can't be Oracle business rules if the Merge Scope is set to Customer data management specific areas with restrictions.

**Enable Attribute Source Tracking Setting**

Controls whether the attribute-level change by source system is tracked. This tracking is required for survivorship processes that use source confidence configuration to determine which attribute values in a duplicate set are ultimately written onto the master record. The underlying profile option is ZCH_ENABLE_SURVIVORSHIP.
Add Groovy to Attribute Selection Setting

Controls whether logic written with Application Composer Data Quality Rules are used to determine which attribute values are selected for the master record.

The underlying profile option is ZCH_GROOVYRULE. The options are:

- No: Use only the option selected for the Attribute Selection Type setting to determine which attribute values are selected for the master record.
- Yes: Combine logic written with Application Composer Data Quality Rules with the option selected for the Attribute Selection Type setting to determine which attribute values are selected for the master record.

Consider these points:

- You can't combine Data Quality Rules with the Oracle business rules Attribute Selection Type setting option.

How You Validate the Customer Data Management Setup

Customer Data Management comes with validation processes that you can run to validate whether your setup is complete and consistent. The validation process audits your setup and reports back whether dependent setup options are logically consistent.

For example, you may have specified that Groovy scripts must be used to select master records on the Duplicate Resolution Options tab. But you may have forgotten to provide the Groovy scripts. The validation process can identify such inconsistencies in the setup. Validations help reduce the number of issues resulting from improper setup and recommend the actions needed to fix the issues.

You can run the validation processes, after you have configured the duplicate identification and duplicate resolution simplified profile options, in the Setup and Maintenance work area using the following:

- Offering: Customer Data Management
- Functional Area: Customer Hub
- Task: Manage Customer Data Management Options

1. Click the Validate Setup tab.
2. Click the Run Validation Process button.
The validation report displays:
The list of rules that were validated.
- Their descriptions.
- The severity of errors.
- The recommended actions to fix them.

You can go back to the Duplicate Resolution Options or the Duplicate Identification Options tab to change the configurations as per the recommendations and rerun the validation on the Validate Setup tab until you are satisfied with the outcome.

### Run Request Dispatch Job

The Request Dispatch job is used to process duplicate resolution requests that are in Pending or Submitted status.

You can use the Run Request Dispatch Job setup task to run request dispatch jobs in the following modes:

- **Basic**: To submit the request dispatch job for immediate processing.
- **Advanced**: To schedule the process to run either immediately or on a recurring periodic schedule, such as every hour or every day.

You can also submit request dispatch jobs directly from the Duplicate Resolution work area by clicking the Dispatch button, which will submit the job for immediate processing.

You can use the Scheduled Processes page to monitor the status of Request Dispatch jobs by querying for "Schedule Duplicate Resolution Requests" processes or by querying the specific process ID that was provided when you submitted the job.

### Set Up Duplicate Resolution Using Groovy Scripts

#### Overview of Duplicate Resolution Setup Using Groovy Script

Duplicate resolution is a set of processes that you can use, after duplicate records are identified, to consolidate those records. You can resolve duplicates in two ways, either by linking them or by merging them. Linking involves associating the duplicate records.

The linked records are treated as unique records in the data registry, and have their own unique identifiers. Merging involves combining duplicate records into one new master record.

You can setup linking by configuring a couple of profile options discussed in the topic Duplicate Resolution Simplified Profile Options. However, the setup for merging is a bit more elaborate. It consists of configuring logic to:

- Determine which record from a set of identified duplicates should be designated as the master record. You can set this up by configuring Set Master Record Rules.
- Determine which attribute value instances from across the set of duplicates the master record should contain. You can set this up by configuring Set Attribute Value Rules. The Set Master Record Rules and Set Attribute Value Rules are collectively called Survivorship Rules.
• Determine whether the merge is violating any of the conditions under which a merge should be prohibited. You can set this up by configuring Agreement Rules.

You can easily setup survivorship and agreement rules using Groovy Script in Application Composer. If you already have defined survivorship and agreement rules without using the Groovy Scripts, you can migrate them to Groovy Script incrementally. For example, you could continue to use your existing agreement rules while also using Groovy Script for your set master rules.

How You Enable Groovy Script-based Survivorship and Agreement Rules

Before you can start using groovy scripts to configure survivorship and agreement rules, you must enable groovy scripting in Setup and Maintenance.

Follow these steps to enable Groovy Script-based survivorship and agreement rules:

1. In the Setup and Maintenance work area, go to the following:
   ◦ Offering: Customer Data Management
   ◦ Functional Area: Customer Hub
   ◦ Task: Manage Customer Data Management Options

2. In the Merge Behavior section under the Duplicate Resolution Options tab, select the groovy script options as the value for one or more of the following fields as required:
   ◦ Master Record Selection: Select the Select master record using groovy scripts option to define the rules for selecting master records using Groovy Scripts.
   ◦ Attribute Selection Type: To define attribute selection rules using Groovy Scripts, select the following options:
     - Select either Use source confidence with newest record as the tie breaker or Use source confidence with oldest record as the tiebreaker.
     - Select Yes for the Add Groovy to Attribute Selection field.
   ◦ Agreement Rules Type: Select the Default agreement rules with groovy scripts option to define agreement rules using Groovy Scripts.

Create an Application Composer Sandbox

The configuration of Groovy Script survivorship and agreement rules is done in Application Composer using the standard Unified Sandbox framework for developing and testing your scripts.

We recommend that you create a separate, dedicated sandbox for survivorship and agreement rules rather than combine survivorship and agreement rule configuration with other types of Application Composer configuration activities. This approach gives you the greatest flexibility for iterative design, testing, and deployment of your survivorship and agreement rules.

To create an Application Composer Sandbox:

1. Click Navigator > Configuration > Application Composer > Sandboxes
2. Click Create Sandbox.
3. Specify a name and select Application Composer under All Tools. Also select the Publishable option as Yes.
4. Click Create and Enter.
5. Click the Application Composer icon.
6. Go to Common Setup and click Data Quality Rules.

On the Data Quality Rules page, you should be able to see six predefined templates for survivorship rules of the type set master and set attributes and agreement rules. You should be able to see three rules for the Contact (Person) entity and three for the Account (Organization) entity.

You are now ready to configure the survivorship or agreement rules using Groovy Script for accounts or contacts. For more information about creating sandboxes, see the Related Topics section.

Related Topics
- Overview of Sandboxes

Configure Predefined Data Quality Rules to Your Requirements in Application Composer

You can configure predefined data quality rules to your requirements in the application composer.

Follow these steps:

1. In your Sandbox dedicated for Data Quality rules, click the Application Composer icon.
2. Go to Common Setup and click Data Quality Rules to view the predefined data quality rules. You should be able to see six predefined templates for data quality rules, three for the Contact (Person) entity and three for the Account (Organization) entity. These templates are:
   - ContactSetMaster: Configure rules for determining the master record in contact merges.
   - ContactSetAttribute: Configure attribute survivorship rules for contact merges.
   - ContactMergeAgreement: Configure merge agreement rules for contact records.
   - AccountSetMaster: Configure rules for determining the master record in account merges.
   - AccountSetAttribute: Configure attribute survivorship rules for account merges.
   - AccountMergeAgreement: Configure merge agreement rules for account records.
3. To configure the merge processing logic for any of these templates, you can:
   - Click the required template.
   - Select the desired row and click Actions > Edit.
4. Create and save your scripts in the Groovy Script editing interface that’s displayed when you click edit for a given survivorship or agreement rule.

Configure Groovy Script Based Set Master Record Rules

In this example, you will learn how to create a set master record rule to select the master record in a resolution request, with different logic depending on whether the resolution request is merge request or a link request.
The logical requirements of the scenario are as follows:

- If the resolution request is a merge request:
  - Records integrated with RNOW source system are the top priority to be master record.
  - If multiple records are present from a prioritized source system, use the most recently updated record as the tiebreaker.
  - If no RNOW-integrated records are present in the merge, take whatever record had been designated as master by the upstream process.

- If the resolution request is a link request:
  - The record with the highest DataFox Account Score should be selected as the master record.
  - If multiple records are tied for the highest DataFox Account Score, use the most recently updated record as the tiebreaker.
  - If none of the records in the link request have been assigned a DataFox Account Score, take whatever record had been designated as master by the upstream process.

Steps to Perform

1. Enable Groovy Scripts to select master records:
   a. In the Setup and Maintenance work area, go to the following:
      - Offering: Customer Data Management
      - Functional Area: Customer Hub
      - Task: Manage Customer Data Management Options
   b. In the Merge Behavior section, select the Select master record using groovy scripts option for the Master Record Selection field.

2. Create an Application Composer sandbox. Refer to the Create an Application Composer Sandbox topic for the steps.

3. Populate the sample script in the AccountSetMaster template:
   - Navigate to Common Setup and click Data Quality Rules.
   - Click AccountSetMaster.
   - Copy and paste the code given in the Sample Code section in the Edit Data Quality Rules page.
   - Click Save and Close.

4. Test the code. Refer to the Test the Survivorship and Agreement Rules Configuration topic to test the code.

5. Deploy the Code, after you're satisfied with the results of the Set Master Record Rules. See the topic: Deploy the Survivorship and Agreement Rules Configuration.

What the Sample Script Does

The script begins by calling the getRows() input function to access the records in the resolution request. After initializing additional variables, the script calls getAttribute("ResolutionType") to determine what type of resolution request is being processed.

If the Resolution Type is MERGE, the script loops through the records in the resolution request to inspect which source system reference assignments exist for each record. When a record with an RNOW source system reference is found, the row is added to the list of records having the given source system reference assignment.

Once all the rows in the resolution request have been tested for their source system reference values, the script tests whether any records from the prioritized source system reference were found. If records are found in the top priority list, they're tested by last updated date. Then the most recently updated record having the highest priority source system reference is designated to become the master record.
If the Resolution Type is LINK, the script loops through the records in the resolution request to inspect each record’s DataFox Account Score value. Each record’s value is compared to the highest value found so far, and if the current row has a higher value than the highest value found so far, that row is promoted to become the master record of the link set.

Finally, the script calls the selectMaster() output function to designate the master record. If a top-priority or second-priority record was identified earlier in the script, that record is provided to the selectMaster() function. If no priority record was identified in either the Merge or Link execution blocks, then the default master record specified by the upstream process will be retained as the master record for the resolution request.

Sample Code

```java
try {
    def requestRows = getRows();
    def rowMaster = false;
    def osrMap = ['RNOW': []];
    def rowDefaultMaster = getMaster();
    def iHighestAccountScore = 0;
    def resolutionType = getAttribute("ResolutionType");

    if (resolutionType == "MERGE") {
        for (row in requestRows) {
            def osrRows = row.getAttribute("OriginalSystemReference");
            osrRows.reset();
            while (osrRows.hasNext()) {
                def osrRow = osrRows.next()
                if (osrRow.OrigSystem == "RNOW") {
                    osrMap['RNOW'].add(row);
                }
            }
            if (rowMaster == false && osrMap['RNOW'].size() > 0) {
                rowMaster = osrMap['RNOW'][0];
                for (row in osrMap['RNOW']) {
                    if (row.LastUpdateDate > rowMaster.LastUpdateDate) {
                        rowMaster = row;
                    }
                }
            }
        }
    }

    if (resolutionType == "LINK") {
        for (row in requestRows) {
            if (nvl(row.AccountScore, 0) > iHighestAccountScore) {
                rowMaster = row;
                iHighestAccountScore = row.AccountScore;
            }
        }
        if (rowMaster) {
            selectMaster(rowMaster);
        } else {
            selectMaster(rowDefaultMaster);
        }
    }
}
```
Configure Groovy Script Based Set Attribute Value Rules

In this example, you will learn how to create a set attribute value rule to override the standard attribute source confidence-based survivorship processing with groovy script based on the classification code assignment of the records.

The logical requirements of the scenario are as follows:

- If the merge contains a record that has been classified as OFN Category One account, use that OFN Category One record's value for a set of key fields regardless of the attribute source confidence score.
- If multiple rows in the merge have been classified as OFN Category One, use the attribute values from the most recently updated row.

Steps to Perform

1. Enable Groovy Scripts to select master records:
   a. In the Setup and Maintenance work area, go to the following:
      - Offering: Customer Data Management
      - Functional Area: Customer Hub
      - Task: Manage Customer Data Management Options
   b. In the Merge Behavior section under the Duplicate Resolution Options tab, select the following options:
      - Select either Use source confidence with newest record as the tie breaker or Use source confidence with oldest record as the tiebreaker for the Attribute Selection Type field.
      - Select Yes for the Add Groovy to Attribute Selection field.
   c. Create an Application Composer sandbox. Refer to the Create an Application Composer Sandbox topic for the steps.

2. Populate the sample script in the AccountSetAttribute template:
   a. Navigate to Common Setup and click Data Quality Rules.
   b. Copy and paste the code given in Sample Code section in the Edit Data Quality Rules page.
   c. Click Save and Close.

3. Test the code. Refer to the Test the Survivorship and Agreement Rules Configuration section to test the code.

4. Deploy the code after you're satisfied with the results of the attribute value rules, you can. See the topic: Deploy the Survivorship and Agreement Rules Configuration.

What the Sample Script Does

The script begins by calling the getRows() input function to access the records in the merge request. Next, the script loops through each of the row records and accesses its Code Assignment collection. The script then loops through the code assignments to test whether the specified code assignment value is present. When a row having the specified code assignment is identified, the row is copied into an array of prioritized records for subsequent processing.

Once all the rows in the merge request have been tested for their code assignment values, the list of prioritized records is sorted based on the records' last update date. Finally, the script identifies the most recently updated row having the specified code assignment value. After this row is identified, the script calls the selectAttribute() output function to designate that priority row as being the attribute value source for a set of defined attributes.

Sample Code

```java
try {
    // ...
```
def rowDuplicates = getRows();
def rowPriorities = [];
def exceptionAttributes = ['BusinessScope', 'CeoTitle'];
def CAs;
def CAi;
for (row in rowDuplicates) {
    CAs = row.getAttribute("CodeAssignment");
    if (CAs) {
        for (CA in CAs) {
            CA.reset();
            while (CA.hasNext()) {
                CAi = CA.next();
                if (CAi.ClassCategory == "OFN" && CAi.ClassCode == "OFN1") {
                    rowPriorities.add(row);
                }
            }
        }
    }
}
if (rowPriorities.size()) {
    def rowPriority = rowPriorities[0];
    for (row in rowPriorities) {
        if (row.LastUpdateDate > rowPriority.LastUpdateDate) {
            rowPriority = row;
        }
    }
    for (a in exceptionAttributes) {
        selectAttribute(a, rowPriority);
    }
}

catch (Exception e) {
    def sMsg = "Exception in Account Set Attribute: " + e.getMessage();
    println(sMsg);
}

Configure Groovy Script Based Agreement Rules

In this example, we are operating in a complex business ecosystem where it's not always appropriate to merge certain accounts that have been identified as duplicates.

When the conditions that prohibit a merge from happening are encountered, the data steward needs to see an informative message explaining exactly which records blocked the merge, and for what reasons. The conditions that can prevent a merge are as follows:

When the conditions that prohibit a merge from happening are encountered, the data steward needs to see an informative message explaining exactly which records blocked the merge, and for what reasons. The conditions that can prevent a merge are as follows:

- A non-master record is integrated with the Legal Hold system
- A non-master record has a Certification Score value of 100

Steps to Perform

1. Enable Groovy Scripts to select master records:
   a. In the Setup and Maintenance work area, go to the following:
      - Offering: Customer Data Management
- Functional Area: Customer Hub
  - Task: Manage Customer Data Management Options

b. In the Merge Behavior section under the Duplicate Resolution Options tab, select the Default agreement rules with groovy scripts option for the Agreement Rules Type field.

2. Create an Application Composer sandbox. Refer to the Create an Application Composer Sandbox topic for the steps.

3. Populate the sample script in the AccountMergeAgreement template:
   a. Navigate to Common Setup and click Data Quality Rules.
   b. Click AccountMergeAgreement.


5. Click Save and Close.

6. Test the code. Refer to the Test the Survivorship and Agreement Rules Configuration topic to test the code.

7. Deploy the code after you're satisfied with the results of the agreement rules. See the topic: Deploy the Survivorship and Agreement Rules Configuration.

What the Sample Script Does

The script begins by calling the getNonMasters() input function to access the non-master records in the merge request. Note that the result of a Set Master groovy scripts is expressed in getMaster() and getNonMasters() responses in Agreement Rule and Attribute Selection scripts. Next, the script loops through each of the row records to test for the two different conditions that would lead to the merge being rejected. The first test is to evaluate the source system reference assignments of the records to determine if the record is integrated with the Legal Hold system. The second test is to check the Certification Level value of the non-master records. If a given record matches either of the tests, a partial rejection message is added to the vetoMessages array.

After all the non-master rows in the merge request have been tested, the script checks to see if the vetoMessages array has any data in it. If it does, then a final rejection message is constructed from the data in the vetoMessages array and the merge is rejected with that constructed message being displayed to the data steward in the duplicate resolution UI.

Sample Code

```java
try {
    def rowNonMasters = getNonMasters();
    def sMsg = "";
    def rejectMsg = "";
    def vetoMessages = [];
    for (row in rowNonMasters){
        def OSRs = row.getAttribute("OriginalSystemReference");
        OSRs.reset();
        sMsg = "";
        while(OSRs.hasNext()) {
            def OS = OSRs.next();
            if (OS.getAttribute("OrigSystem") == "LEGAL_HOLD" && sMsg == "") {
                sMsg = "A legal hold has been placed on Account " + row.getAttribute("PartyNumber");
                vetoMessages.add(sMsg);
            }
        }
        sMsg = "";
        if (row.getAttribute("CertificationLevel") == "100") {
            sMsg = "A Certification Level of 100 was found on Account " + row.getAttribute("PartyNumber");
            vetoMessages.add(sMsg);
        }
    }
    if (vetoMessages.size()) {
        rejectMsg = "Merge rejection reasons: ";
        vetoMessages.eachWithIndex { item, index ->
            rejectMsg += ((index +1) + "") + item + " ");
        }
        rejectRequest(rejectMsg);
```
Test the Survivorship and Agreement Rules Configuration

You can test your Groovy Script-based survivorship and agreement rules configuration while working inside of the sandbox by creating a Test Merge Request in the Duplicate Resolution work area.

A Test Merge Request invokes whatever survivorship and agreement rules have been configured inside the current sandbox. For more information about creating test merge requests, see Related Topics section.

After you have identified potential duplicates in your database through a duplicate identification batch, you can resolve these duplicate sets by creating and submitting a duplicate resolution request.

To create and submit a resolution request:

1. Navigate to the Create Resolution Request UI page as follows: Navigator > Customer Data Management > Duplicate Resolution > Tasks
2. Search for and multi-select the duplicate records using the shift key.
3. Click Create Request.
4. Click Test Merge and click OK.

You can optionally select one of the records as master. Once the request is submitted, the application generates a Request ID, which you can use to track the status of the duplicate resolution process.

5. You can tweak your survivorship and agreement rules configuration and retest your code using new test merge requests to ensure that the code is working as expected.

Note: This process tests the merge request configuration without changing your application data.

Deploy the Survivorship and Agreement Rules Configuration

When you’re satisfied with your configured survivorship and agreement rules, you can deploy the configuration by using the standard sandbox publication process.

When you publish the sandbox, whatever Groovy Script-based rules were previously in the mainline configuration are replaced with whatever scripts are in the sandbox. Once the sandbox has been published, the Request Dispatch scheduled process begins to use the new Groovy Scripts during the processing of regular merge requests.

To publish a sandbox to deploy your survivorship and agreement rules configuration:

1. Click Navigator > Configuration > Sandboxes
2. On the Sandboxes page, click the name of the sandbox you want to publish.
3. Click Publish.

Note: The Publish button might be disabled for your sandbox because of various reasons. For example, you haven’t yet made any changes in your sandbox, or the Control Publish Sandbox Action in Production Environment profile option (FND_ALLOW_PUBLISH_SANDBOX) is set to No.
4. Click Continue to Publish. The sandbox is published.
5. Click Done.

Best Practices for Configuring Groovy Scripts Based Survivorship and Agreement Rules

In this topic we discuss the best practices for configuring groovy scripts.

- If you configure your implementation to use Groovy Scripts for Set Master rules, merges aren't processed until a valid Set Master script has been deployed.
- Any survivorship rules written using the Manage Survivorship Rules setup task which uses the Oracle Business Rules framework, continues to function if you don't enable groovy script survivorship rules.
- For a given survivorship process type, such as Set Master or Agreement Rules, you can either use Groovy script or Oracle Business Rules. You can't combine the two frameworks for a single process type. For example you can't define one Set Master rule using Groovy Script and another Set Master rule using Oracle Business rules.
- You can combine Oracle Business Rules and Groovy script between different survivorship process types, such as using Oracle Business Rules for Set Master logic and Groovy script for Set Attribute logic.
- For best performance with attribute survivorship processing, try to use attribute source confidence as much as possible for your Set Attribute survivorship logic.
- Merge request processing may handle very large volumes of records, so groovy scripts should be as fast and efficient as possible. Avoid using `newView()` functions and web service calls unless absolutely necessary; and if necessary, assure that these types of operations will be fast and reliable.
- Select one of the Use source confidence Attribute Selection Type options from the Manage Customer Data Management Options setup page.
- If needed, use Groovy script along with your source confidence configuration to handle exception scenarios.

Overview of Groovy Scripting Functions

Groovy Script support for configuring survivorship and agreement rules is based on a specific set of functions that let you interact with the data records in the context of a merge request. These functions are of the following categories:

- Functions that let you inspect the records in the merge requests
- Functions that let you define the result of the merge request

These categories of specialized functions help you to create survivorship and agreement rules using standard Groovy Script syntax and operations.

Input Functions

These functions provide the data that your survivorship and agreement rules evaluate. Generally, these functions are called at the beginning of your script to instantiate the information required to determine the proper merge process outputs.

`getRuleType()`

This function lets you determine the functional context of the script. This function returns `SetAttribute`, `SetMaster`, or Agreement depending on which type of script calls it. It's generally not necessary to programmatically determine the rule type because the script types are presented as distinct functions within the Application Composer Data Quality Rules task. But there may be cases where it's helpful for logging or testing.
getObjectType()

This function lets you determine what type of party the merge request is processing. This function returns PERSON or ORGANIZATION depending on which type of script calls it. It's generally not necessary to programmatically determine the object type because the scripts for Persons and Organizations are clearly differentiated as distinct functions within the Application Composer Data Quality Rules task. But there may be cases where it's helpful for logging or testing.

getMaster()

This function lets you access the data record that has been identified as the master record for the merge request. The function is called without parameters and it returns a single Row object that contains the details of the master record. The following example shows a typical usage of this function:

```java
def rowMaster = getMaster();
def masterName = rowMaster.getAttribute("OrganizationName");
// etc...
```

getNonMasters()

This function lets you access the set of data records that have been identified as the non-master records for the merge request because the merge process inactivates them. This function is called without parameters and it returns a list of row objects consisting of one list entry for each non-master record. It's important to note that the getNonMasters list isn't an ADF recordset object. ADF recordset functions such as reset() and first() don't work with the list. The following example shows a typical usage of this function:

```java
getNonMasters()
def rowNonMasters = getNonMasters();
def nonmasterName;
for (nonmaster in rowNonMasters) {
    nonmasterName = nonmaster.getAttribute("OrganizationName");
} // etc...
```

getRows()

This function lets you access the full set of customer records for the merge request, which is the union of the master and non-master sets of rows. This function is called without parameters and it returns a list of row objects consisting of one list entry for each non-master record. Like the getNonMasters function, it's important to note that the getRows list isn't an ADF recordset object. ADF recordset functions such as reset() and first() don't work with the list. The following example shows a typical usage of this function:

```java
def rowDuplicates = getRows()
def duplicateName;
for (duplicate in rowDuplicates) {
    duplicateName = duplicate.getAttribute("OrganizationName");
} // etc...
```

ggetSourceInfo(Row row, String attributeName)

This function lets you access information about which source system provided the current value of an attribute for a given master or non-master row. This function is called using the following parameters:

- A row object for the non-master or master row of interest
- The name of a source-confidence configured attribute

This function returns a source information record for the attribute in question. The structure of the source information record is as follows:
<table>
<thead>
<tr>
<th>Attribute</th>
<th>Definition</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>RecordId</td>
<td>The party ID of the person or organization record referenced by the row object parameter.</td>
<td>300100184760397</td>
</tr>
<tr>
<td>AttributeName</td>
<td>The name of the attribute parameter.</td>
<td>OrganizationName</td>
</tr>
<tr>
<td>AttributeValue</td>
<td>The current value of the attribute on the row.</td>
<td>Pinnacle Systems</td>
</tr>
<tr>
<td>Source</td>
<td>The code of the registered source system for the attribute value.</td>
<td>RNOW</td>
</tr>
<tr>
<td>SourceConfidenceLevel</td>
<td>The configured attribute source confidence value of the given attribute for the given source system.</td>
<td>90</td>
</tr>
<tr>
<td>SourceUpdateDate</td>
<td>The time stamp when the person or organization record was updated with the current value.</td>
<td>1/24/2020 11:48:03 PM</td>
</tr>
</tbody>
</table>

**Note:** The `getSourceInfo` function is only available for attributes that have been configured with source system confidence using the Manage Source System Confidence setup task.

The following example shows a typical usage of this function:

```java
def rowDuplicates = getRows();
def rowSource;
def bestSource;
def bestValue;
bestSource = getSourceInfo(rowDuplicates[0],"OrganizationName");
for (row in rowDuplicates) {
    rowSource = getSourceInfo(row,"OrganizationName");
    if(rowSource.SourceConfidenceLevel > bestSource.SourceConfidenceLevel) {
        bestSource = rowSource;
    }
} bestValue = bestSource.AttributeValue;
```

**Output Functions**

Output functions create the final behavior of the merge process based on the logic of a survivorship or agreement rule script. Generally, these functions are called at the end of the script after the data provided by the input functions has been evaluated with scripted logic.

**selectMaster(Row row)**

This function is used in Contact Set Master and Account Set Master scripts to specify which record from the merge request should be retained as the master record after the merge. This function takes a data Row instance as its only parameter, and whatever row is passed to the function is the record that's retained as the master. All other records in the merge request are inactivated during merge processing. The following example shows a typical usage of this function:

```java
... def masterRow = rowDuplicates[0];
```
for (row in rowDuplicates) {
    if row.LastUpdateDate > masterRow.LastUpdateDate {
        masterRow = row;
    }
}
selectMaster(masterRow);

selectAttribute(String attributeName, Row row)

This function is used in Contact Set Attributes and Account Set Attributes scripts to define which attribute value instances from across the records in the merge should be used to build the master record. This function takes the name of an attribute and a Row instance as its parameters. The value for the given parameter that's found in the given row is retained on the master record. This function is logically equivalent to using the Duplicate Resolution override flow to select the source record for a given attribute. The following example shows the syntax of this function:

```
def rowDuplicates = getRows();
def bestSourceRow;
def fieldName = "OrganizationName";
rowBestSource = rowDuplicates[0];
for (row in rowDuplicates) {
    if(getSourceInfo(row, fieldName).SourceConfidenceLevel > getSourceInfo(rowBestSource, fieldName).SourceConfidenceLevel) {
        rowBestSource = row;
    }
}
selectAttribute(fieldName, rowBestSource);
```

overrideAttribute(String attributeName, Object attributeValue)

This function is used in Contact Set Attribute and Account Set Attribute rules to specify an attribute value for the master record, which can't be derived in the normal fashion from the records in the merge request. This function takes the name of an attribute and the value for the attribute as its parameters and sets the final value of the master record's given field to the given value. This function is logically equivalent to using the Duplicate Resolution Override flow to enter your own value for a given attribute.

**Note:** Ensure that the value's data type and format are correct because this function sets an externally-defined value.

The following example shows the syntax for this function:

```
def fieldName = "OrganizationName";
def fieldValue = "Pinnacle Systems";
overrideAttribute(fieldName, fieldValue);
```

This function is used in Contact Agreement Rule and Account Agreement Rule scripts to veto a merge request if a specified set of conditions are observed in the merge request's records. This function takes a single parameter which defines the rejection message that's displayed on the merge request if the rejection criteria are met. The following example shows the syntax for this function:

```
def rowNonMasters = getNonMasters;
for (row in rowNonMasters) {
    if (row.value != null) {
        rejectRequest("Unable to merge contacts that have this value");
    }
}
```

Evaluating the Data

Once you have called the appropriate functions, your survivorship or agreement rules script need to evaluate the data to determine the correct merge result. This evaluation process uses standard Groovy Script operators and functions. For more information about Groovy scripts, see the Oracle Applications Cloud Groovy Scripting Reference guide.
Putting It Together

You can generally follow this pattern in groovy scripting:

1. Call Input Functions
2. Evaluate the Data
3. Call Output Functions

To further illustrate this concept, the following is a simple script to determine the master record for a merge request based on the most recent Last Updated Date from the records:

```groovy
/* Input Functions: call getRows() to initialize a list of the party records in the merge request and then define a variable to designate the Master record and set it to the first record in the list of Rows */
def rowDuplicates = getRows();
def masterRow = rowDuplicates[0];

/* Evaluate the Data: iterate through the list of records to determine if the current list item was more recently updated than whatever record has been designated the master. If the current record was more recently updated, promote it to become the new Master */
for (row in rowDuplicates) {
    if (row.LastUpdateDate > masterRow.LastUpdateDate) {
        masterRow = row;
    }
}

/* Call Output Functions: use the selectMaster() function to dictate which record from the merge set should become the master */
selectMaster(masterRow);
```

Best Practices for Groovy Scripting

Consider the following points when planning and configuring your survivorship and agreement rules using groovy scripts:

- The Rows returned by the `getRows()`, `getNonMasters()`, and `getMaster()` functions is a standard Groovy Script list object, not an Oracle ADF recordset object. You must use standard Groovy methods for traversing the `recordset` such as for (item in list) instead of ADF functions such as reset(), first(), or hasNext().
- The responses of the `getRows()`, `getNonMasters()`, or `getMaster()` functions are cached for each script execution. So the data state of row objects of your scripts don't show any changes within the scope of a script execution.
- The result of a Set Master script is reflected in the response to `getNonMasters()` or `getMaster()` functions called in Set Attribute or Agreement Rules scripts.
- You can't access the Resolution Request header object in your survivorship scripts. The only supported means for initializing data objects in your scripts are the input functions described in this topic.
- The `selectAttribute()` and `overrideAttribute()` functions can be used on top-level attributes of the Row object. Fields that contain embedded child record collections can't be manipulated with these functions.
- You can interact with custom attributes and custom child objects by using the API name for the attribute or object that was specified when the custom entity was created in Application Composer.
- The script fragments provided in this topic are intended to illustrate the syntax and usage of the Input and Output functions. Refer to the Sample Scripts section for examples of complete scripts.
Set Up Duplicate Resolution Using Oracle Business Rules

Overview of Duplicate Resolution Setup Using Oracle Business Rules

An alternative to using Groovy Scripts based survivorship and agreement rules is to configure them using Oracle Business Rules. Before you process merge requests, you must configure survivorship and agreement rules. You can do this configuration in the Setup and Maintenance work area using the Manage Survivorship Rules and Manage Agreement Rules setup tasks.

Set Up Survivorship

Survivorship Rules
Survivorship rules are a collection of business rules that determine the master or surviving record and its attributes during the merge operation.

Survivorship rules create the best version of a record from multiple source systems, based on business rules. You can configure survivorship rules to resolve conflicts while merging duplicate records.

Survivorship Rules Types
There are two types of survivorship rules. You can configure them based on your business needs. They are as follows:

- **Set master record**: Configure the set master record rule to define the criteria for selecting the master record from a set of potential duplicate records.
- **Set attribute value**: Configure the set attribute value rule to define the criteria for selecting the best attribute values from multiple input records.

Predefined Survivorship Rules
Six predefined set attribute value rules are provided ready-to-use with the application:

- **Least Recently Updated Organization Attribute (History Wins)**: This rule selects the organization attributes that have the oldest updated date.
- **Most Recently Updated Organization Attribute (Recent Wins)**: This rule selects the organization attributes that have the most recent updated date.
- **Highest Source Confidence Level Wins for Organization**: This rule selects the organization attribute values that have the highest source confidence.
• **Least Recently Updated Person Attribute (History Wins):** This rule selects the person attributes that have the oldest updated date.

• **Most Recently Updated Person Attribute (Recent Wins):** This rule selects the person attributes that have the most recent updated date.

• **Highest Source Confidence Level Wins for Person:** This rule selects the person attribute values that have the highest source confidence.

In addition, you can use predefined templates to create new Set Attribute Value rules.

To see these predefined attribute rules, click **Search** button on the **Manage Survivorship Rules** task. You can use these predefined survivorship rules as a starting point to define the criteria that’s best for your business. These rules are updated with every release. You can also create, edit, and delete these rules. However, deleting an existing rule isn’t recommended. By default, these predefined survivorship rules are in the inactive status and you can activate these rules from the Manage Survivorship Rules task.

**How You Enable Survivorship Rules**

You can enable the survivorship functionality by setting the **ZCH_ENABLE_SURVIVORSHIP** profile option to **Yes** in the Setup and Maintenance work area, using the following:

- **Offering:** Customer Data Management
- **Functional Area:** Customer Hub
- **Task:** Manage Customer Hub Profile Options

**How You Manage Survivorship Rules**

You can create, edit, and delete survivorship rules in the Setup and Maintenance work area by going to the following:

- **Offering:** Customer Data Management
- **Functional Area:** Customer Hub
- **Task:** Manage Survivorship Rules

The rules use source system confidence level and other criteria to determine the attributes of the record that should be retained from a particular source system, and are stored in the survivorship rules dictionary XML file.

**Note:** The application doesn’t support changing survivorship rules inside the Application Composer sandbox. Therefore, the merge engine doesn’t pick up the changes made to these rules inside the Application Composer sandbox. When you define custom attributes or custom objects in an Application Composer sandbox, you should Publish and Exit the sandbox before changing a survivorship rule in the Manage Survivorship Rules setup task.

**Define Survivorship Rules**

This example demonstrates how to create a survivorship rule. Survivorship rules enable intelligent creation of the best version record, especially from multiple source systems, by specifying criteria for selecting the record to be retained during a merge operation.

**Create A Survivorship Rule**

To create a survivorship rule:

1. In the Setup and Maintenance work area, go to the following:
2. On the Manage Survivorship Rules page, click **Add** from the Actions menu.
3. Enter the sample information provided in the following table on the Create Survivorship Rule page.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rule Name</td>
<td>PickPersonMasterRule</td>
</tr>
<tr>
<td>Description</td>
<td>Select the master person record based on original source system of the record.</td>
</tr>
<tr>
<td>Rule Type</td>
<td>Set master record</td>
</tr>
<tr>
<td>Note:</td>
<td>You can create the following two types of survivorship rules: Set Master Record and Set Attribute Value. You can use predefined templates to create the Set Attribute Value rules.</td>
</tr>
<tr>
<td>Object Type</td>
<td>Person</td>
</tr>
<tr>
<td>Note:</td>
<td>You can create a survivorship rule for the following two types of party records: Person and Organization.</td>
</tr>
</tbody>
</table>

4. Click **Apply**. The Define Survivorship Rules: Select Master Record page appears.

**Specify Criteria for Selecting the Master Record**

The following are the steps to specify criteria for selecting the master record:

1. Navigate to the Define Survivorship Rules: Select Master Record page.
2. Enter the information provided in the following table as IF/THEN rules condition in the Define Survivorship Rules: Select Master Record page.

<table>
<thead>
<tr>
<th>Rule Condition</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>IF Condition</td>
<td>IF PersonParty is a TCHFactTypeDictionary.PersonPartyVO and there's a case where {OrigSourceSystem} != null and OrigSourceSystem.OwnerTableId == PersonParty.PartyId and OrigSourceSystem.OrigSystem == &quot;GSI&quot;</td>
</tr>
<tr>
<td>THEN Condition</td>
<td>THEN Assert new Result (name:&quot;masterId&quot;, value:&quot;PersonParty.PartyId&quot;)</td>
</tr>
</tbody>
</table>
Note the following specification in the Define Survivorship Rules: Select Master Record page.

- Click the + icon to add additional patterns to include additional conditions
- Click the Surround with Parenthesis option to add more features to the conditions
- Select the + Simple Test option to add additional clauses

The following figure shows the Define Survivorship Rules: Select Master Record page with the Surround icon highlighted.

3. Click the Advanced Settings button to verify the effective date of the rule that you're going to create.

The following figure shows Advanced Settings icon on the Define Survivorship Rule: Select Master Record page.

4. Select an effective date, as appropriate. The default effective date is Always. You can select an Effective From or Effective To date, or you can select an Effective Date range.

5. Select a priority for the rule, as appropriate.

The default priority of the Survivorship rules is Medium. These rules get executed in the order of their priority.
6. Ensure that the Rules Active option is selected.

The following figure shows how the survivorship rule looks like when fully defined. The details include the rule name and the IF and THEN conditions for determining the master.

![Survivorship Rule Setup](image)

7. Click Save and Close. You can view the newly created rule in the Manage Survivorship Rules page by searching for it.

8. Click Submit.

**Tip:** To activate the rule you must click Submit. You may have selected the Active mode, but that doesn't activate a rule unless submitted.

Related Topics

- MOS document: Define Survivorship Rules

**Define Set Master Record Rules**

This procedure demonstrates how to create a survivorship rule of the type Set Master Record.

You can determine survivorship at the record level using the set master record rule type. Set master rules are used in party merge to set a single record as the master record.

**Create Set Master Record Rules**

The input to the survivorship rule is given in the IF clause. In a set master rule, the input is a set of party records. The THEN clause contains the output that determines the master record. In the Set Master Record rule, the output is a
result object that contains a specific Party ID. If multiple records with different Party IDs are returned, then it results in a conflict error. To create Set Master rules, you may perform the following steps:

To create Set Master rules, you perform the following steps:

1. Navigate to the Manage Survivorship Rules task.
2. Click Add. The Create Survivorship Rule page appears.
3. Enter the information provided in the following table on the Create Survivorship Rule page.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rule Name</td>
<td>PickOrganizationMasterRule</td>
</tr>
<tr>
<td>Description</td>
<td>Select the master organization record based on the specified criteria for setting the master record.</td>
</tr>
<tr>
<td>Rule Type</td>
<td>Set master record</td>
</tr>
<tr>
<td>Object Type</td>
<td>Organization</td>
</tr>
</tbody>
</table>

4. Click Apply. You’re taken to the Define Survivorship Rules: Select Master Record page.

In the Define Survivorship Rules: Select Master Record page, you specify criteria for picking the master record. The criteria that you define in this page determine the output of the rule.

The following topics contain three worked examples that show different ways of defining criteria in the Define Survivorship Rules: Select Master Record page to set a master records:

- Set the Record with Oldest Creation Date as Master
- Set the Record with D-U-N-S Number and Smallest Party ID as Master
- Set the Record with D-U-N-S Number and Highest Number of Party Site as Master

How You Set the Record with the Oldest Creation Date as Master

This rule has a single condition to set a record that has the oldest creation date as the master.

1. Navigate to the Define Survivorship Rules: Select Master Record page.
2. Enter the information provided in the following table as IF/THEN rules condition in the Define Survivorship Rule: Select Master Record page.

<table>
<thead>
<tr>
<th>Rule Condition</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>IF Condition</td>
<td>IF master is an HZ_PERSON_FactType.PersonPartyVO and there is no case where {nonmaster == HZ_PERSON_FactType.PersonPartyVO and master.PartyId isn't nonmaster.PartyId and master.creationDate is more than nonmaster.CreationDate}</td>
</tr>
<tr>
<td>THEN Condition</td>
<td>THEN Assert new Result (name:&quot;masterId&quot;, value:&quot; master.PartyId&quot;)</td>
</tr>
</tbody>
</table>
The following figure displays the Define Survivorship Rules: Select Master Record page with completely filled IF and THEN rules conditions for setting a record that has the oldest creation date as the master.

How You Set the Record with D-U-N-S Number and Smallest Party ID as Master
This rule identifies and returns the master record based on the following three conditions in the order of priority listed:

1. Pick master that has D-U-N-S Number.
2. If more than one record has D-U-N-S Number, pick one based on the smallest Party ID.
3. If no record has D-U-N-S Number, pick one based on the smallest Party ID.

The following are the use cases for a set master record rule to pick the master based on the D-U-N-S number and the smallest Party ID.

**Use Case 1**
In this case, there are two records with D-U-N-S number. Therefore, the record with the smaller party ID is picked as the master record. The following table contains the sample record information for this use case.

<table>
<thead>
<tr>
<th>Record Name</th>
<th>Party ID</th>
<th>D-U-N-S Number</th>
<th>Master</th>
</tr>
</thead>
<tbody>
<tr>
<td>Record 1</td>
<td>11</td>
<td>998837472</td>
<td>Yes</td>
</tr>
<tr>
<td>Record 2</td>
<td>12</td>
<td>null</td>
<td>No</td>
</tr>
<tr>
<td>Record 3</td>
<td>13</td>
<td>984939234</td>
<td>No</td>
</tr>
</tbody>
</table>
The following table lists the IF and THEN rules condition values that you must enter on the Define Survivorship Rules: Select Master Record page for this use case.

<table>
<thead>
<tr>
<th>Rule Condition</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>IF Condition</strong></td>
<td>Pick D-U-N-S number{IF master is an HZ_PERSON_FactType.OrganizationPartyVO master.DUNsNumberC isn't null} masterPartyID is the minimum of masterPartyID where {master= HZ_PERSON_FactType.OrganizationPartyVO and master.DUNsNumberC isn't null}</td>
</tr>
<tr>
<td><strong>THEN Condition</strong></td>
<td>THEN Assert new Result (name:&quot;masterId&quot;, value:&quot; master.PartyId&quot;)</td>
</tr>
</tbody>
</table>
The following figure shows the Define Survivorship Rules: Select Master Record page with IF and THEN rules conditions for picking the record with D-U-N-S number and minimum party ID as master.

**Use Case 2**

In this case, there is no record with D-U-N-S number. Therefore, the record with smallest party ID is picked as the master record. The following table lists the sample record information for this use case.

<table>
<thead>
<tr>
<th>Record Name</th>
<th>Party ID</th>
<th>D-U-N-S Number</th>
<th>Master</th>
</tr>
</thead>
<tbody>
<tr>
<td>Record 1</td>
<td>21</td>
<td>null</td>
<td>Yes</td>
</tr>
<tr>
<td>Record 2</td>
<td>22</td>
<td>null</td>
<td>No</td>
</tr>
<tr>
<td>Record 3</td>
<td>23</td>
<td>null</td>
<td>No</td>
</tr>
</tbody>
</table>
The following table lists the IF and THEN rules condition values that you must enter on the Define Survivorship Rules: Select Master Record page for this use case.

<table>
<thead>
<tr>
<th>Rule Condition</th>
<th>Value</th>
</tr>
</thead>
</table>
| IF Condition   | Pick D-U-N-S number  
{IF master is an HZ_PERSON_FactType.OrganizationPartyVO  
master.DUNsNumberC isn’t null}  
and  
masterPartyID is the minimum of masterPartyID  
where  
{master= HZ_PERSON_FactType.OrganizationPartyVO and  
master.DUNsNumberC isn’t null} |
| THEN Condition | THEN  
Assert new Result (name:”masterId”, value:” master.PartyId) |

The following figure displays the Define Survivorship Rules: Select Master Record page with completely filled IF and THEN rules conditions to set the record that has the smallest party ID as the master when no record with D-U-N-S number is found.

In this example, you have created two set master rules for Organization. First rule is for the cases where the input records have at least one record with D-U-N-S number. The second is for the case where no records have D-U-N-S Number.

**Note:** You can activate more than one survivorship rule at a time. When you activate multiple rules, make sure that the rules aren’t conflicting and the conditions in the rule are set according to the priority.
How You Set the Record with D-U-N-S Number and Highest Number of Party Sites as Master

This rule identifies and returns the master record based on the following three conditions in the order of priority listed:

1. Pick master that has D-U-N-S Number.
2. Pick master that has more party sites.
3. Pick master that has the smallest Party ID.

The following are two use cases for creating a set master rule to select the master record based on D-U-N-S number, number of party sites, and party ID:

**Use Case 1**

In this case, there are three records with D-U-N-S number and two records with highest number of party sites. Among those two records, the one with the lower value for party ID is selected as master. The following table contains the sample record information for this use case.

<table>
<thead>
<tr>
<th>Record Name</th>
<th>Party ID</th>
<th>Number of Party Sites</th>
<th>D-U-N-S Number</th>
<th>Master</th>
</tr>
</thead>
<tbody>
<tr>
<td>Record 1</td>
<td>11</td>
<td>3</td>
<td>198837472</td>
<td>Yes</td>
</tr>
<tr>
<td>Record 2</td>
<td>12</td>
<td>3</td>
<td>489205901</td>
<td>No</td>
</tr>
<tr>
<td>Record 3</td>
<td>13</td>
<td>2</td>
<td>384792392</td>
<td>No</td>
</tr>
<tr>
<td>Record 4</td>
<td>14</td>
<td>1</td>
<td>null</td>
<td>No</td>
</tr>
</tbody>
</table>

**Use Case 2**

In this case, there are no records with D-U-N-S number. So, among the two records with higher number of party sites, the record with the smaller party ID is picked as the master record. The following table contains the sample record information for this use case.

<table>
<thead>
<tr>
<th>Record Name</th>
<th>Party ID</th>
<th>Number of Party Sites</th>
<th>D-U-N-S Number</th>
<th>Master</th>
</tr>
</thead>
<tbody>
<tr>
<td>Record 1</td>
<td>21</td>
<td>1</td>
<td>null</td>
<td>No</td>
</tr>
<tr>
<td>Record 2</td>
<td>22</td>
<td>2</td>
<td>null</td>
<td>Yes</td>
</tr>
<tr>
<td>Record 3</td>
<td>23</td>
<td>3</td>
<td>null</td>
<td>No</td>
</tr>
</tbody>
</table>

To create a master record with D-U-N-S number, number of party sites, and party ID, you add one more condition to the previous example where you set a master record with D-U-N-S number. Adding a condition to the previous example makes the rules complicated and cumbersome. Instead, you can create a simple rule for each condition to narrow down the list of potential master records and create another simple rule in the end to pick one record from the remaining potential master records.
**Note:** You can activate more than one survivorship rule at a time. When you activate multiple rules, make sure that the rules aren't conflicting and the conditions in the rule are set according to the priority.

The following figure displays the Survivorship Rules: Select Master Record page with the IF and THEN rules condition values for creating a set master rule to set the record that has D-U-N-S Number as master. The priority of the rule is set as highest. The details of the conditions are as follows:

**Priority: Highest**

**IF condition:** If number of non-null DUNS records is the count where {master is a HZ_ORGANIZATION_FactType.OrganizationPartyVO and master.DUNSNumberC isn't null} and number of non-null DUNS records more than 0 and master is a HZ_ORGANIZATION_FactType.OrganizationPartyVO and master.DUNSNumberC is null

**THEN condition:** Then retract master

Now, you set the conditions to set the record with the maximum number of party sites as the master.

The following figure shows the Survivorship Rules: Select Master Record page with the IF and THEN condition values to set the record with the maximum number of party sites as the master from the remaining potential records. The priority of the rule is set as higher. The details of the conditions are as follows:

**Priority: Higher**

**IF condition:** If maximum party site number is the maximum of master.PartySite.size() where {master is a HZ_ORGANIZATION_FactType.OrganizationPartyVO} and master is a HZ_ORGANIZATION_FactType.OrganizationPartyVO and master.PartySite.size() isn't maximum party site number

**THEN condition:** Then retract master

Now, you set the conditions to set the record with the maximum number of party sites as the master.

The following figure shows the Survivorship Rules: Select Master Record page with the IF and THEN condition values to set the record with the maximum number of party sites as the master from the remaining potential records. The priority of the rule is set as higher. The details of the conditions are as follows:

**Priority: Higher**

**IF condition:** If maximum party site number is the maximum of master.PartySite.size() where {master is a HZ_ORGANIZATION_FactType.OrganizationPartyVO} and master is a HZ_ORGANIZATION_FactType.OrganizationPartyVO and master.PartySite.size() isn't maximum party site number

**THEN condition:** Then retract master
When the records are screened with two previous conditions, you create a third condition to screen all remaining potential records with the smallest party ID.

The following figure shows the Survivorship Rules: Select Master Record page with the IF and THEN condition values for creating a set master rule to set the record with the smallest party ID as the master. The priority of the rule is set as medium. The details of the conditions are as follows:

**Priority: Medium**

**IF condition:** If master.PartyId is the minimum of master.PartyId where {master is a HZ_ORGANIZATION_FactType.OrganizationPartyVO}

**THEN condition:** Assert new Result(name:
In this example, the rules are created to narrow down the list of potential master records. When you activate more than one rule at a time you should set the conditions for the rule according to the priority to narrow down the list of potential master records. In this example Eliminate Null D-U-N-S Number rule is executed first to select records with D-U-N-S Number. Select the Most Address rule is executed next to find the master record with most number of party sites among the potential master records having D-U-N-S Number. Finally, Select Minimum Party ID rule is executed at the end to pick the minimum party ID from the remaining party records.

**Define Set Attribute Value Rules**

This example demonstrates how to create a survivorship rule of the type Set Attribute Value.

You can determine survivorship at the attribute level using the set attribute value survivorship rule type. Set attribute value rules are used in party merge to determine which attribute value should come from which record.

The input to the survivorship rule is given in the IF clause. In a set attribute value rule, the inputs are the party records and their source information. The source information contains information about all attributes for each record in the database. If you're creating rules that use the Source information VO, you define it in the Define Source Systems Confidence page of the Manage Source System Confidence task. You must map each attribute to its source system and given a Source Confidence score on a scale of 1 to 100.

The following table lists the attributes in the source information VO to create a set attribute value rule.

<table>
<thead>
<tr>
<th>Attribute Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>RecordId</td>
<td>The record ID of a specific attribute.</td>
</tr>
</tbody>
</table>
The THEN clause determines the output object that picks the master record. In this case, setAttribute function creates the output object. To create Set Attribute Value rules, you perform the following steps:

1. Navigate to the Manage Survivorship Rules task.
2. Click Add. The Create Survivorship Rule page appears.

**Tip:** You can select attributes from the available attributes in the Create Survivorship Rule page. It pre-populates the rule template with the selected attributes. It's not mandatory to set attributes from the available attribute.

3. Enter the sample information provided in the following table on the Create Survivorship Rule page.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rule Name</td>
<td>PickAttributeValueRule</td>
</tr>
<tr>
<td>Description</td>
<td>Select the master value for a specific attribute based on specified master selection criteria.</td>
</tr>
<tr>
<td>Set attribute value</td>
<td></td>
</tr>
<tr>
<td>Object Type</td>
<td>Organization</td>
</tr>
<tr>
<td>Template</td>
<td>Select the Attribute Based template to select the surviving value based on the characteristic of the attributes. For example, you need an Attribute Based template to pick an attribute with the highest or lowest value such as a party number, or salary, or the earliest incorporated year. Select the Source Confidence Based template to select the surviving value based on the confidence in the source information.</td>
</tr>
</tbody>
</table>

4. Select attributes from the available attributes to pre-populate the rules template. In case you want to use the predefined set attribute rules, don’t select any attributes.
5. Click Apply. You’re taken to the Define Survivorship Rules: Select Attribute Value page.
Duplicate Resolution Setup

In the Define Survivorship Rules: Select Attribute Value page, you specify criteria for selecting the master attribute value. The criteria that you define in this page determine the feature of the rule. You also have the option of using one of the following three predefined templates:

- Highest Source Confidence Level Wins for Organization (or Person): Use this rule to select the attribute values with the highest source confidence level.
- Most recently updated Organization (or person) attribute: Use this rule to select the attribute values with the most recently updated date.
- Least recently updated Organization (or person) attribute: Use this rule to select the attribute values with the oldest updated date.

The following sections of this topic contain three worked examples that show different ways of manually setting master attribute values in the Define Survivorship Rules: Select Attribute Value page. They are as follows:

- Set the Values with the Earliest Update Date as the Surviving Attribute Values
- Set the Value with the Highest Source Confidence Level as the Surviving Attribute Value for D-U-N-S Number
- Set the Values with the Earliest Incorporated Year as the Surviving Attribute Values

How You Set the Values with the Earliest Update Date as Surviving Attribute Values

This rule has a single condition to set all the surviving attribute values based on the earliest update date. The following is a use case for a set attribute rule to select the values with the earliest update date as surviving attribute values:

**Use Case 1**

**Party Record**

The following table contains information for party records.

<table>
<thead>
<tr>
<th>Record Name</th>
<th>Party ID</th>
<th>Party Name</th>
<th>D-U-N-S Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Record 1</td>
<td>1</td>
<td>Oracle Corp</td>
<td>198837472</td>
</tr>
<tr>
<td>Record 2</td>
<td>2</td>
<td>Oracle USA Corp</td>
<td>489203901</td>
</tr>
<tr>
<td>Record 3</td>
<td>3</td>
<td>Oracle</td>
<td>null</td>
</tr>
</tbody>
</table>

**Source Information**

The following table contains information for source information records.

<table>
<thead>
<tr>
<th>Record ID</th>
<th>Attribute Name</th>
<th>Source</th>
<th>Source Confidence Level</th>
<th>Source Update Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Party Name</td>
<td>FUSION</td>
<td>95</td>
<td>1/5/2016</td>
</tr>
<tr>
<td>2</td>
<td>Party Name</td>
<td>FUSION</td>
<td>95</td>
<td>1/5/2010</td>
</tr>
<tr>
<td>3</td>
<td>Party Name</td>
<td>SIEBEL</td>
<td>90</td>
<td>1/5/2000</td>
</tr>
<tr>
<td>1</td>
<td>D-U-N-S Number</td>
<td>DNB</td>
<td>100</td>
<td>2/5/1990</td>
</tr>
</tbody>
</table>
In this case:

- The D-U-N-S number attribute value from the record with ID 1 is selected as master because the source information indicates that it has the earliest source update date.
- The Party Name attribute value from the record with the ID 3 is selected as master because the source information indicates that it has the earliest source update date.

Populate the Define Survivorship Rules: Select Attribute Values page with the IF and THEN rules condition values provided in the following table.

<table>
<thead>
<tr>
<th>Rule Condition</th>
<th>Value</th>
</tr>
</thead>
</table>
| IF Condition         | IF picked attribute is a AttributeSourceInfoVO and there is no case where {
                      Other Attribute == AttributeSourceInfoVO and there is no case where
                      Other Attribute is a AttributeSourceInfoVO
                      Picked Attribute.AttributeName is Other Attribute.AttributeName and
                      PickedAttribute.RecordId isn't Other Attribute.RecordId and
                      Picked Attribute SOURCEUPDATEDATE more than Other Attribute SOURCEUPDATEDATE} |
| THEN Condition       | THEN call setAttribute (picked attribute.AttributeName, Picked Attribute.RecordId) |

The following figure displays the Define Survivorship Rules: Select Attribute Values page with the IF and THEN rules conditions to create the set attribute value rule that selects the values with the earliest source update date as the surviving attribute value. The figure provides the following details. Name of the rule: History WinsIF condition: If picked attribute is a AttributeSourceInfoVO and there is no case where {Other Attribute is AttributeSourceInfoVO and Picked Attribute.AttributeName is Other Attribute.AttributeName and PickedAttribute.RecordId isn't Other Attribute.RecordId and Picked Attribute SOURCEUPDATEDATE more than Other Attribute SOURCEUPDATEDATE}
How You Set the Value with the Highest Source System Confidence Level as the Surviving Attribute Value for D-U-N-S Number

This rule has a single condition to select the D-U-N-S number value with the highest source confidence level as the surviving attribute value for the D-U-N-S number attribute. The following is a use case for a set attribute rule to select the D-U-N-S number value with the highest source confidence level as the surviving attribute value:

**Use Case**

**Party Record**

The following table contains information for party records.

<table>
<thead>
<tr>
<th>Record Name</th>
<th>Party ID</th>
<th>Party Name</th>
<th>D-U-N-S Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Record 1</td>
<td>1</td>
<td>Oracle Corp</td>
<td>198837472</td>
</tr>
<tr>
<td>Record 2</td>
<td>2</td>
<td>Oracle USA Corp</td>
<td>489203901</td>
</tr>
<tr>
<td>Record 3</td>
<td>3</td>
<td>Oracle</td>
<td>null</td>
</tr>
</tbody>
</table>
In this case, the party record contains three records with the attribute Party Name and two records with D-U-N-S number. These attributes are picked to create the source information. The source information table defined using the attributes from this party record table is as follows:

**Source Information**

The following table contains information for source information records.

<table>
<thead>
<tr>
<th>Record ID</th>
<th>Attribute Name</th>
<th>Source</th>
<th>Source Confidence Level</th>
<th>Source Update Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Party Name</td>
<td>FUSION</td>
<td>95</td>
<td>1/5/2016</td>
</tr>
<tr>
<td>2</td>
<td>Party Name</td>
<td>FUSION</td>
<td>95</td>
<td>1/5/2010</td>
</tr>
<tr>
<td>3</td>
<td>Party Name</td>
<td>SIEBEL</td>
<td>90</td>
<td>1/5/2000</td>
</tr>
<tr>
<td>1</td>
<td>D-U-N-S Number</td>
<td>DNB</td>
<td>100</td>
<td>2/5/1990</td>
</tr>
<tr>
<td>2</td>
<td>D-U-N-S Number</td>
<td>FUSION</td>
<td>95</td>
<td>1/5/2016</td>
</tr>
</tbody>
</table>

In this case, the D-U-N-S attribute value for the record with ID 1 is selected as master because the source information indicates that it has the highest source confidence level among all records that have the D-U-N-S Number attribute.

The following figure displays Define Survivorship Rules: Select Attribute Values page with the IF and THEN rules condition values to set the attribute value with the highest source system confidence level as the master. The figure provides the following details.Name of the rule: Highest Source Confidence LevelIF condition: If picked attribute is a AttributeSourceInfoVO and Picked Attribute.AttributeName is EnquireDUNSNumberC and there is no case where {Other Attribute is a AttributeSourceInfoVO and Picked Attribute.AttributeName is Other Attribute.AttributeName and Picked Attribute.RecordId isn’t Other Attribute.RecordId and Picked Attribute.SourceConfidenceLevel is less than...
How You Set the Values with the Earliest Incorporated Year as the Surviving Attribute Values

This rule has a single condition to select values with the earliest incorporated year as the surviving attribute values. The following is a use case for creating such a set attribute value rule:

**Use Case 1**

**Party Record**

The following table contains information for party records.

<table>
<thead>
<tr>
<th>Record Name</th>
<th>Party ID</th>
<th>Party Name</th>
<th>Incorporated Year</th>
</tr>
</thead>
<tbody>
<tr>
<td>Record 1</td>
<td>1</td>
<td>Oracle Corp</td>
<td>1980</td>
</tr>
<tr>
<td>Record 2</td>
<td>2</td>
<td>Oracle USA Corp</td>
<td>1990</td>
</tr>
<tr>
<td>Record 3</td>
<td>3</td>
<td>Oracle</td>
<td>2000</td>
</tr>
</tbody>
</table>

In this case, the party record table contains three records with the attributes Party Name, Party ID, and Incorporated Year. The attribute values for the record with the earliest incorporated year are picked as master attribute values.

The following figure displays Define Survivorship Rules: Select Attribute Values page with the IF and THEN rules condition values to set the attribute with the earliest incorporated year as the master. The figure provides the following details:

Name of the rule: Selecting the Earliest Incorporated Year

IF condition: If for each case where org is a OrganizationDVO and org.IncorpYear isn’t null and there is no case where another org is a OrganizationDVO
and org.PartyId isn't another org.PartyId and another org.IncorpYear isn't null and org.IncorpYear.intValue() is more than another org.incorpYear.intValue() THEN condition: Then call setAttribute ("IncorpYear", org.PartyId)

Survivorship Rules for Parties with Custom Objects and Attributes

This topic describes how to define survivorship rules for merging parties having custom objects and attributes.

For example, you can define a survivorship rule of the type Set Master Record to select the party with the maximum number of custom objects or the party with a specific attribute as the master. You can also define a survivorship rule of the type Set Attribute Value to select the smallest value for a specific attribute.

Custom Objects and Attributes

You can use Oracle Application Composer to configure and extend Oracle CX Sales and B2B Service applications. The Application composer provides you the ability to extend an Oracle CX Sales and B2B Service application's object model. You can configure CX Sales and B2B Service objects by adding new fields (custom fields or custom attributes) to an existing object (standard objects). Or you create entirely new objects (custom objects) and related fields (custom attributes).

Custom Objects and Attributes in Survivorship Rules

The following table describes the basic merge operations that can be performed on standard or custom objects.
### Duplicate Resolution Setup

<table>
<thead>
<tr>
<th>Object</th>
<th>Examples</th>
<th>Can be merged</th>
<th>Can be transferred</th>
<th>Can be removed</th>
</tr>
</thead>
<tbody>
<tr>
<td>Standard Top-Level Object</td>
<td>Account/Organization</td>
<td>Yes</td>
<td>Not applicable for top-level objects</td>
<td>Not applicable for top-level objects</td>
</tr>
<tr>
<td></td>
<td>Contact/Person</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Standard Child Object</td>
<td>Address</td>
<td>Yes (by reviewing in the Data Steward UI)</td>
<td>Yes (by default if not merged or removed)</td>
<td>Yes (by reviewing in the Data Steward UI)</td>
</tr>
<tr>
<td></td>
<td>Phone</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Standard Child Object</td>
<td>Lead</td>
<td>No</td>
<td>Yes (always)</td>
<td>No</td>
</tr>
<tr>
<td></td>
<td>Opportunity</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Custom Top-Level Object</td>
<td>Not applicable (implementation specific)</td>
<td>No</td>
<td>Not applicable for top-level objects</td>
<td>Not applicable for top-level object</td>
</tr>
<tr>
<td>Custom Child Object</td>
<td>Not applicable (implementation specific)</td>
<td>No</td>
<td>Yes (always)</td>
<td>No</td>
</tr>
</tbody>
</table>

The following table describes whether or not these objects and attributes can be used while defining conditions, clauses, and actions for survivorship rules of the type Set Master Record and Set Attribute Value.

<table>
<thead>
<tr>
<th>Object</th>
<th>Examples</th>
<th>Can be used in Set Master Record rule conditions</th>
<th>Can be used in Set Master Record rule actions</th>
<th>Can be used in Set Attribute Value rule conditions</th>
<th>Can be used in Set Attribute Value rule actions</th>
<th>Can be used for Attribute Override in Data Steward UI</th>
</tr>
</thead>
<tbody>
<tr>
<td>Standard Top-Level Object</td>
<td>Account/Organization</td>
<td>Yes (standard and custom attributes)</td>
<td>Yes (standard record ID attribute)</td>
<td>Yes (standard and custom attributes)</td>
<td>Yes (standard and custom attributes)</td>
<td>Yes (standard and custom attributes)</td>
</tr>
<tr>
<td></td>
<td>Contact/Person</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Standard Child Object</td>
<td>Address</td>
<td>Yes (standard and custom attributes)</td>
<td>No, survivorship not supported for child objects</td>
<td>No, survivorship not supported for child objects</td>
<td>No, survivorship not supported for child objects</td>
<td>No, attribute override not supported for child objects</td>
</tr>
<tr>
<td></td>
<td>Phone</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Standard Child Object</td>
<td>Lead</td>
<td>Yes (standard and custom attributes)</td>
<td>Not applicable if you can't merge the records</td>
<td>No</td>
<td>Not applicable if you can't merge the records</td>
<td>Not applicable if you can't merge the records</td>
</tr>
<tr>
<td></td>
<td>Opportunity</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Custom Top-Level Object</td>
<td>Not applicable (implementation specific)</td>
<td>No</td>
<td>Not applicable if you can't merge the records</td>
<td>No</td>
<td>Not applicable if you can't merge the records</td>
<td>Not applicable if you can't merge the records</td>
</tr>
<tr>
<td>Custom Child Object</td>
<td>Not applicable (implementation specific)</td>
<td>Yes (all attributes are custom)</td>
<td>Not applicable if you can't merge the records</td>
<td>No</td>
<td>Not applicable if you can't merge the records</td>
<td>Not applicable if you can't merge the records</td>
</tr>
</tbody>
</table>

**Notes:**
- **Can be merged:** Indicates whether the object can be merged during duplicate resolution. Yes indicates that merging is supported, while No indicates that merging is not supported.
- **Can be transferred:** Indicates whether the object can be transferred as a result of a merge. Yes indicates that transfer is supported, while No indicates that transfer is not supported.
- **Can be removed:** Indicates whether the object can be removed as a result of a merge. Yes indicates that removal is supported, while No indicates that removal is not supported.
- **Examples:** Provides examples of the types of objects and attributes that are applicable for each category.
Example of Defining Set Master Record Rules for Parties with Custom Child Objects

This topic explains how to define a survivorship rule of the type Set Master Record to select the party with the maximum number of custom child objects.

This rule identifies and returns the master record based on the following two conditions:

1. Pick master that has the most custom child objects.
2. Pick master that has the highest party ID.

The following table provides the details of a use case for set master record rule to select the party with the maximum number of custom child objects and the highest party ID as the master record.

<table>
<thead>
<tr>
<th>Record Number</th>
<th>Party ID</th>
<th>Number of Custom Child Objects</th>
<th>Master</th>
</tr>
</thead>
<tbody>
<tr>
<td>Record 1</td>
<td>11</td>
<td>3</td>
<td>No</td>
</tr>
<tr>
<td>Record 2</td>
<td>12</td>
<td>3</td>
<td>Yes</td>
</tr>
<tr>
<td>Record 3</td>
<td>13</td>
<td>3</td>
<td>No</td>
</tr>
<tr>
<td>Record 4</td>
<td>14</td>
<td>1</td>
<td>No</td>
</tr>
</tbody>
</table>

In this case, there are two records with the same number of custom child objects. Therefore, the record with the highest party ID is picked up as the master record.

**Note:** The number of child objects of the custom object is shown up as Fact Types. You can also find out the number of child objects using the accessor inside OrganizationDVO or PersonDVO.

The following figure displays Define Survivorship Rules: Select Master Record page with the IF and THEN rules condition values for creating the set master rule to pick up the
record with the highest party ID and maximum custom child objects as the master record.

Example of Defining Set Master Record Rules for Parties with Custom Attributes

This rule identifies and returns the master record based on the following two conditions:

- Pick master that has a specified custom attribute. In this case the custom attribute is Testfieldone_c.
- Pick master that has the highest Party ID.

The following table provides the details of a use case for setting master record rule to select the party with a specific custom attribute as the master.

<table>
<thead>
<tr>
<th>Record Number</th>
<th>Party ID</th>
<th>Testfieldone_c</th>
<th>Master</th>
</tr>
</thead>
<tbody>
<tr>
<td>Record 1</td>
<td>11</td>
<td>Test</td>
<td>No</td>
</tr>
<tr>
<td>Record 2</td>
<td>12</td>
<td>Test</td>
<td>Yes</td>
</tr>
<tr>
<td>Record 3</td>
<td>13</td>
<td>None</td>
<td>No</td>
</tr>
<tr>
<td>Record 4</td>
<td>14</td>
<td>None</td>
<td>No</td>
</tr>
</tbody>
</table>
In this case, there are two records with the custom attribute Testfielddone_c. Therefore, the record with highest party ID is picked as the master record.

The following figure displays Define Survivorship Rules: Select Master Record page with the IF and THEN rules condition values to create the set master record rule to pick the record with specified attributes as the master. The details of the conditions are as follows:

IF condition: If masterPartyId is the maximum of master.PartyId where {master is a HZ_PERSON_FactType.PersonDVO and master.Testfielddone_c isn't null}

THEN condition: Then Assert new Result (name:"masterId", value:masterPartyId)

Define Survivorship Rules: Select Master Record
This image depicts defining survivorship.

Example of Defining Set Attribute Value Rules for Custom Attributes
This topic explains how to define a survivorship rule of the type Set Attribute Value to select the smallest value for a specific attribute. This rule has a single condition where it picks a record that has the smallest value for the specified custom attribute.

The following table contains the details of a use case for a set attribute value rule to select the smallest value for a specific custom attribute as the survivor. In this case the example attribute name is CustomField1_c.

<table>
<thead>
<tr>
<th>Record Number</th>
<th>Party ID</th>
<th>CustomField1_c Attribute Value</th>
<th>Party Name</th>
<th>Survivor</th>
</tr>
</thead>
<tbody>
<tr>
<td>Record 1</td>
<td>11</td>
<td>123</td>
<td>Oracle Corp</td>
<td>Yes</td>
</tr>
<tr>
<td>Record 2</td>
<td>12</td>
<td>1456</td>
<td>Oracle USA Corp</td>
<td>No</td>
</tr>
<tr>
<td>Record 3</td>
<td>13</td>
<td>239940</td>
<td>Oracle</td>
<td>No</td>
</tr>
</tbody>
</table>

In this case, there are three records with CustomField1_c custom attribute. The value 123 is picked up as the survivor value for the CustomField1_c custom attribute because it's the smallest value for that attribute.

The following figure displays the Define Survivorship Rules: Select Attribute Value page with the IF and THEN rules condition values to create the set attribute value rule to pick the smallest value for the CustomField1_c custom attribute as the survivor. The details of the conditions are as follows:

IF condition: If (for each case where) {org is a OrganizationDVO and org.CustomField1_c isn't null } and there is no case where {another org is a OrganizationDVO and another org.CustomField1_c isn't null and org.PartyId isn't another org.PartyId and org.CustomField1_c.length()
What's the difference between survivorship rules and merge agreement rules?
Survivorship rules are a collection of business rules defined for the creation of the best version record intelligently, especially from multiple source systems, by specifying criteria for selecting record and attributes to be retained during merge or link operations.

A merge agreement rule is a collection of patterns and conditions that are defined to determine whether a merge request should be vetoed by the application or not. Merge requests that violate these rules are either rejected or end in error.

How can I check if the survivorship rules that I created work?
You can create two parties and merge them into a single record to check if your survivorship rules are working. You must ensure that your survivorship rules are active before merging the parties.
What are the seeded sample survivorship rules that Oracle Fusion Applications provide by default?

Oracle Fusion Applications offers some sample survivorship rules. Here are predefined sample survivorship rules:

- For organizations, history wins: The attribute value with earlier source update date wins. This rule is applicable for all organization attributes.
- For persons, recent wins: The attribute value with later source update date wins. This rule is applicable for all person attributes.
- For organizations, assign the highest source confidence level to the D-U-N-S number.

The seeded survivorship rules are in inactive status out-of-the-box. These rules are updated with every release. However, once you change these rules, these rules aren't updated.

Agreement Rules

Overview of Agreement Rules

An agreement rule is a collection of patterns and conditions that are defined to determine whether a merge request should be vetoed by the application or not. Merge requests that violate these rules are either rejected or end in error.

Agreement rules let you check a merge request for any veto conditions that can prevent a merge from occurring. These rules save resources and time by obviating the need to review merge requests to prevent undesired merge from being processed. Besides, agreement rules prompt you to consider alternative duplicate resolution mechanism such as linking.

Agreement rule can be of the following two types:

- Predefined
- User-defined

Predefined Agreement Rules

These are agreement rules that are predefined in the application. You can only view the predefined agreement rules.

The following table describes the predefined agreement rules shipped out of the box with the application. Merge requests that violate these rules are automatically rejected.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>HR_APPLICANT_VETO</td>
<td>Prevents a person party with an active party usage of HR_APPLICANT from merging with another party.</td>
</tr>
<tr>
<td>HR_EMPLOYEE_VETO</td>
<td>Prevents a person party with an active party usage of HR_EMPLOYEE from merging with another party.</td>
</tr>
<tr>
<td>HR_CONTINGENT_WORKER_VETO</td>
<td>Prevents a person party with an active party usage of HR_CONTINGENT_WORKER from merging with another party.</td>
</tr>
<tr>
<td>Name</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>HR_PARTY_SITE_VETO</td>
<td>Prevents a party site with active original system reference from Oracle Fusion Human Capital Management system from merging with another party site.</td>
</tr>
<tr>
<td>RESOURCE_PERSON_VETO</td>
<td>Prevents a person party with an active party usage of RESOURCE from merging with another party.</td>
</tr>
<tr>
<td>BANK_VETO</td>
<td>Prevents an organization party with an active party usage of BANK from merging with another party.</td>
</tr>
<tr>
<td>CLEARINGHOUSE_VETO</td>
<td>Prevents an organization party with an active party usage of CLEARINGHOUSE from merging with another party.</td>
</tr>
<tr>
<td>BANK_BRANCH_VETO</td>
<td>Prevents an organization party with an active party usage of BANK_BRANCH from merging with another party.</td>
</tr>
<tr>
<td>BRANCH_CLEARINGHOUSE_VETO</td>
<td>Prevents an organization party with an active party usage of CLEARINGHOUSE_BRANCH from merging with another party.</td>
</tr>
<tr>
<td>LEGAL_EXTLEGAL_PARTYUSGRULE_VETO</td>
<td>Prevents an organization party with active party usage of LEGAL_ENTITY from merging with another organization party with active party usage of EXTERNAL_LEGAL_ENTITY.</td>
</tr>
<tr>
<td>IC_PARTICIPANT_PERSON_VETO</td>
<td>Prevents a person party with an active party usage of INCENTIVE_COMP_PARTICIPANT from merging with another party.</td>
</tr>
<tr>
<td>IC_PARTICIPANT_ORG_VETO</td>
<td>Prevents an organization party with an active party usage of INCENTIVE_COMP_PARTICIPANT from merging with another party.</td>
</tr>
<tr>
<td>PARTNER_VETO</td>
<td>Prevents an organization party with an active party usage of PARTNER from merging with another party.</td>
</tr>
<tr>
<td>INACTIVE_PARTNER_VETO</td>
<td>Prevents an organization party with an active party usage of INACTIVE_PARTNER from merging with another party.</td>
</tr>
<tr>
<td>CUST_CONTACT_DIFFRESOURCE_ORG_VETO</td>
<td>Prevents two partner owned contacts belonging to different resource organizations from being merged.</td>
</tr>
<tr>
<td>CUST_CONTACT_INTERNAL_PARTNER_VETO</td>
<td>Prevents a partner owned contact that doesn't belong to a resource organization from merging with another partner owned contact that belongs to a resource organization.</td>
</tr>
<tr>
<td>CUST_CONTACT_INTERNAL_PARTNER_ORG_VETO</td>
<td>Prevents a contact owned by an internal user from merging with a contact owned by a partner user.</td>
</tr>
<tr>
<td>CARD_ISSUER_VETO</td>
<td>Prevents an organization party with an active party usage of CREDIT_CARD_PROVIDER from merging with another party.</td>
</tr>
<tr>
<td>LEGAL_ENTITY_VETO</td>
<td>Prevents an organization party with an active party usage of LEGAL_ENTITY from merging with another party.</td>
</tr>
</tbody>
</table>
Duplicate Resolution Setup

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ESTABLISHMENT_VETO</td>
<td>Prevents an organization party with an active party usage of ESTABLISHMENT from merging with another party.</td>
</tr>
<tr>
<td>HIERARCHY_CYCLE_PREVENTION_VETO</td>
<td>Prevents merge from happening when the master party record is at a level lower than the nonmaster party record within the same active tree version.</td>
</tr>
<tr>
<td>NAMEDACCOUNT_UNNAMEDACCOUNT_VETO</td>
<td>Prevents merge from happening when the master party record isn't a named account whereas the nonmaster party record is a named account and these are in active hierarchies.</td>
</tr>
</tbody>
</table>

User-defined Agreement Rules

These are additional agreement rules that you can define to determine whether a merge request should be vetoed by the application. You can create, view, update, and delete user-defined agreement rules.

**Note:** The application doesn't support changing agreement rules inside the Application Composer sandbox. Therefore, the merge engine doesn't pickup the changes made to these rules inside the Application Composer sandbox.

Agreement Rules Dictionary

An agreements rules dictionary is a collection of predefined terms and attributes that can be used to define agreement rules.

The Oracle Customer Data Hub comes with a single predefined dictionary (HZ_Parties) that contains all the predefined Agreement Rules shipped out of the box with the application. You can also use this dictionary to define custom agreement rules according to your business requirements. Note that you can only view the predefined agreement rules. You can't edit them. In contrast, you can create, view, update, and delete user-defined agreement rules. Merge requests that violate agreement rules are rejected.

Before using this dictionary to define custom agreement rules, you must review whether the agreement rule terms and term attributes existing in the predefined agreement rules dictionary are sufficient to define custom agreement rules needed to meet your business requirements. If required, refresh terms to import the latest terms, term attributes, and related metadata, for example, fact types such as entities and objects. Refreshing the dictionary help you pull in all the newly added custom attributes for accounts and contacts.

Define Agreement Rules

This example demonstrates how to create user-defined agreement rules that you can use to prevent a merge request from being processed.

Agreement rules are collections of patterns and conditions that are defined to determine whether a merge request should be vetoed by the application or not. Perform the following tasks to define agreement rules:

- Review and refresh terms in the predefined agreement rules dictionary shipped out of the box
- Add a new agreement rule

Review and Refresh Terms in the Predefined Agreement Rules Dictionary

The Customer Hub application is shipped with a predefined agreement rules dictionary that contains all the predefined Agreement Rules shipped out of the box with the application. Before using this dictionary to define custom agreement rules, you must review whether the agreement rule terms and term attributes existing in the predefined agreement rules dictionary are sufficient to define custom agreement rules needed to meet your business requirements. If required, refresh terms to import the latest terms, term attributes, and related metadata, for example, fact types such as entities and objects. Refreshing the dictionary helps you pull in all the newly added custom attributes for accounts and contacts. Use the following steps to review and refresh the agreement rules dictionary:

1. In the Setup and Maintenance work area, go to the following:
   - Offering: Customer Data Management
   - Functional Area: Customer Hub
   - Task: Manage Agreement Rules

2. On the Manage Agreement Rules page, review whether the agreement rule terms and term attributes existing in the predefined agreement rules dictionary are sufficient to define custom agreement rules needed to meet your business requirements.

3. Click **Refresh Terms** to import the latest terms, term attributes, and related metadata.

4. Click **OK** in response to the confirmation message.

Add a New Agreement Rule

After reviewing and refreshing the Agreement Rules Dictionary using the earlier steps, perform the following steps to create a new custom agreement rule:

1. On the Manage Agreement Rules page, click **Next** to navigate to the Manage Agreement Rules: Define Rules page.
2. Click **Add** from the Actions menu to add a new rule.
3. Enter a rule name.
4. Click **Define Rule**.
5. Enter the reason for creating the agreement rule in the **Justification Reason**.
6. Click **Add** from the Actions menu to create a new pattern.
7. Complete the fields in the new pattern field using the sample information provided in the following table. Use the default values except where indicated. Note that the relation is always AND between patterns and can't be edited. You must include the Dictionary Terms OrganizationPartyVO and PersonPartyVO, with defined MergeType, into the Define Patterns column. These patterns determines the master and nonmaster records.

<table>
<thead>
<tr>
<th>Pattern</th>
<th>Dictionary Term</th>
<th>Term Alias</th>
<th>Relation</th>
</tr>
</thead>
<tbody>
<tr>
<td>for each case where</td>
<td>PersonPartyVO</td>
<td>Person</td>
<td>AND</td>
</tr>
<tr>
<td>for each case where</td>
<td>OrganizationPartyVO</td>
<td>NonmasterParty</td>
<td>AND</td>
</tr>
<tr>
<td>there is a case where</td>
<td>PartyUsageAssignmentVO</td>
<td>PartyUsageAssignment</td>
<td>AND</td>
</tr>
</tbody>
</table>

8. Navigate to the Conditions table.
9. Click **Add** from the Actions menu to add a new condition and complete the fields using the sample information provided in the following table. Use the default values except where indicated.
Source System Confidence

Source System Confidence Levels

Source system confidence levels indicate the reliability of a particular source system for specific attributes. They are used to determine the master or surviving record among multiple duplicate records from different source systems.

For each source system, you can set source confidence score for attributes in the Person and Organization objects. The scores are used to select attributes for the master record during merge operation. The scores are used to select attributes, based on the survivorship rules, for the master record during merge operation. You assign source confidence levels based on your understanding of the quality of the data stored in the various source systems within your organization.

Source system confidence levels range from 0 to 100.

How Source System Confidence Levels Work With Survivorship Rules

You can use source system confidence levels for creating survivorship rules. Survivorship rules are used to retain master records during merge, insert, or update operations.

Source system confidence levels

You can import data from legacy or source systems into the application. The legacy or source systems usually store data associated with the same attributes across systems. Similarly, multiple source systems may have data related to the same account.

Source system confidence levels let you indicate how much you trust the data from a specific source system for an attribute. For example, you may trust the customer address data coming from a financial system more than the same data from a marketing system. Similarly, you may trust the employee name data coming from the Human Relationships...
system more than the same data coming from the Marketing system. While specifying source system confidence levels, you must ensure that only the most reliable data is selected as the master data.

**Survivorship rules**

Oracle CX Sales and B2B Service uses a central data model updated by authorized users from multiple applications. Often, different applications or source systems update the same data resulting in a data conflict.

Survivorship rules are custom business rules that determine how conflicts should be automatically resolved while merging or updating duplicate records from different source systems or applications. For example, you can create a survivorship rule to select the latest customer address data when there are duplicate records.

**Relationship between source system confidence levels and survivorship rules**

Source system confidence levels enable you to build your survivorship rules to resolve duplicate data associated with specific attributes. For example, you could create survivorship rules to:

- Select the record from a source system with confidence values of 80 and above as the master record.
- Automatically reject records from source systems with confidence values of 30 and below.

**Synchronization of Attribute Change History for New Attributes**

When a new attribute is configured for source confidence, you can synchronize the survivorship on update with that attribute's change history. Synchronization is relevant for the first-time a given attribute is configured with source confidence. Changes to an attribute's existing source confidence setup don't require synchronization. Synchronization isn't required to track changes later.

Here's how you synchronize an attribute's source history:

1. In the Setup and Maintenance work area, go to the following:
   - Offering: Customer Data Management
   - Functional Area: Customer Hub
   - Task: Manage Source System Confidence

2. Click Synchronize.

   The sync dialog provides information about the most recently run synchronization job.

3. Select the Object you want to synchronize on the Synchronize Attribute Source History.

4. You can select the **Recommended synchronization start date** option or select **Specify the synchronization start date** option and specify a date.

5. (Optional) Select **Send Notifications** to receive notifications when the synchronization job completes.

6. Click **Submit**.

**Note:** The time taken for this process to complete depends on the number of records to be processed. If this process is taking a long time complete, you can view Last Sync Date and Sync Request ID columns and refresh the page to see the progress. You can also go to the Scheduled Processes page to check the status using the Sync Request ID.
FAQs for Source System Confidence

What are Set Master and Set Attribute rules?
Set Master rules enable you to define the logical business criteria for selecting the master record from a set of potential duplicate records for merge operations.

Set Attribute rules enable you to define the logical business criteria for selecting the best attribute values from multiple input records during merge operation.

Can multiple attributes of an object type have the same source system confidence level?
Yes, you can apply the same source system confidence level to multiple attributes of an object type. You can manage source system confidence levels using the following in the Setup and Maintenance work area: offering: Customer Data Management; functional area: Customer Hub; task: Manage Source System Confidence.

Automerge

The automerge functionality merges duplicate records without any approval or intervention from the data steward. Automatic processing of merge requests is critical when processing large volumes of customer data as automerge can expedite the resolution of duplicate records without manual review.

During automerge, the child entities of the duplicate records, such as contact points, relationships, classifications, and cross references, become the child entities of the master record. Note that groovy scripts on relationship objects don’t run during merges. If they’re critical, you can re-implement the scripts on the parent account or contact.

How Records are Selected for Automerge
Records are selected for automerge based on the following criteria:

- Score threshold: The score threshold is defined in the Match Configuration and determines if a record is included in a duplicate set.
- Automerge threshold: The automerge threshold is defined by the ZCH_AUTO_MERGE_THRESHOLD profile option and determines if the merge request for a duplicate set is processed automatically or if it must be reviewed manually.

Three possible outcomes for each record with regard to duplicate identification and merging are as follows:

- Low score below score threshold: The record isn’t included in duplicate set and in the merge request for that duplicate set.
- Medium score above score threshold and below automerge threshold: The record is included in duplicate set but merge request for that duplicate set must be reviewed manually.
- High score above score threshold and above automerge threshold: The record is included in duplicate set and merge request is processed automatically.
The score for all the records in a duplicate set must be above the automerge threshold for automated processing. If one record in the duplicate set is below automerge threshold, and the other records are above the automerge threshold, the merge request must be reviewed manually.

**Note:** When you merge two or more records with exactly same children information under phone, email, or address the children information is merged and rolled up to the master record.

### How You Configure Automerge

Enabling Automerge involves several implementation steps that must be completed by an implementor using the following tasks from the Customer Data Management offering in the Setup and Maintenance work area:

- **Manage Customer Hub Profile Options**: Use this task from the Customer Hub functional area to perform the following implementation steps:
  
  - Set Auto Merge Threshold profile option (ZCH_AUTO_MERGE_THRESHOLD) to the required value. This profile option specifies the threshold for auto merge. Merge requests with lower scores need data steward review. An exact match is 100.
  - Review the Record Size Limit of Duplicate Set (ZCH_DI_MERGEREQ_REC_SIZE). This profile option determines the maximum number of records in the duplicate set that can be merged automatically. By default, the maximum number is set to 10 records.
  - Set the Survivorship Enabled profile option (ZCH_ENABLE_SURVIVORSHIP) to Yes. This profile option enables the survivorship rules to select the master record and retain the attributes during a merge operation.

- **Manage Survivorship Rules**: Use this task from the Customer Hub functional area to create Set Master survivorship rules to choose the master record for merge requests created from the duplicate identification batch and set the rule to active.

  If there are no active Set Master rules or if the Set Master rules didn't trigger, the merge request must be reviewed manually, even if the ZCH_AUTO_MERGE_THRESHOLD profile option is set, the score for all records is above the threshold value, and the number of records is below the record size limit.

  **Note:** You can use the Set Attribute rules with Set Master rules to determine the Golden Master record. For automerge, Set Master rule is mandatory.

- **Manage Enterprise Data Quality Matching Configurations**: Use this task from the Data Quality Foundation functional area to perform the following implementation steps:
  
  - Create an active Match Configuration in Manage Enterprise Data Quality Matching Configurations task or use a predefined Match Configuration. Rebuild the keys if necessary.
  - Enable EDQ Real Time and Batch Basic Match Server in Manage Server Configurations task.

### Run Automerge

This task involves the following two steps:

1. Create a duplicate identification batch and select Create Merge Request as the Automatic Processing Option.
2. Perform the task Run Request Dispatch Job to disposition the duplicate resolution sets.
The Dispatch Job processes any resolution request in Pending or Submitted status. You can run this job in two modes:

- **On demand**: Run Request Dispatch Job > Submit
- **Per a specific schedule**: Do the following steps to set up a recurring job:
  a. Click Advanced on the Run Request Dispatch Job task.
  b. Click Schedule tab and select the Using a Schedule radio button.
  c. Select the frequency you want and click Submit.

To see the list of dispatch jobs, and their statuses, navigate to Scheduled Processes under Tools.

**Troubleshoot Automerge Issues**

After you create your Duplicate Identification Batch, drill down into the completed batch to see the results. If duplicate sets have been found, and automerge is enabled, resolution requests are automatically submitted for merge.

If the resolution request wasn't submitted automatically, you can drill down to the duplicate set and compare the score for each record with the threshold in the ZCH_AUTO_MERGE_THRESHOLD profile option and the number of records with the limit in the ZCH_DI_MERGEREQ_REC_SIZE profile option. If all scores are above the threshold and the number of records is below the limit, verify that the following are true:

- Set Master rules are active and triggered to choose a master for the records in the duplicate set.
- ZCH_ENABLE_SURVIVORSHIP is set to yes.

**High Volume Batch Deduplication**

Batch deduplication of account or contact records in Oracle Customer Data Management Cloud Service by duplicate identification or resolution.

Batch deduplication consists of the following two steps:

- **Duplicate Identification**: This step includes the identification of duplicate records by submitting a Duplicate Identification Batch job.
  You can define and submit this job from the Duplicate Identification page.
- **Duplicate Resolution**: This step includes the resolution of the duplicates, typically by merging each set of duplicate records.
  You can resolve the duplicates either automatically by submitting the Duplicate Identification Batch job (called Automerge) or manually by submitting records in bulk from the Duplicate Identification Batch results review page.

For more details on these steps and for configuration of Automerge, see Merge Requests, Implementing Customer Data Management.

Both of these jobs are data-intensive operations that can read or update millions of rows of data in various Oracle Application Cloud tables. This document is intended to provide the guidelines and best practices for planning the data-sets, and applying appropriate configurations to achieve optimal throughput for high volume deduplication in Oracle Customer Data Management Cloud Service. Each customer’s data set is unique. The time required to process a duplicate identification batch varies on the data shape.
Best Practices for High Volume Batch Deduplication

Customer Data Management merge is a data-intensive process that scans and updates a large number of tables in Oracle Applications Cloud, to correctly merge two or more Accounts or Contacts.

This section describes how you can use the following profile options to optimize the merge process:

- **Scope of Merge Process** (ORA_ZCH_MERGE_SCOPE): You can use this profile option to define the scope of the merge process.
- **Master Record Selection Method** (ORA_ZCH_SETMASTER): You can use this profile option to specify the method for selecting the master record in a merge request.
- **Create Automerge with Review** (ORA_ZCH_AUTOMERGE_REVIEW): You can use the profile option to select an appropriate processing option for Automerge.
- **Maximum Number of Concurrent Merge Jobs** (ORA_ZCH_MERGE_MAX_REQUEST_LIMIT): Specify the maximum number of merge jobs to be processed at a time. If you don’t set the maximum limit, all merge jobs are submitted for concurrent processing.

You can set these profile options in the Setup and Maintenance work area using the following:

- Offering: Customer Data Management
- Functional Area: Customer Hub
- Task: Manage Customer Hub Profile Options

How You Define the Scope of the Merge Process

When you merge two or more records, the application scans hundreds of transactional and reference tables across all modules in the Oracle Applications Cloud such as, Core Customer Data Management, CRM, Financials, and Manufacturing. This can make merge a data-intensive and time consuming process. However, you can use the Scope of Merge Process (ORA_ZCH_MERGE_SCOPE) profile option to define and limit the scope of merge process in an implementation so that the application scans only the necessary business areas. This optimizes the size of the merge memory and execution profile.

The following options are supported by the Scope of Merge Process profile option:

- **All Functional Areas (ALL):** This is the default option and scans across all areas of Oracle Applications Cloud. You use this option when there's a global implementation running various modules of Oracle Applications Cloud such as, Core Customer Data Management, CRM, Financials, and Manufacturing.
- **All Customer Relationship Management Related Areas (CRM):** This option limits the scope of the process to handle all the CRM entities such as, Opportunities, and Leads, core Customer Data, Common Entities such as, Notes, and Activities, and Custom Objects. You use this option when there's a CRM implementation along with the use of Customer Data Management functionality.
- **Customer Data Management Specific Areas:** This option limits the scope of the process to core Customer Data, Common Entities such as Notes and Activities, and Custom Objects. You use this option during the initial customer data consolidation and to achieve best performance for Customer Data management, implementations.

**Note:** The profile option settings can be changed at any time, if additional modules are turned on the instance. For instance, the Customer Data Management option might be used during initial consolidation and cleanup of customer data and then changed to CRM or ALL options if other modules are implemented later.
How You Define the Master Record Selection Method

The performance of the merge process also depends on the method used to select the master record. You can use the Master Record Selection Method (ORA_ZCH_SETMASTER) profile option to specify an appropriate option for selecting the master party automatically during merge. The following options are supported by the Master Record Selection Method profile option:

- Select master record using survivorship rule (RULE): This is set as the default master selection option. This option selects the master record based on the Set Master rules defined in the Manage Survivorship task. These rules are applied using the Oracle Business Rules component. You use this option when there are complex business rules required to pick the master.
- Select the oldest record as master (OLDEST): This option selects the party with the earliest creation date as the master.
- Select the newest record as master (NEWEST): This option selects the party with the newest creation date as the master.
- Select master based on duplicate identification results (ANY) - This option randomly selects one of the parties in the set as a master.

How you Configure Automerge Action

Automerge is the process of automatically merging identified duplicate sets that exceed the automerge threshold. The process is initiated by creating a duplicate identification batch with the Create Merge Request option. You can use the Create Automerge with Review (ORA_ZCH_AUTOMERGE_REVIEW) profile option that has Yes and No values to select an appropriate processing option for Automerge:

- Create merge requests only for duplicate sets exceeding the automerge threshold: To enable this processing option, select No as the value for the Create Automerge with Review (ORA_ZCH_AUTOMERGE_REVIEW) profile option. If you select this option, the application processes duplicate sets as follows:
  - The application preprocesses the duplicate sets exceeding the automerge threshold and merges them into a single job. This option is ideal for processing high volumes of merge requests when the duplicate sets require no review or any further action.
  - Duplicate sets not exceeding the automerge threshold remain in Not Reviewed status in the Duplicate Identification page, from where they can be manually converted to merge requests, or rejected, if needed.
- Create Merge Requests for all duplicate sets: To enable this processing option, select Yes as the value for the Create Automerge with Review (ORA_ZCH_AUTOMERGE_REVIEW) profile option. If you select this option, merge requests are created for all duplicate sets. All requests are first pre-processed. Then they’re either merged (if they exceed the automerge threshold), or put in “New” status (so that they can be reviewed) if they don't exceed automerge threshold.

How you Control the Concurrency of Merge Processes

Each merge request executes as a single batch process in the Enterprise Service Scheduler (ESS). The number of merge requests executing concurrently is limited by the number of batches being concurrently processed. Therefore, if there are other ESS processes competing for threads when there are a large number of merge requests queued up, then the scheduling of those jobs could get delayed.

During initial consolidation of customer data, it's advantageous to use the maximum available threads. However, in steady state when there are other processes running in the background, it may be necessary to limit and control the number of concurrent merge ESS jobs.
To achieve this, set the following profile option to an appropriate value:

- **Profile Option Name**: Maximum Number of Concurrent Merge Jobs
- **Profile Option Code**: ORA_ZCH_MERGE_MAX_REQUEST_LIMIT

  - When the profile option value is left blank or when no value is defined, the ESS will allocate merge requests according to the threads available. This is recommended during initial high volume data processing.
  - After initial data load, set the profile option value to ten or lower if other processes such as Web services or other ESS jobs are running.

### FAQs for Duplicate Resolution

#### Why didn't I see custom objects while creating a merge request?

The merge process handles custom objects that have been published to the mainline repository; it doesn't handle custom objects in unpublished sandboxes.

#### Why can't I see the results of real-time matching of Accounts and Contacts?

During real-time matching of Accounts and Contacts using the UI, the visibility of the results depends upon the user account you're using which could be restricted based on the security configuration. This isn't applicable to batch or web services matching operations.

#### Is there a limit to the number of characters in an API name of custom fields in a duplicate resolution request?

Yes, there is a character limit. Ensure that the API name of custom fields in a duplicate resolution request is 100 characters or less.
21 Customer Data Management Integration with Other Cloud Services

Customer Data Management Integration Approaches

You can integrate the Customer Data Management functionality of Oracle CX Sales and B2B Service with other cloud services using REST APIs and SOAP APIs to provide address cleansing, duplicate identification, and duplicate resolution capabilities.

Alternatively you can use the Integration Cloud Service to develop work flows to integrate Customer Data Management with other cloud based or on-premise applications.

Customer Data Management Integration Using REST APIs

The Oracle Customer Data Management functionality of Oracle CX Sales and B2B Service provides multiple public REST APIs that can be used to access data stored in the Customer Data Management database and construct integrations to other systems. The APIs include resources to Get, Post (create), Patch (update), and Delete organizations (accounts) and persons (contacts). Also there are resources to identify and create resolution request for duplicate parties.

For more information on public REST APIs, see REST API for CX Sales and B2B Service.

Customer Data Management Integration Using SOAP APIs

The Customer Data Management functionality of Oracle CX Sales and B2B Service provides SOAP services to create and update organizations (accounts) and persons (contacts). You can also use these services to identify and resolve duplicate parties.

For more information on SOAP APIs, see Oracle CX SOAP Web Services for CX Sales and B2B Service.

Customer Data Management Integration with Import and Export

You can use Import and Export Management, and Data Import to import and export application data using text or XML files into and out of the Customer Data Management registry.

You can also import attachments using Import and Export Management. Note that the imported attachments aren't visible in Customer Data Management if you used the Account or the Contact import objects but can be viewed in Customer Center. To import attachments in Customer Data Management, using Import and Export Management you must use the Organization and Person import objects. For more information about importing attachments, see the Related Topics section.

You can also use import to create or update records in the Customer Data Management registry.

Customer Data Management Integration Using the Integration Cloud Service

You can use the Integration Cloud Service to leverage predefined integrations between Customer Data Management, other cloud services, and on premise applications. For example, you can integrate Oracle Service Cloud with Customer Data Management to provide the duplicate resolution capability. Using this capability, you can merge an Oracle Sales
and B2B Service account (organization) or contact (person) with an Oracle B2C Service account (organization) or contact (person).

For more information on the Integration Cloud Service, see Oracle Integration Cloud Service in the Related Topics section.

Customer Data Management Integrations for Accounts (Organization) and Contacts (Persons)

The following table shows the possible integrations options for Oracle Customer Data Management. The table also lists the available REST and SOAP web services that you can use to perform the different Customer Data Management processes.

<table>
<thead>
<tr>
<th>Customer Data Management Process (Batch Job)</th>
<th>REST Service</th>
<th>Data Import (for account Receivables only)</th>
<th>Data Import</th>
<th>Data Export</th>
<th>ICS Events</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Address Cleansing</td>
<td>Address Cleansing is available by the REST service from Oracle Address, Email, and Phone Verification only.</td>
<td>No</td>
<td>No</td>
<td>Yes (Batch Summary only). Doesn’t include child object such as duplicate address and relationships.</td>
<td>No</td>
<td>None</td>
</tr>
<tr>
<td>Duplicate Identification</td>
<td>Yes. The ‘accounts’, ‘contacts’, ‘hubOrganizations’, and ‘hubPersons’ REST resources all support the findDuplicates action for API-based real-time duplicate identification.</td>
<td>No</td>
<td>No</td>
<td>Yes (Batch Summary only). Doesn’t include child object such as duplicate address and relationships.</td>
<td>No</td>
<td>None</td>
</tr>
<tr>
<td>Duplicate Resolution and Merging</td>
<td>Yes. The crmRestApi/resources/latest/resolutionRequests REST service can create new resolution requests and query existing resolution requests but can’t update the existing requests.</td>
<td>No</td>
<td>No</td>
<td>Yes. The Resolution Details object which is a child of the resolution request header export object. The resolution details object provides the full details for child objects in the merge scope.</td>
<td>Yes. Public Resolution Request Updated.</td>
<td>None</td>
</tr>
<tr>
<td>Data Enrichment</td>
<td>Data enrichment is available by REST service from Oracle Account and Contact</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
<td>No</td>
<td>None</td>
</tr>
</tbody>
</table>
## Customer Data Management Integration with Other Cloud Services

### Customer Data Management Process (Batch Job)

<table>
<thead>
<tr>
<th>REST Service</th>
<th>Data Import (for account Receivables only)</th>
<th>Data Import</th>
<th>Data Export</th>
<th>ICS Events</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enrichment by Dun &amp; Bradstreet (D&amp;B) only.</td>
<td>N/A</td>
<td>Yes</td>
<td>Yes</td>
<td>N/A</td>
<td>None</td>
</tr>
<tr>
<td>Non-Duplicate</td>
<td>crmRestApi/resources/latest/nonDuplicates</td>
<td>N/A</td>
<td>Yes</td>
<td>Yes</td>
<td>N/A</td>
</tr>
<tr>
<td>Resolution Link</td>
<td>crmRestApi/resources/latest/resolutionLinks</td>
<td>N/A</td>
<td>Yes</td>
<td>Yes</td>
<td>N/A</td>
</tr>
</tbody>
</table>

### Related Topics
- Import Attachments
- Oracle Integration Cloud Service
- Import Your Resolution Link Data
- Import Your Nonduplicate Data

## Merge Operation Process During Integration Cloud Service Based Integration

The Customer Data Management functionality of Oracle CX Sales and B2B Service acts as the customer master during Integration Cloud Service based integration between different cloud services (also known as spoke systems).

You can use Customer Data Management to cleanse, consolidate, and share customer data across integrated cloud services. This topic explains how the duplicate resolution capability of the Customer Data Management functionality merges records across integrated cloud services, for example, how it merges an Oracle CX Sales and B2B Service account or contact with an Oracle Service Cloud account or contact.

### Merge Operation Process for Point to Point Integration

In this integration scenario, Customer Data Management provides the duplicate resolution capability to a single spoke system.

The following diagram shows the before merge status of two contacts, Contact A and Contact B, of an account from Spoke 1.
The following diagram illustrates how the two contacts, A and B, of the account from Spoke 1 are being merged in CDM and how the Contact A emerges as the master and the Contact B becomes the non-master.
The following diagram shows the after merge status of two contacts, A and B, of the account. Note that in Spoke 1 only Contact A has survived and remained active after the merge.

![Diagram showing merge status]

**Merge Operation Process for Publish and Subscribe Integration**

In this integration scenario, Customer Data Management provides the duplicate resolution capability to two or more integrated cloud services or spoke systems. Duplicate data from spoke systems is consolidated in CDM and the mastered data is published to the subscribing spoke systems.

The following diagram shows the before merge status of two contacts, A and B, of an account that exists both in Spoke 1 and Spoke 2.
The following diagram shows the after merge status of two contacts, A and B, of the account.
Take note of the following:

- Data about Contacts A and B comes in Customer Data Management registry from both the spoke systems.
- The merge is taking place in Customer Data Management registry and any owned objects by the non-masters are moved (re-parented) to master record in CDM.
- The mastered data is published to both the spoke systems and, consequently, Contact B is deleted from both the spoke systems.
- When performing merge across different cloud services using ICS based integration, you should explicitly publish to merge events and not rely on account, contact, and household composite events. You can publish merge events by implementing the Resolution Request Updated business event in ICS.